Modeling Population Dynamics

André M. de Roos
Modeling Population Dynamics

André M. de Roos

Institute for Biodiversity and Ecosystem Dynamics
Population Biology Section, University of Amsterdam
Kruislaan 320, 1098 SM Amsterdam, The Netherlands
E-mail: A.M.deRoos@uva.nl

December 17, 2014
Contents

I Preface and Introduction

1 Introduction
   1.1 Some modeling philosophy

II Unstructured Population Models in Continuous Time

2 Modelling population dynamics
   2.1 Describing a population and its environment
      2.1.1 The population or p-state
      2.1.2 The individual or i-state
      2.1.3 The environmental or E-condition
   2.2 Population balance equation
   2.3 Characterizing the population
   2.4 Population-level and per capita rates
   2.5 Model building
      2.5.1 Exponential population growth
      2.5.2 Logistic population growth
      2.5.3 Two-sexes population growth
   2.6 Parameters and state variables
   2.7 Deterministic and stochastic models

3 Single ordinary differential equations
   3.1 Explicit solutions
   3.2 Numerical integration
   3.3 Analyzing flow patterns
   3.4 Steady states and their stability
   3.5 Units and non-dimensionalization
   3.6 Existence and uniqueness of solutions
   3.7 Epilogue

4 Competing for resources
   4.1 Intraspecific competition
<p>| CONTENTS |
|-----------------|-----------------|
| 4.1.1 Growth of yeast in a closed container | 38 |
| 4.1.2 Bacterial growth in a chemostat | 40 |
| 4.1.3 Asymptotic dynamics | 43 |
| 4.1.4 Phase-plane methods and graphical analysis | 44 |
| 4.2 Interspecific competition | 52 |
| 4.2.1 Lotka-Volterra competition model | 53 |
| 4.2.2 Competition for resources | 57 |
| 5 Systems of ordinary differential equations | 77 |
| 5.1 Computation of steady states | 77 |
| 5.2 Linearization of dynamics | 78 |
| 5.3 Characteristic equation, eigenvalues and eigenvectors | 81 |
| 5.4 Phase portraits of dynamics in planar systems | 84 |
| 5.4.1 Two real eigenvalues | 85 |
| 5.4.2 Two complex eigenvalues | 90 |
| 5.5 Stability of steady states in planar ODE systems | 94 |
| 5.6 Models with 3 or more variables | 96 |
| 6 Predator-prey interactions | 99 |
| 6.1 The Lotka-Volterra predator-prey model | 100 |
| 6.1.1 Incorporating prey logistic growth | 104 |
| 6.1.2 Incorporating a predator type II functional response | 108 |
| 6.2 Confronting models and experiments | 117 |
| 6.2.1 Predator-controlled, steady state abundance of prey | 119 |
| 6.2.2 Oscillatory dynamics at high prey carrying capacities | 123 |
| 6.2.3 Concluding remarks | 127 |
| III Bifurcation theory | 131 |
| 7 Continuous time models | 133 |
| 7.1 General setting | 134 |
| 7.2 Transcritical bifurcation and branching point | 132 |
| 7.3 Saddle-node bifurcation and limit point | 143 |
| 7.4 Hopf bifurcation | 143 |
| 7.5 Concluding remarks | 136 |
| IV Exercises | 147 |
| 8 Exercises | 149 |
| 8.1 ODEs (differential equations) in 1 dimension | 149 |
| 8.1.1 Population size and population growth rate | 149 |</p>
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.6 The Paradox of Enrichment</td>
<td>201</td>
</tr>
<tr>
<td>10.7 The Return of the Paradox of Enrichment</td>
<td>202</td>
</tr>
<tr>
<td>10.8 Cannibalism</td>
<td>203</td>
</tr>
<tr>
<td>10.9 A predator-prey model with density-dependent prey development</td>
<td>204</td>
</tr>
</tbody>
</table>

Bibliography 205
List of Figures

2.1 Growth of the world population over the last century

2.2 Population age distribution in the Netherlands in 1950, 1975 and 2000

2.3 Total number of births and death per 5 year age class in the Netherlands in 1999

4.1 Growth of the yeast Schizosaccharomyces kephir over a period of 160 h

4.2 Schematic layout of a chemostat for continuous culture of micro-organisms

4.3 Geometric representation of a system of ODEs in the phase plane

4.4 The phase plane of the bacterial growth model in a chemostat

4.5 Operating diagram of a chemostat

4.6 Four isocline cases for the Lotka-Volterra competition model

4.7 Four isocline cases with steady states and flow patterns for the Lotka-Volterra competition model

4.8 Michaelis-Menten relationship as a function of resource concentration

4.9 Zero net growth isoclines for a one consumer-two resource model

4.10 Steady state location in a one consumer-two resource model

4.11 Steady state location in a two consumer-two resource model

4.12 Predicted and observed outcomes of competition for phosphate and silicate by Asterionella formosa and Cyclotella meneghiniana

4.13 Single-species Monod growth experiments for four diatoms under conditions of limited silicate

4.14 Single-species Monod growth experiments for four diatoms under conditions of limited phosphate

4.15 Predicted and observed outcomes of competition between Asterionella formosa and Synedra filiformis

4.16 Predicted and observed outcomes of competition between Asterionella formosa and Tabellaria flocculosa

4.17 Predicted and observed outcomes of competition between Asterionella formosa and Fragilaria crotonensis

4.18 Predicted and observed outcomes of competition between Synedra and Fragilaria

4.19 Predicted and observed outcomes of competition between Synedra and Tabellaria

4.20 Predicted and observed outcomes of competition between Fragilaria and Tabellaria

4.21 The four cases of resource competition in a two consumer-two resource model
5.1 Geometric representation of two real-valued eigenvectors in a planar system ................................. 87
5.2 Characteristic flow patterns in the neighborhood of the steady state with real-valued eigenvalues and eigenvectors ................................................................. 88
5.3 Geometric representation of the two basis vectors in a planar system with complex eigenvectors ................................................................. 91
5.4 Characteristic flow patterns in the neighborhood of the steady state with complex eigenvalues and eigenvectors ................................................................. 92
5.5 Summary of stability properties for planar ODE systems ................................................................. 95
6.1 Solution curves in the phase plane of the Lotka-Volterra predator-prey model ........................................ 102
6.2 Prey dynamics predicted by the Lotka-Volterra predator-prey model ........................................ 103
6.3 Solution curves in the phase plane of the Lotka-Volterra predator-prey model with logistic prey growth ................................................................. 107
6.4 Functional response of *Daphnia pulex* on three algal species ................................................................. 109
6.5 Nullclines of the Rosenzweig-MacArthur predator-prey model ................................................................. 112
6.6 Solution curves in the phase plane of the Rosenzweig-MacArthur predator-prey model ................................................................. 116
6.7 Solution curve in the phase plane of the Rosenzweig-MacArthur predator-prey model for high carrying capacity ................................................................. 117
6.8 Oscillatory dynamics of the Rosenzweig-MacArthur predator-prey model for high carrying capacity ................................................................. 118
6.9 *Daphnia pulex* carrying asexual eggs in the brood pouch ................................................................. 119
6.10 Schematic setup of the experiments by Arditi et al. (1991) ................................................................. 120
6.11 Population dynamics of *Daphnia*, *Ceriodaphnia* and *Scapholeberis* in a chain of semi-chemostats ................................................................. 122
6.12 Population equilibria of *Daphnia* and *Ceriodaphnia* in a chain of semi-chemostats ................................................................. 123
6.13 Predicted and observed equilibrium values of algae in the presence of *Daphnia* ................................................................. 124
6.14 Population dynamics of the snowshoe hare and the lynx in northern Canada ................................................................. 125
6.15 Population dynamics of two species of voles in northern Finland ................................................................. 126
6.16 Cycle amplitudes (log) observed for *Daphnia* and algal populations from lakes and ponds ................................................................. 126
6.17 Examples of the dynamics of *Daphnia* and algae in nutrient-rich and nutrient-poor, experimental tanks ................................................................. 127
6.18 Large- and small-amplitude cycles of *Daphnia* and edible algae in the same global environment ................................................................. 128
6.19 Energy channelling towards sexual reproduction prevents the occurrence of large-amplitude predator-prey cycles in *Daphnia* ................................................................. 128
7.1 Eigenvalue positions in the complex plane corresponding to a stability change in a 2 ODE model ................................................................. 136
7.2 Bifurcation structure of the cannibalism model for \( \alpha < \rho \) ................................................................. 140
7.3 Bifurcation structure of the cannibalism model for \( \alpha > \rho \) ................................................................. 141
7.4 Schematic, 3-dimensional representation of the Hopf-bifurcation in the Rosenzweig-MacArthur model ................................................................. 144
9.1 The main system window of \texttt{MatCont} \hfill 178
9.2 Empty system specification window of \texttt{MatCont} \hfill 179
9.3 Specification of the logistic growth model in \texttt{MatCont} \hfill 180
9.4 \texttt{MatCont}'s numeric window and its layout submenu \hfill 181
9.5 \texttt{MatCont}'s 2D-plot window \hfill 182
9.6 Desktop with all \texttt{MatCont} windows after computing an orbit of the logistic growth model \hfill 184
9.7 Implementation of the Rosenzweig-MacArthur model in \texttt{MatCont} \hfill 186
9.8 Desktop view of the Rosenzweig-MacArthur model in \texttt{MatCont} after computation of the branch of trivial equilibria (with zero predator density) \hfill 187
9.9 Desktop view of the Rosenzweig-MacArthur model in \texttt{MatCont} \hfill 188
9.10 Modifying the curve colors in \texttt{MatCont}'s 2D-plot window \hfill 189
9.11 Modifying a \texttt{MatCont} 2D-plot using the \texttt{Matlab}'s Figure editor \hfill 191
List of Tables

4.1 State variables and parameters of a bacterial growth model in a chemostat . . 42
4.2 State variables and parameters of Tilman’s resource competition model . . . 58
4.3 Silicate and phosphate parameters for four Lake Michigan diatoms . . . . 72

5.1 Important characteristics of systems consisting of two linear(ized) differential equations .................................................. 86
5.2 The Routh-Hurwitz stability criteria (following May 1974) ....................... 97

7.1 Characteristics of all possible types of steady states in a 2-dimensional, continuous-time model ................................................. 135
Part I

Preface and Introduction
Chapter 1

Introduction

This course is intended as an introduction to the formulation, analysis and application of mathematical models that describe the dynamics of biological populations. It starts at a very basic level, probably repeating some material that is also part of an introductory ecology course. Nonetheless, I think this rehearsal is necessary and useful, while it allows me to emphasize some theoretical aspects that are certainly not part of an introductory ecology course.

The course material brought together here stems to a larger or lesser extent from earlier textbooks on theoretical ecology. Most notably, I have used the books by Edelstein-Keshet (1988), Yodzis (1989) and Murray (1989) as sources for the text presented. However, all of these books have slightly different approaches and put emphasis on slightly different aspects of theoretical ecology. My intention is to emphasize more the biological and the conceptual aspects of the theory in that I devote quite some attention to the formulation of models (the model building stage) and the interpretation of the mathematical analysis in terms of biological conclusions. This approach is probably most similar to the approach in Yodzis (1989), although I also add some new material and I hope to put even more emphasis on biological case studies.

1.1 Some modeling philosophy

In my opinion it is fair to say that every scientist in one way or another uses models, although they are by far not all mathematical. It is indeed hard to imagine to do science without a model: even the most empirical scientist will have some idea or hypothetical/stylized representation in his mind of the system that he is working on. This mental representation subsequently guides him in making new observations that lead to a better understanding of the system studied. In my opinion a model should hence not strive for a description, but rather a conceptualization of a system. Moreover, this conceptualization should not just be a static reflection, but should incorporate the workings or mechanics of the system. I hence as much as possible advocate a mechanistic approach to model building. Given that a model is a conceptualization or abstraction, by definition it is also an incomplete and often even a false representation of the system. The analysis of models that turn out to be at odds with observations often elucidates more insight about the system than a model whose predictions are roughly in line with observations. In this respect, I tend to compare models with the $H_0$ and $H_1$ hypotheses in statistics: Only a rejection of the $H_0$-hypothesis in favor of the $H_1$-hypothesis makes a strong statement about a particular phenomenon. Loosely speaking one could therefore say: “The best model is a wrong one!”

To students that are new to modelling, models always seem very simplistic and hence a poor reflection of the real world. This often leads to the misconception that experimental results
CHAPTER 1. INTRODUCTION

convey more information about a particular system than the analysis of a model. Moreover, many people are likely to think that making a model and analysing it is a quick and easy job, while experiments take much more time and effort. I would strongly argue against both these misconceptions. First of all, any attempt, be it experimental or theoretical, to comprehend how a particular system works is forced to use a simplified conceptualization of the system. In my opinion the main difference is that, especially mathematical, models are extremely explicit about the assumptions they make. Experimental studies often make similar assumption, but very implicitly. \cite{Caswell1988} has nicely discussed this issue using data that he obtained from a purely empirical poster session during the IVth International Congress of Ecology in Syracuse, N.Y., in 1986: The majority of experimental studies presented at the poster session only considered one or two, at most three factors in their experimental setup. These studies did not assume that other factors were unimportant, but they were simply not part of the study. While building a mathematical model, a theoretician would quickly be forced to make this particular situation explicit by making a statement like “I assume that all other factors are constant”. Even though in essence the experimental and theoretical study are not different in their basic assumptions, the explicitness with which a modeller states his assumptions often meets with a lot of opposition.

Also the perception that modeling studies are quick and easy is rather misleading. It is indeed true that it only takes an afternoon or two to write down some equations that with a lot of handwaving might be argued to reflect a biological system. Given the availability of modern software packages, the same afternoon would also provide sufficient time to analyse the characteristics of this set of equations. Such an exercise would be comparable with a very simple pilot experiment, which could in some cases also be carried out in a single afternoon. It is very unlikely that either of the two, the quick and easy modeling exercise and the pilot experiment, would yield results that are worth publishing. From my own experience of using models I can only conclude that using mathematical models for developing theory which has a sound logical basis and moreover deepens our insight about a particular system in my opinion takes just as long as an experimental approach to gaining the same insight (if it were feasible). There is essentially less difference between the two approaches as one might think of at first.

There are good reasons for mathematical models to be so widely used in ecology. Ecosystems tend to be very complex and governed by many intricate and usually non-linear mechanistic interactions. Thinking through these complex relationships might be attempted with just a verbal reasoning approach. However, as \cite{Yodzis1989} phrases it, this would be too mind-boggling confusing. Mathematics is ideally suited to not only express these complex relationships in a succinct way, but mathematics also forces one to be exact in his or her statements of a system. As mentioned before, a mathematical model is very explicit about what exactly is assumed about a system and what not. Moreover, once a model has been formulated mathematics offers the appropriate tools to analyse its consequences, again exactly. Mathematics can hence be viewed as a language that is most appropriate for logical reasoning and logical analysis of problems.
Part II

Unstructured Population Models in Continuous Time
Chapter 2

Modelling population dynamics

Population ecology is concerned with developing theory and insight about the persistence, structure and dynamics of biological communities. Often these communities are made up by a large number of species. Necessarily, population ecology is therefore dominated by a focus on interspecific interactions such as competition and predation. Studies that focus on developing mathematical models to describe population dynamics hence also often consider more than a single species. From this focus on multispecies communities one could easily get the impression that modeling the dynamics of a single species is not important or uninteresting. Or one could think that there is not much to discover in models of single populations. There are, however, many cases in which relatively simple processes of population growth are of fundamental importance, both from a scientific and an applied point of view. In this respect one can, for example, think about the following cases where the growth of a single population is the predominant process:

- Exponential population growth of the human population
- Invasions of exotic or genetically modified organisms in natural environments
- Epidemics of infectious diseases and strategies for their prevention.

In the following sections I will subsequently discuss what it takes to model the dynamics of populations and what can be learned from the analysis of the models derived. The aim is to introduce some basic principles of population modeling and some techniques for model analysis.

2.1 Describing a population and its environment

In this section I will introduce some basic concepts of population dynamic models. The discussion in this section is rather formal as it does not directly relate to a biological system or idea.

2.1.1 The population or p-state

Formulating a model for the dynamics of any population is equivalent to specifying a recipe for population change. Basically, a population dynamic model answers the question how a population is going to change in the (near) future, given (1) its current status and (2) the environmental conditions that the population is exposed to. These changes in the population may be changes in the total number of individuals present, \textit{i.e.} in the number of population members, but may also pertain to changes in the composition of the population. For example, the population model may be a recipe for how the number of small and large individuals, or juvenile
and adult individuals is going to change. Alternatively, the population may change in overall abundance, while the relative frequency of old and young individuals stays constant. As an example, consider the changes in the human population over the last 100 years (see Figure 2.1). Not only has there been a lot of interest in the changes in the total number of people in the world, as it grows virtually exponentially to what might be unsustainable abundances, but also has there been a lot of interest in the population age structure or age distribution, leading to expressions like “baby boomers” or “aging population” (see Figure 2.2). The two important characteristics of a population for its future developments are (1) the total number of individuals in the population and (2) the composition of the population in terms of old/young, small/large or juvenile/adult individuals. More formally, the first of these two aspects is often referred to as the population size or population abundance, while the second is referred to as the population structure. Together the population abundance and structure define the population state or p-state. The p-state is the characterization of the population in terms of how many individuals of which type (e.g. age, size, sex) are present in the population.

2.1.2 The individual or i-state

The individual organism itself is the fundamental entity in the dynamics of the population, since changes in the population can only come about because of events that happen with individual organisms. For example, changes in the population abundance are the direct consequence of birth, death, immigration and emigration of individual organisms, while changes in the population age- or size-distribution are the result of aging or growth in body size of individual organisms.

If we want to keep track of the age- or size-distribution of a population it is necessary to distinguish the individual members of the population on the basis of their age or body size, respectively. On the other hand, in many cases the chance that a particular individual will give
2.1. DESCRIBING A POPULATION AND ITS ENVIRONMENT

Figure 2.2: Population age distribution in the Netherlands in 1950, 1975 and 2000. Every bar represents the number of individuals in the Netherlands in a 5 year age class, starting with 0-4 year and 5-9 year old individuals and ending with 90-94 year old individuals and individuals of 95 year and older. Data: CBS, The Netherlands.

birth or will die strongly depends on its age or its body size. For example, in humans living in a developed country giving birth mainly occurs between the age of 18 and 45 years (for the mother), while death occurs mainly at older ages (see Figure 2.3).

For a variety of reasons we therefore often want to distinguish individual organisms from each other on the basis of a number of physiological characteristics, such as age, body size or sex. The individual state or i-state is the collection of physiological traits, that are used to characterize individual organisms within a population and that influence its life history in terms of its chance to reproduce, die, grow or migrate. The individual state may be any collection of variables that characterize individuals, but its choice is usually kept limited to one or two physiological variables (e.g. age and/or size).

2.1.3 The environmental or E-condition

The environmental conditions that a population is exposed to are important for its dynamics, while it usually sets the limits for its development. Environmental conditions can pertain to biotic and abiotic factors, for example, temperature, humidity, food abundance and the number of predators or competitors around. Since the individual organism is the fundamental entity in population dynamics, it is actually more appropriate to consider the environmental conditions that an individual member of the population is exposed to. For a specific individual organism, the environment is not only made up by the ambient temperature or food abundance that it is exposed to, but also by the number and type of fellow members within the population. This aspect of its environment is, for example, important if the individual reproduces via sexual reproduction. As an another example, if a species is potentially cannibalistic, the number of
CHAPTER 2. MODELLING POPULATION DYNAMICS

5 year age class

Figure 2.3: Total number of births and death per 5 year age class in the Netherlands in 1999. Every bar represents the number of individuals born (red) or died (blue) in the Netherlands in a 5 year age class, starting with 0-4 year and 5-9 year old individuals and ending with 90-94 year old individuals and individuals of 95 year and older. Data: CBS, The Netherlands.

fellow population members may influence the risk of dying for a particular young and small individual.

The environmental or $E$-condition of a particular individual hence comprises the collection of abiotic and biotic factors, external to the individual itself, that influences its life history. The $i$-state of a particular individual could hence be viewed as determining, for example, its potential reproduction, while the $E$-condition will modulate this potential and thus set the realized reproduction. Similar arguments hold for the chances of a particular individual to die or grow.

2.2 Population balance equation

If we consider a population to be the collection of individuals of a particular species that lives within a well-defined area, any changes in the number of individuals within this population comes about by reproduction, death or migration of individual organisms. More formally, we can express a population dynamic model with the following (semi-)equation:

\[
\text{Population change} = \text{Births} - \text{Deaths} + \text{Immigration} - \text{Emigration} \quad (2.1)
\]
2.3. CHARACTERIZING THE POPULATION

This equation reflects the general structure of a population balance equation. The phrase “balance equation” refers to the fact that changes in population abundance are a balance between processes that decrease this abundance (e.g., death and emigration) and processes that increase the abundance (e.g., reproduction and immigration).

Both immigration and emigration of individuals can be neglected if the area in which the population is considered to live is closed off to any movement of individual across its perimeter. Also when the size of the area is very large relative to its circumference, immigration and emigration might be of negligible importance. In those cases, population dynamics is just the balance between the number of birth and death cases of individual organisms. Population for which immigration and emigration can be neglected are usually referred to as closed populations or closed systems, as opposed to open populations or open systems, that are “open” to migration. Good examples of closed systems are lakes and many of the population living in them, while rivers or tidal zones on the shore are typical examples of open systems.

2.3 Characterizing the population

Before we can make the general population balance equation (2.1) more explicit we will have to decide on how to characterize the population that we want to model. This process is the first step in building or formulating a model. Model building is a crucial aspect of theoretical population biology, as it forces a modeler to think carefully about the important aspects of the system that he/she wants to describe. Important issues to consider while choosing a particular representation of a population are, for example:

- Is it necessary to distinguish individual organisms from each other and if yes, what variables are used for this purpose?
- What individual traits predominantly influence reproduction and death on the individuals within the population?
- Are there biotic or abiotic factors in the environment that strongly influence the life history of individuals?

Answering these questions is not straightforward and is actually an art in itself (“the art of modeling”). Many people that are new to modeling are tempted to say that a model should include as many variables as possible to describe a particular system. However, ultimately such an approach would just lead to a mathematical copy of reality, which would probably be impossible to investigate and from which we could only learn just as much as we can learn from studying the real-world system we want to model. What then is the aim to develop a model?

Therefore, building a population dynamic model forces a modeler to make judicious choices about which aspects of the study system to include into the model and which to neglect. Such choices should be decided upon on the basis a number of different considerations:

- What is the aim of the model to be developed? For example, if a model is developed to study the age-distribution of the human population it is necessary to distinguish individuals of the population on the basis of their age. However, for many other species (think about algae or mosquitoes) characterizing individual organisms with their age is in most cases not very relevant. Even more, it may be unnecessary to distinguish individual organisms from each other at all!
- What are the important processes that influence the population dynamics? For example, does the model have to account for immigration or emigration or is it appropriate to consider a closed population?
• Which factors influence the chance that individuals give birth or die? For example, are there any predators present that individuals might fall prey to?

• What is technically feasible? This is often a very important modeling consideration. Ideally, a model should be as simple as possible, while still capturing the essentials of the system that is to be modeled (the “most parsimonious model”). It is, however, obvious that there will always be a trade-off between model simplicity and the amount of detail that a model can incorporate. If the model incorporates too much detail, it becomes impossible to analyze while with too much simplicity the model looses its meaning.

Even though the individual organism is such a fundamental entity in both ecology and evolution, most population dynamic models do not at all distinguish between different individuals. This is very much the result of technical limitations: accounting for population structure makes the more explicit specification of the population balance equation (2.1) just so much more difficult and its analysis a daunting task. In general, ecological and evolutionary theory is therefore based on so-called unstructured population models, that is, models that ignore the presence of population structure. Developing theory that does account for differences among individuals within the same population, i.e. on the basis of structured population models that do account for population structure, is very much the cutting edge of contemporary ecological research.

Unstructured population models are hence based on an assumption that all individuals within a population are identical. The population state or $p$-state is in this case simply the same as the total number of individuals within a population. This total number at a specific point in time $t$ will frequently be denoted by $N(t)$. Often the explicit occurrence of the time $t$ as an argument is left out and we simply write $N$ to indicate the total population abundance.

### Restrictions:

To start with we will ignore any population structure and hence consider the population abundance $N$ as the quantity that specifies our population state. Only in later discussions we will sometimes take into account population structure. Moreover, we start by considering closed populations and hence neglect immigration and emigration of individuals to and from our population under study.

### 2.4 Population-level and per capita rates

Consider now the population abundance at time $t$, indicated by $N(t)$, and its abundance some time later, indicated by $N(t+\Delta t)$. $\Delta t$ refers here to the, possibly small, interval of time. Making the balance equation (2.1) more explicit, we can now write

$$N(t + \Delta t) - N(t) = \text{Number of births during } \Delta t - \text{Number of deaths during } \Delta t$$

(2.2)

Obviously, the change in the population state (which is the same as the population abundance due to our restrictions) is the difference between $N(t + \Delta t)$ and $N(t)$. Because we have assumed

---

1Strictly speaking, it is fair to say that unstructured models assume that all individuals within a population can be represented by some “average” type.
2.4. POPULATION-LEVEL AND PER CAPITA RATES

that there is no immigration and emigration, this change should equal the difference between
the number of individuals that have been born during the time interval \( \Delta t \) and the number
that have died during that interval. Note that the quantities in the above equation all relate to
numbers of individuals.

In the previous section we imposed two restrictions on the class of models that we are going to
discuss: (1) we decided to focus on unstructured population models, which ignore population
structure, and (2) we decided to focus on closed populations. These restrictions can be viewed
as dichotomies between different classes of models: the first restriction sets the class of unstruc-
tured population models apart from the class of structured population models, while the second
restriction sets the class of models for closed populations apart from those for open populations.
Here we encounter another dichotomy, which sets apart the class of discrete-time models from
continuous-time models.

Many text books on population modeling start by considering population dynamics in discrete
time. This is a very useful assumption, for example, when the aim is to model a population
of annual plants. If reproduction only occurs once a year (or once a season) we could simply
choose to specify the changes in the population state from year to year without specifying how
the number of individuals in the population changes within a year. Take as an example a
population of annual plants that reproduce by producing seeds, which overwinter and germinate
in the next year. We could model this population by observing the number of plants present
at the beginning of a growing season, say May 1st of every year. \( N(t) \) would in this case be
the number of plants in one year and \( N(t + \Delta t) \) the number in the year after, while \( \Delta t \) equals
exactly 1 year. Specifying the number of deaths during \( \Delta t \) (\( = 1 \) year) is straightforward, as
all plants are annual and hence die before the next census time at \( t + \Delta t \). The modeling of
the dynamics in this case would boil down to specifying how the number of plants in a specific
year (at time \( t + \Delta t \)) is related to the number of plants in the year before (at time \( t \)). This
involves specifying the relationship between the number of seeds produced by a population of
size \( N(t) \), the probability that a seed germinates into a seedling and the probability that this
seedling grows into a new plant. The essence is that the model only describes what the state of
the population is at May 1st of each year. Two different species might show the same population
dynamics (when censused at May 1st of each year), while the one species flowers only in May
with all plants dying before the end of June and the other flowers all summer and plants die only
during winter. In other words, discrete time models only determine the state of the (modeled)
population at specific points in time and do not tell what happens inbetween.

None of the above arguments is really problematic and discrete-time models have been widely and
successfully used to develop many pieces of important ecological theory. There are, however,
some subtle but fundamental differences between the mathematical theory on discrete-time
models and continuous-time models. In my opinion, these differences have often caused quite a
bit of confusion with students that were new to modeling population dynamics. Hence, I decided
not to treat both discrete-time and continuous-time models next to each other as separate model
classes, but instead to discuss one of them at length and in detail. Hence, I will discuss basic
theory about population models using continuous-time models, ignoring for the time being the
considerable amount of theory on discrete-time models.

A continuous-time version of the balance equation (2.2) can be derived by dividing both sides
of the equation by \( \Delta t \):

\[
\frac{N(t + \Delta t) - N(t)}{\Delta t} = \frac{\text{Number of births during } \Delta t}{\Delta t} - \frac{\text{Number of deaths during } \Delta t}{\Delta t}
\]

By taking the limit \( \Delta t \to 0 \), the left-hand side of this equation becomes the derivative of \( N(t) \)
with respect to time \( t \), while the right-hand side becomes the difference between the rate with
which individuals are born into the population and the rate with which individuals disappear from the population due to death. Hence, the continuous-time, population balance equation can be written as:

$$\frac{dN(t)}{dt} = B(N) - D(N)$$  \hspace{1cm} (2.3)

In this balance equation, I have written the birth and death rate $B(N)$ and $D(N)$, respectively, as explicit function of the total number of individuals $N$ to indicate that the number of individuals present in the population usually to a very large extent determine the number of births and deaths that do occur during a certain time period. Equation (2.3) is an ordinary differential equation or ODE for short. Here the model is specified by a single ODE, but they may also occur as systems of ODEs in more complex situations, for example, when we want to model more than a single population. The formulation and analysis of ODEs, both single equations and system of two or more ODEs, is a major focus of the following chapters.

The function $B(N)$ and $D(N)$ are the population birth rate and population death rate, respectively. These are therefore population-level quantities, because they, for example, refer to the total number of offspring produced by the entire population. Because all individuals in the population are assumed identical any way, the balance equation (2.3) can be rewritten in terms of individual-level birth and death rates, the so-called per capita birth rate and per capita death rate, respectively. By defining the per capita birth rate $b(N)$ as:

$$b(N) = \frac{B(N)}{N}$$ \hspace{1cm} (2.4)

and the per capita death rate $d(N)$ as:

$$d(N) = \frac{D(N)}{N}$$ \hspace{1cm} (2.5)

the balance equation (2.3) can be rewritten as:

$$\frac{dN(t)}{dt} = b(N)N - d(N)N$$ \hspace{1cm} (2.6)

The equation above is a general population balance equation for changes in the population abundance occurring in continuous time. It will be the basis of many of the population models in the forthcoming sections.

The rates that occur in the population balance equation are not as easy to interpret as the number of individuals born or dying during a particular period of time which occur in the discrete-time balance equation (2.2). Both the population-level birth and death rate $B(N)$ and $D(N)$, respectively, and the per capita birth and death rate $b(N)$ and $d(N)$, respectively, have a formal interpretation as a probability per unit time. For the per capita death rate $d(N)$ this means, for example, that within an timespan $\Delta t$ that is infinitesimally short, an individual has a probability to die equal to $d(N)\Delta t$. Also, on average the time elapsing between two death events equals $1/d(N)$. Every individual of the population thus has an expected lifetime of $1/d(N)$ units of time. Similar arguments hold for the other rate functions, such that the average time between two consecutive times at which a particular individual gives birth equals $1/b(N)$.

The population balance equation (2.6) does not specify a complete population dynamic model yet, as it only determines how the population abundance is going to change over time. We therefore still have to specify from what value it is going to change to start with. In other words, we have to specify an initial state of our population. Usually, this is done by specifying the number of individuals present at some particular point in time, which then simultaneously is chosen to equal the start of our time axis ($t = 0$):

$$N(0) = N_0$$ \hspace{1cm} (2.7)
In this initial state equation, the quantity $N_0$ is a known value from which the population dynamics is going to develop.

## 2.5 Model building

Building a model to describe the dynamics of a particular population or in more complicated cases a collection of populations can be separated into two distinct steps:

- First, we have to choose the mathematical representation of the population in our model. This issue was addressed in section 2.3 where we also discussed some issues to consider when choosing a particular representation. For example, it was discussed whether to include any more aspects of the population in our model than the total number of individuals (i.e. the abundance).

- Second, once we have chosen a particular representation for the population it is necessary to write down the population balance equation and to specify the exact form of the rates (either *per capita* or population-level rates) that occur in it.

It should be noted that equation (2.6) is specific for a model in which the population is only characterized by its abundance $N$. If we choose a slightly more complicated representation of our population the corresponding balance equation will be analogous but slightly different. For example, if we would choose to keep track of both juvenile and adult individuals in the population a balance equation for both classes of individuals should be specified. This is still a relatively simple extension of the basic equation (2.6), but things can be much more complicated if we, for example, want to keep track of the entire age distribution of the population.

The second step in formulating a model involves specifying the rate functions that occur in the population balance equation. Determining their actual form as dependent on the population abundance $N$ is again where modeling becomes an art instead of a scientific procedure. As was the case for choosing the appropriate population representation there is no simple recipe how to do it and the process of model building can hence only be discussed by example. I will introduce here 3 examples which will be used in the next chapter to illustrate the steps in model analysis.

### 2.5.1 Exponential population growth

Malthus (1798) investigated the birth and death register of his parish and concluded that the population of his parish doubled every 30 years. He considered the following population balance equation:

$$\frac{dN(t)}{dt} = \beta N - \delta N$$  \hspace{1cm} (2.8)

in which $\beta$ and $\delta$ are now the specific form chosen for the *per capita* birth and death rate $b(N)$ and $d(N)$. Implicitly, Malthus (1798) hence made two very specific assumptions about the *per capita* birth and death rate $b(N)$ and $d(N)$ in that that they were constant and hence independent of $N$ (It is perhaps fairer to say that he did not consider at all that $b(N)$ and $d(N)$ could depend on $N$, but the end effect is the same). Because in this case $b(N) = \beta$ and $d(N) = \delta$ do not depend on the population density $N$, this model is density independent. In a density independent model the *per capita* rates are not influenced by any aspect of the population at all, neither direct nor indirect. An indirect population effect on the *per capita* rates might occur if the population feeds on a food resource, depleting it to low levels, and the food density itself subsequently affects the *per capita* birth and death rate. As an aside, note that when the *per
capita birth or death rate is density independent, the population-level birth and death rates are linear in (i.e. proportional to) \( N \).

The population balance equation (2.8) used by Malthus (1798) can be written more succinctly as:

\[
\frac{d N(t)}{d t} = r N
\]

where

\[
r = \beta - \delta
\]

Equation (2.9) is the famous exponential growth equation or “Malthus’ growth law”. The quantity \( r \) is known as the population growth rate or the Malthusian parameter.

Equation (2.9) can easily be solved once we have also specified the initial state of the population (i.e. the population abundance \( N_0 \) at time \( t = 0 \); see eq. (2.7)). As an explicit function of time \( t \) the solution is:

\[
N(t) = N_0 e^{rt}
\]

On the basis of Malthus’ observation that the population of his parish doubled every 30 years we can now estimate the parameter \( r \) to equal \( r = 0.0231 \) year\(^{-1} \) (try to derive this estimate!). In other words, the population of Malthus’ parish was estimated to grow with 2.31% a year, which is not too far off the current growth rate of the human population (Fig. 2.1)!

2.5.2 Logistic population growth

The story goes that the prediction by Malthus (1798) led to some concern, because it implied that the human population would quickly exhaust its natural resources. Verhulst (1838) claimed that the model proposed by Malthus (1798) was too simplistic as it only included linear terms. Verhulst (1838) hence wrote as an alternative model:

\[
\frac{d N(t)}{d t} = aN - bN^2
\]

including an additional quadratic term with a negative coefficient.

There are a number of different ways in which this particular form of the population balance equation might come about. Let me suggest here one scenario that leads to the form proposed by Verhulst (1838) by considering a population in which the per capita birth rate decreases with population abundance. The simplest way to achieve such a density dependence is by assuming that the parameter \( \beta \) that was already introduced in Malthus’ equation (2.8) is actually the per capita birth rate at very low (actually infinitesimally small) population abundances. Moreover, with increasing values of the population abundance \( N \) it is assumed to decrease linearly with \( N \) to reach a value of 0 at some arbitrary population density \( N = \Gamma \). If I in addition assume that the per capita death rate is again density independent, these assumptions lead to the following balance equation:

\[
\frac{d N(t)}{d t} = \beta N \left(1 - \frac{N}{\Gamma}\right) - \delta N
\]

With a little bit of algebraic manipulation this equation can be rewritten in a far more familiar form, the logistic growth equation:

\[
\frac{d N(t)}{d t} = r N \left(1 - \frac{N}{K}\right)
\]
in which the parameters $r$ and $K$, representing the population growth rate and its carrying capacity, respectively, are related to the parameters $\beta$, $\delta$ and $\Gamma$ from equation (2.13) by:

\[
\begin{align*}
    r &= \beta - \delta \\
    K &= \frac{\beta - \delta}{\beta} \Gamma
\end{align*}
\] (2.15) (2.16)

The logistic growth equation (2.14) must be familiar to any student that has followed an introductory ecology course. However, it can be conveniently used to discuss some techniques to analyze population dynamic models in terms of ODEs.

The logistic growth equation (2.14) can not be taken seriously as a model that quantitatively describes the dynamics of any real-life population. There are examples of isolated laboratory populations (usually bacteria), whose growth in time, i.e. the function $N(t)$, can be fitted quite well by the solution of the logistic equation, but a number of alternative equations would fit such data with similar goodness-of-fit. In other words, the measurement noise in population data often is far too big to unambiguously decide that the growth of the population is obeying a particular model.

The real utility of the logistic equation is, rather, as an embodiment of a qualitative behavior which is not so uncommon (except for humans): a population that starts out with a small number of individuals will ultimately grow to a maximum density, its carrying capacity, which is set by environmental conditions.

2.5.3 Two-sexes population growth

Here I also formulate a model for a population that reproduces by means of sexual reproduction. Unlike the exponential and logistic growth model, this one is not an established population dynamic model that has been widely used in the population biological literature. Rather, it is introduced here mainly to illustrate some techniques for model analysis in the next chapter.

The assumptions on which this model is based and its mathematical form are also much more debatable than the the previous two models introduced.

To model a population with sexual reproduction it is necessary to derive a mathematical representation for the process of two individuals encountering each other, mating and producing one or more offspring. Especially how to describe the rate at which encounters between sexual partners take place is not an easy or straightforward task. I follow an approach that has a long history in the modeling of chemical reactions: when two compounds $A$ and $B$ in a dilute gas or a solution react to yield a product $C$, the rate at which this chemical reaction takes place is assumed to be proportional to the densities of both reactants $A$ and $B$. Hence, for the chemical reaction

\[
A + B \rightarrow C
\]

the rate with which the product $C$ is produced is proportional to

\[
[A] \cdot [B]
\]

where $[\cdot]$ refers to the concentration of a substance in the medium. The assumption that the rate of product formation is proportional to the product of the reactant concentrations has become known as the law of mass action or mass action law. Two requirements for it to hold is that the reactants move about randomly and are uniformly distributed through space.

Analogously to this approach from chemical reaction kinetics, I assume that the rate at which sexual partners encounter each other is proportional to the product of their abundance. If I
furthermore assume that the sex ratio in the population is constant, the rate of encounter is proportional to the squared abundance \( N^2 \). On encounter I assume that the partners produce offspring at a rate that decreases linearly with the population abundance \( N \), as in the logistic growth equation. Hence, population reproduction can be described by a term

\[
\beta N^2 \left( 1 - \frac{N}{\Gamma} \right)
\]

in which the term \( (1 - N/\Gamma) \) represents the density dependent reduction in offspring production. To describe the death of individuals I simply assume that the rate of mortality equals \( \delta \), as has been similarly assumed in the exponential and logistic growth equation. The rate at which individuals disappear from the population through death hence equals \( \delta N \). Putting these model pieces together, the dynamics of a population reproducing by means of sexual reproduction could therefore be described by the following ODE:

\[
\frac{dN(t)}{dt} = \beta N^2 \left( 1 - \frac{N}{\Gamma} \right) - \delta N \tag{2.17}
\]

### 2.6 Parameters and state variables

Above I already used the phrases *parameter* and *state variables*, without really discussing their distinction. It is very important to distinguish what is a parameter and what is a state variable in a model. State variables are those quantities (1) that characterize the state of the system, in our case the biological population, and (2) that change over time. It is the change in these quantities that the model determines. Parameters, on the other hand, are also characteristic for a specific system (*i.e.* population), but *parameters do not change over time*. They hence occur in the population dynamic models above, but the models do not specify that they change over time. They can be viewed as a kind of innate properties of the system.

In all the examples above, there was only a single state variable, *i.e.* the population abundance indicated with \( N \). On the other hand, the quantities \( r \) (in both the exponential and logistic growth equation), \( K \) (in the logistic growth equation), \( \Gamma \) (in the logistic and two-sexes population growth model) and \( \beta \) and \( \delta \) (in all three models) are all parameters. The parameters \( r \) and \( K \) can furthermore be identified as *compound* parameters, because they are in reality a combination of the low-level parameters \( \beta \), \( \delta \) and \( \Gamma \) (see equation (2.10), (2.15) and (2.16)).

**Important:**

In the following chapters I will adopt the convention, which is common to most if not all population dynamic models, that model parameters are introduced in such a way that they can only meaningfully take on positive values. Since I have earlier on imposed the restriction that the populations considered are only represented by their abundance, the same positivity condition will hold for the state variables in the models as well.
2.7. Deterministic and stochastic models

In the following chapters I will mainly formulate and analyze deterministic models, as opposed to stochastic models. Given an initial state of the population, deterministic models specify a unique dynamic path of the system. Such a dynamic path is called a trajectory. Hence, a deterministic model attaches to every single initial condition, a single and unique trajectory. On the other hand, in stochastic models the initial state of the population determines an entire family of trajectories and every one of these may occur with a given probability.

A simple example may illustrate the distinction between these two model frameworks. Imagine the fate of the last two individuals of an endangered species in a particular habitat. Each of these two individuals might have a chance to die, say, 0.1% per day. For simplicity I will assume that the two individuals are of the same sex and can hence not reproduce. How long these two individuals will survive, when the first and last one will die, is the outcome of a chance process. In other words, given the starting condition (the last two individuals) there are many different possible outcomes and which one will actually happen is not a priori determined. The only thing possible to do is to calculate the probability that one or the other scenario (or trajectory) will occur.

Now imagine another population of individuals with a probability of 0.1% per day to die. However, this population consists of a very large number of individuals, say $10^{10}$. Given this large number of individuals we can expect that approximately $10^7$ of these individuals will die every day. Because it is the outcome of a large number of independent chance processes (for every individual one) this number will also be relatively constant (This is due to the fact that the variance in the mean outcome of a large number of independent trials decreases with the number of trials). We can hence rather faithfully represent the death process in this population by a deterministic rate of 0.1% of the total population per day.

Most, if not all, population dynamic processes are stochastic: individuals usually have a chance to die or give birth and hardly ever have a predestined time of reproduction or death. Nonetheless, the example above indicates that such stochastic dynamics can in principle be faithfully described by a deterministic model as long as the number of individuals is large. Hence, a deterministic model can be viewed as the limit of a particular stochastic model for when the number of individuals in the population becomes large, a fact which is usually referred to as the law of large numbers. I will focus on deterministic population models, because there exist tools and techniques to analyze there behavior. The analysis of stochastic population models is technically much more demanding and the only thing one can usually do is just simulate there dynamics. In section 3.2 I will argue that such simulations (often also referred to as Mont Carlo simulations) have sometimes very limited power to elucidate the dynamic possibilities that a model allows. Deterministic models allow a much more rigorous and detailed investigation of the model potential.
Chapter 3

Single ordinary differential equations

In the previous chapter we have presented three different models for the growth of a single population, that can generally be written in the form:

$$\frac{dN(t)}{dt} = f(N)$$  \hspace{1cm} (3.1)

The function $f(N)$ differed among the three different models introduced

- Exponential growth equation: $f(N) = rN$  \hspace{1cm} (3.2)

- Logistic growth equation: $f(N) = rN \left(1 - \frac{N}{K}\right)$  \hspace{1cm} (3.3)

- Two-sexes growth equation: $f(N) = \beta N^2 \left(1 - \frac{N}{\Gamma}\right) - \delta N$  \hspace{1cm} (3.4)

In this chapter we will discuss basic techniques that can be used to analyze the predictions of these models. Although the models itself are overly simply and in any case much simpler than the population dynamic models that are used in scientific studies, the basic techniques can conveniently be introduced using these simple growth equations.

It should be realized that the process of model analysis as such is a purely mathematical procedure. Hence, it is possible to give a more or less complete recipe for analyzing the equations that determine a population dynamic model. However, the analysis of the equations can never be the final result of a population dynamical study (unless you are a mathematician and just interested in the equations). Once the analysis of the equations is complete, the results of that analysis have to be translated into biological conclusions about the system, that the model was developed for. Even though many beginning students may think the mathematics itself a stumbling block, the step preceding and following the mathematical analysis, i.e. building the model and interpreting the mathematical results into biological conclusions, turn out to be usually far more difficult and time consuming and in general requires far deeper thinking than the mathematical analysis does! As for model building, there is also no clear-cut recipe how to interpret the mathematical results in biological terms. Again, this can only be discussed by example.

3.1 Explicit solutions

Ideally, the analysis of a mathematical model should simply consist of specifying its explicit solution. This means that given the ODE for $N(t)$ and the density of individuals at time $t = 0$
(\(N(0)\)), we should write down the explicit expression for \(N(t)\). An explicit solution would allow a very complete analysis of the properties of the model, including numerical studies showing the development of the population over time. However, an explicit solution is seldom possible unless the right-hand side of the ODE (i.e. the function \(f(N)\) in the ODE (3.1)) is linear in \(N\). In the previous chapter we have discussed that a linear form of \(f(N)\) implies that the \textit{per capita} birth and death rates are density independent, i.e. independent of \(N\) itself.

For the exponential growth equation (3.2) it is hence possible to write down the explicit solution:

\[
N(t) = N_0 e^{rt}
\]  

(3.5)

where \(N_0\) is the population abundance at \(t = 0\) and the parameter \(r\) is the population growth rate. This explicit solution can be obtained by re-writing the ODE to separate the two variables occurring in the ODE, i.e. time \(t\) and population abundance \(N\), respectively. I leave a complete treatment of this integration to the reader as an exercise.

It must be said that also the logistic growth equation (3.3) allows for an explicit solution in terms of the population abundance \(N\) as a function of time \(t\). This solution can be obtained by first re-writing the ODE as:

\[
\frac{K}{N(K - N)} dN = r dt.
\]

Subsequently, the left-hand side of this equation can be separated in a term with denominator \(N\) and a term with denominator \(K - N\):

\[
\left(\frac{1}{N} + \frac{1}{K - N}\right) dN = r dt.
\]

The left- and right-hand side of this last equation can be integrated to yield:

\[
\ln(N) \bigg|_0^t - \ln(K - N) \bigg|_0^t = rt
\]

From this the following explicit solution to the logistic growth equation (3.3) can be obtained:

\[
N(t) = \frac{N_0 K}{N_0 + (K - N_0) e^{-rt}}
\]  

(3.6)

In the explicit solution the initial condition has already been used to substitute \(N(0)\) by the value \(N_0\).

The logistic growth equation:

\[
\frac{dN(t)}{dt} = r N \left(1 - \frac{N}{K}\right)
\]  

(3.7)

is an example of a \textit{non-linear differential equation}, while the exponential growth equation:

\[
\frac{dN(t)}{dt} = r N
\]  

(3.8)

is a \textit{linear differential equation} with constant coefficients (The phrase “constant coefficient” refers to the fact that the only parameter in the equation \(r\) does not depend on time \(t\)). The distinction between linear and non-linear ODEs is a very important one, as we have seen that linear ODEs with constant coefficients can be solved explicitly. This even holds for systems of coupled, linear ODEs, which may occur in models with multiple species that interact with each other (see later chapters). Non-linear ODEs, on the other hand, can only be solved in exceptional cases, such as in case of the logistic growth equation. Coupled systems of non-linear ODEs are virtually never possible to solve explicitly.
What then is exactly a linear differential equation? The definition of a linear ODEs requires the right-hand side $f(N)$ to have the following properties:

\[ f(N_1 + N_2) = f(N_1) + f(N_2) \]  
\[ f(aN_1) = af(N_1) \]

In words, if the right-hand side function is applied to the sum of two quantities, the results should be the same as the sum of the function applied to the two quantities separately. Moreover, applying the right-hand side function to a value of $N$ that is twice as large, should be identical to twice the result of applying the function to $N$ itself. It should be noted that these two requirements decide upon the linearity of both single and systems of ODEs. In the latter case, the quantity $N$ represents a vector and $f(N)$ is a vector-valued function.

### 3.2 Numerical integration

In the previous section it was explained that only a limited number of, mostly linear, ODEs allow an explicit solution as a function of time $t$. Moreover, even if an explicit solution can be given, how do we proceed to gain insight into the properties of the differential equations? First of all, what are the properties of an ODE? Of course, modern computer facilities make it very easy to just draw an explicit solution $N(t)$ as a function of time $t$ in a simple graph. A requirement to do this is that all parameters in the model, i.e. the growth rate $r$ and the carrying capacity $K$ in the logistic growth equation, and the initial state $N(0)$ are given specific numerical values. Even more complex models, consisting of multiple species that interact or a single species with an age structure taken into account, can be studied in this way: once all parameters and the initial condition of a model are given explicit values, the solution as a function of time $t$ can usually be obtained in a rather straightforward manner. If the explicit solution of the ODE is not available, as is the case for most systems of ODEs, numerical integration methods are readily available to generate the numerical solution of a system of ODEs (see, for example, [Press et al. 1988](#), for a selection of numerical methods for ODEs). This procedure of obtaining a numerical solution for a system of ODEs for which both the parameters and the initial state are given explicit numerical values, is referred to as numerical integration or sometimes numerical simulation (the first term is actually more appropriate, while “numerical simulation” often implies that the model is stochastic). Methods for numerical integration come in a large variety, which I will not further discuss here.

Numerical integration of a model is a very good way to quickly gain some superficial insight into the behavior of the model. By just repetitively choosing parameter values and initial conditions, it can show whether the populations will persist for the chosen values or not, whether they will approach constant values or whether they fluctuate indefinitely over time. However, a numerical integration only gives insight about one particular set of parameters and one particular set of initial conditions. In later chapters we will encounter models that show drastically different behavior for two slightly different values of a single parameter. Let’s for the moment assume that you are investigating a model that can indeed show these drastically different types of behavior for parameter values that are only slightly different. What should you do?

One of the first reactions that students new to modeling show is to ask what the appropriate parameter value is that holds for the natural situation. This is like asking: Does the population growth rate in the logistic equation a value of $r = 0.3$ or $r = 0.29$? There are at least two good reasons why it is not very useful to ask what the “real” value of $r$ for the ecological system you are studying:
First of all, parameter values are always hard to extract from experimental data. Given the noise that is usually present in measurements on a system, it is, for example, undoable to decide whether $r = 0.3$ is more appropriate than $r = 0.29$ in an exponential growth equation.

Second of all, I have argued in chapter 1 that a model is a conceptualization of a system. As such it is an abstraction and hence parameters are not necessarily objects that can be unambiguously identified in the system, as they might only exist in our conceptualization of it. This is a rather difficult issue to explain when encountered for the first time, but in my opinion it is fair to say that the existence of such a thing as a carrying capacity $K$ of a natural population is debatable.

Basically, these two reasons state that there is a lot of uncertainty, not just in the value of model parameters, but even in the conceptualization of the system: the same ecological system might be equally well represented by a conceptualization that incorporates slightly different mathematical functions.

Because of these uncertainties it is often much more useful to try and gain an understanding of the qualitative behavior of the model. This means that one tries to answer the questions:

- What different types or classes of dynamics can the model exhibit? In other words, does the model predict fluctuating population abundances for certain parameter values?

- What are approximately the ranges of parameter values and initial conditions for which the different types of dynamics occur in the model?

- At which parameter values do transitions between the different types of dynamics occur?

I will loosely refer to these investigations into the qualitative behavior of the population model as a bifurcation analysis of the model, even though the exact meaning of bifurcation analysis is arguably slightly different. Also, why it is called bifurcation analysis will only become clear in later chapters.

### 3.3 Analyzing flow patterns

A rather straightforward and intuitive way of analyzing the qualitative properties of a population dynamic model is by means of graphical methods. Graphical analysis is especially useful for simple models formulated in a single or at most two differential equations. The aim is to evaluate the right-hand side $f(N)$ of the ODE (3.1) and draw in figures for which values of $N$ the population abundance will increase and for which it will decrease. Because it is aimed at resolving in which direction $N$ will change given its current value, the approach is also referred to as the analysis of flow patterns.

Imagine now the exponential growth equation (3.2). Depending on the values of the birth and death rates $\beta$ and $\delta$, respectively, the right-hand side $f(N)$ is either a linearly increasing, strictly positive or a linearly decreasing, strictly negative function of $N$ (or zero for all values of $N$ when $r = 0$, but this case is too exceptional to discuss). For positive values of $f(N)$ the population abundance will increase, while for negative values the abundance will decrease, as is shown in the following sketch:
3.3. ANALYZING FLOW PATTERNS

Now consider the logistic equation (3.3). A graph of the the right-hand side $f(N)$ as a function of $N$ is given below:

```
```

Obviously, the right-hand side $f(N)$ equals 0 for both $N = 0$ and $N = K$. Hence, for these two values of the population abundance the model predicts no change. If the initial population abundance would be either $N(0) = 0$ or $N(0) = K$ the abundance would remain 0 and $K$ for all times. Such a value for the population abundance is referred to as a steady state or equilibrium. More generally, a steady state is such a state that, if started from it initially, the population would keep for all times.

However, even if the population would remain in a steady state once started in that state, it does not imply that the population would also approach that state if the initial population state is only close to the steady state. Or if the population would be displaced from the steady state only a little bit, it will not necessarily return to a steady state. The graph of the logistic growth equation shown above, indicates that if the population abundance would be displaced away from $N = 0$ to a small positive value, the population abundance would actually increase even further, because the value of $f(N)$ is positive for $0 < N < K$. On the other hand, if the population abundance would be displaced from the steady state $N = K$ to a slightly smaller
population abundance, the population growth rate would change from \( f(N) = 0 \) to a positive value. If the population abundance would be displaced from the steady state \( N = K \) to a slightly larger population abundance, the population growth rate would change from \( f(N) = 0 \) to a negative value. Hence, if the population abundance is perturbed away from the steady state \( N = K \) in whatever direction (positive or negative) it would approach the steady state anew. The steady state \( N = K \) is hence referred to as a stable equilibrium. The steady state \( N = 0 \), on the other hand, is unstable, as the population abundance would grow away from it when perturbed. Clearly, the analysis of the flow of the population abundance (i.e. the arrows in the graphs above) in the neighborhood of a steady state has shown us the general behavior of the logistic growth equation: when starting from a non-zero positive population abundance, the model predicts that the population will grow asymptotically to the stable equilibrium \( N = K \) (Note that mathematically the population abundance will never become equal to \( K \), but will only come infinitesimally close to it). Even if the population abundance is perturbed away from this equilibrium, it will ultimately return to it.

Finally, let's consider the two-sexes population growth model. First we have to try to sketch a graph of the function \( f(N) \) (see equation (3.4)) as a function of its argument \( N \). How to do this is the subject of basic function analysis and will not be discussed here in detail. The points to note about the function \( f(N) \) are:

- the growth rate \( f(N) \) equals 0 for \( N = 0 \) (as should be the case for any dynamic model of a closed population),
- for non-zero, but very small, positive values of \( N \) \( f(N) \) decreases to negative values,
- for very large values of \( N \) the value of \( f(N) \) becomes very large, but negative, and
- as long as \( \beta \Gamma > 4 \delta \)

the function \( f(N) \) has two additional roots for which \( f(N) = 0 \). These roots will be indicated with the symbols \( \bar{N} \) and \( \underline{N} \), respectively.

Altogether, this leads to the following qualitative graph of \( f(N) \) as a function of \( N \):

\[ f(N) \]

From this graph we can infer that the two-sexes population model has 3 steady states: \( N = 0 \), \( N = \underline{N} \) and \( N = \bar{N} \), respectively. As before, if the population would initially have an abundance
equal to one of these three values, it would keep the particular abundance for all times. However, the graph above also shows that not all of these 3 steady states are stable. In contrast to the logistic growth equation, if the population abundance is perturbed away from \( N = 0 \) to a small positive abundance, its growth rate will be negative. Hence, it will decrease and approach \( N = 0 \) again. The steady state \( N = 0 \) is therefore stable. Similarly, if the population abundance is perturbed away from \( N = \overline{N} \) to a slightly larger value, it will also have a negative growth rate, hence decrease and approach \( N = \overline{N} \) anew. If perturbed away from \( N = \overline{N} \) to a slightly smaller value, the population growth rate will be positive and \( N = \overline{N} \) is approached as well. The steady state \( N = \overline{N} \) is therefore also stable.

The steady state \( N = \overline{N} \) is an entirely different matter: if perturbed away from this abundance to a slightly smaller value of \( N \), the population growth rate will be negative and the abundance will decrease and eventually approach the steady state \( N = 0 \). On the other hand, if perturbed away from this abundance to a slightly larger value, the population growth rate will be positive and the abundance will increase to eventually approach the steady state \( N = \overline{N} \). The steady state \( N = \overline{N} \) hence is an unstable steady state, because whenever the population abundance is perturbed away from this steady state, it will only move farther and farther away. In addition, it has the character of a breakpoint: it separates values of \( N \) that would eventually lead to approaching the stable steady state \( N = 0 \) from those values of \( N \) that would eventually lead to approaching the stable steady state \( N = \overline{N} \). An unstable steady state like the one \( N = \overline{N} \) encountered here is called a saddle point.

From the graphs of the logistic and the two-sexes growth equations shown above, we can also deduce that at stable steady states the curve of \( f(N) \) as a function of \( N \) has a negative slope, while at unstable steady states (i.e., saddle points) the slope of \( f(N) \) is positive.

Two more points can be deduced from the graphs presented here:

- Every stable steady state has a basin of attraction. This is the technical term for those initial states of a population dynamic model that would eventually lead to the particular steady state considered. Hence, the basin of attraction of the steady state \( N = 0 \) are all those population abundances for which

\[
0 < N < \overline{N}.
\]

while the basin of attraction of the steady state \( N = \overline{N} \) are all those population abundances for which

\[
N > \overline{N}.
\]

The boundary between the basins of attraction of two different, stable steady states is referred to as a separatrix. When, as in the cases considered here, the model is only one-dimensional (meaning it consists of only a single ODE) a separatrix is only a single point, in the two-sexes population model considered here, the saddle point \( N = \overline{N} \). If the model is, however, of higher dimensions (i.e., described by more ODEs) separatrices can be lines, (curved) planes or even more complicated geometrical objects.

- The stability of a stable steady state may only be a relative concept: if the population abundance would initially be in the stable steady state \( N = \overline{N} \), but would be drastically perturbed to a value below \( N = \overline{N} \), the population abundance would approach the other stable steady state \( N = 0 \). Hence, that a steady state is stable against perturbations only holds for small perturbations that do not bring the abundance outside the basin of attraction of the steady state. Mathematically, we therefore consider only the local stability of a steady state. It would hence be more appropriate to refer to a steady state as locally stable. Nonetheless, the adjective “locally” is often dropped in the ecological
literature. This has led to quite some confusion and different interpretations of the phrase *stability*. When discussing steady states, I will always use the adjective “stable” in the sense of “locally stable”, unless explicitly indicated otherwise. For example, for the logistic growth equation the population would always approach the steady state $N = K$, whatever the initial population abundance is. This steady state is not only locally stable but also *globally stable*.

A remarkable feature of the two-sexes population growth model is that it can not grow away from $N = 0$, which means that for small, but positive abundances $N$ the population will actually decline, even though for larger abundances ($N > N$) the population will eventually grow to a positive steady state. This feature is referred to as an *Allee effect* (Allee 1931). In this particular model, the biological explanation for its occurrence is that at low population abundances, individuals do not stand a chance to find a partner. Hence, reproduction is very much reduced. More generally, the phrase “Allee effect” is used to indicate a situation in which individuals at very low density are actually performing worse than at slightly higher densities.

Summarizing, in this section we have learned the following qualitative theory about population models of the type (3.1):

1. At those values of $N$ for which $f(N)$ is positive, the dynamics of the ODE (3.1) will cause the population abundance $N$ to increase.

2. At those values of $N$ for which $f(N)$ is negative, the dynamics of the ODE (3.1) will cause the population abundance $N$ to decrease.

3. If for some value of $N_e$ the value of $f(N_e)$ equals 0, then this population abundance $N_e$ is called a *steady state* of the ODE (3.1). If initially the population abundance equals this value $N_e$, it will remain at this value (because $dN/dt = f(N_e) = 0$, meaning there is no change), until the population abundance is displaced away from $N_e$.

4. If the slope of the curve $f(N)$ at the value of $N_e$ is negative:
   
   $\left. \frac{df}{dN} \right|_{N_e} < 0$

   the equilibrium $N_e$ is stable. After a small displacement away from $N_e$ the population abundance will return to it. The value $N_e$ is hence called a (locally) stable equilibrium of the ODE (3.1).

5. If the slope of the curve $f(N)$ at the value of $N_e$ is positive:
   
   $\left. \frac{df}{dN} \right|_{N_e} > 0$

   the equilibrium $N_e$ is unstable. After a small displacement away from $N_e$ the population abundance will grow or decline further away from it. The value $N_e$ is hence called an unstable equilibrium of the ODE (3.1).

### 3.4 Computation of steady states and analysis of their stability

In this section we discuss what is usually the core part of the analysis of a population dynamic model. At the same time it is also mathematically the most demanding part of the analysis.
3.4. STEADY STATES AND THEIR STABILITY

The key problem is that the graphical analysis discussed in section 3.3 is very useful for models consisting of one or two ODES, but is hardly usable for models of higher dimensions. In general, in more complicated situations the graphical method of analysis is very difficult, if not impossible, to apply. The techniques discussed in this section constitute a more rigorous and robust method of analysis with the same aim as the graphical method of analysis: determining the qualitative behavior of the population dynamic model.

Basically, the graphical analysis discussed in section 3.3 resulted in:

- the identification of steady states, i.e. states that a population would keep for all times, if initially started in it, and
- the determination of the local stability of these steady states, i.e. analyzing whether the population abundance would return to the steady state, if displaced away from it by a (infinitesimally) small, but otherwise arbitrary amount.

These same results can be obtained by means of a mathematical analysis, that furthermore generalizes to more complicated situations (unlike the graphical analysis).

The identification of steady states is relatively straightforward. It boils down to determining all values of \( N \), for which:

\[
f(N) = 0
\]  

(3.11)

Implicitly, we already used this property of steady states to draw the graphs in section 3.3 for the logistic and the two-sexes population growth equations. Step 1 in a mathematical analysis of a population dynamic model is to determine its steady states by figuring out for which values of the population abundance(s) \( N \) the right-hand side of the ODE, \( f(N) \), vanishes. Doing some basic analysis on the function \( f(N) \) in equation (3.4) for the two-sexes population model, leads to the following 3 steady state values for the population abundance \( N \):

\[
N = 0
\]  

(3.12a)

\[
N = \frac{1}{2} \Gamma \left( 1 - \sqrt{1 - 4 \delta \beta \Gamma} \right)
\]  

(3.12b)

\[
N = \frac{1}{2} \Gamma \left( 1 + \sqrt{1 - 4 \delta \beta \Gamma} \right)
\]  

(3.12c)

Modern computer software for symbolic calculations, like Mathematica or Maple, allows for a rather rapid and easy derivation of such steady state values from the model equations.

More challenging is the question, how to determine the stability of a steady state in a mathematically rigorous way that can also be applied in more complicated cases, for example, when the dynamics is described by 3 or even more ODEs. To analyze the stability of the steady states presented in equations (3.12), we make use of two crucial mathematical properties:

1. Linear ODEs and even systems of linear ODEs can be solved explicitly, as was discussed in section 3.1

2. Every mathematical function \( f(N) \) can be approximated in a small neighborhood around a particular value \( N = N^* \) by its Taylor expansion:

\[
f(N) = f(N^*) + f'(N^*)\Delta N + \frac{1}{2} f''(N^*)\Delta N^2 + O(\Delta N^2)
\]  

(3.13)
in which I have used $\Delta_N$ as a shorthand notation for:

$$\Delta_N := N - N^*$$

An easy approximation of the function $f(N)$ is obtained by dropping all terms that incorporate the quantity $\Delta_N$ with a power of 2 or higher:

$$f(N) \approx f(N^*) + f'(N^*)\Delta_N \tag{3.14}$$

or written without the shorthand notation $\Delta_N$:

$$f(N) \approx f(N^*) + f'(N^*)(N - N^*) \tag{3.15}$$

The right-hand side of this equation is referred to as the first-order Taylor approximation of the function $f(N)$ in the neighborhood of $N = N^*$. Note that the first-order Taylor approximation to the function $f(N)$ in the neighborhood of $N = N^*$ is a linear function of the population abundance $N$, since both $f(N^*)$ and $f'(N^*)$ have constant values.

In the section 3.3 the stability of a steady state was essentially determined by investigating whether the population state would return to the steady state after being displaced away from this steady state by an infinitesimally small amount. The displacement had to be very small to avoid ending up outside the basin of attraction of the steady state. Let’s define the small displacement away from the steady state by $\Delta_N(t)$:

$$\Delta_N(t) := N(t) - N_{eq} \tag{3.16}$$

Here I have used the notation $N_{eq}$ to indicate some arbitrary steady state of the population dynamic model, the stability of which I want to investigate. The ODE (3.1) that represents our population dynamic model not only specifies the dynamics of the population abundance $N(t)$, but because $\Delta_N(t)$ is defined in terms of $N(t)$ and a constant value $N_{eq}$, it also specifies the dynamics of this small displacement $\Delta_N(t)$. Mathematically, this is expressed by the following:

$$\frac{d\Delta_N(t)}{dt} = \frac{d(N(t) - N_{eq})}{dt} = \frac{dN(t)}{dt} - \frac{dN_{eq}}{dt} = \frac{dN(t)}{dt} \tag{3.17}$$

Hence, the right-hand side of the ODE describing the dynamics of $\Delta_N(t)$ is the same as the right-hand side of the ODE for $N(t)$:

$$\frac{d\Delta_N(t)}{dt} = f(N) \tag{3.18}$$

Using the relation between $\Delta_N(t)$ and $N(t)$ (3.16), this ODE can be rewritten as:

$$\frac{d\Delta_N(t)}{dt} = f(N_{eq} + \Delta_N) \tag{3.19}$$

This last ODE still exactly describes the dynamics of the small displacement $\Delta_N(t)$ away from the equilibrium $N_{eq}$. Moreover, as the function $f(N)$ will generally be a non-linear function that is impossible to solve explicitly, also this exact ODE for the dynamics of $\Delta_N(t)$ can not be solved explicitly. By rewriting the original ODE of the population model in terms of the dynamics of the small displacement $\Delta_N(t)$ I have ended up with an ODE that is just as complicated and essentially I have not gained anything. However, using the fact that $\Delta_N(t)$ is small I can gain a lot of analytic power, because it allows me to approximate the ODE (3.19) with an ODE in which I substitute the right-hand side $f(N_{eq} + \Delta_N)$ by its first-order Taylor expansion around $N_{eq}$:

$$\frac{d\Delta_N(t)}{dt} \approx f(N_{eq}) + f'(N_{eq})\Delta_N \tag{3.20}$$
3.4. STEADY STATES AND THEIR STABILITY

Because \( N_{eq} \) is an equilibrium, \( f(N_{eq}) \) equals 0. Hence, the ODE above simplifies to:

\[
\frac{d\Delta N(t)}{dt} = f'(N_{eq})\Delta N
\]  
(3.21)

This final ODE is a linear one, which we have learned to solve explicitly in section 3.1. Hence, the dynamics of \( \Delta N(t) \) is given by:

\[
\Delta N(t) = \Delta N(0) \exp(f'(N_{eq})t)
\]  
(3.22)

in which \( \Delta N(0) \) is the initial displacement away from the steady state \( N_{eq} \) (compare the derivation of equation (3.5)). From this solution we can infer that the steady state is stable if the derivative of the function \( f(N) \) at the steady state value \( N = N_{eq} \) is negative, while the steady state is unstable if this derivative is positive (When the derivative exactly equals 0 the steady state is at the edge of stability and instability and hence its stability is undetermined. This exceptional situation will not be discussed further here).

It should be noted that the relationship between the sign of the derivative of the function \( f(N) \) at the steady state value \( N = N_{eq} \) and the stability of the steady state, was already discovered in section 3.3. There it was found that a steady state was stable if the slope of the curve \( f(N) \) as a function of \( N \) was negative, while the steady state was unstable if this slope was positive. Essentially, by deriving the linear ODE (3.21) for the small displacement \( \Delta N(t) \) we have approximated the curve of \( f(N) \) as a function of \( N \) by a straight line through the point \( N = N_{eq} \), i.e. the tangent line in this point. The derivative of the function \( f(N) \) at \( N = N_{eq} \) is exactly the slope of this tangent line and hence the slope of the curve \( f(N) \) as a function of \( N \). The approximation of the term \( f(N_{eq} + \Delta N) \) by its first-order Taylor expansion equal to \( f'(N_{eq})\Delta N \) is therefore based on the assumption that in a very small neighborhood of the steady state \( N = N_{eq} \) we can approximate the curve \( f(N) \) by its tangent line in \( N = N_{eq} \), ignoring any higher order curvature.

The above process of deriving a linear ODE for the dynamics of a small displacement \( \Delta N(t) \) in the neighborhood of a steady state \( N = N_{eq} \) is referred to as local linearization of the dynamics, as the full model dynamics is locally represented by a linear type of dynamics. In mathematical literature the analysis is also referred to as linear stability analysis to indicate that the stability of a steady state is determined by a linear analysis. The proof that the linear analysis explained here indeed determines the stability of a steady state and the conditions that have to hold for it to apply or to fail (which indeed occurs!) will not be discussed here, as they are mathematically too complex (for details see, for example, Kuznetsov 1995).

In later chapters, when analyzing models that are formulated in terms of more than a single ODE, a similar procedure will be followed to investigate the stability of steady states: the system of ODEs describing the model dynamics will be linearized in the neighborhood of a particular steady state to determine the fate of a small but arbitrary displacement (perturbation) away from the steady state. However, in contrast to the procedure described above leading to equation (3.22), the full solution of the linearized system of ODEs will not be derived or written down. Instead, based on the insight that linear ODEs yield solutions of exponential form, a trial solution of the form

\[
Ce^{\lambda t}
\]  
(3.23)

will be substituted into the linearized system of ODEs (\( C \) is here some arbitrary constant). This will allow us to derive an expression of the exponential growth rate(s) \( \lambda \) that are characteristic for the linearized dynamics in the neighborhood of the steady state. Again, it will turn out that these growth rates should all be negative for a steady state to be stable.

I will illustrate this procedure for the linearized ODE (3.21) even though its explicit solution has already been given. Substituting the trial solution (3.23) for \( \Delta N(t) \) into the linearized ODE
CHAPTER 3. SINGLE ORDINARY DIFFERENTIAL EQUATIONS

yields:

$$\frac{dCe^{\lambda t}}{dt} = f'(N_{eq})Ce^{\lambda t}. \quad (3.24)$$

The time derivative in the left-hand side of this ODE can be simplified to yield:

$$\lambda Ce^{\lambda t} = f'(N_{eq})Ce^{\lambda t}. \quad (3.25)$$

After dividing both sides of the resulting equation by $C \exp(\lambda t)$, the following equation is obtained:

$$\lambda = f'(N_{eq}) \quad (3.26)$$

This equation is referred to as the characteristic equation, as it specifies the characteristic growth rate $\lambda$ of the linearized dynamics. As was already concluded, if $\lambda$ is positive the steady state is unstable, while it is stable if $\lambda$ is negative. The quantity $\lambda$, which you can interpret as a characteristic growth rate, is called the eigenvalue of the linearized dynamics.

The entire discussion of characteristic equation and eigenvalue in the context of the single ODE models that are the topic of this chapter is a little bit overdone. However, it illustrates nicely the approach taken with more complicated models, formulated in terms of systems of ODEs. In those cases, the characteristic equation is often a more complicated, matrix equation which will only implicitly determine the eigenvalues. Surely, it will in general not be possible to specify the eigenvalues as explicitly as it is done in equation (3.26). Nonetheless, the idea is the same: a characteristic equation is derived for the linearized dynamics in the neighborhood of a steady state. This characteristic equation determines, usually in a rather difficult way, the eigenvalues (or characteristic growth rates) $\lambda$, which all have to be negative for the particular steady state to be stable.

Important:

It should be noted that the eigenvalues pertain to a particular steady state of a particular model. Hence, if a model has multiple steady states, as we encountered before, to each of these steady states belongs a unique set of eigenvalues.

3.5 Units of measurement and non-dimensionalization

The analysis of the physical dimensions in which the model equations are expressed is a powerful tool for checking their validity. There are some simple rules that the equations should conform to:

- If an ODE is written down both the right-hand side and the left-hand side of the ODE should carry the same physical dimension. Since the left-hand side ($dN/dt$) usually carries the dimension of number per unit of time or density per unit of time, the right-hand side of the ODE (i.e. the function $f(N)$) should carry this dimension as well.

- In general the right-hand side $f(N)$ is a collection of various terms that are added or subtracted. When adding or subtracting terms, these should have the same dimension. This rule allows us to deduce, for example, the dimension of the parameter $K$ in the
logistic growth equation (3.3). Since the ration \( N/K \) in this equation is subtracted from the dimensionless constant 1, both \( N \) and \( K \) have to have the same dimension. The term \((1 - N/K)\) as a whole is therefore dimensionless. Because the entire right-hand side should have the dimension of number per unit of time, the dimension of the parameter \( r \) is hence \textit{per unit time}. Notice that such an analysis shows that the birth parameter \( \beta \) in the logistic equation (2.13) has a \textit{different} dimension than the same parameter in the two-sexes population growth equation (2.17) (I leave it to the reader to figure out the correct dimensions of these two parameters).

- If two quantities are multiplied, the result carries the product of their dimensions.

- Dividing two quantities is more subtle: if two quantities with \textit{different} dimensions are divided the result carries the ratio of their dimensions. For example, the number of individuals in a population divided by the surface of the habitat they live in yields the population density in terms of the number of individuals per unit area.

- On the other hand, if two quantities with \textit{identical} dimensions are divided the result is dimensionless. Whether dimensions are different or identical is sometimes a bit subtle, as the following example illustrates: a frequently encountered parameter in population models is the \textit{assimilation efficiency}. This is the efficiency with which ingested food is transformed into assimilated energy. If both food and assimilated energy are measured in the same units, for example both are measured in terms of their caloric value, \textit{i.e.} in Joules, the ratio of assimilated energy over ingested food is truly dimensionless. On the other hand, the \textit{per capita} rate with which a predator consumes prey individuals has the dimension of number of individuals per individual per unit of time, \textit{ind/(ind · time)}, and not simply per unit of time. The reason is that the one type of individuals are prey (in the numerator) while the other type of individuals (in the denominator) are predators. Hence, these dimensions do \textit{not} cancel. As a rule if two quantities could be added to each other on the basis of their dimensions, their dimensions would cancel out when their ratio is computed.

Using the above rules it is good practice to check whether a set of model equations bear the correct dimensions and whether the parameters in the model indeed are expressed in terms of the correct dimensions. A lack of consistency in dimensions often points at some inconsistency in the model formulation.

The choice of physical dimensions for model variables are to some extent arbitrary. For example, to express a density of \(10^5\) bacteria in a volume of 1 liter growth medium, any of the following dimensions can be used:

\[
N = 10^5 \text{ cells/liter}
= 0.1 \text{ million cells/liter}
= 0.1 \text{ cells/mm}^3
= 100 \text{ cells/milliliter}
\]

Similarly, the variable time \( t \) in the model could be measured in minutes, days, weeks or years and this choice is absolutely arbitrary. This freedom in choosing model dimensions allows us to write all measured quantities in the model as a product of a scalar multiple and a unit carrying dimensions. For example, the density \( N \) can be written as

\[
N = N^* \cdot \hat{N}
\]  

in which \( \hat{N} \) determines the scale of measurement, for example, cells/liter, cells/mm\(^3\) or cells/milliliter and carries the physical dimensions. The quantity \( N^* \) takes on different values, \textit{i.e.} \(10^5\), 0.1 or
100, depending on the scale set by $\hat{N}$. Similarly, the time $t$ can be expressed as the product of a scalar multiple $t^*$ and a quantity setting the scale of measurement and carrying the physical dimension $\hat{t}$:

$$ t = t^* \cdot \hat{t} \quad (3.28) $$

Over time the model specifies that the values of both $N$ and $N^*$ will change, but the quantity $\hat{N}$ remains constant. Similarly, the value of the time variable $t$ and $t^*$ will change, but not the scaling variable $\hat{t}$.

The choice of units in which to express the state variables in the model will determine the particular value of parameters: if a population growth rate $r$ is to be specified, it should be in terms of the unit of time adopted in the model, i.e. either, say, $r = 0.1$ per day or equivalently $r = 0.7$ per week. On the other hand, it is obvious that the qualitative dynamics of the population model should be independent of this choice of units. The invariance in model dynamics under a change of measurement units can be exploited to reduce the number of parameters in the model and hence to reduce the number of quantities that determine the ultimate population dynamics.

Consider for example the logistic growth equation:

$$ \frac{dN}{dt} = rN \left(1 - \frac{N}{K}\right) \quad (3.29) $$

and substitute the expressions (3.27) and (3.28) for $N$ and $t$, respectively:

$$ \frac{d(N^*\hat{N})}{d(t^*\hat{t})} = r(N^*\hat{N}) \left(1 - \frac{(N^*\hat{N})}{K}\right) \quad (3.30) $$

Because both $\hat{N}$ and $\hat{t}$ are time-independent constants, this ODE can be rewritten as:

$$ \frac{\hat{N} \, dN^*}{t \, dt^*} = r(N^*\hat{N}) \left(1 - \frac{(N^*\hat{N})}{K}\right) $$

Multiplying both sides of this latter ODE by $\hat{t}/\hat{N}$ yields the ODE:

$$ \frac{dN^*}{dt^*} = r\hat{t}N^* \left(1 - \frac{(N^*\hat{N})}{K}\right) \quad (3.31) $$

Notice that we are still free in our choice of measurement units $\hat{N}$ and $\hat{t}$, as we did not yet make any assumption about them and their choice is arbitrary. There are some smart (or rather judicious) choices we could make for these two scales of measurement. For example, choosing:

$$ \hat{t} = 1/r \quad (3.32) $$

$$ \hat{N} = K \quad (3.33) $$

leads to an ODE in terms of dimensionless quantities $N^*$ and $t^*$:

$$ \frac{dN^*}{dt^*} = N^* \left(1 - N^*\right) $$

which does not contain any parameters anymore. By dropping the starred superscripts on the quantities $N^*$ and $t^*$ the ODE can be written in the following form:

$$ \frac{dN}{dt} = N \left(1 - N\right) \quad (3.34) $$
3.6. EXISTENCE AND UNIQUENESS OF SOLUTIONS

The key point of the procedure just described is that by making judicious choices for our units in which the state variables in the model are expressed, we have been able to reduce the number of parameters by 2: For whatever values of \( r \) and \( K \), the dynamics of the model \( (3.29) \) is identical to the dynamics of the ODE \( (3.34) \) except for some scaling of both the axis of time \( t \) and density \( N \).

By appropriately choosing our scales of measurement in the model, it has been possible to arrive at a dimensionless form of the logistic growth model from which we eliminated two parameters and which no longer depends on parameters at all. The resulting equation is much simpler and does not contain any degrees of freedom, which severely reduces the amount of work needed to analyze the model properties. As a rule, by rewriting a population dynamic model in a dimensionless form we can reduce the parameters set in the model by a number that equals the number of state variables in the model (i.e. all population densities plus the time variable). For example, a dimensionless form of the two-sexes population growth model \( (2.17) \) will ultimately contain only a single parameter.

As shown in this section, rewriting population dynamic models in a dimensionless form is a powerful approach to reduce some of the complexity of the model and to do away with some of its degrees of freedom.

3.6 Existence and uniqueness of solutions

The existence and uniqueness of solutions for particular ODEs is usually a topic that mathematicians are concerned about and hence investigate. Ecological modelers are much less or perhaps even not at all concerned about this. Nonetheless, it is appropriate to at least warn for the possibility that after formulating a population dynamic model we could potentially end up with a (system of) ODE(s) for which no unique solution exists or for which no solution exists at all! The existence and uniqueness of solutions in general not only depends on the ODE itself, but on the combination of the ODE and the initial condition. I will not discuss this issue in detail, but I will give just two examples that may give some idea of the problems that you can run into:

- A solution of an ODE is not necessarily always a nice function of the time \( t \). For example, had we formulated the two-sexes population growth equation \( (3.4) \) with a density independent reproduction rate and had we ignored the mortality rate, we would have ended up with the ODE:

\[
\frac{dN(t)}{dt} = \beta N^2
\]

(3.35)

The solution of this ODE for an initial population abundance \( N(0) = N_0 \) equals:

\[
N(t) = \frac{N_0}{1 - N_0 t}.
\]

(3.36)

This solution only exists for \( t < 1/N_0 \). At \( t = 1/N_0 \) the ODE \( (3.35) \) does not hold any longer, while the solution \( (3.36) \) in the meanwhile became infinitely large. The reason is that the right-hand side of the ODE \( (3.35) \) increases too quickly with increasing values of \( N \). Explosions of this kind (and also implosions that are qualitatively similar) are in any case impossible if the right-hand side of the ODE fulfills the condition:

\[-m - kN < f(N) < m + kN\]

for some arbitrary, but positive constants \( k \) and \( m \) and \( N > 0 \) (a similar condition can be formulated for \( N < 0 \), but is considered uninteresting in the current context).
An example of an ODE without a unique solution is:

\[
\frac{dN(t)}{dt} = \sqrt{N}, \quad N(0) = 0 \tag{3.37}
\]

Even though it is hard to imagine that this ODE represents a population dynamic model, it suits our purpose to illustrate the non-uniqueness of solutions. The equation

\[
N(t) = \begin{cases} 
0 & \text{for } t \leq c \\
\left(\frac{t - c}{2}\right)^2 & \text{for } t \geq c 
\end{cases} \tag{3.38}
\]

with \(c\) an arbitrary, positive constant specifies an entire family of solutions to the ODE: for whatever value of \(c\), equation (3.38) is a solution for the ODE. Hence, these solutions are never unique. The problem is that the right-hand side of the ODE (3.37) increases too quickly for \(N = 0\), since the tangent to \(\sqrt{N}\) in this point is a vertical line. This type of non-uniqueness is guaranteed not to occur if the derivative of the right-hand side function \(f(N)\) exists and is continuous for all permissible values of its argument \(N\).

### 3.7 Epilogue

In principle this chapter has discussed most of the theory about how to analyze population dynamic models that are formulated in terms of (systems of) ODEs. Also, most of the material discussed allows generalization to models that are formulated in terms of other frameworks, such as difference equations or integral equations. When models become of higher dimension, new concepts will be needed to deal with technical complications, making the analysis also technically more difficult. For example, when analyzing systems of ODEs matrix calculus is needed to derive the characteristic equation and the eigenvalues. Nonetheless, the basic ideas are the same as discussed here for one-dimensional models (i.e. in terms of a single ODE):

- Models can be reformulated as non-dimensional analogues. These analogues are phrased in terms of scaled state variables and scaled time with the minimum number of (scaled) parameters, but describe exactly the same dynamics.
- Steady states are determined by finding those states for which the right-hand side of the ODEs vanish.
- The stability of the steady states can be determined by studying the linearized version of the model in the neighborhood of the steady states. For this linearized system a characteristic equation can be derived, which the eigenvalues (or characteristic growth rates) of the model in the neighborhood of the steady state.

One aspect of model analysis has not been discussed in this chapter: studying the behavior of the model for different parameter values. This addresses the question how the model dynamics is going to change when particular parameters are increased or decreased, what type of different dynamics can occur over the full range of relevant parameter values, how one type of dynamics transforms into the other, etc. These questions are within the domain of bifurcation theory which will be discussed in part III.
Chapter 4

Competing for resources

Even though the concept “competition” is central to population dynamics and ecology, its precise meaning is less clear cut. In a general textbook on ecology (Begon et al. 1996), competition is defined as

an interaction in which one organism consumes a resource that would have been available to, and might have been consumed by, another. One organism deprives another, and as a consequence, the other organism grows more slowly, leaves fewer progeny or is at greater risk of death.

The above definition suggest that competition is about food, as the definition refers to organisms “consuming” resources. However, competition may be about many different things that have nothing to do with feeding, such as nesting sites, territoria and mating partners. Basically, competition is always an act that one individual takes, eats or uses something, which is subsequently unavailable to other individuals of the same or other species. That something is referred to as a resource.

Competition may be between individuals of the same species, in which case we call it intraspecific competition, or of different species, in which case it is called interspecific competition. Moreover, competition may be direct or indirect. An example of direct or interference competition is when two individuals fight for the same piece of food that one of them has just caught. Also competition for sexual partners is usually a form of interference competition. On the other hand, indirect competition, which is also referred to as exploitation competition does not involve direct contact among the competitors. The most obvious example is when individuals feed on a shared food source: the food eaten by one individual is unavailable to the others and hence there is a competitive interaction. In this chapter we will mainly deal with exploitation competition.

After this introduction of the most common terminology regarding competition we return to the question what exactly is a resource? Answering this question is actually very hard. Instead of elaborately discussing the meaning of the term resource I will just give some examples of what can rightfully be called resources. Food is definitely a resource for all heterotrophic organisms. Appropriate types of shelter or space have also been termed resources if they have an effect on an individual’s probabilities of birth and death. Common resources for plants are light, mineral nutrients, water, pollinators and seed dispersal agents. Within a species, members of one of the sexes have been called a resource for the opposite sex. Basically, two requirements can be distinguished for something to be considered a resource:

1. it should affect the survival or reproduction of an individual, and

2. it should be consumed or used and hence depleted, making it unavailable to other individuals.
CHAPTER 4. COMPETING FOR RESOURCES

Figure 4.1: Growth of the yeast *Schizosaccharomyces kephir* over a period of 160 h. The circles are experimental observations. The solid curve is the fitted curve $N(t) = 5.8/(1 + \exp(2.47 - 0.0607t))$. From Gause (1934).

This chapter is devoted to formulating various models that incorporate intra- and/or interspecific competition. The overall aim of the chapter is on the one hand to introduce a number of concepts and ideas that have been developed as part of a competition theory. On the other hand, while discussing the ins and outs of competition within and among species, a number of new techniques or extensions of already discussed techniques will be introduced. The first part of the chapter will deal with intraspecific competition, while the second part will focus on interspecific competition.

4.1 Intraspecific competition in a single population

4.1.1 Growth of yeast in a closed container

Some classic examples about population growth and intraspecific competition are the experiments carried out by Gause (1934) with the yeast *Schizosaccharomyces kephir* (see Fig. 4.1). These experiments have been carried out in closed containers such as test tubes and Erlenmeyer flasks. The experiments were started with a “virgin” container with growth medium and a small inoculation of yeast. Figure 4.1 shows that at first the yeast population starts to grow exponentially, but that growth decelerates and population abundance reaches a constant level. The fitted curve in Fig. 4.1 is actually the logistic growth equation (2.14). Both the logistic and two-sexes population growth model (Eq. 2.14 and 2.17, respectively) are examples of models that *implicitly* incorporate intraspecific competition, because in both cases the per capita reproduction rate decreases with population abundance. These model hence do specify that the presence of other individuals around decreases the reproductive output of single individuals, i.e. individuals in the population do compete, but the models leave unspecified what the precise mechanism of this decrease is. It could hence be because food availability declines or because individuals at higher densities spend more time fighting each other.

For the experimental design used by Gause (1934) it is possible to formulate an explicit and
mechanistic model for the growth of the yeast in the closed container. In the end this model will be the same as the logistic growth model \(^{(2.14)}\), but it will be derived on the basis of an explicit conceptualization of the competition process going on among the yeast cells.

To this end assume that

- the growth of the yeast is limited by a single nutrient (resource), whose concentration at time \(t\) is indicated by \(R(t)\),
- every yeast cell contains \(\alpha\) units of the limiting nutrient,
- the initial concentration of the limiting nutrient equals \(R(0)\), while the initial abundance of yeast cells equals \(N(0)\),
- a single yeast cell takes up the limiting nutrient at a rate \(\kappa R(t)\) that is proportional to the current nutrient concentration, and
- a single yeast cell divides into 2 identical daughter cells after having taken up \(\alpha\) units of the limiting nutrient.

At the start of the experiment, the total amount of limiting nutrient in the experimental vessel equals:

\[
R^0 := R(0) + \alpha N(0) \tag{4.1}
\]

which is the sum of the nutrient amount in solution and the nutrient amount contained in the initial yeast population. Since nutrient only disappears from the solution through uptake by the yeast, at any time \(t\) the total amount of nutrient in the vessel (both in solution and incorporated into the yeast population) should equal \(R^0\):

\[
R(t) + \alpha N(t) = R^0 \tag{4.2}
\]

The uptake rate of the limiting nutrient by a single yeast cell equals \(\kappa R(t)\). As a consequence the time it takes to take up sufficient nutrients for a new daughter cell equals

\[
\frac{\alpha}{\kappa R(t)},
\]

such that the rate at which a single yeast cell produces new daughter cells equals

\[
\frac{\kappa R(t)}{\alpha}.
\]

This leads to the following ODE, describing the dynamics of yeast cells:

\[
\frac{dN}{dt} = \frac{\kappa R(t)}{\alpha} N(t) \tag{4.3}
\]

If now the relation (4.2) is substituted in this ODE we obtain:

\[
\frac{dN}{dt} = \kappa \left( \frac{R^0}{\alpha} - N(t) \right) N(t) \tag{4.4}
\]

which can be rewritten as:

\[
\frac{dN}{dt} = \frac{\kappa R^0}{\alpha} \left( 1 - \frac{N(t)}{R^0/\alpha} \right) N(t) \tag{4.5}
\]
CHAPTER 4. COMPETING FOR RESOURCES

This latter ODE is identical to the logistic growth equation \((4.5)\) with the parameters \(r\) and \(K\) defined as:

\[
\begin{align*}
r &= \frac{\kappa R^0}{\alpha} \quad (4.6a) \\
K &= \frac{R^0}{\alpha} \quad (4.6b)
\end{align*}
\]

The dynamics of both the limiting nutrient concentration \(R(t)\) and the yeast cell abundance \(N(t)\) could have been expressed as a system of two, coupled ODEs:

\[
\begin{align*}
\frac{dR}{dt} &= -\kappa R(t)N(t) \quad (4.7a) \\
\frac{dN}{dt} &= \kappa R(t) \frac{1}{\alpha} N(t) \quad (4.7b)
\end{align*}
\]

The derivation of the logistic growth equation \((4.5)\) for the yeast cell abundance \(N(t)\) actually represents a way of solving the coupled system of ODEs \((4.7)\). In a more formal way of solving the system of ODEs, the first equation \((4.7a)\) is rewritten by using the second ODE \((4.7b)\):

\[
\frac{dR}{dt} = -\frac{\alpha}{\kappa} \frac{dN}{dt} \quad (4.8)
\]

By integrating both the left-hand and right-hand side of this latter ODE we actually end up with:

\[
\int_0^t \frac{dR}{dt} \, dt = -\alpha \int_0^t \frac{dN}{dt} \, dt
\]

\[
R(t) - R(0) = -\alpha (N(t) - N(0))
\]

\[
R(t) = -\alpha N(t) + R(0) + \alpha N(0)
\]

which is equivalent to equation \((4.24)\) relating the current concentration of nutrient in solution and the current yeast cell abundance to the total amount of nutrient initially present in the experimental vessel.

The above derivation shows that the logistic growth model can actually have a solid mechanistic basis in terms of competition for a limiting nutrient supply.

### 4.1.2 Bacterial growth in a chemostat

Chemostats are experimental systems that are used to sustain a continuous culture of bacteria. In contrast to the closed container experiments discussed in the previous section, a chemostat is an open system with a continuous supply of nutrients. Figure 4.2 shows a schematic layout of a chemostat. A stock nutrient solution, in which the concentration of limiting nutrient equals \(R^0\), is pumped into the culture vessel at rate \(F\). An equal efflux keeps the total volume \(V\) in the culture vessel constant over time. Note that through the outflow both nutrient and bacteria leave the culture vessel.

Apart from the importance of the chemostat for sustaining a continuous culture of microorganisms (primarily bacteria), it also constitutes a highly idealized system for modeling and studying competition within and among species, which has given rise to even textbooks on the theory of the chemostat (Smith & Waltman 1994). To model a single bacterial population in continuous culture we make the following assumptions:
4.1. INTRASPECIFIC COMPETITION

Figure 4.2: Schematic layout of a chemostat for continuous culture of micro-organisms. A stock nutrient solution, in which the concentration of limiting nutrient equals $R^0$, is pumped into the culture vessel at rate $F$. An equal efflux keeps the total volume $V$ in the culture vessel constant over time.

- It is assumed that the culture vessel is kept well stirred, such that there are no spatial inhomogeneities in the concentration of either nutrient or bacteria. This assumption allows us to describe the growth process entirely in terms of ordinary differential equations.

- Although the nutrient medium may contain a number of components, we will focus attention on a single growth-limiting nutrient whose concentration will determine entirely the growth of the bacteria. The current concentration of this limiting nutrient in the culture vessel at time $t$ will be denoted by $R(t)$.

- Bacteria take up the limiting nutrient at a rate $\kappa R(t)$ that is proportional to the current nutrient concentration.

- Every bacterial cell is assumed to contain $\alpha$ units of the limiting nutrient. A bacteria divides into 2 identical daughter cells after having taken up $\alpha$ units of the limiting nutrient.

These assumptions are very much analogous to the assumptions made while formulating the yeast growth model in a closed container (see section 4.1.1). The essential difference between the model for the chemostat and the yeast growth model, is that now fresh nutrient medium is pumped into the culture vessel at rate $F$, while both nutrient and bacterial cells leave the culture chamber at the same rate $F$. Table 4.1 lists the state variables and parameters of the model along with their interpretation and dimension. As a first start, we can use the model equations (4.7) as a basis to describe the dynamics of both the nutrient concentration and the bacterial population abundance in the chemostat. The only terms that have to be added are the ones accounting for inflow of fresh nutrient from the reservoir and outflow of nutrient and bacteria from the culture chamber. A first attempt for the model equations hence is:

\[
\frac{dR}{dt} = FR^0 - FR - \kappa RN \tag{4.9a}
\]

\[
\frac{dN}{dt} = \frac{\kappa R}{\alpha} N - FN \tag{4.9b}
\]

In these equations I have dropped the explicit dependence of $R$ and $N$ on time $t$ in the right-hand side of the ODE. This is an established practice as the ODE itself indicates that these quantities are functions of time. The first ODE of this system contains the terms $FR^0$ and $FR$, respectively, modeling the inflow and outflow of nutrients. Similarly, the second ODE of
Table 4.1: State variables and parameters of a bacterial growth model in a chemostat

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>$R(t)$</td>
<td>Nutrient concentration in culture chamber</td>
<td>mass/volume</td>
</tr>
<tr>
<td>$N(t)$</td>
<td>Bacterial population abundance</td>
<td>number/volume</td>
</tr>
</tbody>
</table>

### Parameters

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>$R^0$</td>
<td>Nutrient concentration in reservoir</td>
<td>mass/volume</td>
</tr>
<tr>
<td>$F$</td>
<td>Input and output flow rate</td>
<td>volume/time</td>
</tr>
<tr>
<td>$V$</td>
<td>Volume of the culture chamber</td>
<td>volume</td>
</tr>
<tr>
<td>$\kappa$</td>
<td>Proportionality constant for bacterial nutrient uptake</td>
<td>volume/time</td>
</tr>
<tr>
<td>$\alpha$</td>
<td>Nutrient content of single bacteria</td>
<td>mass</td>
</tr>
</tbody>
</table>

the system incorporates the term $FN$, which models the outflow of bacteria from the culture chamber.

Even though these ODEs contain all the necessary terms, they are not correct. This becomes clear when we carefully check the dimensions of all terms in the above system of ODEs (cf. section 3.5). First of all we should figure out what the dimension of the parameter $\kappa$ is, while that is not immediately clear from the assumptions. Because the left-hand side of equation (4.9b) bears the dimension number/(volume·time), the right-hand side should bear this dimensions as well. Given the dimensions of $N$, $R$ and $\alpha$, occurring in the first term of the right-hand side (4.9b), we can infer that $\kappa$ needs to bear the dimensions volume/time, as is already listed in table 4.1. However, the second term in the right-hand side of equation (4.9b) has dimension number/time which lacks a volumetric dimension in the denominator. Similarly, the left-hand side of equation (4.9a) bears dimension mass/(volume·time), while the first and second term of its right-hand side have a dimension mass/time. Again a volumetric dimension is missing in the denominator. (Superficially, the last term in the right-hand side of equation (4.9a) also has the wrong dimension, since straightforward application of the dimensions listed in table 4.1 would suggest that this term carries the dimension (number-mass)/(volume·time). It should be realized, however, that a number is essentially dimensionless such that the dimension is indeed correct: mass/(volume·time)).

The mistake made in the derivation of the system of ODEs (4.9) is that the rate $F$ with which fresh nutrient supply of concentration $R^0$ enters the culture chamber distributes itself over the entire volume $V$ of the culture vessel. The total input of fresh nutrients, equal to $FR^0$, hence distributes itself over a volume $V$ and cause a change in the nutrient concentration equal to $FR^0/V$. Similar arguments hold for the outflow rates of nutrients and bacteria from the culture vessel, $FR$ and $FN$ respectively, which also have to be divided by the vessel volume $V$ to correctly express the effect of outflow on the nutrient concentration $R(t)$ and cell abundance $N(t)$. Therefore, the correct set of equations describing the dynamics of nutrients and bacteria in the chemostat is:

$$
\frac{dR}{dt} = \frac{FR^0}{V} - \frac{FR}{V} - \kappa RN 
$$  \hspace{1cm} (4.10a)

$$
\frac{dN}{dt} = \frac{\kappa R}{\alpha} N - \frac{FN}{V} 
$$  \hspace{1cm} (4.10b)
4.1. INTRASPECIFIC COMPETITION

This set of ODEs is the first system of coupled ODEs that we encounter. Such coupled sets of equations occur in all models that describe the dynamics of more than a single component. These components can be multiple species or nutrients and populations as in the chemostat example discussed here. In the following sections we will discuss a number of different methods to analyze the behavior prescribed by the model.

4.1.3 Asymptotic dynamics

One approach to analyzing a system of ODEs like (4.11) is to attempt an analogous simplification as was discussed in section 4.1.1 (see equation (4.8)) for the growth of a yeast population in a closed container. In other words, can we solve the ODE (4.10a) for the nutrient concentration \( R(t) \) in terms of the cell abundance \( N(t) \)? The background of equation (4.8) was that the total nutrient concentration, that is the sum of nutrients in solution plus nutrients contained in yeast, remained constant over time, as the dynamics were taking place in a closed container. By defining the total nutrient concentration in the chemostat (both free in solution and bound in bacterial cells) as:

\[ T_R(t) := R(t) + \alpha N(t), \quad (4.11) \]

an ODE can be derived for \( T_R(t) \) as follows:

\[
\frac{dT_R}{dt} = \frac{d(R + \alpha N)}{dt} = \frac{dR}{dt} + \frac{\alpha dN}{dt} = \frac{FR^0}{V} - \frac{FR}{V} - \kappa RN + \alpha \left( \frac{\kappa R}{\alpha} N - \frac{FN}{V} \right) = \frac{FR^0}{V} - \frac{FR}{V} - \alpha \frac{FN}{V} = \frac{FR^0}{V} - \frac{FT_R}{V}
\]

Hence, eventually the total nutrient concentration in the culture chamber will follow the ODE:

\[
\frac{dT_R}{dt} = F \left( \frac{R^0}{V} - T_R \right) \quad (4.12)
\]

From this ODE we can easily see that

\[
\lim_{t \to \infty} T_R(t) = R^0 \quad (4.13)
\]

The value \( T_R = R^0 \) is actually the steady state value for the total nutrient concentration \( T_R \), i.e. the concentration for which \( dT_R/dt = 0 \). We could now simply assume that

\[
\frac{dT_R}{dt} \approx 0
\]

holds for all times \( t \). Especially if the flow rate \( F \) is large and the volume is not too large, the quotient \( F/V \) can be large in comparison with the growth rate of the bacteria, which equals \( \kappa R/\alpha \):

\[
\frac{F}{V} \gg \frac{\kappa R}{\alpha}
\]
In this case, the total nutrient concentration $T_R(t)$ will have approximated its steady state value $R^0$ long before the cell abundance $N(t)$ has even changed a little from its initial value. In this case we can simply pretend that

$$T_R = R(t) + \alpha N(t) \approx R^0$$

This latter equality can subsequently be used to eliminate the nutrient concentration $R(t)$ from the ODE (4.10b) for the dynamics of the bacterial cell abundance. This leads to:

$$\frac{dN}{dt} = \kappa (R^0 - \alpha N) - \frac{FN}{V}$$

$$= \left( \frac{\kappa R^0}{\alpha} - \frac{F}{V} - \kappa N \right) N$$

After some algebraic manipulation we see that the resulting ODE can be written as a logistic growth equation (2.14) with parameters:

$$r = \frac{\kappa R^0}{\alpha} - \frac{F}{V} \quad (4.14a)$$

$$K = \frac{R^0}{\alpha} - \frac{F}{\kappa V} \quad (4.14b)$$

The logistic growth equation can hence show up even though the underlying mechanisms are entirely different. The expressions for the parameters (4.14) also make clear that the parameters $r$ and $K$ in this case have no interpretation that is intrinsic to the bacteria, since also the flow rate $F$, the nutrient supply concentration $R^0$, and the vessel volume $V$ show up in both $r$ and $K$.

4.1.4 Phase-plane methods and graphical analysis

The aim of this chapter is to study the behavior of systems of coupled ODEs mostly through graphical and geometric approaches. Hence, instead of more rigorous algebraic manipulations we will exploit geometric insights and some intuition to chart out the qualitative behavior of a model in a pictorial form. Such pictures are generally far more informative than mathematical expressions and lead to a better understanding of the model dynamics and how it is influenced by its parameters.

For systems of two ODEs it is possible to carry out a graphical analysis much along the lines that was discussed in section 3.3 (Some people even claim to analyze systems of three ODEs in this manner, but such experience is simply beyond me). However, since there are now 2 state variables it is not much use any longer to plot the right-hand side of the ODE as a function of a single state variable (cf. section 3.3). Instead, our basic analysis will use graphs spanned by an $x$- and a $y$-axis on which the two state variables $R(t)$ and $N(t)$ are indicated. The choice which state variable to represent with which axis is arbitrary, but I will consistently use $R(t)$ on the $x$-axis and $N(t)$ on the $y$-axis of the graphs.
4.1. INTRASPECIFIC COMPETITION

Such a graph spanned by axes that represent state variables is called a phase plane graph. Its name is derived from the fact that all the combinations \((R, N)\) depicted in the graph represent all possible states that the system we are modeling can adopt. If the model we are studying becomes higher dimensional, for example, in terms of three or more variables, we are usually referring to a phase space or state space instead of a phase plane, because the set of all possible states that the system can adopt also becomes higher dimensional. In the following I will refer to the phase plane as the \((R, N)\)-plane.

First, let us rewrite the chemostat model equations (4.10) as:

\[
\begin{align*}
\frac{dR}{dt} &= f(R, N) \quad (4.15a) \\
\frac{dN}{dt} &= g(R, N) \quad (4.15b)
\end{align*}
\]

in which the right-hand side functions \(f(R, N)\) and \(g(R, N)\) are defined as:

\[
\begin{align*}
f(R, N) &= \frac{FR_0}{V} - \frac{FR}{V} - \kappa RN \\g(R, N) &= \frac{\kappa R}{\alpha} N - \frac{FN}{V}
\end{align*}
\] (4.16a) (4.16b)

Technically, we have to assume that \(f(R, N)\) and \(g(R, N)\) are continuous functions and that their derivatives with respect to both \(R\) and \(N\) exist to ensure that the set of ODEs actually specifies a unique solution for an particular initial conditions \(R(0)\) and \(N(0)\) (see also section 3.6).

Two, time-dependent functions, \(R(t)\) and \(N(t)\), would be a solution to the system of ODEs (4.15) if they satisfy the set of ODEs (4.15) together with the initial conditions \(R(0)\) and \(N(0)\) imposed (if there are any). In the phase plane any combination of \(R(t)\) and \(N(t)\) represents a point, which we can equivalently represent by a vector \(\mathbf{x}(t)\) defined as:

\[
\mathbf{x}(t) := \begin{pmatrix} R(t) \\ N(t) \end{pmatrix}
\] (4.17)

The system of ODEs (4.15) is a recipe that specifies how the values \(R(t)\) and \(N(t)\) change over time. At the same time, it therefore specifies how the point \((R(t), N(t))\) or vector \(\mathbf{x}(t)\) moves over time through the \((R, N)\)-plane. By defining a vector-valued function \(\mathbf{H}(\mathbf{x})\) as follows:

\[
\mathbf{H}(\mathbf{x}) := \begin{pmatrix} f \\ g \end{pmatrix} = \begin{pmatrix} dR/dt \\ dN/dt \end{pmatrix}
\] (4.18)
CHAPTER 4. COMPETING FOR RESOURCES

46

Figure 4.3: Geometric representation of a system of ODEs in the phase plane. The curve starting in the point \( R(0), N(0) \) represents some imaginary solution curve to a system of ODEs, which also passes through the point \( (R(t), N(t)) \) at time \( t \). The vector \( x(t) \) is the vector representation of this latter point. Also indicated is the velocity vector \( dx/dt \) determined by the system of ODEs.

The systems of ODEs (4.15) could therefore also be written in vector form as:

\[
\frac{dx}{dt} = H(x) \tag{4.19}
\]

(Notice that I have left out the explicit dependence of the functions \( f \) and \( g \) in equation (4.18) on the state variable \( R \) and \( N \)).

Loosely speaking, the left-hand side of ODEs (4.15a) and (4.15b), \( dR/dt \) and \( dN/dt \), respectively, can be interpreted as the change in the nutrient concentration \( R(t) \) and bacterial cell abundance \( N(t) \) during an infinitesimally small time interval \( dt \). In the phase plane these two quantities determine the direction of a curve through the point \( (R(t), N(t)) \), which is the solution curve to the system of ODEs (see also Figure 4.3). This direction specified by \( dR/dt \) and \( dN/dt \) can again be represented by a vector, which in equation (4.18) is defined as \( H(x) \). This vector is \textit{tangent} to the solution curve in the point \( x(t) = (R(t), N(t)) \).

These geometric representations of the system of ODEs (4.15) and (4.19) are illustrated in the phase plane graph in Fig. 4.3. Verbally they can be summarized as follows:

1. The pair of values \( (R(t), N(t)) \) that forms a solution to the system of ODEs (4.15) represents a \textit{curve} in the \( (R, N) \)-phase-plane. Each position on this curve is uniquely determined by the time value \( t \) (i.e. the curve is parameterized by \( t \)).

2. The point \( (R(t), N(t)) \) can also be represented by a \textit{vector} \( x(t) \), starting in the origin and pointing to a position along the solution curve \( (R(t), N(t)) \), which is the state of the system at time \( t \).

3. The vector \( dx/dt \), which is just a short-hand notation for \( (dR/dt, dN/dt) \) is the tangent vector to the solution curve in the point \( x(t) \) and thus represents the curve direction.
4.1. INTRASPECIFIC COMPETITION

Its magnitude, which is indicated by $|d\mathbf{x}/dt|$, represents the speed of motion of the point $(R(t), N(t))$ along the solution curve. The vector $d\mathbf{x}/dt$ is hence also referred to as the velocity vector or direction vector, while the vector $\mathbf{x}(t)$ is referred to as the position vector.

4. Using $\mathbf{x}(t)$ the system of ODEs (4.15) for the change in nutrient concentration $R(t)$ and cell abundance $N(t)$ can also be written in the shorter, vector form

$$\frac{d\mathbf{x}}{dt} = \mathbf{H}(\mathbf{x})$$

Here the vector function $\mathbf{H}(\mathbf{x})$, defined in equation (4.18), assigns a velocity vector to every location $\mathbf{x}$ in the phase plane.

Having determined that the right-hand side of a system of ODEs like the one in equation (4.15) determines a tangent velocity vector to the unique solution curve through any point $\mathbf{x} = (R, N)$, one way to proceed with a graphical analysis is by drawing a large number of these velocity vectors in the $(R, N)$-phase-plane. Together such a collection of velocity vectors is referred to as a direction field or a phase plane portrait. Drawing phase planes with direction fields gives, after some training, good insight into the dynamics of systems of 2 ODEs (see, for example, Edelstein-Keshet 1988, section 5.4 on page 175-178). Another way to gain insight into the dynamics is by delineating in the phase plane graph the regions with $(R, N)$ combinations for which:

• both the nutrient concentration $R$ and the bacterial cell abundance $N$ increase,
• both the nutrient concentration $R$ and the bacterial cell abundance $N$ decrease,
• the nutrient concentration $R$ increases, but the bacterial cell abundance $N$ decreases, and
• the nutrient concentration $R$ decreases, but the bacterial cell abundance $N$ increases.

Delineating these 4 different regions will be carried out in two steps: first we will find those combinations of $(R, N)$ for which the nutrient concentration $R$ increases or decreases. In the second step, the same procedure will be repeated for the bacterial cell abundance $N$.

For which values of $R$ and $N$ the nutrient concentration $R$ increases or decreases can be derived by considering for $(R, N)$ combinations it does not change. In other words, we first derive for which values of $R$ and $N$

$$\frac{dR}{dt} = 0$$

Substituting the right-hand side of the ODE (4.10a) in the equality above leads to the equation:

$$\frac{FR^0}{V} - \frac{FR}{V} - \kappa RN = 0$$

With some simple algebraic manipulation this equality can be rewritten as:

$$N = \frac{F}{\kappa V} \left( \frac{R^0}{R} - 1 \right) \quad (4.20)$$

This last equation determines a curve in the $(R, N)$-phase plane, indicating all those values of $R$ and $N$ for which the nutrient concentration $R$ does NOT change. Such a curve, for which $dR/dt = 0$ holds, is called the isocline for the nutrient concentration $R$. Isoclines or nullclines are curves in the phase plane for which one of the state variables ($R$ and $N$ in the case considered here) does not change.
Equation (4.20) determines a curve that intersects the $x$-axis of the phase plane (i.e. the axis $N = 0$) for the value $R = R_0$. On the other hand, if $R$ decreases to 0, $R \downarrow 0$ the bacterial cell abundance $N$ increases unboundedly, $N \to \infty$. If we substitute the values $R = 0$ and $N = 0$ in the right-hand side of the ODE (4.10a), the rate of change of the nutrient concentration $R$ is found to equal:

$$\frac{dR}{dt} = \frac{FR_0}{V}$$

which is clearly positive. Therefore, for values of $R$ and $N$ close to 0 the rate of change $dR/dt$ is clearly positive. On the other hand, if $R$ and $N$ are both very large, it is easily inferred from the right-hand side of the ODE (4.10a) that the rate of change $dR/dt$ is negative. These characteristics of the ODE (4.10a) can now be summarized in the following phase plane graph:

The thick solid curve drawn in the graph above is the isocline for the nutrient concentration $R$. Hence, for those combination of $R$ and $N$ the rate of change $dR/dt$ equals 0 (i.e. not change in nutrient concentration). The arrows below and above the curve indicate that in these regions with $(R, N)$-combinations the rate of change $dR/dt$ is positive (i.e. $R$ will increase with time) or negative (i.e. $R$ will decrease with time), respectively.

Next we repeat the same type of analysis for the ODE (4.10b) determining the rate of change $dN/dt$ of the bacterial cell abundance $N$. Equating $dN/dt$ to 0 leads to the relation:

$$\frac{\kappa R}{\alpha}N - \frac{FN}{V} = 0$$

which shows that it is possible to infer two relations for which $dN/dt = 0$:

$$N = 0$$

or

$$R = \frac{\alpha F}{\kappa V}$$

The curves of these relations in the $(R, N)$ phase plane are again referred to as the isoclines, now for the bacterial cell abundance $N$. Obviously, one isocline for the bacterial cell abundance $N$ is given by $N = 0$: if there are no bacteria at all present there will be neither growth or decline and hence $dN/dt$ obviously equals 0 (this zero isocline is encountered in almost every population dynamical model, in which population growth or decline only depends the population
4.1. INTRASPECIFIC COMPETITION

abundance and there hence is no immigration). In addition, equation (4.22) determines a second isocline for the bacterial cell abundance $N$ which constitutes a vertical line in the $(R, N)$ phase plane. For high values of nutrient concentration $R$ and non-zero bacterial densities $N > 0$, the right-hand side of the ODE (4.10b) clearly shows that $dN/dt$ is positive and hence the bacterial cell abundance will increase. For values of nutrient concentration $R$ close to zero and non-zero bacterial densities $N > 0$, $dN/dt$ is negative and $N$ will decrease. These properties of the ODE (4.10b) are summarized in the following graph:

The isoclines in this graph are indicated with thick dashed line, one isocline being $N = 0$, the other $R = \alpha F/(\kappa V)$. To the left of the latter isocline the bacterial abundance will decline, to the right of it the bacterial cell abundance $N$ will increase.

The next step is that we combine the two graphs shown above with the isoclines and flow patterns of the nutrient concentration $R$ and the bacterial cell abundance $N$ into a single phase plane graph. Figure 4.4 shows the resulting graph. The two intersections of the $R$-isocline with the $N$-isoclines are the steady states of the model (4.10), as for these two combinations of $R$ and $N$ neither the nutrient concentration, nor the bacterial cell abundance will change (i.e. both $dR/dt$ and $dN/dt$ equal 0). The two steady states are indicated by solid circles in the graph above. The phase plane with positive value of $R$ and $N$ (usually referred to as the positive quadrant or more generally the “positive cone”) is hence divided into 4 different regions by the $R$- and $N$-isoclines. In each of these regions a single pair of a vertical and a horizontal arrow in the graph above indicate whether the nutrient concentration $R$ and the bacterial cell abundance $N$ increase or decrease, respectively. Mathematically, the two steady states are given by:

$$\text{Extinct steady state:} \quad \{R, N\} = \{R^0, 0\}$$ (4.23)

$$\text{Internal steady state:} \quad \{R, N\} = \{\alpha F/(\kappa V), R^0/\alpha - F/(\kappa V)\}$$ (4.24)

The bacterial cell abundance $N$ for the internal steady state is obtained by substituting $R = \alpha F/(\kappa V)$ into equation (4.20) and simplifying the resulting expression.

From the isoclines and flow patterns it is sometimes possible to work out whether the steady states are stable and what the dynamics will eventually be in the neighborhood of the steady states. This can be done for the extinct steady state $\{R, N\} = \{R^0, 0\}$. The phase plane graph (Fig. 4.4) shows that if the bacterial cell abundance $N$ would be slightly perturbed (displaced) to a very small positive value, the abundance would actually increase (the flow arrows are pointing upwards and to the left). Hence, the cell abundance $N$ would increase even further, while the
nutrient concentration $R$ will decrease. On the other hand, if the nutrient concentration would be slightly perturbed to a lower or higher value than $R^0$, the nutrient concentration would return to $R^0$, as long as the bacterial cell abundance is kept at 0. This assessment can be derived from the ODEs (4.10) and by studying the phase plane graph in Fig. 4.4. Therefore, the extinct steady state is in general unstable, but it is stable against perturbations along the $x$-axis of the nutrient concentrations $R$. A steady state with the property that it can withstand perturbations in particular directions, but not in all and that is hence unstable, is called a saddle point.

A similar analysis for the internal steady state is, however, in general not possible. The following graph zooms in at the phase plane in the neighborhood of this steady state:

In this graph I have also drawn direction vectors for 4 points on the two isoclines. The vectors for the points at the $R$-isocline necessarily point in a vertical direction, since for all the points on the $R$-isocline $dR/dt = 0$. Similarly, the vectors for the points at the $N$-isocline necessarily point in a horizontal direction, since for all the points on this isocline $dN/dt = 0$. The graph above seems to indicate that the solution curves tend to spiral around the steady state point,
but nothing in the graph indicates whether they will spiral inward towards the steady state point (in which case the latter is stable) or outward away from the steady state point (in which case it is unstable). Graphical methods do not suffice to resolve this issue and we will have to build up some more analytical understanding of dynamics in the neighborhood of a steady state before we can determine whether the state of the system will eventually approach the steady state or not (see also chapter 5).

Actually the bacterial population in a chemostat is an exception to the above rule that we cannot work out the stability of a steady state from a phase plane analysis. In section 4.1.3 we already learned that the total nutrient concentration in the chemostat, both free in solution and bound in bacteria, obeys the very simple ODE (4.12). This total nutrient concentration $T_R$ equals $R + \alpha N$ and the ODE (4.12) specifies that it will never cross the value $T_R = R^0$: if the total nutrient concentration $T_R$ at time 0 is larger than $R^0$ it will always remain larger and if it is smaller it will always remain smaller than $R^0$. In the phase plane graph this means that no solution curve will cross the line which is determined by the relation:

$$R + \alpha N = R^0$$  \hspace{1cm} (4.25)

Using this fact we can actually work out the dynamics in the neighborhood of the internal steady state in this particular case, as is shown in the following diagram:

Here I have added the line determined by (4.25) to the phase plane and have sketched two representative solution curves that approach the internal steady state (note that these curves only qualitatively represent the actual trajectories of the model). One of these solution curves start with a total nutrient concentration $T_R$ larger than $R^0$, the other with $T_R$ smaller than $R^0$. In the entire discussion of the chemostat model up to this point, I have pretended that the vertical $N$-isocline was located at a nutrient concentration $R$ that is smaller than $R^0$. The $N$-isocline was located at $R = \alpha F/(\kappa V)$. As long as $R^0 > \alpha F/(\kappa V)$ there exists an internal steady state, because the $N$-isocline and the $R$-isocline intersect in the positive quadrant (see Fig. 4.4). However, if

$$R^0 < \alpha F/(\kappa V)$$

an internal steady state is impossible to maintain. Under these conditions the input nutrient concentration is too low to sustain a bacterial population in the chemostat. The relation

$$F = \frac{\kappa V R^0}{\alpha}$$ \hspace{1cm} (4.26)

therefore determines a critical boundary, separating those parameter values $R^0$, $F$, and $V$ for which a bacterial population can be maintained in the chemostat from those parameter values
for which the bacteria will go extinct. Because the critical boundary is also determined by the flow rate $F$ of the chemostat, the extinction of the bacteria is also referred to as wash-out, since too high a flow rate will cause the bacteria to go extinct.

If an internal steady state is possible (i.e. $F < \kappa V R^0 / \alpha$), the steady state outflow of bacteria equals:

$$F N_{ss} = \frac{R^0 F}{\alpha} - \frac{F^2}{\kappa V}$$

where $N_{ss}$ is used to indicate the steady state bacterial abundance (see also equation (4.24)). This outflow of bacteria is referred to as the yield of the chemostat, while the idea of the chemostat is to harvest the bacteria growing in the culture vessel. The yield of bacteria is maximal for a flow rate $F$ equal to:

$$F = \frac{\kappa V R^0}{2\alpha}$$

which is exactly half the flow rate above which wash-out of the bacteria will occur. Schematically these relations are summarized in Figure 4.5 which represents a parameter plane spanned by a $x$-axis representing the nutrient concentration in the inflow $R^0$ and a $y$-axis representing the flow rate $F$. The figure gives an overview of all parameter combinations for which bacterial wash-out will occur and graphs the relation (4.27) for the optimal flow rate of the chemostat.

4.2 Interspecific competition

4.2.1 Lotka-Volterra competition model

The most well-known model for interspecific competition has been proposed by Lotka and Volterra and has been studied extensively by Gause (1934). In the Lotka-Volterra model the competition between two species is represented without any reference to resources. For a particular species the presence of a competitor is simply assumed to reduce its growth.
4.2. **INTERSPECIFIC COMPETITION**

Let us denote the two species by their population abundance $N_1$ and $N_2$, respectively. In the absence of the competitor, both species 1 and 2 are assumed to grow following the logistic growth model (2.14). When both species are present their dynamics are assumed to be described by the following system of ODEs:

$$\frac{dN_1}{dt} = r_1 N_1 \left( 1 - \frac{N_1 + \beta_{12} N_2}{K_1} \right) \quad (4.28a)$$

$$\frac{dN_2}{dt} = r_2 N_2 \left( 1 - \frac{N_2 + \beta_{21} N_1}{K_2} \right) \quad (4.28b)$$

In these equations $r_1$ and $r_2$ are the logistic, population growth rate of species 1 and 2, respectively. $K_1$ and $K_2$ are the carrying capacity of both species. The term $\beta_{12} N_2$ in equation (4.28a) can be thought of as the decrease in growth rate of species 1 due to the presence of species 2. The parameter $\beta_{12}$ represents the *per capita* decline (per individual of *species 2*). Similarly, the term $\beta_{21} N_1$ represents the decrease in growth rate of species 2 due to the presence of species 1 with the parameter $\beta_{21}$ is the *per capita* decline (per individual of *species 1*). Under specific assumptions the Lotka-Volterra model can be shown to mechanistically represent competition for resources by two competing species, but it has mostly been studied without any reference to mechanisms. Its analysis can be carried out graphically and the results constitute an important part of competition theory.

To analyze the properties of the Lotka-Volterra model we will carry out a phase-plane analysis of the model equations (4.28) by the following steps:

- determine the isoclines for both $N_1$ and $N_2$ and represent them in a $(N_1, N_2)$-phase-plane,
- determine the steady states as the intersection points of the isoclines, and
- determine the stability properties of these steady states as far this is possible using graphical methods.

From equation (4.28a) we observe that $dN_1/dt$ equals 0 yields the following expressions for the $N_1$-isoclines:

$$N_1 = 0 \quad (4.29a)$$

and

$$K_1 - N_1 - \beta_{12} N_2 = 0 \quad (4.29b)$$

Similarly, equation (4.28b) yields the following expressions for the $N_2$-isoclines:

$$N_2 = 0 \quad (4.30a)$$

and

$$K_2 - N_2 - \beta_{21} N_1 = 0 \quad (4.30b)$$

The first isocline for both species 1 (4.29a) and species 2 (4.30a) simply are the $N_1$- and $N_2$-axis, respectively. The second isocline for species 1 (4.29b) intersects the axis where $N_2 = 0$.
at the carrying capacity of species 1 \( N_1 = K_1 \), while it intersects the axis where \( N_1 = 0 \) at \( N_2 = K_1 / \beta_{12} \). Similarly, the second isocline for species 2 (4.30b) intersects the axis where \( N_1 = 0 \) at the carrying capacity of species 2 \( N_2 = K_2 \), while it intersects the axis where \( N_2 = 0 \) at \( N_1 = K_2 / \beta_{21} \). One pair of these four intersection points lies on the \( N_1 \)-axis, while the other pair lies on the \( N_2 \) axis. This gives rise to four distinct possible constellations, depending on which of the two members of each pair is larger. The four cases are characterized by:

- case I: \( \frac{K_2}{\beta_{21}} > K_1 \) and \( K_2 > \frac{K_1}{\beta_{12}} \) (4.31a)
- case II: \( K_1 > \frac{K_2}{\beta_{21}} \) and \( \frac{K_1}{\beta_{12}} > K_2 \) (4.31b)
- case III: \( K_1 > \frac{K_2}{\beta_{21}} \) and \( K_2 > \frac{K_1}{\beta_{12}} \) (4.31c)
- case IV: \( \frac{K_2}{\beta_{21}} > K_1 \) and \( \frac{K_1}{\beta_{12}} > K_2 \) (4.31d)

Figure 4.6 illustrates these four possible cases of the isoclines in the Lotka-Volterra model. All isoclines are straight lines as could already be inferred from their mathematical expressions (4.29).
and (4.30). From Figure 4.6 we can deduce the possible steady states of the Lotka-Volterra model as the intersection points of a $N_1$-isocline and a $N_2$-isocline. All four cases allow the following three steady states:

- **Extinct state:** $(N_1, N_2) = (0, 0)$ (4.32a)
- **$N_1$-only state:** $(N_1, N_2) = (K_1, 0)$ (4.32b)
- **$N_2$-only state:** $(N_1, N_2) = (0, K_2)$ (4.32c)

In the extinct state both species are absent. In the $N_1$-only state, species 1 reaches its carrying capacity, while species 2 goes extinct, while in the $N_2$-only state species 1 goes extinct and species 2 tends to its carrying capacity.

The cases III and IV allow in addition to these three steady states in which at least one of the species is always absent, an *internal steady state* in which both species have non-zero abundance:

- **Coexistence state:**
  $$ (N_1, N_2) = \left( \frac{K_1 - \beta_{12}K_2}{1 - \beta_{12}\beta_{21}}, \frac{K_2 - \beta_{21}K_1}{1 - \beta_{12}\beta_{21}} \right) $$ (4.33)
Figure 4.7 is almost identical to Figure 4.6, but indicates in addition the steady states for the Lotka-Volterra competition model and the direction fields in the phase plane. To draw these direction fields, observe that:

- in the absence of species 2, species 1 grows logistically to its carrying capacity \( K_1 \),
- in the absence of species 1, species 2 grows logistically to its carrying capacity \( K_2 \),
- across the \( N_1 \)-isoclines the flow in the direction of the \( N_1 \)-axis is always 0, i.e. the flow is always parallel to the \( N_2 \)-axis (vertical direction in Figure 4.7), and
- across the \( N_2 \)-isoclines the flow in the direction of the \( N_2 \)-axis is always 0, i.e. the flow is always parallel to the \( N_1 \)-axis (horizontal direction in Figure 4.7).

In Figure 4.7 these flows across the \( N_1 \)- and \( N_2 \)-isoclines have been drawn for all four cases of the isocline configuration. From these flows across the isoclines the direction fields within each separate region in the phase plane can be worked out. For example, in case I it is obvious that all solution curves will eventually end up inbetween the two slanted lines that form the isocline for species 1 and 2, respectively. Within the area bounded by these two lines the flow is towards the top-left corner (see Fig. 4.7), which implies that all solutions will tend to the \( N_2 \)-only state \((N_1, N_2) = (0, K_2)\). Similarly, in case II all solution curves will also end up inbetween the two slanted lines, but the flow within the enclosed region is towards the bottom-right corner (see Fig. 4.7). In case II therefore all solutions will tend to the \( N_1 \)-only state \((N_1, N_2) = (K_1, 0)\). The cases III and IV are more difficult to analyze, but from the flow patterns in Figure 4.7 the following observations can be made:

- in case III, both the \( N_1 \)-only state \((N_1, N_2) = (K_1, 0)\) and \( N_2 \)-only state \((N_1, N_2) = (0, K_2)\) are stable. This can be seen from the fact in the neighborhood of these two steady states the flow is towards the steady state from all directions. Hence, after a small perturbation away from any of these two steady states the steady state will be approached anew.

- in case III, the internal steady state is a saddle point. This can be deduced from the fact that the direction field points away from the steady state within the triangular regions bounded by the two slanted lines that represent the \( N_1 \)- and \( N_2 \)-isoclines. A small perturbation that would displace the state of the systems into one of these two triangular regions would hence increase with time and the system would move away from the internal steady state. Notice that such a perturbation into the lower triangular region (towards the \( N_1 \)-only state \((N_1, N_2) = (K_1, 0)\)) will cause species 2 to go extinct, while a perturbation into the higher triangular region (towards the \( N_2 \)-only state \((N_1, N_2) = (0, K_2)\)) will cause species 1 to go extinct. Also notice that after a perturbation which displaces the system away from the internal steady state, but not into one of the two triangular regions bounded by the \( N_1 \)- and \( N_2 \)-isoclines, the state of the system will approach the internal steady state anew, as the flow from those directions is towards the steady state. The internal steady state is hence a saddle point.

- in case IV, the flow around the internal steady state is always in the direction of the steady state (see Fig. 4.7). The internal steady state is hence stable. On the other hand, a small displacement of the system away from either the \( N_1 \)-only state \((N_1, N_2) = (K_1, 0)\) or the \( N_2 \)-only state \((N_1, N_2) = (0, K_2)\) steady state will always grow, because the direction field around these steady states points away from them. Both the \( N_1 \)-only and the \( N_2 \)-only steady state are hence unstable.

Together, these deductions lead to the following outcomes of the competition between species 1 and 2:
\textbf{4.2. INTERSPECIFIC COMPETITION}

case I: Species 2 outcompetes species 1.

case II: Species 1 outcompetes species 2.

 caso III: Species 1 can outcompete species 2, but species 2 can also outcompete species 1. The outcome depends on the initial condition.

 caso IV: Species 1 and 2 coexist.

Hence, only in case IV both species can coexist, but they will do so at abundances below their carrying capacity (see equation (4.33)). In all other cases, one species will outcompete the other.

From the conditions (4.31) delineating the four different cases it can be seen that for case IV to occur the interspecific competition parameters $\beta_{12}$ and $\beta_{21}$ cannot be large. If the two carrying capacities are equal $K_1 = K_2$ the condition (4.31d) simplifies to

$$\beta_{21} < 1 \text{ and } \beta_{12} < 1 \quad (4.34)$$

which states that the \textit{interspecific} competition is less intense than the \textit{intraspecific} competition (note the coefficients of 1 in equation (4.28a) and (4.28b)). If in any way, interspecific competition is stronger than intraspecific competition, that is one of the species is more aggressively competing with the other than with its conspecifics, one of the two species will be excluded.

Since the model predicts that competitive exclusion (i.e. one species outcompeting the other and driving it to extinction) will be observed in many situations, an important topic in population biology is to search for explanations why so many, apparently competing species can coexist in the same habitat. In other words, an important field of investigations in population biology addresses the question which mechanism(s) prevents competitive exclusion of competing species. Of course, the Lotka-Volterra model is very simplistic and its neglects many complicating factors, but its strong predictions, which hold true in some experimental situations (see the next section), have reshaped some preconceptions about coexistence and species interactions. The model has hence played an important role in rephrasing the type of research questions being investigated in communities of interacting species that apparently seem to persist without excluding each other.

\textbf{4.2.2 Competition for resources}

An extensive and important body of population biological theory concerns the competition for shared resources between different consumer species. This body of theory has been mainly developed by \textit{Tilman} [1980], see also \textit{Tilman} [1981, 1982] on the basis of competition experiments with different algal species in chemostats. The theory has been primarily developed using a graphical approach \textit{Tilman} [1980]. Hence, a discussion of this body of theory is appropriate in the current chapter, which to a large extent depends on graphical methods as well. The focus of the following presentation of Tilman’s competition theory will be on the ecological aspects of the theory, as opposed to its theoretical and mathematical issues. These theoretical and mathematical ins and outs will hence not be discussed in too much a depth.

\textbf{One consumer and one resource}

The basis of the theory is the interaction between consumer species and \textit{abiotic} resources. Algae that use nutrients like phosphate and silicate for their growth are species to which the theory applies best and which hence have been used extensively to test and show the validity of the theory. The basic set of equations that is used to model this consumer-resource interaction is
Table 4.2: State variables and parameters of Tilman’s resource competition model

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>State variables</strong></td>
<td></td>
</tr>
<tr>
<td>$R(t)$</td>
<td>Available concentration of the resource</td>
</tr>
<tr>
<td>$N(t)$</td>
<td>Abundance of consumers</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>$S$</td>
<td>Maximum concentration of resource supplied to the habitat</td>
</tr>
<tr>
<td>For a chemostat: the influent concentration of resource</td>
<td></td>
</tr>
<tr>
<td>$F$</td>
<td>Flow or supply rate of the resource</td>
</tr>
<tr>
<td>$\mu$</td>
<td>Maximum population growth rate of consumers</td>
</tr>
<tr>
<td>$D$</td>
<td>Per capita death or mortality rate of consumers</td>
</tr>
<tr>
<td>$K$</td>
<td>Half-saturation constant for consumers feeding on resource</td>
</tr>
<tr>
<td>$Q$</td>
<td>Amount of resource required to produce one consumer individual</td>
</tr>
</tbody>
</table>

similar to the system of equations (4.11), describing the growth of bacteria in a chemostat. The coupled system of ODEs central to the theory is the following:

\[
\frac{dN}{dt} = \left( \mu \frac{R}{K + R} - D \right) N \tag{4.35a}
\]

\[
\frac{dR}{dt} = F (S - R) - Q \mu \frac{R}{K + R} N \tag{4.35b}
\]

In the above equations the state variable $N$ represents the abundance of consumers. It is assumed that the growth of the consumers is limited by a single resource, of which the actual concentration is denoted by $R$. The parameter $S$ represents the maximum nutrient concentration that is possible in the habitat, which in a chemostat is identical to the inflow nutrient concentration of resource. The parameter $F$ is the flow or supply rate of resource, which is expressed per unit volume habitat volume (see the discussion in section 4.1.2). The parameter $Q$ indicates the amount of resource that is needed to produce a single consumer individual. Its inverse $1/Q$ is often referred to as the yield, since it represents the number of consumer individuals that a single unit of resource can yield. In the ODE (4.35a), the parameter $\mu$ represents the maximum population growth rate and $D$ the per capita mortality or death rate of consumers. The realized population growth rate is assumed to depend on the resource concentration following a Michaelis-Menten equation, $R/(K + R)$. For very large values of the resource concentration this equation approximates the value 1. For a resource concentration equal to $K$ it has the value of 1/2, which is the reason that $K$ is referred to as the half-saturation constant. The Michaelis-Menten equation is a well-known relationship from enzyme kinetics. It represents a saturating production rate as a function of substrate concentration. Figure 4.8 illustrate the form of this Michaelis-Menten relation as a function of the resource concentration $R$. In chapter 6 we will see that the same function is widely used to model the predator functional response, which is the relationship between the amount of prey eaten by a single predator and the current prey abundance. In that chapter we will also discuss a mechanistic basis for this functional relationship. Table 4.2 summarizes and lists all parameters used in Tilman’s competition model (4.35).
4.2. INTERSPECIFIC COMPETITION

The properties of the single species version of Tilman’s model (4.35) are relatively simple: For all initial conditions the state of the system will approach a stable equilibrium (in this chapter we will not proof the stability of this equilibrium). The resource concentration in this stable equilibrium can be inferred from ODE (4.35a) by equating its right-hand side to 0, yielding:

\[ N^* = 0 \] (4.36)

\[ R^* = \frac{DK}{\mu - D} \] (4.37)

The latter equilibrium value for the resource concentration \( R \) is the solution of the equation:

\[ \mu \frac{R}{K + R} = D \]

If the value of \( R^* \) is too large, i.e. if \( R^* > S \)

the consumer population can not persist and the extinct steady state \( N = 0 \) is stable. If, on the other hand, the maximum resource concentration in the habitat \( S \) is sufficiently large, i.e. if the habitat is sufficiently productive, the consumers can establish a stable population and control the resource concentration in the habitat at the concentration equal to \( R^* \). The consumer abundance in this internal equilibrium can be derived from ODE (4.35b) by substitution of the value \( R = R^* \). This leads to

\[ N^* = \frac{F(S - R^*)}{DQ} = \frac{F(S - DK/(\mu - D))}{DQ} \] (4.38)

This equilibrium consumer abundance, however, does not play a prominent role in Tilman’s theory on resource competition and is hence hardly ever discussed. The crucial quantity is the equilibrium resource concentration \( R^* \) (eq. (4.37)). Hence, the theory is also referred to as the \( R^* \)-theory.
Two consumers and one resource

Adding a second species of consumer to the consumer-resource model \((4.35)\) relatively straightforwardly leads to the following system of ODEs:

\[
\begin{align*}
\frac{dN_1}{dt} &= \left( \mu_1 \frac{R}{K_1 + R} - D_1 \right) N_1 \\
\frac{dN_2}{dt} &= \left( \mu_2 \frac{R}{K_2 + R} - D_2 \right) N_2 \\
\frac{dR}{dt} &= F (S - R) - Q_1 \mu_1 \frac{R}{K_1 + R} N_1 - Q_2 \mu_2 \frac{R}{K_2 + R} N_2
\end{align*}
\]

This model simply includes an additional consumer ODE for the second consumer species. The ODE itself is of identical form for both consumers, only the parameters are assumed to differ between the two consumer species. The abundance of the two consumers is now referred to as \(N_1\) and \(N_2\), while all parameters bear an index 1 or 2 to indicate which consumer species they apply to.

In the absence of the competing consumer species, each of the two species would establish a steady state population, as long as we assume that the habitat is sufficiently productive. Each of the two consumer species would impose an equilibrium resource concentration equal to its \(R^*\)-value. These \(R^*\)-values will be referred to as

\[R_1^*\]

and

\[R_2^*\]

for species 1 and 2, respectively. Only in very exceptional cases, the two \(R^*\)-values will be equal to each other. In general, either \(R_1^*\) or \(R_2^*\) will be the smaller of the two:

\[R_1^* < R_2^* \quad \text{or} \quad R_2^* < R_1^*\]  

(4.40)

In the first case, species 1 can sustain a stable population at a resource level that is too low for species 2 to persist. Hence, species 2 will go extinct. In the second case, the opposite occurs that species 2 drives species 1 to extinction due to its ability to persist at lower resource concentrations. In other words, it is the species with the lowest value of \(R^*\) that outcompetes the other consumers and drives to extinction.

The latter result can be generalized to multiple species. If there are \(p\) consumer species competing for the same resource, they can be ordered and indexed on the basis of their \(R^*\)-values:

\[R_1^* < R_2^* < R_3^* < R_4^* \ldots < R_p^*\]

Consumer species 1 will be able to establish and sustain a stable population at a resource level below the resource concentration that the other species need for persistence. Hence, species 1 will competitively displace all other consumer species. This result exemplifies the competitive exclusion principle, which states that:

**Competitive exclusion principle:**

\(p\) consumer species cannot coexist in a stable equilibrium state on fewer than \(p\) resources
4.2. INTERSPECIFIC COMPETITION

One consumer and two resources

An extension of Tilman’s model for resource competition to a single consumer feeding on two different resources is represented by the following system of ODEs:

\[
\frac{dN_1}{dt} = \left( \mu_1 \min \left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) - D_1 \right) N_1 \tag{4.41a}
\]

\[
\frac{dR_1}{dt} = F \left( S_1 - R_1 \right) - Q_{11} \mu_1 \min \left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) N_1 \tag{4.41b}
\]

\[
\frac{dR_2}{dt} = F \left( S_2 - R_2 \right) - Q_{12} \mu_1 \min \left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) N_1 \tag{4.41c}
\]

In these equations the abundance of consumers is represented by \( N_1 \) (the subscript 1 is retained in these equations because of the models formulated in the previous and the following section, which both deal with two consumer species). \( R_1 \) and \( R_2 \) represent the current concentration of resource 1 and 2, respectively. The parameter \( F \) again represents the flow or supply rate of resources per unit volume habitat volume. It is assumed that \( F \) is the same for both resources, as would be the case if the model was to mimic the dynamics of competitors in a chemostat. The parameters \( S_1 \) and \( S_2 \) represent the maximum nutrient concentration of resource 1 and 2, respectively, that is possible in the habitat. In a chemostat it is identical to the inflow nutrient concentration of resources. The parameters \( Q_{11} \) and \( Q_{12} \) indicate the amount of resource 1 and 2, respectively, that is needed to produce a single consumer individual, their inverse again represent the yield (see section 4.2.2). Note that in case a parameter carries two subscripts, the first one refers to the consumer species, while the second one refers to the resource. Hence, \( Q_{12} \) represents the amount of resource 2 that a consumer individual of species 1 needs to produce an offspring. In the ODE (4.41a), the parameter \( \mu_1 \) again represents the maximum population growth rate and \( D_1 \) the per capita mortality or death rate of consumers.

It is assumed that both resources are essential, which means that they are both needed for population growth and one resource can not be used to substitute the other. Essential resources for algae are, for example, light and carbon dioxide: both substances are required for photosynthesis and for algal growth. Neither of them can make up for the absence of the other. The opposite of essential resources are substitutable resources. Of two substitutable resources an organism will only need one to grow and reproduce. For many heterotrophic organisms fat and sugars are to a large extent substitutable resource as they both provide energy that is used for growing and reproducing. If two resources are truly essential and non-substitutable, the one of them that is shortest in supply, will be limiting population growth. In the above ODEs this expressed by the term

\[
\mu_1 \min \left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right)
\]

which represents the realized population growth rate. The fractions \( R_1/(K_{11}+R_1) \) and \( R_2/(K_{12}+R_2) \) are the Michaelis-Menten relationships relating the consumer population growth rate to the current concentration of resource 1 and 2, respectively. The population growth rate that is realized is the minimum of the two possible values (“Liebig’s law of the minimum”). The parameters \( K_{11} \) and \( K_{12} \) represent the half-saturation concentration of resource 1 and 2, respectively for consumer species 1, i.e. those concentrations at which the fractions reach the value 1/2.
Figure 4.9: Zero net growth isoclines for a one consumer-two resource model. Resource combinations in the hatched area allow consumer growth, combinations in the unhatched cause consumer decline. The thick solid lines between these regions are the zero-growth isoclines.

The analysis of the model (4.41) is an important first step for the case considered in the next section, where we will analyze the outcome of competition of two consumers for two essential resources. Hence, we also retained the subscript 1 to denote the consumer species. To infer the dynamics predicted by the system of ODEs (4.41), notice that for both resources it is possible to derive an $R^*$-value for consumer species 1:

$$R_{11}^* = \frac{D_1 K_{11}}{\mu_1 - D_1} \quad (4.42a)$$

$$R_{12}^* = \frac{D_1 K_{12}}{\mu_1 - D_1} \quad (4.42b)$$

These $R^*$-value only differ in the parameters $K_{11}$ and $K_{12}$. In other words, the differences in $R^*$-value are solely determined by the affinity of the consumer species for both resources. In steady state the per capita birth rate of the consumers should equal their death rate, which implies that the right-hand side of the ODE (4.41a) should equal 0. Ignoring the trivial steady state in which no consumers are present and equating the right-hand side of (4.41a) with 0 leads to the following steady state condition:

$$\mu_1 \min \left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) = D_1 \quad (4.43)$$

This steady state equation does not specify a single combination of $R_1$ and $R_2$, but a large number of such combinations. More specifically, this steady state condition determines two line segments that are perpendicular to each other and are located at $R_1 = R_{11}^*$ and $R_2 = R_{12}^*$, respectively, as shown in Figure 4.9. The two thick solid lines in this figure are all combinations of $R_1$ and $R_2$ that fulfill the steady state condition (4.43). The two perpendicular line segments are together referred to as the zero net growth isocline, which is hereafter abbreviated to ZNGI.
4.2. INTERSPECIFIC COMPETITION

Figure 4.10: Steady state location in a one consumer-two resource model. The thick solid line indicates the zero net growth isocline (ZNGI) at which consumer growth equals 0. The point indicated by \((S_1, S_2)\) represents the supply point, i.e. the maximum nutrient concentrations of resource 1 and 2, respectively, that are possible in the habitat. In a chemostat these would equal the concentrations of the two resources in the inflowing nutrient solution. The vector \((-Q_{11} - Q_{12})\) represents the consumption vector of the consumer species. This vector indicates the direction in which the resource state \((R_1, R_2)\) declines due to consumer feeding. Both resources increase due to resource inflow or regeneration which is always in the direction of the supply point \((S_1, S_2)\) when considered from the current combination of resource concentrations \((R_1, R_2)\). Hence, the direction in which the resource state \((R_1, R_2)\) changes due to inflow or regeneration is given by the supply vector \((S_1 - R_1) / (S_2 - R_2)\). The steady state is the unique point on the ZNGI where the consumption and supply vectors are pointing in exactly opposite direction.

For combinations of \(R_1\) and \(R_2\) in the hatched area above and to the right the ZNGI, the consumer population will grow, while for combinations of \(R_1\) and \(R_2\) below and to the left of the ZNGI (the unhatched area) the consumer abundance will decline. The steady state of the model is located somewhere at the border of the hatched and unhatched area where the consumer growth rate is 0.

To determine the steady state of the model, we could of course equate the right-hand sides of the ODEs (4.41b) and (4.41c) to 0 and combine this with the steady state condition (4.43). After some considerable algebraic labor we will then find the steady state expressions for the consumer abundance and the two resource concentrations. However, there also exists a graphical approach to determine the location of the steady state, which will be discussed here as it fits in with the graphical and intuitive methods of analysis presented in this chapter. In this graphical analysis the consumer abundance does not play an important role and is not discussed any further. The main aim of the graphical analysis is to determine the location of the resource concentrations \(R_1\) and \(R_2\) in steady state. In other words, where on the ZNGI shown in figure 4.9 the steady state is actually located.

Figure 4.10 shows the same ZNGI as presented in figure 4.9. In addition, Figure 4.10 indicates the supply point, which is the set of concentrations of resource 1 and 2 that can maximally occur
in the habitat. This combination of resource concentrations equals \((S_1, S_2)\). It can only occur in model (4.41) in the absence of consumer, i.e. when \(N_1 = 0\). In case the model represents the growth of a consumer species in a chemostat, the supply point represents the concentrations of resource 1 and 2 in the nutrient stock solution with which the culture chamber is fed.

The graphical approach to locating the steady state of model (4.41) now proceeds by considering the direction in which the current resource state \((R_1, R_2)\) would move through the \((R_1, R_2)\)-phase space due to consumer feeding and due to resource inflow or regeneration. Taking the ratio of the last term in equation (4.41b) and the last term in equation (4.41c) shows that the ratio between the feeding pressure by consumers on resource 1 and 2, respectively, always equals \(Q_{11}/Q_{12}\). In other words, consumer feeding on both resources will force the current resource state \((R_1, R_2)\) into the direction of the vector
\[
\mathbf{Q}_1 := \begin{pmatrix} -Q_{11} \\ -Q_{12} \end{pmatrix}
\] (4.44)
This vector is referred to as the consumption vector of the consumer species. Higher or lower concentrations of resource 1 or 2 and higher or lower densities of consumers would only imply a scaling of the absolute resource consumption rate by consumers, but would not change the relative rate with which resource 1 is consumed in comparison with resource 2. Hence, consumer feeding will always force the current resource state \((R_1, R_2)\) into the direction of the consumption vector.

The direction in which the current resource state \((R_1, R_2)\) will change due to inflow or regeneration can be determined by taking the ratio between the first term in equation (4.41b) and the first term in equation (4.41c). This shows that inflow or regeneration will always force the current resource state \((R_1, R_2)\) into the direction of the supply point \((S_1, S_2)\). This direction is represented by the supply vector:
\[
\begin{pmatrix} S_1 - R_1 \\ S_2 - R_2 \end{pmatrix}
\] (4.45)
(Note that the assumption that the flow rate \(F\) is equal for both resources is crucial to obtain this result). In steady state resource consumption should nullify resource regeneration. Hence, the steady state of model (4.41) can only occur at the unique resource state \((R_1, R_2)\) on the ZNGI, where the supply vector is pointing in exactly the opposite direction as the consumption vector (see Figure 4.10). For all other resource combinations \((R_1, R_2)\) on the ZNGI the two vectors would have slightly different directions and would hence never cancel. The consumer abundance in steady state will be such that the absolute consumption rate equals the absolute supply rate. Hence, if the concentration of resource 1 in steady state is denoted by \(\hat{R}_1\) the steady state consumer abundance \(\hat{N}_1\) is given by:
\[
\hat{N}_1 = \frac{F}{Q_{11}} \frac{S_1 - \hat{R}_1}{D_1}
\] (4.46)

The above analysis shows that an intuitive and graphical consideration of the equations can yield substantial insight into model dynamics, to the extent that it has been possible to graphically locate the steady state in a three dimensional ODE model. Of course, the above analysis does not yield any insight into the stability of the steady state determined. For that aspect of model analysis we will have to use the analytical approach that is the subject of chapter 5.

Such a stability analysis would show that the steady state determined in this section is stable whenever it exists, i.e. whenever the supply point \((S_1, S_2)\) is located within the growth region (the hatched area in Figure 4.9). On the other hand, the one consumer-two resource model is just the preliminary step towards the analysis of a two consumer-two resource model, which has been the central piece of research on which Tilman’s competition theory is founded. This two consumer-two resource model is discussed next.
Two consumers and two resources

The model of the previous section can be straightforwardly extended to include a second consumer species by adding an ODE analogous to equation (4.41a) for the abundance of species 2, \( N_2 \). In addition, the equations describing the dynamics of each resource concentration should be extended with a term that represents the feeding of the second consumer species on both resources. The modeling of these consumption terms will be analogous to the consumption of both resources by species 1. The resulting set of ODEs hence becomes:

\[
\frac{dN_1}{dt} = \left( \mu_1 \min\left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) - D_1 \right) N_1 \tag{4.47a}
\]

\[
\frac{dN_2}{dt} = \left( \mu_2 \min\left( \frac{R_1}{K_{21} + R_1}, \frac{R_2}{K_{22} + R_2} \right) - D_2 \right) N_2 \tag{4.47b}
\]

\[
\frac{dR_1}{dt} = F (S_1 - R_1) - Q_{11} \mu_1 \min\left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) N_1 - Q_{21} \mu_2 \min\left( \frac{R_1}{K_{21} + R_1}, \frac{R_2}{K_{22} + R_2} \right) N_2 \tag{4.47c}
\]

\[
\frac{dR_2}{dt} = F (S_2 - R_2) - Q_{12} \mu_1 \min\left( \frac{R_1}{K_{11} + R_1}, \frac{R_2}{K_{12} + R_2} \right) N_1 - Q_{22} \mu_2 \min\left( \frac{R_1}{K_{21} + R_1}, \frac{R_2}{K_{22} + R_2} \right) N_2 \tag{4.47d}
\]

In these equations the abundance of consumers of species 1 is again represented by \( N_1 \), while the abundance of species 2 consumers is represented by \( N_2 \). As before, \( R_1 \) and \( R_2 \) represent the current concentration of resource 1 and 2, respectively. The parameters \( Q_{21} \) and \( Q_{22} \) indicate the amount of resource 1 and 2, respectively, that is needed to produce a single consumer individual of species 2, while the parameter \( \mu_2 \) represents the maximum per capita growth rate of species 2. The parameters \( K_{21} \) and \( K_{22} \) represent the half-saturation concentration of resource 1 and 2, respectively for consumer species 2, i.e. those concentrations at which the Michaelis-Menten equations \( R_1/(K_{21} + R_1) \) and \( R_2/(K_{22} + R_2) \), respectively, equal 1/2. All other parameters have identical interpretations as in model (4.41) for a single consumer feeding on two resources.

The ODE (4.47b) describing the dynamics of species 2 consumers is fully analogous to the ODE (4.47a) for species 1. Moreover, the consumption terms representing the feeding of species 2 on both resource, given by

\[
Q_{21} \mu_2 \min\left( \frac{R_1}{K_{21} + R_1}, \frac{R_2}{K_{22} + R_2} \right) N_2
\]

and

\[
Q_{22} \mu_2 \min\left( \frac{R_1}{K_{21} + R_1}, \frac{R_2}{K_{22} + R_2} \right) N_2,
\]

respectively, are completely analogous to the corresponding terms modeling the feeding of species 1 on both resources.

Determining the steady state in the 4-dimensional model (4.47) and analyzing its stability is a daunting, analytical task, which goes beyond the purpose of the current discussion. Full details of these computations can be found in [Tilman] (1980). However, as in the previous section a
CHAPTER 4. COMPETING FOR RESOURCES

Figure 4.11: Steady state location in a two consumer-two resource model. *Left:* Stable equilibrium case. The thick solid line indicates the zero net growth isocline (ZNGI) for species 1. The thick, dashed line is the corresponding ZNGI for species 2. The internal steady state is located at the intersection point of these two ZNGIs. $R_{11}$ and $R_{12}$ are the zero growth resource concentration of species 1 for resource 1 and 2, respectively, while $R_{21}$ and $R_{22}$ are the corresponding values for species 2. In the steady state point the two consumption vectors, $Q_1$ for species 1 and $Q_2$ for species 2, are drawn, as well as two separation lines through the steady state point with the same direction as these consumption vectors. For supply points $(S_1, S_2)$ in region I both species will go extinct. For $(S_1, S_2)$ in region II species 1 will outcompete species 2, while for $(S_1, S_2)$ in region VI the opposite occurs. In region III, IV and V the resource supply $(S_1, S_2)$ is sufficiently high for both consumer species to persist in the absence of the other. However, in region III species 1 will outcompete species 2, while in region V the opposite occurs. On for supply points $(S_1, S_2)$ in region IV stable coexistence of both consumer species is possible. *Right:* Unstable equilibrium case. Completely analogous to the stable equilibrium case, except for supply points $(S_1, S_2)$ in region IV stable coexistence of both consumer species is possible.

When considering the zero net growth isoclines (ZNGIs) for both species in the $(R_1, R_2)$-phase plane, it is clear that stable coexistence of both species is only possible if these ZNGIs intersect (see Figure 4.11). If the ZNGI for species 2 would be located completely to the right and above the ZNGI for species 1, the latter would outcompete the former for all possible values of the supply point $(S_1, S_2)$. On the other hand, if the ZNGI for species 1 would be located completely to right and above the ZNGI for species 2, the opposite would occur. This immediately determines the only possible steady state in the two-consumer-two resources model in which both species may coexist (see Fig. 4.11). In addition, this coexistence equilibrium is only feasible if the supply point $(S_1, S_2)$ is to the right and above the ZNGI of both species, i.e. if $(S_1, S_2)$ in region III, IV or V in Fig. 4.11. For supply points $(S_1, S_2)$ in region I, the maximum concentrations of both resources are insufficient for both consumers to persist. For supply points $(S_1, S_2)$ in region II the maximum concentrations of both resources are sufficient for consumer species 1,
4.2. INTERSPECIFIC COMPETITION

but insufficient for species 2 to persist. For supply points \((S_1, S_2)\) in region VI, the opposite is true (species 2 can persist, species 1 not).

If the two consumer species would coexist in a stable equilibrium, their combined consumption simply equals the sum of their individual consumptions. Hence, in a coexistence equilibrium the consumption vector for both consumer species together is a linear combination of their individual consumption vectors, where each individual consumption vector may be multiplied by a strictly positive constant. This implies that the combined consumption vector has a direction that is bounded by both individual consumption vectors \(Q_1\) and \(Q_2\) (see Fig. 4.11). Since consumption must cancel resource regeneration in steady state, it follows that only resource supply points \((S_1, S_2)\) in region IV may lead to coexistence of both consumers. Only for points in this region the supply vector \(\left(\frac{S_1 - \hat{R}_1}{S_2 - \hat{R}_2}\right)\) in the steady state \((\hat{R}_1, \hat{R}_2)\) can be compensated by a combined consumption vector that is within the region bounded by the individual consumption vectors \(Q_1\) and \(Q_2\) and that hence constitutes a linear combination of these two vectors. For supply points \((S_1, S_2)\) in region III or V the supply vector \(\left(\frac{S_1 - \hat{R}_1}{S_2 - \hat{R}_2}\right)\) can never be compensated by a consumption vector that is a linear, strictly positive combination (i.e. with positive coefficients) of \(Q_1\) and \(Q_2\) (see Fig. 4.11). For supply points \((S_1, S_2)\) in region III, species 1 will outcompete species 2. Note that for supply points in this region a steady state with only consumer species 2 present would always be located at the vertical part of the ZNGI for this species (remember how the one-consumer-two-resources steady state was located in section 4.2.2). This vertical part is, however, located in the growth region of species 1. Species 1 would hence be able to invade such an equilibrium and subsequently outcompete species 2. An analogous argumentation holds for a species 1-only steady state and supply points \((S_1, S_2)\) in region V. A species 1-only steady state would be located at the horizontal part of its ZNGI which is within the growth region of species 2. For \((S_1, S_2)\) in this region species 2 therefore always outcompetes species 1.

Even if an equilibrium with two coexisting consumer species is feasible, it is not necessarily a stable equilibrium. Determining the stability of the two-consumer equilibrium shown in Figure 4.11 can only be achieved by means of a far from trivial analysis. Tilman (1980) has carried out this local stability analysis for the coexistence equilibrium and has derived a set of necessary conditions for it to be stable. For a two-consumer-two resource equilibrium to be locally stable, it is necessary that the following conditions hold:

- For two consumers to stably coexist on two resources, each consumer species must, relative to the other, consume proportionally more of the one resource which more limits its own growth rate.

- The amounts of each resource consumed by individuals of each species may change only slightly in response to small changes in the availability of each resource.

The first of these conditions is graphically represented in the two panels in Figure 4.11. The left panel of this figure represents a stable two-species equilibrium, while the right panel represents an unstable equilibrium. For supply points \((S_1, S_2)\) in region IV’ (right panel, Fig. 4.11) the coexistence equilibrium is unstable and species 1 will either outcompete species 2 or species 2 will outcompete species 1. The precise outcome is dependent on the initial abundances of both consumers and both resources. Hence, both single-species steady states are stable, while the coexistence equilibrium is a saddle point. From Figure 4.11 it is possible to understand that the arrangement of the two consumption vectors \(Q_1\) and \(Q_2\) which is shown in the left panel of the figure implies that coexistence of both species will occur. For supply points in region IV, a species 2-only equilibrium is unstable, because it would be located at the (vertical) part of the ZNGI which is inside the growth region of species 1 (remember how the one-consumer-two-resources steady state was located in section 4.2.2). Similarly, a species 1-only equilibrium is
unstable, because it would be located at the (horizontal) part of the ZNGI which is inside the growth region of species 2. Because both single-species steady states are unstable, it follows that coexistence is at least ensured. Moreover, consider the system to be in steady state. If the abundance of species 2, $N_2$, would be slightly increased, it would lead to a stronger decline in resource 1 if the consumption vectors $Q_1$ and $Q_2$ are ordered as in the left panel of Figure 4.11. Resource 1 is in this case the resource for which species 2 is the worst competitor, meaning that the increase of species 2 lead to conditions that favor species 1. Hence, the latter species can regain the balance which was perturbed with the increase in species 2. On the other hand, with the arrangement of consumption vectors $Q_1$ and $Q_2$ as in the right panel of Figure 4.11 a similar increase in species 2 would lead to conditions that favor itself, causing an even further deviation from the steady state. Even though this argumentation is by no means a full proof of the stability of the steady state, the first condition for stability listed above is intuitively understandable. In contrast, the second condition for stability of the coexistence equilibrium follows from the mathematical analysis, but can not be motivated otherwise. It is hence less intuitive.

The theory discussed above has been largely developed by Tilman (1980, see also Tilman 1981, 1982). Most importantly, he has tested the predictions of the theory with an extensive set of experiments with different diatom species competing for phosphate (PO$_4$) and silicate (SiO$_2$). For diatoms both nutrients are essential as they need silicate to build their hard outer wall and phosphate for photosynthesis. Figure 4.12 summarizes the results for competition experiments between Asterionella formosa and Cyclotella meneghiniana. For these two species coexistence is possible, but only for particular values of the resource supply ($S_1, S_2$). The observed outcomes of the experiments match the theoretical predictions remarkably well (see Figure 4.12 and its legend for further details).

In addition, Figure 4.13 to 4.20 show further experimental results for the competition between four different diatom species (Fragilaria crotonensis, Asterionella formosa, Synedra filiformis and Tabellaria flocculosa), competing for phosphate and silicate. Figure 4.13 and 4.14 show the results of single species growth experiments that are used to estimate the model parameters for all 4 species. The estimates for these parameters are presented in Table 4.3. The Figures 4.15 to 4.20 show the results of all 6 pairwise competition experiments that are possible between these 4 diatom species.

On the basis of the estimated parameters, it was predicted that Tabellaria flocculosa would never be able to coexist with any of the other species. Moreover, this species can never outcompete any of the other species. The results in Figure 4.16, 4.19 and 4.20 rigorously confirm these predictions. In many of the presented cases even the observed dynamics of the two competing species is accurately predicted by the model (see the figures).

The two species Asterionella formosa and Fragilaria crotonensis turned out to have virtually identical $R^*$-values for silicate (see Table 4.3) and in addition have $R^*$-values for phosphate that differ only insignificantly from each other. Hence, the prediction is that either both species should be able to coexist for all possible values of the resource supply or Asterionella should win the competition on the basis of its slightly lower $R^*$-value for phosphate. Figure 4.17 that both species coexist for all supply conditions that have been examined.

Since the characteristics of Asterionella formosa and Fragilaria crotonensis are so similar, the predictions regarding the competition of each of these two species with Synedra filiformis are virtually identical (see Figure 4.15 and 4.18). Synedra has the lowest $R^*$-value for phosphate of all 4 diatom species and hence is predicted to outcompete all other species if the supply rate of phosphate is low. On the other hand, in comparison with Asterionella and Fragilaria Synedra has a high $R^*$-value for silicate, which leads to the prediction that Asterionella and Fragilaria will outcompete Synedra under low silicate supplies. In addition, there is a large region
of resource supply values for silicate and phosphate that are predicted to lead to coexistence between *Asterionella* and *Synedra* and between *Fragilaria* and *Synedra*. Figure 4.15 and 4.18 confirm the theoretical predictions remarkably well and once more show that even the observed dynamics in the experiments is reasonable well matched by the predictions of the model. The combination of the convincing experimental test results and the logic behind the theory on resource competition provide a strong basis to the insights that have been revealed by studying the models in the last sections.

In addition to the experimental results discussed above Tilman (1980) has extended the theory even further to include also substitutable and partly substitutable resources. For partly substitutable resources the ZNGIs will not consist of two perpendicular line segments any longer but will have a more continuous shape. As shown in Figure 4.21 this generically leads to 4 possible arrangements of the ZNGIs that strongly resemble the 4 cases of competitive outcome predicted by the Lotka-Volterra competition equations (compare Figure 4.21 with Figure 4.7). More generally, even with the perpendicular shape of the ZNGIs for essential resources, exactly 4 different arrangements of the ZNGIs are feasible and these are completely analogous to the 4 different cases of competitive outcome predicted by the Lotka-Volterra model for interspecific competition, which does not explicitly account for resources.
Figure 4.12: Predicted and observed outcomes of competition for phosphate and silicate by Asterionella formosa and Cyclotella meneghiniana. The mortality (flow) equals 0.25 day$^{-1}$. The two-species equilibrium point occurs at 1.9 μM SiO$_2$ and 0.2 μM PO$_4$. The consumption vectors (from Tilman 1977) have a slope (Si/P) of 87 for Asterionella and 6.2 for Cyclotella. For resource supply points in the region labeled 3, Asterionella should be dominant. For resource supply points in region 4, both species should coexist. Cyclotella should be dominant in region 5. Experiments (Tilman 1977) for which Asterionella was dominant are shown with an asterisk; those for which Cyclotella was dominant are shown with a diamond, and those for which both species coexisted are shown with a dot. A supply point off the graph (9.8 μM PO$_4$, 15 μM SiO$_2$) was dominated by Cyclotella, as predicted. For this analysis, the observed maximal growth rates, reported in Tilman & Kilham (1976), were used even though the maximal rates under PO$_4$ and SiO$_2$ limitation for each species differed. The boundaries shown differ slightly from those of Tilman (1977) because of this difference in maximal rates. (Figure 10 with legend from Tilman (1980))
4.2. INTERSPECIFIC COMPETITION

Figure 4.13: Single-species Monod growth experiments for four diatoms under conditions of limited silicate. Curves were fitted using a nonlinear regression. (Figure 2 with legend from Tilman (1981))

Figure 4.14: Single-species Monod growth experiments for four diatoms under conditions of limited phosphate. Curves were fitted using a nonlinear regression. (Figure 3 with legend from Tilman (1981))
Table 4.3: Silicate and phosphate parameters for four Lake Michigan diatoms. $K$ is the half saturation constant; $r$ the maximal growth rate; $Q$ the quotient; and $R^*$ the calculated amount of nutrients required to grow at $D = 0.25$ d$^{-1}$. The 95% confidence intervals are in parentheses. (Table 1 with legend from [Tilman (1981)])

<table>
<thead>
<tr>
<th>Species</th>
<th>$r$ (d$^{-1}$)</th>
<th>$K$ (μmol/L)</th>
<th>$Q$ (μmol/cell)</th>
<th>$R^*$ (μmol/L)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Silicate limited experiments</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Fragilaria</em></td>
<td>0.62</td>
<td>1.5</td>
<td>$9.7 \times 10^{-7}$</td>
<td>1.0</td>
</tr>
<tr>
<td></td>
<td>(.54-.70)</td>
<td>(.7-.2.5)</td>
<td></td>
<td>(.7-.1.5)</td>
</tr>
<tr>
<td><em>Asterionella</em></td>
<td>0.78</td>
<td>2.2</td>
<td>$1.5 \times 10^{-6}$</td>
<td>1.0</td>
</tr>
<tr>
<td></td>
<td>(.72-.84)</td>
<td>(1.6-2.9)</td>
<td></td>
<td>(.8-.1.3)</td>
</tr>
<tr>
<td><em>Synedra</em></td>
<td>1.11</td>
<td>19.7</td>
<td>$5.8 \times 10^{-6}$</td>
<td>5.7</td>
</tr>
<tr>
<td></td>
<td>(.87-.36)</td>
<td>(12.7-30.3)</td>
<td></td>
<td>(4.0-.8.3)</td>
</tr>
<tr>
<td><em>Tabellaria</em></td>
<td>0.74</td>
<td>19.0</td>
<td>$6.3 \times 10^{-6}$</td>
<td>9.7</td>
</tr>
<tr>
<td></td>
<td>(.44-.04)</td>
<td>(9.0-41.7)</td>
<td></td>
<td>(5.3-23.0)</td>
</tr>
<tr>
<td><strong>Phosphate limited experiments</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Fragilaria</em></td>
<td>0.80</td>
<td>0.011</td>
<td>$4.7 \times 10^{-8}$</td>
<td>0.005</td>
</tr>
<tr>
<td></td>
<td>(.72-.88)</td>
<td>(0-.024)</td>
<td></td>
<td>(.002-.008)</td>
</tr>
<tr>
<td><em>Asterionella</em></td>
<td>0.59</td>
<td>0.006</td>
<td>$2.6 \times 10^{-8}$</td>
<td>0.004</td>
</tr>
<tr>
<td></td>
<td>(.53-.64)</td>
<td>(.002-.011)</td>
<td></td>
<td>(.003-.007)</td>
</tr>
<tr>
<td><em>Synedra</em></td>
<td>0.65</td>
<td>0.003</td>
<td>$1.1 \times 10^{-7}$</td>
<td>0.002</td>
</tr>
<tr>
<td></td>
<td>(.61-.69)</td>
<td>(0-.015)</td>
<td></td>
<td>(.001-.006)</td>
</tr>
<tr>
<td><em>Tabellaria</em></td>
<td>0.36</td>
<td>0.008</td>
<td>$1.9 \times 10^{-7}$</td>
<td>0.02</td>
</tr>
<tr>
<td></td>
<td>(.30-.33)</td>
<td>(0-.04)</td>
<td></td>
<td>(.006-.07)</td>
</tr>
</tbody>
</table>
4.2. INTERSPECIFIC COMPETITION

Figure 4.15: Predicted and observed outcomes of competition between *Asterionella formosa* and *Synedra filiformis*. (A): predicted outcomes of resource competition between *Asterionella* (Af) and *Synedra* (Sf). (B) Observed results of competition experiments for Case 1 (low silicate) are shown with stars for Af and dots for Sf. The continuous thick line, labeled Af, and the continuous thin line, labeled Sf, show the predicted population dynamics. (C) As (B), but for Case 2 (intermediate concentrations of silicate and phosphate). (D) As (B), but for Case 3 (low phosphate concentrations). (Figure 4 with legend from Tilman (1981)).

Figure 4.16: Predicted and observed outcomes of competition between *Asterionella formosa* and *Tabellaria flocculosa*. Af, stars, thick lines: *Asterionella*; Tf, squares, thin lines: *Tabellaria*, using the notation of Fig. 4.15 (Figure 5 with legend from Tilman (1981)).
Figure 4.17: Predicted and observed outcomes of competition between Asterionella formosa and Fragilaria crotonensis. Af, stars, thick lines: Asterionella; Fc, triangles, thin lines: Fragilaria, using the notation of Fig. 4.15 (Figure 6 with legend from Tilman [1981]).

Figure 4.18: Predicted and observed outcomes of competition between Synedra and Fragilaria. Sf, dots, thick lines: Synedra; Fc, triangles, thin lines: Fragilaria, using the notation of Fig. 4.15 (Figure 7 with legend from Tilman [1981]).
4.2. INTERSPECIFIC COMPETITION

Figure 4.19: Predicted and observed outcomes of competition between *Synedra* and *Tabellaria*. Sf, dots, thick lines: *Synedra*; Tf, squares, thin lines: *Tabellaria*, using the notation of Fig. 4.15 (Figure 8 with legend from Tilman [1981]).

Figure 4.20: Predicted and observed outcomes of competition between *Fragilaria* and *Tabellaria*. Fc, triangles, thick lines: *Fragilaria*; Tf, squares, thin lines: *Tabellaria*, using the notation of Fig. 4.15 (Figure 9 with legend from Tilman [1981]).
Figure 4.21: The four cases of resource competition in a two consumer-two resource model. These four cases are directly analogous to the four cases of the Lotka-Volterra competition equations. The outcomes of competition are labeled consistently in all four parts of this figure: 1 = neither species able to survive for resource supply points in this region; 2 = only species A able to survive; 3 = species A competitively displaces species B; 4 = stable coexistence of both species; 5 = species B competitively displaces species A; 6 = only species B able to survive. Case 1: Because the ZNGI (zero net growth isocline) of species A is inside that of species B, species A will always competitively displace species B. Case 2: Because the ZNGI of species B is always inside that of species A, species B will always win in competition with species A. Case 3: This equilibrium point is locally stable. Any resource supply point in region 4 will lead to both species stably coexisting at the resource equilibrium point. Case 4: This two-species resource equilibrium point is locally unstable. Any resource supply point in the region labeled “3 or 5” will eventually result in the competitive exclusion of either species A or B. The outcome of competition in this region depends on the starting conditions. (Figure 6 with legend from Tilman [1980])
Chapter 5

Systems of ordinary differential equations

In section 4.1.4 (see the discussion following equation (4.24)) it was already stated that graphical methods of analysis in general are not sufficient to determine the stability of steady states in models that are phrased in terms of 2 or more systems of ODEs. Chapter 4 discussed several models of 2 ODEs that are exceptions, such as the bacterial chemostat model and the Lotka-Volterra competition model, but in general graphical methods do not suffice. In this chapter I will first focus on the linearization of the dynamics in the neighborhood of steady states, much along the lines as followed in section 3.4. Subsequently, I will discuss how the linearized approximation to the model dynamics in the neighborhood of a steady state can be solved explicitly and what this implies for the stability of the steady state. These results allow a complete classification of the types of dynamics that may be observed in models that are formulated in terms of a system of 2 ODEs. Such systems are also referred to as planar ODE systems, as their state space constitutes a plane spanned by two axes. The approach in this chapter will be more formal and rigorous than in the previous chapter. Indeed, it will be a purely analytical approach. Finally, in section 5.6 I will discuss how the theory generalizes to models in terms of 3 or more ODEs. Because this entire chapter deals with theory that is based on the linearized approximation to the dynamics in the neighborhood of steady states, the theory derived from it is referred to as linear stability theory. Before proceeding, it should be stressed once more that the analysis in this chapter are mostly valid only in the very close vicinity of steady states and hence only provide information about the local stability of the steady state. This means that the analysis can only reveal what will happen after an infinitesimally small displacement of the system away from its steady state. Only in specific cases this local analysis will also give insight in the global behavior of the model, i.e. the model dynamics far away from the steady state.

5.1 Computation of steady states

In section 4.1.4 it was explained that a system of 2 ODEs could also be represented in vector notation (see equation (4.19)). I will use here two arbitrary symbols, \( y(t) \) and \( z(t) \), respectively, to indicate the state variables in the model. Moreover, I will assume that the dynamics are described by the following system of ODEs:
the precise form of the functions $F(y, z)$ and $G(y, z)$ I will not specify any further. I will only assume that these functions are continuous and that their derivatives with respect to both $y$ and $z$ exist to ensure that the set of ODEs actually specifies a unique solution for an particular initial conditions $y(0)$ and $z(0)$ (see also section 5.6).

The system of ODEs (5.1) can be written in vector form by defining a vector $x$:

$$x := \begin{pmatrix} y \\ z \end{pmatrix} \quad (5.2)$$

and a vector valued function $H(x)$:

$$H(x) := \begin{pmatrix} F(y, z) \\ G(y, z) \end{pmatrix} \quad (5.3)$$

as:

$$\frac{dx}{dt} = H(x) \quad (5.4)$$

This latter equation is simply a shorter and more abstract way of writing the system of ODEs which describes the model dynamics. Rewriting the ODEs (5.1) into the form (5.4) is hence only a matter of definitions and notation. The advantage of the rewriting is that it allows an immediate extension to systems of more than 2 ODEs, as equation (5.4) could as well describe the dynamics of a model with 3 or more variables (see section 5.6).

Steady states of the model, specified by equation (5.4), are always characterized by the fact that the value of the state variables do not change over time. Hence, all steady states are determined by the equality:

$$H(x) = 0 \quad (5.5)$$

Notice that in our case of a model in terms of 2 ODEs this equation represents actually two equations ($H$ was a vector function!). Because population dynamic models usually incorporate non-linear relations between state variables, this system of equations is in general non-linear as well and hence hard to solve explicitly. Numerically, it is often possible, though, to calculate the value of a steady state for a particular set of parameters. Let’s assume that a particular steady state of the model (5.4) is indicated by $\tilde{x}$, such that

$$H(\tilde{x}) = 0 \quad (5.6)$$

### 5.2 Linearization of dynamics

How do we describe the dynamics in the neighborhood of the steady state? In section 3.4 this was achieved by studying the fate of a small perturbation or displacement away from the steady state with the help of the linearized dynamics around the steady state. The linearized dynamics was obtained by replacing the right-hand side function with its Taylor expansion around the steady state. For systems of 2 ODEs we follow exactly the same procedure. Let’s define a small perturbation away from the steady state:

$$\Delta x(t) := x(t) - \tilde{x} \quad (5.7)$$
5.2. LINEARIZATION OF DYNAMICS

Notice that $\Delta_x(t)$ again is a 2-dimensional vector which could also be defined as:

$$
\Delta_x(t) := \left( \begin{array}{c} \Delta_y(t) \\ \Delta_z(t) \end{array} \right) = \left( \begin{array}{c} y(t) - \tilde{y} \\ z(t) - \tilde{z} \end{array} \right) = \left( \begin{array}{c} y(t) \\ z(t) \end{array} \right) - \left( \begin{array}{c} \tilde{y} \\ \tilde{z} \end{array} \right)
$$

In this equation I have used $\tilde{y}$ and $\tilde{z}$ to denote the steady state values of the state variables in the model. Following the same procedure as with single ODEs, the dynamics of the displacement vector $\Delta_x(t)$ can be described by:

$$
\frac{d \Delta_x(t)}{dt} = \frac{d(x(t) - \bar{x})}{dt} = \frac{dx(t)}{dt} - \frac{d\bar{x}}{dt} = \frac{dx(t)}{dt}
$$ (5.8)

(cf. equation (3.14)). Using the model equation (5.4) this equality can be rewritten as:

$$
\frac{d \Delta_x(t)}{dt} = H(x) = H(\bar{x} + \Delta_x)
$$ (5.9)

This latter ODE describes the dynamics in the neighborhood of the steady state exactly. Therefore, the ODE is just as (un)solvable as the ODE (5.4) we started out with.

Analogous to the procedure for single ODEs, in which the dynamics in the neighborhood of a steady state was approximated by the Taylor expansion of the function $f(N)$ around $N^*$ (see equation (3.13), we replace the function $H(x)$ by its Taylor expansion around $\bar{x}$, as follows:

$$
H(x) = H(\bar{x}) + H'(\bar{x}) \Delta_x + H''(\bar{x}) \Delta_x^2 + O(\Delta_x^3)
$$ (5.10)

Approximation to first order is achieved by dropping all terms in $\Delta_x$ with a power of 2 or higher (cf. equation (3.15)):

$$
H(x) \approx H(\bar{x}) + H'(\bar{x}) \Delta_x
$$ (5.11)

Substitution of this equality into the ODE (5.9) and noting that the equilibrium condition (5.6) implies that the first term on the right-hand side vanishes, leads to the following ODE describing the approximate dynamics of $\Delta_x$:

$$
\frac{d \Delta_x(t)}{dt} = H'(\bar{x}) \Delta_x(t)
$$ (5.12)

In this derivation we have followed the exact same steps as were taken for the analysis of single ODEs. Although this is formally correct, $H(x)$ is a vector-valued function and its derivative $H'(\bar{x})$ is not a mere number like the derivative $f'(N^*)$ in equation (3.15). For a function of two variables, such as $F(y, z)$, one of the elements of $H(x)$, the Taylor expansion in the neighborhood of a particular steady state $(\tilde{y}, \tilde{z})$ is defined as (cf. equation (3.13)):

$$
F(y, z) = F(\tilde{y}, \tilde{z}) + \frac{\partial F}{\partial y} \bigg|_{y=\tilde{y}, z=\tilde{z}} \Delta_y + \frac{\partial F}{\partial z} \bigg|_{y=\tilde{y}, z=\tilde{z}} \Delta_z +
$$

$$
\frac{1}{2} \frac{\partial^2 F}{\partial y^2} \bigg|_{y=\tilde{y}, z=\tilde{z}} \Delta_y^2 + \frac{\partial^2 F}{\partial y \partial z} \bigg|_{y=\tilde{y}, z=\tilde{z}} \Delta_y \Delta_z + \frac{1}{2} \frac{\partial^2 F}{\partial z^2} \bigg|_{y=\tilde{y}, z=\tilde{z}} \Delta_z^2 + O(\Delta^3)
$$

The last term $O(\Delta^3)$ represents all higher order terms in the expansion, i.e. all those which at least include a term $\Delta_y^3$, $\Delta_y^2 \Delta_z$, $\Delta_y \Delta_z^2$ or $\Delta_z^3$. The above expression is the generalization of
the Taylor expansion given in equation (5.13) to functions with two arguments. Dropping all terms of order 2 and higher yields the following expression for the first order Taylor expansion of $F(y, z)$ in the neighborhood of a steady state $(\bar{y}, \bar{z})$:

$$F(y, z) \approx F(\bar{y}, \bar{z}) + \frac{\partial F}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}} \Delta y + \frac{\partial F}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}} \Delta z$$

(5.13)

Similarly, the function $G(y, z)$ can in the neighborhood of the steady state $(\bar{y}, \bar{z})$, be approximated by:

$$G(y, z) \approx G(\bar{y}, \bar{z}) + \frac{\partial G}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}} \Delta y + \frac{\partial G}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}} \Delta z$$

(5.14)

In vector notation the last two equations can be written as:

$$\begin{pmatrix} F(y, z) \\ G(y, z) \end{pmatrix} \approx \begin{pmatrix} F(\bar{y}, \bar{z}) \\ G(\bar{y}, \bar{z}) \end{pmatrix} + \begin{pmatrix} \frac{\partial F}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}} & \frac{\partial F}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}} \\ \frac{\partial G}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}} & \frac{\partial G}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}} \end{pmatrix} \begin{pmatrix} \Delta y \\ \Delta z \end{pmatrix}$$

(5.15)

Comparing the last equation with equation (5.11) it is easy to see that the derivative $H'(\bar{x})$ has to be interpreted as the matrix of partial derivatives, evaluated at the steady state:

$$H'(\bar{x}) = \begin{pmatrix} \frac{\partial F}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}} & \frac{\partial F}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}} \\ \frac{\partial G}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}} & \frac{\partial G}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}} \end{pmatrix}$$

(5.16)

We will denote this matrix of partial derivatives with the symbol $A$ and its elements with $a_{11}$, $a_{12}$, $a_{21}$ and $a_{22}$, respectively:

$$A = \begin{pmatrix} a_{11} & a_{12} \\ a_{21} & a_{22} \end{pmatrix}$$

(5.17)

The elements $a_{11}$, $a_{12}$, $a_{21}$ and $a_{22}$ are hence defined as:

$$a_{11} = \frac{\partial F}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}}$$

(5.18a)

$$a_{12} = \frac{\partial F}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}}$$

(5.18b)

$$a_{21} = \frac{\partial G}{\partial y} \bigg|_{y=\bar{y}, z=\bar{z}}$$

(5.18c)

$$a_{22} = \frac{\partial G}{\partial z} \bigg|_{y=\bar{y}, z=\bar{z}}$$

(5.18d)
5.3. *CHARACTERISTIC EQUATION, EIGENVALUES AND EIGENVECTORS*

The matrix of partial derivatives $A$ is referred to as the *Jacobian* matrix (or in short Jacobian) of the function $H(x)$, evaluated at the steady state $\tilde{x}$. The Jacobian plays an important role in the stability analysis of the steady state.

In general, the dynamics of a tiny deviation $\Delta x$ from a steady state $\tilde{x}$ is thus described by the ODE:

$$\frac{d\Delta x}{dt} = A \Delta x$$  \hspace{1cm} (5.19)

Since the Jacobian matrix $A$ is evaluated at the steady state $\tilde{x}$ and thus constant, this ODE is linear in the perturbation $\Delta x$. It approximates the dynamics of the model in the neighborhood of the steady state by its *linearized* dynamics.

### 5.3 Characteristic equation, eigenvalues and eigenvectors

Having obtained a system of 2 linear ODEs describing the dynamics of small displacements $\Delta y(t)$ and $\Delta z(t)$, respectively, from the steady state $(\tilde{y}, \tilde{z})$, we analyse in this section whether these displacements will ultimately grow or shrink in magnitude. If they shrink, the state of the system will ultimately return to the steady state value after a small perturbation. The steady state is in this case locally stable. On the other hand, if small perturbations to the state of the system in the close neighborhood of the steady state grow over time, the steady state is unstable.

In section 3.4 we have already discovered that linear ODEs yield solutions of exponential form. For this reason, we analyze what results from substitution of an exponential *trial solution*

$$v e^{\lambda t}$$  \hspace{1cm} (5.20)

into the linearized ODE (5.19) (cf. the derivation in equations (3.23)-(3.26)). In the above equation $v$ refers to the initial perturbation $(\Delta y(0), \Delta z(0))$ to the state of the system at $t = 0$. Since this initial perturbation does not depend on the time variable, the substitution of the trial solution into the ODE (5.19) yields:

$$\frac{d v e^{\lambda t}}{dt} = A v e^{\lambda t} \Rightarrow$$

$$\lambda v e^{\lambda t} = A v e^{\lambda t}$$  \hspace{1cm} (5.22)

Dividing by the common factor $\exp(\lambda t)$ yields the equation

$$A v = \lambda v$$  \hspace{1cm} (5.23)

It should be noted that the quantity $v$ cannot be canceled, like the common factor $\exp(\lambda t)$, since it represents a vector and accordingly $Av$ represents a matrix multiplication. However, equation (5.23) can be rewritten as

$$(A - \lambda I) v = 0$$  \hspace{1cm} (5.24)

in which the $I$ represents the identity or unit matrix.
Equation (5.24) is trivially satisfied when \( v = 0 \) (here, 0 refers to the null-vector \((0,0)\)). However, we are concerned with studying the fate of a perturbation away from the steady state of the system and hence we exclude this trivial case of a zero displacement. For non-trivial perturbations \( v \), readers that are familiar with linear algebra will recognize that equation (5.24) can only be satisfied if

\[
\det(A - \lambda I) = 0 \tag{5.25}
\]

By substituting the expressions for the matrices \( A \) and \( I \) into the above equation, this equation can be rewritten as:

\[
\det\begin{pmatrix} a_{11} - \lambda & a_{12} \\ a_{21} & a_{22} - \lambda \end{pmatrix} = 0 \tag{5.26}
\]

and after computation of the determinant as

\[(a_{11} - \lambda) (a_{22} - \lambda) - a_{12} a_{21} = 0 \tag{5.27}\]

The latter equation can be rearranged to a quadratic polynomial in terms of the unknown quantity \( \lambda \):

\[\lambda^2 - (a_{11} + a_{22}) \lambda + (a_{11} a_{22} - a_{12} a_{21}) = 0 \tag{5.28}\]

Readers that are not familiar with linear algebra may check that equation (5.24) corresponds to the following system of equations:

\[
\begin{align*}
(a_{11} - \lambda) \Delta_y(0) + a_{12} \Delta_z(0) &= 0 \tag{5.29a} \\
a_{21} \Delta_y(0) + (a_{22} - \lambda) \Delta_z(0) &= 0 \tag{5.29b}
\end{align*}
\]

From these two equations the quantity \( \Delta_z(0) \) can be eliminated by multiplying the first and second equation with \((a_{22} - \lambda)\) and \(-a_{12}\), respectively, and adding the results of these two operations. This leads to the following equation for \( \Delta_y(0) \):

\[(a_{11} - \lambda) (a_{22} - \lambda) - a_{12} a_{21} \Delta_y(0) = 0 \tag{5.30}\]

Since we have excluded the case of a zero initial perturbation, it is easily seen that this last equation is identical to equation (5.27), which was derived above.

Equation (5.25) represents the characteristic equation of the model (cf. equation (3.26)). The characteristic equation determines the eigenvalues \( \lambda \). Given that the characteristic equation (5.25) can be rewritten as a quadratic polynomial (cf. equation (5.28)), it is clear that there are two eigenvalues \( \lambda \). These two eigenvalues we will denote by \( \lambda_1 \) and \( \lambda_2 \), respectively, or by
5.3. CHARACTERISTIC EQUATION, EIGENVALUES AND EIGENVECTORS

λᵢ if the discussion applies to both of them. Generically, λ₁ and λ₂ have different values. If for particular choices of the model parameters they are identical, we will still consider them as two distinct entities, which only happen to coincide.

As was discussed at the end of section 3.4 eigenvalues can be interpreted as characteristic growth rates. Their interpretation in the context of the 2-dimensional model is more difficult than in the case of a single ODE. In the latter, the perturbation away from the steady state is just a scalar quantity, for which the eigenvalue λ determined the rate of growth. In case of a 2-dimensional model, the eigenvalues λ₁ and λ₂ are not just the growth rate in the scalar quantities Δy(t) and Δz(t), respectively, but are both associated with a particular vector v, which is called the corresponding eigenvector. The eigenvector v determines a direction in the phase space spanned by the two variables y and z. The eigenvalues λ₁ and λ₂ represent the characteristic growth rate in the direction of their corresponding eigenvector, which we shall denote by

$$v_1 = \begin{pmatrix} v_{11} \\ v_{12} \end{pmatrix} \quad \text{and} \quad v_2 = \begin{pmatrix} v_{21} \\ v_{22} \end{pmatrix},$$

respectively (see also section 5.4). The eigenvector $v_i$ associated with a particular eigenvalue $\lambda_i$ can be computed from the vector equation (5.24) (or equivalently the corresponding system of equations (5.29)). Inspection of this equation shows that we can multiply both sides of the equation with a constant without invalidating it. In other words, the equation does determine the direction of the eigenvector, but it does not determine its length or absolute magnitude. We are hence free to choose one of the elements of the vector $v_i$ equal to 1. For example, if the value of $a_{12} \neq 0$ and the value of $v_{i1}$ is set to 1, we can solve equation (5.29a) for the other element $v_{i2}$ of the eigenvector $v_i$. Therefore, in the case of a 2-dimensional model the eigenvector $v_i$ corresponding to a particular eigenvalue $\lambda_i$ equals

$$v_i = \begin{pmatrix} 1 \\ \frac{\lambda_i - a_{11}}{a_{12}} \end{pmatrix}$$

(5.31)

if $a_{12} \neq 0$. In case $a_{12} = 0$ and $a_{21} \neq 0$ the eigenvector $v_i$ is given by

$$v_i = \begin{pmatrix} \lambda_i - a_{22} \\ \frac{a_{21}}{1} \end{pmatrix}$$

(5.32)

which can be derived from equation (5.29b) by substitution of $v_{i2} = 1$.

Once the eigenvalues $\lambda_1$ and $\lambda_2$ and the corresponding eigenvectors $v_1$ and $v_2$ are found, we can write down a general solution for the linearized dynamics of the perturbation $(\Delta y(t), \Delta z(t))$ in the neighborhood of the steady state $(\tilde{y}, \tilde{z})$. Provided that $\lambda_1 \neq \lambda_2$, any initial perturbation $(\Delta y(0), \Delta z(0))$ can be expressed as a linear combination of the two eigenvectors $v_1$ and $v_2$, say by

$$\Delta x(0) = \begin{pmatrix} \Delta y(0) \\ \Delta z(0) \end{pmatrix} = C_1 v_1 + C_2 v_2$$

(5.33)

In this equation $C_1$ and $C_2$ are constants that are unique for a specific initial perturbation $(\Delta y(0), \Delta z(0))$. From this decomposition it follows that the perturbation $(\Delta y(t), \Delta z(t))$ at time $t$ is given by

$$\Delta x(t) = \begin{pmatrix} \Delta y(t) \\ \Delta z(t) \end{pmatrix} = C_1 v_1 e^{\lambda_1 t} + C_2 v_2 e^{\lambda_2 t}$$

(5.34)
which is a shorthand version of the following:

\[ \Delta y(t) = C_1 v_{11} e^{\lambda_1 t} + C_2 v_{21} e^{\lambda_2 t} \] (5.35a)

\[ \Delta z(t) = C_1 v_{12} e^{\lambda_1 t} + C_2 v_{22} e^{\lambda_2 t} \] (5.35b)

Equation (5.34) and (5.35) follow from the so-called superposition principle, which holds for linear ODEs. This principle states that if two arbitrary functions \( k(t) \) and \( l(t) \) are both solutions of a particular, linear ODE, any linear combination \( p k(t) + q l(t) \) with \( p \) and \( q \) arbitrary constants constitutes a solution of the ODE as well. Assume that the ODE can be written as

\[ \frac{dN}{dt} = \alpha N \]

Since both \( k(t) \) and \( l(t) \) represent solutions, it follows that

\[ \frac{dk(t)}{dt} = \alpha k(t) \quad \text{and} \quad \frac{dl(t)}{dt} = \alpha l(t). \]

For an arbitrary linear combination \( h(t) = p k(t) + q l(t) \), we can derive

\[ \frac{dh(t)}{dt} = \frac{d(p k(t) + q l(t))}{dt} = p \frac{dk(t)}{dt} + q \frac{dl(t)}{dt} \]

Given that both \( k(t) \) and \( l(t) \) represent solutions, the right-hand side of this equation can be written as

\[ p \alpha k(t) + q \alpha l(t) = \alpha (p k(t) + q l(t)) = \alpha h(t) \]

which shows that also the linear combination \( h(t) = p k(t) + q l(t) \) is a solution of the ODE. What follows from the superposition principle is that if a particular initial condition \( \Delta x(0) \) can be written as a linear combination \( C_1 v_1 + C_2 v_2 \) of two quantities \( v_1 \) and \( v_2 \) and we know the solutions of the ODEs that have \( v_1 \) and \( v_2 \) as initial condition, the solution \( \Delta x(t) \) can be expressed as the linear combination of these particular solutions for \( v_1 \) and \( v_2 \). Equation (5.34) expresses this result mathematically. The eigenvectors \( \lambda_1 \) and \( \lambda_2 \) and the corresponding eigenvectors \( v_1 \) and \( v_2 \) therefore completely determine the fate of any arbitrary perturbation.

5.4 Phase portraits of dynamics in planar systems

In the previous section we have derived the characteristic equation, which determines the eigenvalues pertaining to a particular steady state in a 2-dimensional model. It was argued that these eigenvalues and the corresponding eigenvectors completely determine the fate of any arbitrary perturbation in the neighborhood of a particular steady state \( \tilde{x} \). In this section we will analyse the relation between the eigenvalues and the qualitative properties of the dynamics close to a steady state and how its stability properties depend on these eigenvalues.

Based on equation (5.28) the characteristic equation can be expressed as

\[ \lambda^2 - \beta \lambda + \gamma = 0 \] (5.36)

in which the quantities \( \beta \) and \( \gamma \) are defined as

\[ \beta = a_{11} + a_{22} \] (5.37)

\[ \gamma = a_{11} a_{22} - a_{12} a_{21} \] (5.38)
5.4. PHASE PORTRAITS OF DYNAMICS IN PLANAR SYSTEMS

\( \beta \) equals the trace of the Jacobian matrix \( A \), while \( \gamma \) is identical to the determinant of \( A \). Given a particular eigenvalue \( \lambda_i \) its corresponding eigenvector is determined by

\[
\mathbf{v}_i = \begin{pmatrix} a_{12} \\ \lambda_i - a_{11} \end{pmatrix}
\]

(5.39) if \( a_{12} \neq 0 \), and by

\[
\mathbf{v}_i = \begin{pmatrix} \lambda_i - a_{22} \\ a_{21} \end{pmatrix}
\]

(5.40) in case \( a_{12} = 0 \) and \( a_{21} \neq 0 \).

The roots \( \lambda_i \) of the characteristic equation (5.36) are given by

\[
\lambda_1 = \frac{\beta + \sqrt{\delta}}{2}
\]

(5.41)

\[
\lambda_2 = \frac{\beta - \sqrt{\delta}}{2}
\]

(5.42)

where the quantity \( \delta \) equals the discriminant of the Jacobian matrix \( A \):

\[
\delta = \beta^2 - 4\gamma
\]

(5.43)

Clearly, if \( \delta > 0 \) equation (5.41) and (5.42) specify two distinct, real-valued eigenvalues. In contrast, if \( \delta < 0 \) both eigenvalues \( \lambda_1 \) and \( \lambda_2 \) are complex. In the next sections we will study these two situations separately. The case, in which \( \delta = 0 \) and hence \( \lambda_1 \) equals \( \lambda_2 \), will not be discussed any further here. With two identical eigenvalues \( \lambda_1 \) and \( \lambda_2 \) also the eigenvectors are identical. This non-generic case requires special treatment, which can be found in any text book on ODEs. Table 5.1 summarizes the most important properties of systems with two linear(ized) differential equations.

5.4.1 Two real eigenvalues

Equation (5.41) and (5.42) show that both eigenvalues are real-valued, provided the discriminant of the matrix \( A \) is positive:

\[
\text{Disc } A = \delta = \beta^2 - 4\gamma > 0
\]

which always holds if the determinant \( \gamma \) of the matrix \( A \) is negative, \( \gamma < 0 \). If the eigenvalues are real, also both elements of the two corresponding eigenvectors are real-valued (see equation (5.39) and (5.40)). Figure 5.1 schematically depicts the arrangement of the eigenvectors in the phase-plane in the neighborhood of the steady state \( \tilde{x} \). In the figure it is assumed that the steady state is located at the origin (0, 0), which can always be achieved through a translation of the axes. The phase-plane shown in figure 5.1 is therefore spanned by the perturbations in the variables \( y \) and \( z \), \( \Delta y \) and \( \Delta z \), respectively.

Figure 5.1 shows that each of the eigenvectors determines a line in the phase-plane. Recall from equation (5.34) that the solution of the linearized system of equations in the neighborhood of the steady state can be written as

\[
\Delta x(t) = C_1 \mathbf{v}_1 e^{\lambda_1 t} + C_2 \mathbf{v}_2 e^{\lambda_2 t}
\]
Table 5.1: Important characteristics of systems consisting of two linear(ized) differential equations

<table>
<thead>
<tr>
<th>Linear(ized) equations</th>
<th>Vector notation</th>
<th>Algebraic notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\frac{dx}{dt} = Ax$, $A = \begin{pmatrix} a_{11} &amp; a_{12} \ a_{21} &amp; a_{22} \end{pmatrix}$</td>
<td>$\frac{dx_1}{dt} = a_{11}x_1 + a_{12}x_2$</td>
<td>$\frac{dx_2}{dt} = a_{21}x_1 + a_{22}x_2$</td>
</tr>
<tr>
<td>Significant quantities</td>
<td>$\text{Tr } A$</td>
<td>$\beta = a_{11} + a_{22}$</td>
</tr>
<tr>
<td></td>
<td>$\text{Det } A$</td>
<td>$\gamma = a_{11}a_{22} - a_{12}a_{21}$</td>
</tr>
<tr>
<td></td>
<td>$\text{Disc } A$</td>
<td>$\delta = \beta^2 - 4\gamma$</td>
</tr>
<tr>
<td>Characteristic equation</td>
<td>$\text{det}(A - \lambda I) = 0$</td>
<td>$\lambda^2 - \beta\lambda + \gamma = 0$</td>
</tr>
<tr>
<td>Eigenvalues</td>
<td>$\lambda_{1,2} = \frac{\text{Tr } A \pm \sqrt{\text{Disc } A}}{2}$</td>
<td>$\lambda_{1,2} = \frac{\beta \pm \sqrt{\delta}}{2}$</td>
</tr>
<tr>
<td>Eigenvectors</td>
<td>$v_1$ and $v_2$, such that $Av_i = \lambda_i v_i$</td>
<td>if $a_{12} \neq 0$: $\begin{pmatrix} a_{12} \ \lambda_1 - a_{11} \end{pmatrix}$, $\begin{pmatrix} a_{12} \ \lambda_2 - a_{11} \end{pmatrix}$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>if $a_{12} = 0$ and $a_{21} \neq 0$: $\begin{pmatrix} \lambda_1 - a_{22} \ a_{21} \end{pmatrix}$, $\begin{pmatrix} \lambda_2 - a_{22} \ a_{21} \end{pmatrix}$</td>
</tr>
<tr>
<td>Solutions</td>
<td>$x(t) = C_1 v_1 e^{\lambda_1 t} + C_2 v_2 e^{\lambda_2 t}$</td>
<td>if $a_{12} \neq 0$: $x_1(t) = C_1 a_{12} e^{\lambda_1 t} + C_2 a_{21} e^{\lambda_2 t}$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$x_2(t) = C_1 (\lambda_1 - a_{11}) e^{\lambda_1 t} + C_2 (\lambda_2 - a_{11}) e^{\lambda_2 t}$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>if $a_{12} = 0$ and $a_{21} \neq 0$: $x_1(t) = C_1 (\lambda_1 - a_{22}) e^{\lambda_1 t} + C_2 (\lambda_2 - a_{22}) e^{\lambda_2 t}$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$x_2(t) = C_1 a_{21} e^{\lambda_1 t} + C_2 a_{21} e^{\lambda_2 t}$</td>
</tr>
</tbody>
</table>

in which $C_1$ and $C_2$ are constants determined by the initial perturbation. If the initial perturbation $\Delta x(0) = (\Delta y(0), \Delta z(0))$ is on the line spanned by $v_1$, the constant $C_2$ equals 0. The dynamics of the perturbation over time are in this case described by $\Delta x(t) = C_1 v_1 e^{\lambda_1 t}$

For any value of $t$ $\Delta x(t)$ is then a scalar multiple of $v_1$, which means that $\Delta x(t)$ remains on the line spanned by this eigenvector. The scalar multiple is determined by the product of $C_1$ and the last, exponential term in the equation above. If $\lambda_1$ is negative this scalar quantity will decay for large values of $t$, if $\lambda_1$ is positive it will grow. In the limit for $t \to \infty$, the state of the system will hence approach the steady state $\bar{x}$ following the line spanned by $v_1$, if and only if
5.4. PHASE PORTRAITS OF DYNAMICS IN PLANAR SYSTEMS

Figure 5.1: Geometric representation of two real-valued eigenvectors in a planar system. The steady state $\tilde{x}$ is located at the origin $(0,0)$, possibly after translation of the axes. The phase-plane is therefore spanned by the perturbations in the variables $y$ and $z$, $\Delta y$ and $\Delta z$, respectively. $v_1$ and $v_2$ represent the two eigenvectors corresponding to the two eigenvalues $\lambda_1$ and $\lambda_2$, respectively.

$\lambda_1 < 0$.

Analogously, if the initial perturbation $\Delta x(0) = (\Delta y(0), \Delta z(0))$ is on the line spanned by $v_2$, the constant $C_1$ equals 0 and the dynamics are described by

$$\Delta x(t) = C_2 v_2 e^{\lambda_2 t}$$

Also in this case, in the limit for $t \to \infty$, the state of the system will approach the steady state $\tilde{x}$ following the line spanned by $v_2$, if and only if $\lambda_2 < 0$.

It follows that the dynamics of any perturbation that is initially on one of the lines through the steady state spanned by either $v_1$ or $v_2$ will stay on that line for all $t$ and will approach or move away from the steady state, depending on whether $\lambda_1$ or $\lambda_2$ are negative or positive, respectively. Note that because terms like $\exp(\lambda t)$ only approach 0 and never become identical to it, the steady state can be approached for $t \to \infty$, but will never be reached exactly.

Perturbations that are not initially part of one of the lines spanned by the eigenvectors tend to be curved, since their dynamics are described by a weighted sum of terms involving both eigenvectors and eigenvalues (see equation (5.34)). These dynamics will be dominated by the exponential term with the largest eigenvalue, because this term will grow most rapidly or decay most slowly. Hence, the trajectories in the phase-plane determined by such initial perturbations will curve toward the line spanned by the eigenvector, which is associated with the largest eigenvalue.

Depending on the signs of $\lambda_1$ and $\lambda_2$ 3 different cases can now be distinguished, which are illustrated with their flow patterns in figure 5.2.

- **Case 1:** Two negative eigenvalues: $\lambda_1 < 0$, $\lambda_2 < 0$

  For both eigenvalues to be negative, we can infer from equation (5.41) and (5.42) that at least $\beta$ has to be negative as well, $\beta < 0$ (Note that in this section we restrict ourselves to
the case that $\delta > 0$ and that hence $\sqrt{\delta}$ represents a positive, real value. In addition, $\sqrt{\delta}$ should be smaller in absolute value than $\beta$, otherwise the numerator in equation (5.41), and thus $\lambda_1$, will be positive. The inequality $\sqrt{\delta} = \sqrt{\beta^2 - 4\gamma} < |\beta|$ can clearly only be satisfied if $\gamma > 0$. Hence, the necessary and sufficient conditions for $\lambda_1 < 0$ and $\lambda_2 < 0$ are:

$$\beta < 0, \quad \gamma > 0 \quad \text{and} \quad \delta = \beta^2 - 4\gamma > 0 \quad (5.44)$$

The resulting flow pattern in this case is illustrated in the left panel of figure 5.2. Along the lines that are spanned by both eigenvectors $v_1$ and $v_2$ the flow is toward the steady state $\tilde{x}$, since both $\exp(\lambda_1 t)$ and $\exp(\lambda_2 t)$ with negative $\lambda_1$ and $\lambda_2$ are decreasing functions of times. As a consequence, the flow from anywhere in the neighborhood of the steady state $\tilde{x}$ is directed toward the steady state. Any arbitrary displacement of the state away from the steady state will ultimately decay over time and the steady state is locally stable. In this particular case, the steady state is referred to as a **stable node** or a **sink**, a term which more or less captures the characteristic flow pattern in its neighborhood.

- **Case 2**: One positive, one negative eigenvalue: $\lambda_1 > 0$, $\lambda_2 < 0$ or $\lambda_1 < 0$, $\lambda_2 > 0$

For one of the eigenvalues to be positive, the equations (5.41) and (5.42) show that it does not matter what the value of $\beta$ is, as long as the term $\sqrt{\delta}$ is in absolute value larger than $\beta$. If $\sqrt{\delta} > |\beta|$ and $\beta < 0$, equation (5.41) for $\lambda_1$ yields a positive value, while for $\sqrt{\delta} > |\beta|$ and $\beta > 0$ equation (5.42) for $\lambda_2$ results in a negative value. Therefore, the only condition apart from the condition $\delta > 0$ to hold for this case is that $\sqrt{\delta} > |\beta|$. From the analysis of the previous case we can immediately conclude that this inequality holds if and only if $\gamma < 0$. The necessary and sufficient conditions to have one positive and one negative eigenvalue, either $\lambda_1 < 0$ and $\lambda_2 > 0$ or $\lambda_1 > 0$ and $\lambda_2 < 0$, hence are:

$$\gamma < 0 \quad \text{and} \quad \delta = \beta^2 - 4\gamma > 0 \quad (5.45)$$

The flow pattern for the case $\lambda_1 > 0$ and $\lambda_2 < 0$ is shown in the middle panel of figure 5.2. Along the line spanned by the eigenvector $v_2$ the flow is directed toward the steady state $\tilde{x}$ because the factor $\exp(\lambda_2 t)$ with $\lambda_2 < 0$ is decaying over time. In contrast, the flow along the line spanned by the eigenvector $v_1$ is directed **away from** the steady state since the term $\exp(\lambda_1 t)$ with $\lambda_1 > 0$ only increases with time. These different responses along the
two eigenvectors result in a characteristic flow pattern in the neighborhood of the steady state: Trajectories are curving toward the steady state when starting close to the line spanned by \( v_2 \), but bend away from it when coming close to the steady state, leaving its vicinity following the line spanned by the eigenvector \( v_1 \) that is associated with the positive eigenvalue \( \lambda_1 \). As a result, the steady state is initially approached, but subsequently left behind. This bi-phasic response is only apparent for initial states close to the line spanned by the eigenvector that is associated with the negative eigenvalue. Initial states further away from it show this bi-phasic response less and less, such that initial states close to the line spanned by the the eigenvector that is associated with the positive eigenvalue, only show the phase in which the state moves away from the steady state. Because of this bi-phasic flow pattern in its neighborhood, a steady state \( \tilde{x} \) characterized by one positive and one negative eigenvalue is called a *saddle node* or *saddle point*. Since eventually perturbations to the state of the system will cause the state to leave its neighborhood, the steady state is *unstable*.

- **Case 3:** Two positive eigenvalues: \( \lambda_1 > 0, \lambda_2 > 0 \)

This case is by and large the mirror image of case 1. For both eigenvalues to be positive, equation (5.41) and (5.42) show that \( \beta \) has to be positive, \( \beta > 0 \) (Note again that \( \delta > 0 \) and that hence \( \sqrt{\delta} > 0 \)). Like in case 1, \( \sqrt{\delta} \) should be smaller in absolute value than \( \beta \), otherwise the numerator in equation (5.42), and thus \( \lambda_2 \), will be negative. For the case 1 it was already deduced that \( \sqrt{\delta} < |\beta| \) can only be satisfied if \( \gamma > 0 \). Hence, the necessary and sufficient conditions for \( \lambda_1 > 0 \) and \( \lambda_2 > 0 \) are:

\[
\beta > 0, \quad \gamma > 0 \quad \text{and} \quad \delta = \beta^2 - 4\gamma > 0 \quad (5.46)
\]

The right panel in figure 5.2 shows the characteristic flow pattern for this case in the neighborhood of the steady state \( \tilde{x} \). It is analogous to the flow pattern around the sink discussed as case 1 (see left panel of figure 5.2) with only the direction of movement on all trajectories reversed. Along both lines spanned by \( v_1 \) and \( v_2 \) the flow is *away from* the steady state \( \tilde{x} \), since both \( \exp(\lambda_1 t) \) and \( \exp(\lambda_2 t) \) with positive \( \lambda_1 \) and \( \lambda_2 \) are increasing functions of times. As a consequence, the flow from anywhere in the neighborhood of the steady state \( \tilde{x} \) is directed away from the steady state. Any arbitrary displacement of the state away from the steady state will ultimately grow over time and the steady state is unstable. Because all trajectories seem to originate from it, the steady state in this case is referred to as an *unstable node* or a *source*.

**Summary:**

In the neighborhood of a steady state, which is characterized by two real eigenvalues \( \lambda_1 \) and \( \lambda_2 \), these eigenvalues determine the rate with which the steady state is approached (in case of a negative eigenvalue) or left behind (in case of a positive eigenvalue) along the two characteristic directions, spanned by the eigenvectors \( v_1 \) and \( v_2 \) that are associated with \( \lambda_1 \) and \( \lambda_2 \), respectively.
5.4.2 Two complex eigenvalues

If the discriminant of the matrix $\mathbf{A}$ is negative,

$$\text{Disc } \mathbf{A} = \delta = \beta^2 - 4\gamma < 0 \quad (5.47)$$

the factor $\sqrt{\delta}$ in equation (5.41) and (5.42) and therefore both eigenvalues $\lambda_1$ and $\lambda_2$ have a complex value. Moreover, the two eigenvalues $\lambda_1$ and $\lambda_2$ are each other complex conjugate, because the same factor $\sqrt{\delta}$ occurs in the expressions for the eigenvalues, but with a different sign. We can therefore express $\lambda_1$ and $\lambda_2$ as

$$\lambda_1 = p + iq \quad (5.48)$$

and

$$\lambda_2 = p - iq \quad (5.49)$$

in which $i = \sqrt{-1}$ and both factors $p$ and $q$ are real-valued, scalar quantities, defined as

$$p = \frac{\beta}{2} \quad (5.50)$$

$$q = \frac{\sqrt{|\delta|}}{2} = \frac{\sqrt{-\delta}}{2} \quad (5.51)$$

Even for more general models in terms of more than 2 ODEs it holds that if a particular eigenvalue is complex, its complex conjugate is an eigenvalue as well. Thus, complex eigenvalues always occur in conjugate pairs. For the discriminant $\delta$ of the matrix $\mathbf{A}$ to be negative, equation (5.47) shows that $\gamma$ has to be larger than $\beta^2/4$, which implies that $\gamma$ at least has to be positive.

Substitution of equation (5.48) and (5.49) into equation (5.39) shows that the eigenvectors corresponding to $\lambda_1$ and $\lambda_2$ can be written as

$$\mathbf{v}_1 = \begin{pmatrix} a_{12} \\ p + iq - a_{11} \end{pmatrix} = \begin{pmatrix} a_{12} \\ p - a_{11} \end{pmatrix} + i \begin{pmatrix} 0 \\ q \end{pmatrix} \quad (5.52)$$

and

$$\mathbf{v}_2 = \begin{pmatrix} a_{12} \\ p - iq - a_{11} \end{pmatrix} = \begin{pmatrix} a_{12} \\ p - a_{11} \end{pmatrix} - i \begin{pmatrix} 0 \\ q \end{pmatrix} \quad (5.53)$$

Note that the requirement for equation (5.39) to hold, i.e. $a_{12} \neq 0$, is always satisfied. Otherwise, for $a_{12} = 0$ the determinant $\gamma$ of the Jacobian matrix $\mathbf{A}$ equals $a_{11}a_{22}$, which implies that $\lambda_1$ and $\lambda_2$ would both be real-valued and equal to $a_{11}$ and $a_{22}$, respectively (see equation (5.36)-(5.38)).

Defining two real, constant vectors $\mathbf{r}$ and $\mathbf{c}$ as

$$\mathbf{r} = \begin{pmatrix} a_{12} \\ p - a_{11} \end{pmatrix} \quad (5.54)$$

and

$$\mathbf{c} = \begin{pmatrix} 0 \\ q \end{pmatrix}, \quad (5.55)$$

respectively, the eigenvectors $\mathbf{v}_1$ and $\mathbf{v}_2$ can now be expressed as

$$\mathbf{v}_1 = \mathbf{r} + i\mathbf{c} \quad (5.56)$$

$$\mathbf{v}_2 = \mathbf{r} - i\mathbf{c} \quad (5.57)$$
Figure 5.3: Geometric representation of the two basis vectors in a planar system with complex eigenvectors. The steady state $\tilde{x}$ is located at the origin $(0,0)$, possibly after translation of the axes. The phase-plane is therefore spanned by the perturbations in the variables $y$ and $z$, $\Delta y$ and $\Delta z$, respectively. $r$ and $c$ represent the real and complex part of the two eigenvectors $v_1$ and $v_2$ (see equation (5.56) and (5.57)) corresponding to the two eigenvalues $\lambda_1$ and $\lambda_2$, respectively. The closed loop represents the trajectory determined by the two functions $u(t)$ and $w(t)$ (see equation (5.58) and (5.59)).

The complex nature of the eigenvalues $\lambda_{1,2} = p \pm iq$ and the eigenvectors $v_{1,2} = r \pm ic$ raise the question how equation (5.34) can still represent the general solution from any arbitrary point in the neighborhood of the steady state. Complex eigenvectors have no geometrical meaning, like in the case for real eigenvectors (see figure 5.1) and we can hence not draw initial points as linear combinations of them. How do we then represent such a particular perturbation in terms of the eigenvectors and what is there dynamics over time? To answer these questions we substitute the expressions for the eigenvalues and eigenvectors, $\lambda_{1,2} = p \pm iq$ and $v_{1,2} = r \pm ic$, respectively, into equation (5.34) and substitute for the exponential functions the identity

$$e^{(p \pm iq)t} = e^{pt} (\cos qt \pm i \sin qt)$$

With these substitutions equation (5.34) can be rewritten as follows

$$\Delta x(t) = C_1 v_1 e^{\lambda_1 t} + C_2 v_2 e^{\lambda_2 t} = C_1 (r + ic) e^{(p + iq)t} + C_2 (r - ic) e^{(p - iq)t}$$

$$= e^{pt} \{ C_1 (r + ic) (\cos qt + i \sin qt) + C_2 (r - ic) (\cos qt - i \sin qt) \}$$

$$= e^{pt} \{ (C_1 + C_2) (r \cos qt - c \sin qt) + i (C_1 - C_2) (r \sin qt + c \cos qt) \}$$

If we define two real, vector-valued functions $u(t)$ and $w(t)$ as

$$u(t) = r \cos qt - c \sin qt \quad (5.58)$$

$$w(t) = r \sin qt + c \cos qt \quad (5.59)$$
\[ \Delta x(t) \text{ can hence be written as} \]
\[ \Delta x(t) = e^{pt} \{(C_1 + C_2) u(t) + i(C_1 - C_2) w(t)\} \quad (5.60) \]

This equation leads to the conclusion that as long as we choose the constants \( C_1 \) and \( C_2 \) as each other’s complex conjugate, all complex terms in the expression for \( \Delta x(t) \) cancel. More specifically, if we assume that \( C_1 = a - ib \) and \( C_2 = a + ib \) respectively, equation (5.60) simplifies to
\[ \Delta x(t) = e^{pt} \{a u(t) + b w(t)\} \quad (5.61) \]
in which both constants \( a \) and \( b \) as well as both vector-valued functions \( u(t) \) and \( w(t) \) are real.

From equation (5.58) and (5.59) we can infer that for \( t = 0 \) \( u(t) \) evaluates to the vector \( r \), while \( w(t) \) evaluates to \( c \). These two vectors \( r \) and \( c \) constitute a set of independent basis vectors. By choosing the (real) constants \( a \) and \( b \) appropriately, any initial state in the neighborhood of the steady state \( \tilde{x} \) can be represented as a linear combination of them (see figure 5.3). Therefore, we can conclude that equation (5.61) represents the general form of the solution to the linearized dynamics (5.19) from any arbitrary initial point in the neighborhood of the steady state \( \tilde{x} \).

To investigate the characteristics of the general solution we note that the term \( \exp(pt) \) represents a growing or decaying function of time, depending on the value of the (real) constant \( p \) (remember that \( p \) equals the real part of the eigenvalues \( \lambda_1 \) and \( \lambda_2 \)). Equation (5.58) shows that the function \( u(t) \) evaluates to the vector \( r \) at \( t = 0 \), to the vector \( -c \) for \( qt = \pi/2 \), to the vector \( -r \) for \( qt = \pi \), to the vector \( c \) for \( qt = 3\pi/2 \) and once again to the vector \( r \) at \( qt = 2\pi \). In other words, the function \( u(t) \) describes a cyclic pattern in the phase-plane, cycling between the points specified by \( r, -c, -r \) and \( c \) with a periodicity equal to \( 2\pi/q \) (see figure 5.3). Analogously, we can infer from equation (5.59) that the function \( w(t) \) evaluates to \( c \) at \( t = 0 \), to the vector \( r \) for \( qt = \pi/2 \), to the vector \( -c \) for \( qt = \pi \), to the vector \( -r \) for \( qt = 3\pi/2 \) and once again to the vector \( c \) at \( qt = 2\pi \). The function \( w(t) \) hence describes the same cyclic pattern in the phase-plane, cycling between the points specified by \( c, r, -c \) and \( -r \) with a periodicity equal to \( 2\pi/q \), but lagging behind a quarter period (i.e. with a phase shift equal to \( \pi/2 \)) in comparison to the function \( u(t) \).
5.4. PHASE PORTRAITS OF DYNAMICS IN PLANAR SYSTEMS

\( u(t) \). In terms of the phase-plane shown in figure 5.3, the two functions \( u(t) \) and \( w(t) \) describe the same closed trajectory over time, which is followed with a periodicity equal to \( 2\pi/q \). The difference between the two functions is the lag between them of a quarter period.

In addition to the 3 cases with real eigenvalues discussed in section 5.4.1, the conclusions of the analysis above allow us to distinguish 3 additional cases for the dynamics in the neighborhood of a steady state that is characterized by a complex set of eigenvalues and eigenvectors. The flow patterns in the neighborhood of the steady state are illustrated in figure 5.4.

- **Case 4:** Negative real parts: \( \Re \lambda_1 = \Re \lambda_2 < 0 \)

If the real part of \( \lambda_1 \) and \( \lambda_2 \), i.e. the constants \( p \), is negative, the solution for \( \Delta x(t) \) is the product of the oscillatory function of time, given by

\[
a u(t) + b w(t)
\]

and the *decaying* exponential function of time

\[ e^{pt} \]

Therefore, the trajectories in the neighborhood of the steady state \( \bar{x} \) circle around the steady state with a period that is determined by the factor \( 2\pi/q \), while the amplitude, i.e. roughly speaking the distance to the steady state, decreases at a rate \( p \). These trajectories hence represent spiraling dynamics, approaching the steady state for \( t \to \infty \) (see the left panel in figure 5.4). The steady state is clearly stable, as small perturbations will ultimately decay with time. This type of steady state is appropriately referred to as a stable spiral point.

From equation (5.50) it is clear that this case occurs, if in addition to the condition (5.47), \( \beta \) is negative. The necessary and sufficient conditions hence are

\[
\beta < 0 \quad \text{and} \quad \delta = \beta^2 - 4\gamma < 0 \tag{5.62}
\]

- **Case 5:** Positive real parts: \( \Re \lambda_1 = \Re \lambda_2 > 0 \)

This case is the mirror image of the previous case. Therefore, the solution for \( \Delta x(t) \) is the product of the oscillatory function of time, given by

\[
a u(t) + b w(t)
\]

and

\[ e^{pt} \]

which represents an *increasing* function of time. The trajectories in the neighborhood of the steady state \( \bar{x} \) circle around the steady state with a period that is determined by the factor \( 2\pi/q \), while the amplitude (distance to the steady state) increases at a rate \( p \). Altogether, the trajectories represent spiraling dynamics, moving away from the steady state for \( t \to \infty \) (see the right panel in figure 5.4). The steady state is unstable, as small perturbations will increase with time. This type of steady state is referred to as an unstable spiral point.

The necessary and sufficient conditions, for which this case occurs, are

\[
\beta > 0 \quad \text{and} \quad \delta = \beta^2 - 4\gamma < 0 \tag{5.63}
\]
• Case 6: Zero real parts: Re $\lambda_1 = \text{Re} \lambda_2 = 0$

If the real part $p$ of $\lambda_1$ and $\lambda_2$ equals 0, the amplitude of the oscillatory dynamics in the neighborhood of the steady state neither grows nor declines. The solution for $\Delta x(t)$ hence equals

$$a u(t) + b w(t)$$

This function describes purely cyclic dynamics with a period equal to $2\pi/q$. The trajectories form closed loops around the steady state (see the middle panel in figure 5.4). The initial perturbation determines the constants $a$ and $b$ and hence which closed loop is followed. Since initial perturbations neither grow nor decline in magnitude, the steady state is \emph{neutrally stable}. This type of steady state is referred to as a \emph{neutral center}.

The necessary and sufficient conditions, for which this case occurs, are

$$\beta = 0 \quad \text{and} \quad \delta = \beta^2 - 4\gamma < 0 \quad (5.64)$$

This case is rather special and generically only occurs for limited sets of parameters. In essence, it is as special as the case, in which two real eigenvalues are equal, $\lambda_1 = \lambda_2$. This latter case was not discussed in section 5.4.1 precisely because it only occurs for restricted parameter combinations and hence is not generic. The reason that we nonetheless distinguish and discuss the case of complex eigenvalues with zero real part follows from the fact that the classical Lotka-Volterra model for the interactions between predators and their prey yields precisely this class of dynamics (see section 6.1).

\begin{center}
\textbf{Summary:}
\end{center}

For a steady state which is characterized by two complex eigenvalues $\lambda_1$ and $\lambda_2$, the imaginary part $q$ determines the period $2\pi/q$ of the oscillatory dynamics that occur in the neighborhood of the steady state. The real part $p$ of the eigenvalues determines the rate of growth or decline of the amplitude of the oscillatory dynamics, which roughly speaking corresponds to the distance to the steady state.

5.5 Stability of steady states in planar ODE systems

In section 5.4.1 it was shown that in case the eigenvalues are real-valued, a steady state of a planar ODE system is stable if and only if both eigenvalues $\lambda_1$ and $\lambda_2$ are negative. In section 5.4.2 it was shown that in case the eigenvalues are complex, the steady state is a stable spiral if and only if the real parts of the two eigenvalues $\lambda_1$ and $\lambda_2$, which constitute a complex, conjugate pair, is negative. To summarize we can conclude
\[ \delta = \beta^2 - 4\gamma = 0 \]

Figure 5.5: Summary of stability properties for planar ODE systems. The stability properties of the steady state are indicated with the characteristic flow patterns in the neighborhood of the steady state, as a function of the trace \( \beta \), the determinant \( \gamma \) and the discriminant \( \delta \) of the Jacobian matrix \( A \). Types of steady states: (a): Stable spiral; (b): Unstable spiral; (c): Neutral center; (d): Stable node; (e): Unstable node; (f): Saddle node. Note that a neutral center only occurs for \( \beta = 0 \).

**Important:**

In a continuous-time model in terms of ordinary differential equations, a steady state will be stable provided that the eigenvalues of the characteristic equation, which is associated with the linearized dynamics in the close neighborhood of the steady state, are all negative (if real) or have negative real part (if complex). That is,

\[ \text{Re} \lambda_i < 0 \text{ for all } i. \]
On purpose the conclusion above is phrased without a reference to a 2-dimensional, planar system of ODEs. The conclusion generalizes without any change to models of higher, even infinite, dimension. For a model in terms of 2 ODEs we derived in section 5.4.1 and 5.4.2 a complete set of necessary and sufficient conditions determining whether the steady state was a stable or unstable node, a saddle node, a neutral center, a stable or unstable spiral point. As shown in figure 5.2 and 5.4 the type of steady state determined completely the flow of the trajectories in the close neighborhood of the steady state. The conditions were phrased in terms of 3 quantities: $\beta$, the trace of the Jacobian matrix $A$, $\gamma$ the determinant of $A$ and $\delta = \beta^2 - 4\gamma$, its discriminant. Figure 5.5 summarizes these conditions by plotting in the plane spanned by the quantities $\beta$ and $\gamma$ examples of the characteristic flow patterns in the neighborhood of a steady state. All types of steady states occur for measurable sets of $(\beta, \gamma)$-combinations, except for neutral centers, which only occur on the $\gamma$-axis in figure 5.5, i.e. for $\beta = 0$. The quantities $\beta$ and $\gamma$ determine the values of the eigenvalues and the corresponding eigenvectors (see equation (5.41) and (5.42)). As we concluded before, these eigenvalues and eigenvectors determine completely the dynamics of the model in the neighborhood of the steady state.

5.6 Models with 3 or more variables

In general, any model specifying the dynamics of 3 or more variables can be abstractly represented in vector notation by the same equations as presented in section 5.1. Assuming that we are studying a model in terms of $n$ variables, denoted by $x_1, \ldots, x_n$, the dynamics can hence be described by the following, $n$-dimensional system of ODEs

$$\frac{dx}{dt} = H(x)$$

(compare equation (5.4)) in which $x$ represents an $n$-dimensional column vector and $H(x)$ an $n$-dimensional vector-valued function:

$$x = \begin{pmatrix} x_1 \\ \vdots \\ x_n \end{pmatrix}, \quad H(x) = \begin{pmatrix} H_1(x) \\ \vdots \\ H_n(x) \end{pmatrix}$$

The steady state equation of such a model can again be represented by

$$H(\tilde{x}) = 0$$

(compare equation (5.5)), which is now a short-hand notation for a system of $n$ algebraic equations.

The linearization of the dynamics in the neighborhood of a steady state, which is described in section 5.2 for a 2-dimensional model, also generalizes to models of any dimension. Therefore, in the neighborhood of a particular steady state $\tilde{x}$, the dynamics can be approximated by the linearized dynamics, described by the ODE:

$$\frac{d\Delta x}{dt} = A \Delta x$$

(5.65)

Here, $\Delta x$ represents the ($n$-dimensional) perturbation to the steady state $\tilde{x}$. The Jacobian matrix $A$ equals the matrix of partial derivatives of the function $H(x)$, evaluated at the steady
5.6. MODELS WITH 3 OR MORE VARIABLES

Table 5.2: The Routh-Hurwitz stability criteria (following May 1974)

<table>
<thead>
<tr>
<th>n</th>
<th>Stability criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>( c_1 &gt; 0 )</td>
</tr>
<tr>
<td>2</td>
<td>( c_1 &gt; 0, c_2 &gt; 0 )</td>
</tr>
<tr>
<td>3</td>
<td>( c_1 &gt; 0, c_3 &gt; 0, c_1 c_2 &gt; c_3 )</td>
</tr>
<tr>
<td>4</td>
<td>( c_1 c_2 c_3 &gt; c_3^2 + c_1^2 c_4 )</td>
</tr>
<tr>
<td>5</td>
<td>( c_i &gt; 0 ) for all ( i ), ( c_1 c_2 c_3 &gt; c_3^2 + c_1^2 c_4 ), ( (c_1 c_4 - c_5)(c_1 c_2 c_3 - c_3^2 - c_1^2 c_4) &gt; c_5(c_1 c_2 - c_3)^2 + c_1^2 c_5 )</td>
</tr>
</tbody>
</table>

state \( \tilde{x} \). \( A \) is therefore defined as

\[
A = \begin{pmatrix}
  a_{11} & \cdots & a_{1n} \\
  \vdots & \ddots & \vdots \\
  a_{n1} & \cdots & a_{nn}
\end{pmatrix} = \begin{pmatrix}
  \frac{\partial H_1}{\partial x_1}_{|x=\tilde{x}} & \cdots & \frac{\partial H_1}{\partial x_n}_{|x=\tilde{x}} \\
  \vdots & \ddots & \vdots \\
  \frac{\partial H_n}{\partial x_1}_{|x=\tilde{x}} & \cdots & \frac{\partial H_n}{\partial x_n}_{|x=\tilde{x}}
\end{pmatrix}
\] (5.66)

Each element \( a_{ij} \) of the matrix \( A \) equals the partial derivative of the function \( H_i(x) \) with respect to the variable \( x_j \), evaluated at the steady state \( \tilde{x} \).

Substitution of exponential trial solutions of the form \( v e^{\lambda t} \) into the ODE (5.65) yields, in vector notation, the same characteristic equation as derived for a 2-dimensional model:

\[
\det (A - \lambda I) = 0
\] (5.67)

As before, this characteristic equation determines the eigenvalues of the model pertaining to a particular steady state. The matrices \( A \) and \( I \) are now \( n \times n \)-matrices, as opposed to the \( 2 \times 2 \)-matrices encountered in section 5.3. Therefore, computation of the determinant in the characteristic equation will eventually lead to a polynomial expression in \( \lambda \) of degree \( n \), which can be written as

\[
\lambda^n + c_1 \lambda^{n-1} + c_2 \lambda^{n-2} + \cdots + c_{n-2} \lambda^2 + c_{n-1} \lambda + c_n = 0
\] (5.68)

The \( n \) roots of this polynomial equation correspond to the eigenvalues. Note that the number of eigenvalues always equals the dimension of the model. For a 2-dimensional model we have found in section 5.3 that

\[
c_1 = -\beta = -(a_{11} + a_{22})
\]
\[
c_2 = \gamma = a_{11} a_{22} - a_{12} a_{21}
\]

Given a particular eigenvalue \( \lambda_i \) its corresponding eigenvector \( v_i \) can be computed from

\[
A v_i = \lambda_i v
\]
which is analogous to equation (5.23), as derived in section 5.3 for a 2-dimensional model.

Apart from writing down the equations that determine the eigenvalues and eigenvectors of a model with more than 2 variables, further analysis of the stability properties of steady states is very difficult and often not possible analytically. However, as in the 2-dimensional model studied in the previous sections, the general solution of the ODE (5.65), describing the dynamics of the perturbation $\Delta x$ over time, can be written as a sum of eigenvectors and exponentials of the eigenvalues (compare equation (5.34)):

$$\Delta x(t) = \sum_{i=1}^{n} C_i v_i e^{\lambda_i t} \quad (5.69)$$

in which the constants $C_i$ depend on the value of the initial perturbation $\Delta x(0)$ (see equation (5.33)). Strictly speaking, the equation above only holds for the case that all eigenvalues, and hence all eigenvectors, are distinct, similar to the results derived for 2-dimensional models. The case where eigenvalues are not distinct is seldom of substantial practical interest in modeling since an infinitesimal change in one of the matrix elements (for example, due to a very small change in one of the model parameters) will normally remove the problem. Generically, we may thus conclude from equation (5.69) that perturbations to a steady state $\tilde{x}$ will decay and the steady state will thus be stable, provided that all eigenvalues of the matrix $A$ have negative real parts. If any of the eigenvalues has a positive real part, the steady state is unstable and perturbations will grow with time.

The roots of the polynomial (5.68) cannot be evaluated conveniently, unless $n = 1$ or $n = 2$. However, there are some very useful mathematical theorems which provide necessary and sufficient conditions for all the eigenvalues of a matrix to have negative real parts, without involving explicit calculation of the eigenvalues [May 1974]. These stability conditions are known as the Routh-Hurwitz criteria and are expressed in terms of the coefficients $c_i$. Table 5.2 lists these criteria for $n = 1, \ldots, 5$. These conditions themselves are not very enlightening, but for small values of $n$ the inequalities constitute one of the most powerful and widely used theoretical tools to analytically evaluate the stability of steady states.
Chapter 6

Predator-prey interactions

In 1926 the Italian mathematician Vito Volterra wrote a paper, entitled “Fluctuations in the abundance of a species considered mathematically”, which was inspired by a question from his son-in-law, Dr. U. d’Ancona. The question posed by Dr. d’Ancona was why the predatory fish species the Adriatic Sea had increased in abundance after fisheries had ceased during World War I, while the opposite was true for the prey species these predators fed upon. Volterra (1926) developed a model to describe the interaction between a predator and a prey, based on the following assumptions:

- prey would multiply indefinitely (i.e. grow exponentially) in the absence of predators,
- predators would go extinct if prey were absent, due to a lack of food,
- the proportional rate of increase of the prey decreases as the number of predators increases, and
- the growth rate of predators increases when the number of prey increases.

Without stating any equations, his model analysis led Volterra (1926) to the following 3 conclusions:

1. The two species fluctuate periodically in abundance, the period only depending on the coefficients of increase and of destruction of the two species, and on the initial numbers of the individuals of the two species.

2. The average numbers of the two species tend to constant values, whatever the initial may have been, so long as the coefficients of increase or of destruction of the two species and also the coefficients of protection and attack remain constant.

3. If we try to destroy individuals of both species uniformly and proportionally to their number, the average number of individuals of the eaten species grows and the average number of the eating species diminishes. But increased protection of the eaten species increases the average numbers of both.

Volterra (1926) closed his short paper with the modest statement:

Seeing that a great number of biological phenomena are characteristic of associations of species, it is to be hoped that this theory may receive further verification and may be of some use to biologists.
Despite the brevity of the paper and the modest closing sentence, Volterra established with his study a corner-stone for the theory about predator-prey interactions. The Lotka-Volterra predator-prey model, as it has been referred to since Volterra’s contribution, forms a basis on which most if not all models of such interactions have been founded. In addition, it has become clear that predator-prey interactions are one of the most important causes of oscillations in species abundance. Hence, not only the model that Volterra (1926) studied, but also the fluctuations he reported are to the present day important focal points for studying the dynamics of interacting species.

In this chapter the basic Lotka-Volterra predator-prey model will be discussed first, together with some of the models derived from it. Subsequently, I will discuss the relevance of the model conclusions for natural systems and more specifically the occurrence in natural systems of population cycles that might be the result of the interactions between predators and their prey.

6.1 The Lotka-Volterra predator-prey model

Taking the simplest set of ODEs consistent with his assumptions, Volterra (1926) studied the dynamics of the following model:

\[ \frac{dF}{dt} = rF - aFC \]  
\[ \frac{dC}{dt} = \epsilon a FC - \mu C \]  

In these equations, \( F \) and \( C \) represent the abundance of prey (food) and predators (consumers), respectively. The parameter \( r \) represents the exponential growth rate of prey in the absence of the predator, while \( \mu \) represents the death or mortality rate of the predators in the absence of prey. Encounters between prey and predators are assumed to follow the mass action law (see section 2.5.3) and are hence proportional to the product of the abundances \( F \) and \( C \).

The parameter \( a \) represents the attack rate of predators, which equals the area or volume that a predator searches through during a single unit of time. The parameter \( \epsilon \) represents the conversion efficiency, i.e. the efficiency with which predators convert consumed prey into offspring. The notation used in the above equations is not identical to the notation used by Volterra (1926), but chosen for agreement with variants of the model discussed below. Notice that only positive parameter values are meaningful.

The nullclines of the Lotka-Volterra predator-prey model (6.1) where \( dF/dt = 0 \) are given by:

\[ F = 0 \quad \text{and} \quad C = \frac{r}{a} \]  

while the nullclines where \( dC/dt = 0 \) are given by:

\[ C = 0 \quad \text{and} \quad F = \frac{\mu}{\epsilon a} \]  

These nullclines imply that the model possesses two steady states, the trivial steady state:

\[ (F_1, C_1) = (0, 0) \]  

and the internal steady state

\[ (F_2, C_2) = \left( \frac{\mu}{\epsilon a}, \frac{r}{a} \right) \]
6.1. THE LOTKA-VOLterra PREDATOR-PREY MODEL

The Lotka-Volterra predator-prey model makes two counterintuitive predictions regarding the internal steady state:

- The steady state value of the prey is independent of its own growth or mortality rate, but is completely determined by the characteristics of the predator, while
- increased prey growth rates or increased protection of prey against predation (i.e. lower values of $a$) only result in higher predator densities at the steady state.

The strong, regulating coupling between prey and predator induces that at steady state the available prey has to be just sufficient to yield a predator reproduction rate that balances its mortality. Hence, if predators experience a higher mortality a higher steady-state prey abundance is needed to balance it. On the other hand, in steady state there should be sufficiently many predators to keep the total prey production under control. If prey are less sensitive to predator attacks, this implies that there simply have to be more predators around to exert this control.

Next, consider the stability of these two steady states. The Jacobian matrix with partial derivatives is given by:

$$ J = \begin{pmatrix} r - aC & -aF \\ \epsilon aC & \epsilon aF - \mu \end{pmatrix} \quad (6.6) $$

Evaluated at the trivial steady state, this yields:

$$ J_1 = \begin{pmatrix} r & 0 \\ 0 & -\mu \end{pmatrix} \quad (6.7) $$

and the following characteristic equation:

$$(r - \lambda)(-\mu - \lambda) = 0 \quad (6.8)$$

The eigenvalues pertaining to the trivial steady state hence equal:

$$ \lambda_1 = r \quad (6.9a) $$
$$ \lambda_2 = -\mu \quad (6.9b) $$

The corresponding eigenvectors are

$$ v_1 = \begin{pmatrix} 1 \\ 0 \end{pmatrix} \quad (6.10) $$
for $\lambda_1 = r$ and

$$ v_2 = \begin{pmatrix} 0 \\ 1 \end{pmatrix} \quad (6.11) $$

$\lambda_2 = \mu$. These values for the eigenvalues and eigenvectors imply that the trivial steady state will be stable against perturbations in the predator density, but unstable against perturbations in the prey density. It is therefore a saddle point for all values of the parameters.

Substitution of the equilibrium densities (6.5) in the expression for the Jacobian matrix (6.6) yields for the internal steady state:

$$ J_2 = \begin{pmatrix} 0 & -\frac{\mu}{\epsilon} \\ \frac{\epsilon r}{\epsilon} & 0 \end{pmatrix} \quad (6.12) $$
Figure 6.1: Solution curves in the phase plane of the Lotka-Volterra predator-prey model. Two isoclines where \( dF/dt = 0 \) and \( dC/dt = 0 \) are drawn (the isoclines coinciding with the \( x \)- and \( y \)-axis have been omitted). The isoclines intersect in the neutrally stable state. All solutions are closed elliptic curves around this state, each curve completely determined by the initial state \((F_0, C_0)\). Parameter values: \( r = 0.5 \), \( a = 1.0 \), \( \epsilon = 0.5 \) and \( \mu = 0.1 \).

and the following characteristic equation:

\[
\lambda^2 + r\mu = 0 \tag{6.13}
\]

The following pair of complex eigenvalues therefore governs the dynamics in the neighborhood of the internal steady:

\[
\lambda_{1,2} = \pm \sqrt{r\mu} i \tag{6.14}
\]

Because the two eigenvalues are pure imaginary for all values of the parameters the internal steady state is always neutrally stable. Due to the product terms \( aFC \) and \( \epsilon aFC \) in the ODE for the prey and predator abundance, respectively, the model is non-linear. For a linear systems a steady state with purely imaginary eigenvalues is always a neutral center (see chapter 5). The non-linearities in the Lotka-Volterra model could theoretically imply that the steady state is a spiral point, from which trajectories would spiral away. It is possible, however, to show that the internal steady state is in fact a neutral center through the analysis of a differential equation \( dF/dC \) that can be derived by dividing the left-hand sides and right-hand sides of the system of ODEs [5.1]
6.1. THE LOTKA-VOLTERRA PREDATOR-PREY MODEL

Figure 6.2: Prey dynamics predicted by the Lotka-Volterra predator-prey model. The initial predator density has been taken equal to its internal steady state value for the used parameter values, $C = 0.5$. Different initial prey densities lead to solutions that differ in both period and amplitude. The vertical line indicates the oscillation period predicted by the pair of complex eigenvalues, $\tau = 2\pi/\sqrt{r\mu}$. Parameter values: $r = 0.5$, $a = 1.0$, $\epsilon = 0.5$ and $\mu = 0.1$.

The variables in this latter ODE can be separated to yield:

$$\frac{\epsilon a F - \mu}{F} \, dF = \frac{r - a C}{C} \, dC$$

Integrating both sides from the abundances at time 0 to the abundances at time $t$ yields:

$$\int_{F_0}^{F(t)} \frac{-\mu}{F} \, dF + \int_{F_0}^{F(t)} \epsilon a \, dF = \int_{C_0}^{C(t)} \frac{r}{C} \, dC - \int_{C_0}^{C(t)} a \, dC$$

Where $F_0$ and $C_0$ are the initial abundances of prey and predators, respectively, and $F(t)$ and $C(t)$ are the same abundances at time $t$. From this last equation it can be inferred that any solution curve $(F(t), C(t))$ obeys the equation:

$$-\mu \ln F(t) + \epsilon a F(t) - r \ln C(t) + a C(t) = -\mu \ln F_0 + \epsilon a F_0 - r \ln C_0 + a C_0 \quad (6.16)$$

In the $(F,C)$-phase plane this equation describes an elliptic curve through the initial state $(F_0, C_0)$. Hence, the internal steady state is not a spiral point, but a neutral center. All solution curves are closed orbits around this center. Figure 6.1 shows some possible solution curves. The initial state $(F_0, C_0)$ uniquely determines which elliptic curve is followed.

The analysis thus shows that not only the steady state is neutrally stable, but that also all solution orbits are neutrally stable: any small perturbation to the system will force it out of the orbit around the steady state it is currently following into a new orbit. The imaginary eigenvalues (6.14) predict that the period of oscillations is proportional to $(\sqrt{r\mu})^{-1}$. However, the real period of the oscillations also depends on the distance of the orbit to the steady state, as is shown in Figure 6.2. Only infinitesimally close to the steady state is the period of oscillation exactly equal to $(\sqrt{r\mu})^{-1}$, it increases with the distance from the orbit to the steady state.
Nonetheless, a higher prey growth rate \( r \) or a higher predator mortality rate \( \mu \) lead to more rapid oscillations in prey and predator abundance.

The basic Lotka-Volterra predator-prey model thus makes two important predictions:

- Steady-state prey abundances are completely controlled by life-history characteristics of the predator, and

- Oscillations in both prey and predator abundance are the dominant type of dynamics expected.

In the following two section we will see to what extent these conclusions are influenced by the neutral stability of the internal steady state.

### 6.1.1 Incorporating prey logistic growth

A slightly more complicated and realistic version of the Lotka-Volterra predator-prey model (6.1) assumes that prey do not grow indefinitely in the absence of predators, but will ultimately reach a maximum prey abundance. Hence, prey do not grow exponentially, but follow, for example, a logistic growth equation, as in the following set of ODEs:

\[
\begin{align*}
\frac{dF}{dt} &= rF \left( 1 - \frac{F}{K} \right) - aFC \\
\frac{dC}{dt} &= \epsilon aFC - \mu C
\end{align*}
\]  

(6.17a)

(6.17b)

The only difference of this set of equations with the standard model (6.1) is the term \( 1 - F/K \), characterizing the logistic growth process of prey up to a carrying capacity \( K \) in ODE (6.17a).

The nullclines where \( dF/dt = 0 \) for this modified Lotka-Volterra predator-prey model are given by:

\[
F = 0 \quad \text{and} \quad C = \frac{r}{a} \left( 1 - \frac{F}{K} \right)  
\]  

(6.18)

while the nullclines where \( dC/dt = 0 \) are the same as before (cf. equation (6.3)):

\[
C = 0 \quad \text{and} \quad F = \frac{\mu}{\epsilon a}  
\]  

(6.19)

These nullclines imply that the modified model possesses three steady states, the trivial steady state:

\[
(F_1, C_1) = (0, 0)  
\]  

(6.20)

a prey-only steady state:

\[
(F_2, C_2) = (K, 0)  
\]  

(6.21)

and the internal steady state

\[
(F_3, C_3) = \left( \frac{\mu}{\epsilon a}, \frac{r}{a} \left( 1 - \frac{\mu}{\epsilon a K} \right) \right).  
\]  

(6.22)

The prey abundance in the internal steady state is again completely determined by the parameters, i.e. the life-history characteristics, which pertain to the predator. The predator abundance in the internal steady is now also determined by the steady-state prey abundance and therefore indirectly dependent on the predator parameters as well. Nonetheless, the steady-state predator abundance again is just sufficient to keep the total prey growth in steady state under control.
The Jacobian matrix with partial derivatives of the modified model (6.17) is given by:

\[
J = \begin{pmatrix}
  r - 2\frac{rF}{K} & -aC \\
  \epsilon aC & \epsilon aF - \mu
\end{pmatrix}
\]  

(6.23)

Evaluated at the trivial steady state, this yields the same Jacobian as for the basic Lotka-Volterra model (6.1) (cf. equation (6.7)):

\[
J_1 = \begin{pmatrix}
  r & 0 \\
  0 & -\mu
\end{pmatrix}
\]  

(6.24)

The dynamic properties of the trivial steady state are therefore not affected by adopting a logistic growth process for the prey: the trivial steady state is again a saddle point for all values of the parameters, which is stable against perturbations in the predator density, but unstable against perturbations in the prey density (see the discussion following equation (6.7)).

For the prey-only steady state the Jacobian evaluates to:

\[
J_2 = \begin{pmatrix}
  -r & -aK \\
  0 & \epsilon aK - \mu
\end{pmatrix}
\]  

(6.25)

and the corresponding characteristic equation:

\[
(-r - \lambda)(\epsilon aK - \mu - \lambda) = 0
\]  

(6.26)

The dynamics in the neighborhood of the prey-only steady state is hence determined by two real-valued eigenvalues:

\[
\lambda_1 = -r
\]  

(6.27a)

\[
\lambda_2 = \epsilon aK - \mu
\]  

(6.27b)

As long as,

\[
K < K_c := \frac{\mu}{\epsilon a}
\]  

(6.28)

both eigenvalues are negative, which implies that the prey-only steady state is a stable node. If \(K\) is larger than the critical value of the prey carrying capacity \(K_c\), one of the eigenvalues \(\lambda_2\) becomes real, but positive, turning the prey-only steady state into a saddle point.

From equation (6.22) it can be seen that the critical carrying capacity \(K_c\) equals the prey abundance in the internal steady state. For \(K < K_c\) the internal steady state is biologically uninteresting, since the steady state predator abundance adopts a negative value for a prey carrying capacity that low (see eq. (6.22)). Only if \(K > K_c\) the predator abundance in the internal steady state is positive and is the steady state biologically relevant.

In other words, if the maximum prey abundance is lower than the abundance needed by the predator to survive (i.e. the steady-state abundance of prey), the internal steady state assumes negative and thus biologically uninteresting values. For these carrying capacity values the prey-only steady state is the only stable steady state, which is ultimately approached whatever the initial condition of the model. As soon as the internal steady state adopts positive and thus biologically relevant values, the prey-only steady state becomes a saddle point, which allows the predator population to establish itself.
For $K > K_c$ the Jacobian pertaining to the internal steady state evaluates to:

$$J_3 = \begin{pmatrix} -\frac{rF_3}{K} & -aF_3 \\ \frac{aF_3}{\epsilon aC_3} & 0 \end{pmatrix} = \begin{pmatrix} -\frac{r\mu}{\epsilon aK} & -\frac{\mu}{\epsilon} \\ \epsilon r \left(1 - \frac{\mu}{\epsilon aK}\right) & 0 \end{pmatrix}$$  \tag{6.29}

yielding the following characteristic equation:

$$-\lambda \left(-\frac{r\mu}{\epsilon aK} - \lambda\right) + r\mu \left(1 - \frac{\mu}{\epsilon aK}\right) = 0$$  \tag{6.30}

From the characteristic equation the eigenvalues pertaining to the internal steady state can be derived:

$$\lambda_1 = -\frac{1}{2} \frac{r\mu}{\epsilon aK} - \frac{1}{2} \sqrt{\left(\frac{r\mu}{\epsilon aK}\right)^2 - 4r\mu \left(1 - \frac{\mu}{\epsilon aK}\right)}$$  \tag{6.31a}

$$\lambda_2 = -\frac{1}{2} \frac{r\mu}{\epsilon aK} + \frac{1}{2} \sqrt{\left(\frac{r\mu}{\epsilon aK}\right)^2 - 4r\mu \left(1 - \frac{\mu}{\epsilon aK}\right)}$$  \tag{6.31b}

Let $\delta$ refer to the expression below the square root sign:

$$\delta := \left(\frac{r\mu}{\epsilon aK}\right)^2 - 4r\mu \left(1 - \frac{\mu}{\epsilon aK}\right)$$

$\delta$ is positive as long as

$$\frac{r}{\mu} \left(\frac{\mu}{\epsilon aK}\right)^2 + 4 \left(\frac{\mu}{\epsilon aK}\right) - 4 > 0$$

which can be simplified to:

$$\frac{\mu}{\epsilon aK} > 2 \frac{\mu}{r} \left(\sqrt{1 + \frac{r}{\mu}} - 1\right)$$  \tag{6.32}

or equivalently

$$K < K_s := \left(\frac{\mu}{\epsilon a}\right) \left(\frac{1}{2} + \frac{1}{2} \sqrt{1 + \frac{r}{\mu}}\right)$$  \tag{6.33}

$K_s$ is the critical value of the prey carrying capacity, below which the quantity $\delta$ is positive. A positive value of $\delta$ implies that the eigenvalues $\lambda_1$ and $\lambda_2$ are both real-valued. Moreover, because $K > K_c = \mu/(\epsilon a)$ the term

$$1 - \frac{\mu}{\epsilon aK}$$

is always positive as well, which implies that both eigenvalues $\lambda_1$ and $\lambda_2$ are real-valued, but negative. For $K < K_s$ the internal steady state is thus a stable node. On the other hand, if $K > K_s$ the quantity $\delta$ is negative, which implies that the two eigenvalues $\lambda_1$ and $\lambda_2$ constitute a complex pair. Their real part, however, is negative (see eq. (6.31)) which leads to the conclusion that for $K > K_s$ the internal steady state is a stable spiral.

The first term in parentheses in the expression for $K_s$ (eq. (6.33)) equals the prey abundance in the internal steady state, $F_3$, which is also equal to the critical carrying capacity $K_c$. The
6.1. THE LOTKA-VOLTERRA PREDATOR-PREY MODEL

![Figure 6.3](image)

**Figure 6.3**: Solution curves in the phase plane of the Lotka-Volterra predator-prey model with logistic prey growth. Two isoclines where \( \frac{dF}{dt} = 0 \) and \( \frac{dC}{dt} = 0 \) are drawn (the isoclines coinciding with the x- and y-axis have been omitted). The isoclines intersect in the internal steady state. **Top-left panel**: \( K = 0.15 \); the internal steady state is biologically irrelevant, the prey-only equilibrium is a stable node. **Top-right panel**: \( K = 0.3 \); the internal steady state is a stable node. **Bottom-left panel**: \( K = 1.0 \); the internal steady state is a stable spiral. **Bottom-right panel**: \( K = 10.0 \); the internal steady state is a stable spiral. Compare this last figure with Figure 6.1. Other parameter values: \( r = 0.5, a = 1.0, \epsilon = 0.5 \) and \( \mu = 0.1 \).

The second term in parentheses at least larger than 1 and increases with an increasing ratio \( r/\mu \). This leads to the following conclusions regarding the dynamics of the modified Lotka-Volterra model (6.17):

- For \( K < K_c \) the maximum prey abundance is insufficient to allow predators to persist. The internal steady state adopts negative and hence biologically irrelevant values. The prey-only equilibrium is a stable node.
- For \( K_c < K < K_s \) the internal steady state is biologically feasible and is a stable node. The prey-only equilibrium is a saddle point.
- For \( K > K_s \) the internal steady state is still the only biologically feasible and stable steady state, but is has become a stable spiral. Hence, the approach to the steady state is always
oscillatory.

Figure 6.3 shows solution curves in the \((F,C)\)-phase-plane for a number of different values of \(K\), illustrating the conclusions above. If \(K\) is large the approach to the internal steady state is oscillatory. Moreover, the larger the value of \(K\), the smaller the real part of the (complex) eigenvalues. For larger \(K\)-values the oscillations around the internal steady state therefore damp out more slowly.

With respect to the two important predictions that were derived from the basic Lotka-Volterra predator-prey model, the model with logistic prey growth does not change the prediction that steady-state prey abundances are completely controlled by life-history characteristics of the predator. However, incorporating a logistic prey growth stabilizes the internal steady state, such that oscillation are not to be expected any longer. Even for very larger values of the prey carrying capacity the internal steady state is ultimately approached, albeit slowly. The slightest amount of density dependence in the prey growth hence stabilizes the oscillations of the basic Lotka-Volterra model. Because a very small perturbation to the model structure (i.e. adding even a tiny amount of density dependence in prey growth) changes the neutral stability of the steady state and the neutrally stable oscillations, the basic Lotka-Volterra model is not considered structurally stable. Structural stability refers to the property of a model that a small change to its structure does not cause significant changes in its predictions.

### 6.1.2 Incorporating a predator type II functional response

Both the basic Lotka-Volterra predator-prey model and its variant with logistic prey growth assume that the total predation of prey equals

\[
aFC
\]

This assumption implies that the feeding rate of a single predator equals \(aF\), the product of the per-capita attack rate and the current prey abundance. Hence, according to this formulation predators never get satiated as they will eat more and more the more prey there are around: for infinitely large prey abundances the predator feeding rate will also become infinite. The amount of prey eaten by a single predator per unit of time is referred to as the predator’s functional response. The basic Lotka-Volterra assumes that the predator functional is a linear function of the prey abundance. This form is also known as a type I functional response:

\[
\phi_1(F) = aF
\]  

(6.34)

For larger values of the prey abundance this functional response is not very realistic, as predators get quickly satiated when prey availability is very high. Figure 6.4 shows examples for the waterflea \textit{Daphnia pulex} feeding on 3 different algal species. Even though there is substantial scatter between the measurements at each food concentration, these relations between feeding rates and food concentration show a uniform shape: at low food concentration the feeding rate increases rapidly, but levels off at higher food concentrations. Whether at high food densities the feeding rate remains at a constant, high level, continues to increase slowly or even decreases a bit is debatable, but the feeding rate certainly does not increase indefinitely.

A formulation of the predator’s functional response which accounts for the satiation of predators at high food densities is due to Holling (1959). This particular form of the functional response is referred to as Holling’s type II functional response or simply a type II functional response. The most mechanistic mathematical formulation of the type II functional response is:

\[
\phi_2(F) = \frac{aF}{1 + ahF}
\]  

(6.35)
6.1. THE LOTKA-VOLTERRA PREDATOR-PREY MODEL

Figure 6.4: Functional response of *Daphnia pulex* on three algal species. In spite of the different algal species and the scattering of the points the shape of the functional response as a function of food concentration is in principle uniform. (Vertical bars: 95% confidence limits of estimates). Source: Figure 2 in Lampert (1977)

in which the parameter \( a \) again denotes the rate at which a single predator searches for (i.e. attacks) prey whenever it is not currently consuming a prey item and the parameter \( h \) is the average time span a predator uses to consume a prey it has caught.

The type II functional response as presented by equation (6.35) can be derived as follows: Consider the number of prey items \( X \) that a single predator can catch and consume within a total period of time \( T \). Whenever the predator is searching for prey it is assumed to encounter new prey items at a rate \( aF \) just like the assumption in the basic Lotka-Volterra model. However, if the predator needs on average \( h \) time units to consume a prey item caught, it will only have \( T - hX \) time available to effectively search for new prey items. Therefore, the total number of prey items \( X \) caught by a single predator during a total time period \( T \) obeys the following equality:

\[
X = aF(T - hX) \quad (6.36)
\]

The total number of prey items caught \( X \) can be solved from this equality as:

\[
X = \frac{aF}{1 + ahF} T
\]

The type II functional response (eq. (6.35)) represents the rate at which the predator consumes prey items (i.e. the quotient \( X/T \)), given that the predator needs on average \( h \) time units to handle each single item. The type II functional response is hence based on the assumption that at very high prey densities predators become limited by their handling time \( h \). Indeed, for \( F \rightarrow \infty \) the limit of the functional response equals the inverse of the handling time, \( \phi_2(F) \rightarrow 1/h \). Although the derivation presented here is based on an argument that the predator needs some
non-negligible amount of time to physically consume a caught prey item, the same mathematical relationship for the functional response can be derived by considering the digestion of consumed prey items the limiting step in the feeding process. For examples of such a derivation we refer to [Metz & Diekmann 1986] and [Claessen et al. 2000].

The Holling type II functional response is mathematically identical to the Michaelis-Menten equation that was used to model the nutrient uptake by bacteria, which was used in Tilman’s competition model \(4.35\). The form of the Michaelis-Menten equation was already presented in Figure 4.8. Indeed, Holling’s type II functional response is also often presented in the following form:

\[
\phi_2(F) = \frac{F}{F_h + F}
\]  

(6.37)
in which the parameter \(I_m\) represents the maximum predator ingestion rate and the parameter \(F_h\) represents the prey density at which the predator realizes 50% of its maximum food intake. This representation of the type II functional response is completely analogous with the Michaelis-Menten function

\[
\frac{\mu R}{K + R}
\]

which was used to model nutrient uptake in Tilman’s competition model \(4.35\). The two representations of the type II functional response are identical given the parameter equivalences:

\[I_m = \frac{1}{h}\]

and

\[F_h = \frac{1}{ah}\]

The derivation of the type II functional response given above uses the time budget of the predator to determine its net rate of prey consumption. Such a derivation is not easily extendable to more complicated cases, where the predator is also involved in some other activities. For example, if one wants to derive the formulation of a predator’s type II functional response in case the predators next to catching and consuming prey also interfere with each other during the searching process, a time budget analysis is not feasible any longer. In these cases the functional response can be derived by formulating and analyzing a behavioral model that describes the changes in the predators state (i.e. whether it is feeding or consuming) on a short time scale. Here I illustrate this alternative procedure for the type II functional response derived above.

Consider that a predator can be in two behavioral state: it is either actively searching for prey (state \(S\)) or it is consuming a prey item it has just caught (state \(H\)). Let the probability that the predator is in state \(S\) be given by \(P_s\) and the corresponding probability that the predator is in state \(H\) by \(P_h\). On a short time scale we can assume that the prey abundance \(F\) does not change significantly. If predators encounter prey at a rate \(aF\) whenever they are busy searching for it, the probability that a predator individual is actively searching decreases at a rate \(-aFP_s\). Similarly, when predators are busy consuming a caught prey item and they need on average \(h\) time units to consume a prey item, the probability that a predator individual is actively searching increases at a rate \(\frac{P_h}{h}\) (note that \(h\) is a time and hence \(1/h\) represents a rate). Altogether the changes on a short time scale in the probability that a predator is actively searching, \(P_s\), can be described by the following ODE:

\[
\frac{dP_s}{dt} = -aFP_s + \frac{P_h}{h}
\]

Because we assume predators are either searching or handling

\[P_s + P_h = 1\]
6.1. THE LOTKA-VOLTERRA PREDATOR-PREY MODEL

the ODE can be rewritten as

\[ \frac{dP_s}{dt} = -aFP_s + \frac{1 - P_s}{h} \]

This behavioral model for the probability \( P_s \) that a predator is in the searching state \( S \) leads to a steady state value for \( P_s \) given by:

\[ \overline{P}_s = \frac{1}{1 + ahF} \]

Next we assume that the changes in the predator’s state (searching or consuming) are so rapid that on the population dynamical time scale which is relevant for births and deaths of predators, \( P_s \) is approximately equal to its steady state value \( \overline{P}_s \). This assumption is called the pseudo-steady-state assumption. As a consequence, in the population dynamic model we must take into account that the probability that a single predator is actively searching for prey equals \( \overline{P}_s \) and hence that its net rate of food intake equals

\[ aF \overline{P}_s = \frac{aF}{1 + ahF} \]

Again, we end up with the same formulation of the type II functional response as was derived before. The alternative derivation using a model for the changes in behavioral state of the predator seems more complicated than the time budget analysis used at first. Its advantage is that it can also be applied if the predator can be in other behavioral states than just searching or consuming. [Ruxton et al. (1992)] have successfully used the behavioral model approach, for example, to derive various forms of the functional response in case predators waste time fighting with each other over food items. Such derivations are not possible using a time budget analysis.

The predator-prey model that accounts for both logistic prey growth and a predator type II (or satiating) functional response can now be represented by the following system of ODEs:

\[ \frac{dF}{dt} = rF \left( 1 - \frac{F}{K} \right) - \frac{aF}{1 + ahF}C \]

(6.38a)

\[ \frac{dC}{dt} = \epsilon \frac{aF}{1 + ahF}C - \mu C \]

(6.38b)

This model is also referred to as the Rosenzweig-MacArthur model after two authors that have investigated the dynamics of this model in great detail (see, for example, [Rosenzweig (1971)]).

The nullclines where \( dF/dt = 0 \) for the Rosenzweig-MacArthur, predator-prey model are given by:

\[ F = 0 \quad \text{and} \quad C = \frac{r}{a} \left( 1 - \frac{F}{K} \right) (1 + ahF) \]

(6.39)

while the nullclines where \( dC/dt = 0 \) are given by:

\[ C = 0 \quad \text{and} \quad F = \frac{\mu}{a(\epsilon - \mu h)} \]

(6.40)

Disregarding the two trivial nullclines \( F = 0 \) and \( C = 0 \), respectively, these expressions for the nullclines of the model indicate that the nullcline where \( dC/dt = 0 \) constitutes a vertical line in the \((F,C)\)-phase-plane, as was the case for the two predator-prey models discussed before. On the other hand, the non-trivial nullcline where \( dF/dt = 0 \), described by the relationship:

\[ C := H(F) = \frac{r}{a} \left( 1 - \frac{F}{K} \right) (1 + ahF) \]

(6.41)
CHAPTER 6. PREDATOR-PREY INTERACTIONS

Figure 6.5: Nullclines of the Rosenzweig-MacArthur, predator-prey model. Two isoclines where $dF/dt = 0$ (solid curves) and $dC/dt = 0$ (dashed curve) are drawn (the isoclines coinciding with the x- and y-axis have been omitted) for 4 different values of the prey carrying capacity $K$. The isoclines where $dF/dt = 0$ have increasing values of $K$ from the left- to the right-most curve. Closed circles: Stable nodes; Open circles: Saddle points; Closed triangles: Stable spirals; Open triangles: Unstable spirals.

is a quadratic function $H(F)$ of the prey abundance $F$. The function $H(F)$ adopts the value $r/a$ for $F = 0$. Therefore, at negligible prey densities, the isocline has the same value of $C$ as for the basic Lotka-Volterra model and the model with logistic prey growth (see eq. (6.2) and eq. (6.19)). The top of the parabola $H(F)$ occurs at

$$F = F_m := \frac{1}{2} \left( K - \frac{1}{ah} \right) \tag{6.42}$$

As long as

$$K < \frac{1}{ah}$$

the function $H(F)$ is therefore strictly decreasing for positive prey abundances $F$. It is obvious that $H(F)$ becomes zero when the prey abundance equals its carrying capacity, i.e. when $F = K$. Figure 6.5 illustrates the shape of these isoclines in the $(F, C)$-phase-plane for 4 different values of the prey carrying capacity $K$. Notice that the intersections of the nullclines represent the steady states of the model, whose stability will be considered next.

The nullclines imply that the Rosenzweig-MacArthur model possesses three steady states as was the case for the Lotka-Volterra model with logistic growth. First of all, the trivial steady state:

$$(\overline{F}_1, \overline{C}_1) = (0, 0) \tag{6.43}$$
6.1. THE LOTKA-VOLTERRA PREDATOR-PREY MODEL

a prey-only steady state:

$$(F_2, C_2) = (K, 0)$$  \hspace{1cm} (6.44)

and the internal steady state

$$(F_3, C_3) = \left( \frac{\mu}{a(\epsilon - \mu h)}, \frac{\epsilon r (aK(\epsilon - \mu h) - \mu)}{a^2 (\epsilon - \mu h)^2 K} \right).$$  \hspace{1cm} (6.45)

The prey abundance in the internal steady state is again completely determined by the parameters, i.e. the life-history characteristics, which pertain to the predator, while the predator abundance is determined by parameters, i.e. life-history characteristics, of both predator and prey.

The Jacobian matrix with partial derivatives of the Rosenzweig-MacArthur model is given by:

$$J = \begin{pmatrix}
  r - \frac{2rF}{K} - \frac{a}{(1 + ahF)^2} C & -\frac{aF}{1 + ahF} \\
  \frac{\epsilon a}{(1 + ahF)^2} C & \frac{\epsilon aF}{1 + ahF} - \mu
\end{pmatrix}$$  \hspace{1cm} (6.46)

Evaluated at the trivial steady state, this yields the same Jacobian as for the basic Lotka-Volterra model (6.1) (cf. equation (6.7)):

$$J_1 = \begin{pmatrix}
  r & 0 \\
  0 & -\mu
\end{pmatrix}$$  \hspace{1cm} (6.47)

The dynamic properties of the trivial steady state are therefore not affected by adopting a type II predator functional response: the trivial steady state is again a saddle point for all values of the parameters, which is stable against perturbations in the predator density, but unstable against perturbations in the prey density (see the discussion following equation (6.7)).

For the prey-only steady state this Jacobian evaluates to:

$$J_2 = \begin{pmatrix}
  -r & -\frac{aK}{1 + ahK} \\
  0 & \frac{aK}{1 + ahK} - \mu
\end{pmatrix}$$  \hspace{1cm} (6.48)

and the corresponding characteristic equation:

$$(-r - \lambda) \left( \frac{\epsilon aK}{1 + ahK} - \mu - \lambda \right) = 0$$  \hspace{1cm} (6.49)

The dynamics in the neighborhood of the prey-only steady state is hence determined by two real-valued eigenvalues, as was the case for the Lotka-Volterra model with logistic prey growth (cf. eq. (6.27)):

$$\lambda_1 = -r$$  \hspace{1cm} (6.50a)

$$\lambda_2 = \epsilon \frac{aK}{1 + ahK} - \mu$$  \hspace{1cm} (6.50b)

From these expressions it is easy to see that there is again a critical value of prey carrying capacity $K_c$, which equals the prey abundance in the internal steady state (cf. eq. (6.28)):

$$K_c = F_3 = \frac{\mu}{a(\epsilon - \mu h)}$$  \hspace{1cm} (6.51)
For \( K < K_c \) both eigenvalues are negative, which implies that the prey-only steady state is a stable node. If \( K \) is larger than the critical value of the prey carrying capacity \( K_c \), one of the eigenvalues (\( \lambda_2 \)) becomes real, but positive, turning the prey-only steady state into a saddle point. As before, for \( K < K_c \) the internal steady state is biologically uninteresting, since the steady state predator abundance adopts a negative value for a prey carrying capacity that low (see eq. (6.42)). Only if \( K > K_c \) the predator abundance in the internal steady state is positive and is the steady state biologically relevant. In other words, if the maximum prey abundance is lower than the abundance needed by the predator to survive (i.e. the steady-state abundance of prey), the internal steady state assumes negative and thus biologically uninteresting values.

For these carrying capacity values the prey-only steady state is the only stable steady state, which is ultimately approached whatever the initial condition of the model. These conclusions are completely analogous to the conclusions held for the Lotka-Volterra model with logistic prey growth (see the discussion following eq. (6.28) on page 105).

By substituting \( F = F_3 \) and \( C = C_3 \) in the Jacobian matrix (6.46), the Jacobian of the internal steady state evaluates for \( K > K_c \) to:

\[
J_3 = \begin{pmatrix}
\frac{\mu h}{\epsilon} + \frac{\mu}{aK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} & -\frac{\mu}{\epsilon} \\
\frac{r(\epsilon - \mu h - \frac{\mu}{aK})}{\epsilon} & \frac{r}{\epsilon} \left( \frac{\epsilon}{\epsilon - \mu h} \right)
\end{pmatrix}
\] (6.52)

This leads to the following characteristic equation:

\[
\lambda^2 - \frac{\epsilon}{\epsilon - \mu h} \left( \frac{\epsilon}{\epsilon - \mu h} \right)^2 + \lambda + \frac{r\mu}{\epsilon} \left( \epsilon - \mu h - \frac{\mu}{aK} \right) = 0
\] (6.53)

The two eigenvalues pertaining to the internal steady state can hence be represented as:

\[
\lambda_1 = \frac{1}{2} \left( \frac{\mu h}{\epsilon} + \frac{\mu}{aK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} \right) + \frac{1}{2} \sqrt{\delta}
\] (6.54a)

\[
\lambda_2 = \frac{1}{2} \left( \frac{\mu h}{\epsilon} + \frac{\mu}{aK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} \right) - \frac{1}{2} \sqrt{\delta}
\] (6.54b)

where the quantity \( \delta \) is defined as:

\[
\delta := \left( \frac{\mu h}{\epsilon} + \frac{\mu}{aK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} \right)^2 - 4 \frac{r\mu}{\epsilon} \left( \epsilon - \mu h - \frac{\mu}{aK} \right)
\] (6.55)

Since we only consider cases where \( K > K_c \) (see eq. (6.51)), it follows that

\[
\left( \epsilon - \mu h - \frac{\mu}{aK} \right)
\]

is positive and consequently that

\[
\delta < r^2 \left( \frac{\mu h}{\epsilon} + \frac{\mu}{aK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} \right)^2
\] (6.56)
6.1. THE LOTKA-VOLTERRA PREDATOR-PREY MODEL

From the expressions (6.54) for the eigenvalues \( \lambda_1 \) and \( \lambda_2 \) it can now be inferred that the stability of the internal steady state is entirely determined by the sign of the expression

\[
r \left( \frac{\mu h}{\epsilon} + \frac{\mu}{eaK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} \right)
\]  

(6.57)

If this expression is negative and the quantity \( \delta \) is positive, both eigenvalues \( \lambda_1 \) and \( \lambda_2 \) are real-valued but negative, since

\[
\sqrt{\delta} < r \left( \frac{\mu h}{\epsilon} + \frac{\mu}{eaK} - 2 \frac{\mu}{aK(\epsilon - \mu h)} \right)
\]

(refer to inequality (6.56)). In this case the internal steady state is a stable node.

If, on the other hand, the quantity in expression (6.57) is negative and the quantity \( \delta \) is negative as well, both eigenvalues \( \lambda_1 \) and \( \lambda_2 \) form a complex, conjugate pair with negative real part. The internal steady state is then a stable spiral.

However, if the quantity in equation (6.57) changes from negative to positive, it is certain that \( \delta \) is negative (at least initially; see the definition of \( \delta \) in equation (6.55)). In this case, both eigenvalues \( \lambda_1 \) and \( \lambda_2 \) form again a complex, conjugate pair with a real part that now turns from negative to positive. The internal steady state therefore changes from a stable spiral point into an unstable spiral point. This change in stability occurs when the carrying capacity \( K \) becomes larger than the critical value \( K_s \), defined as:

\[
K_s := \frac{\epsilon + \mu h}{ah(\epsilon - \mu h)} = \frac{1}{ah} + 2 \frac{\mu}{a(\epsilon - \mu h)} = \frac{1}{ah} + 2 F_3
\]

(6.58)

In other words, the change in stability occurs when \( F_3 \) becomes smaller than

\[
\frac{1}{2} \left( K - \frac{1}{ah} \right)
\]

which is exactly equal to the prey abundance \( F \) at which the prey isocline \( H(F) \) reaches its maximum (refer to eq. (6.42)). In the context of the location and the shape of the isoclines of the model, this implies that the internal steady state changes from a stable to an unstable spiral point, when the (vertical) predator isocline moves from a location to the right of the top in the (quadratic) prey isocline to a location to the left of this maximum (see Figure 6.5).

Figure 6.6 illustrates the series of changes in dynamics that occur for increasing values of the carrying capacity \( K \):

- For \( K < K_c \) (Fig. 6.6; top-left panel) the internal steady state is biologically irrelevant, as the predator abundance in steady state would be negative (see eq. (6.45)). The prey carrying capacity is below the abundance needed by the predator to sustain itself.

- For \( K_c < K < K_s \) (Fig. 6.6; top-right panel) and \( K \) only slightly larger than \( K_c \) the internal steady state is a stable node. From every initial condition it is approached smoothly, i.e. in a non-oscillatory fashion.

- For larger \( K \), but still \( K < K_s \) (Fig. 6.6; bottom-left panel) the internal steady state turns into a stable spiral and is approached from any initial condition in an oscillatory manner.

- For \( K > K_s \) (Fig. 6.6; bottom-right panel) the internal steady state has become an unstable spiral. Starting from an initial condition close to the steady state, the trajectory spirals away from the steady state and approaches a stable limit cycle surrounding the steady
CHAPTER 6. PREDATOR-PREY INTERACTIONS

Figure 6.6: Solution curves in the phase plane of the Rosenzweig-MacArthur predator-prey model. Two isoclines where $dF/dt = 0$ (dashed line) and $dC/dt = 0$ (dotted line) are drawn (the isoclines coinciding with the $x$- and $y$-axis have been omitted). The isoclines intersect in the internal steady state. Top-left panel: $K = 0.08$; the internal steady state is biologically irrelevant, the prey-only equilibrium is a stable node. Top-right panel: $K = 0.15$; the internal steady state is a stable node. Bottom-left panel: $K = 0.25$; the internal steady state is a stable spiral. Bottom-right panel: $K = 0.3$; the internal steady state is an unstable spiral. In this latter figure two trajectories are drawn: one starting close to the unstable steady state, the other starting far away from it. Both approach the unique limit cycle (thick solid line). Other parameter values: $r = 0.5$, $a = 5.0$, $h = 3.0$, $\epsilon = 0.5$ and $\mu = 0.1$.

state. This stable limit cycle arises when the steady state changes from a stable into an unstable spiral. From all initial conditions the trajectories eventually approach this stable limit cycle. Hence, when an initial condition outside the limit cycle is chosen, the trajectory spirals inwardly towards the limit cycle (as shown in Fig. 6.6). The limit cycle itself is invariant, which means that if an initial state is chosen exactly on the limit cycle, the state of the system would return to exactly this initial state again after going through exactly one period of oscillation. With $K$ becoming larger and larger, the amplitude of the limit cycle grows very rapidly, such that eventually it passes very close to both the $x$- and the $y$-axis of the phase plane (not shown).
6.2. CONFRONTING MODELS AND EXPERIMENTS

Figure 6.7: Solution curve in the phase plane of the Rosenzweig-MacArthur predator-prey model for high carrying capacity. As Figure 6.6 but for $K = 0.6$. Other parameter values: $r = 0.5$, $a = 5.0$, $h = 3.0$, $\epsilon = 0.5$ and $\mu = 0.1$. Note that the scales have been doubled as compared to Fig. 6.6.

It is possible to determine exactly for which value of $K$ with $K_c < K < K_s$ the internal steady state changes from a stable node into a stable spiral from the equality

$$\delta = 0$$

(see eq. (6.55)). However, the resulting expression for $K$ is rather complicated and does not give any particular insight. Its derivation has therefore been omitted here. The analysis would show that eventually for very large values of $K > K_s$ the two eigenvalues $\lambda_1$ and $\lambda_2$ would both become real-valued once again. From equation (6.54) it is clear that $\lambda_1$ and $\lambda_2$ are then both positive. For very large values of $K > K_s$ the internal steady state thus becomes an unstable node or source. This change in character of the steady state is not very relevant, though, since it was already an unstable spiral point, surrounded by a stable limit cycle. The change only implies that with a initial state close to the steady state the trajectory will not spiral away from the steady state, but move away smoothly from the steady state to finally approach the stable limit cycle.

6.2 Confronting models and experiments

All three predator-prey models discussed above predict that in a steady state where both prey and predators coexist, the prey abundance is completely determined by the parameters, i.e. life-history characteristics, of the predator. In other words, even if the environment is richer in nutrients, leading to a higher growth potential (i.e. productivity) of the prey, the prey does not benefit from this enrichment. On the contrary, it is the predator that benefits as its abundance should increase sufficiently to counter the increased productivity of the prey. In conclusion, the predator-prey models of the Lotka-Volterra type predict that predators completely control the steady state abundance of their prey at a constant level and that increases in prey productivity
lead to a higher predator abundance. This prediction is the first one that will be confronted with empirical and experimental observations below.

A second prediction of the predator-prey models discussed pertains to the occurrence of limit cycles in predator and prey abundance. The basic Lotka-Volterra model predicts that abundances should always cycle, while the Rosenzweig-MacArthur model predicts that stable cycles in abundance should occur at higher levels of prey productivity (i.e. higher carrying capacities of the prey). A higher value of the prey carrying capacity can be thought of as representing a natural environment that is richer in basic nutrients. The phenomenon that with increasing values of the prey carrying capacity a predator-prey system would change from approaching a stable steady state to displaying limit cycles in abundance with rapidly increasing amplitude the larger the value of the carrying capacity $K$, has been called the Paradox-of-Enrichment by Rosenzweig (1971). Rosenzweig (1971) argued that intuitively a natural environment that is richer in nutrients is expected to be less prone to extinction of one of its species. However, with very large values of the prey carrying capacity $K$ the Rosenzweig-MacArthur model exhibits large-amplitude limit cycles in which the predator and especially the prey abundance passes through values close to 0 (see Fig. 6.7). The slightest perturbation in these phases of very low densities may cause the prey to go extinct, subsequently leading to the extinction of the predator as well. In this way the Rosenzweig-MacArthur model predicts that environments richer in nutrients may actually be more prone to species extinction, in contrast to the intuitive expectation.

Figure 6.8 shows that the resulting oscillations in prey and predator density also have a characteristic pattern: the maxima and minima in predator abundance are always delayed as compared to the maxima and minima in prey abundance. This phenomenon is referred to as a phase shift between the oscillations in abundance of the two populations. Characteristically, the phase shift between prey and predator abundance is roughly $1/4$ of the cycle period in the Rosenzweig-MacArthur model (see Fig. 6.8).
6.2. CONFRONTING MODELS AND EXPERIMENTS

The ubiquity of cyclic dynamics in predator-prey models has drawn a lot of attention and has led to a large body of scientific research focusing on the question whether these cycles also occur in natural systems and if not, which mechanisms are responsible for this lack of occurrence. Here, I will discuss some empirical evidence, showing that the model prediction is in principle correct, but that the cyclic dynamics are often countered by many different mechanisms. The empirical evidence that will be used in the following discussion mainly relates to observations on species of the genus *Daphnia* (Cladocera; see Fig. 6.9). Daphnids or waterfleas, as they are more commonly known, have been used extensively in population dynamical studies for a variety of reasons. First of all, waterfleas often occupy an important position in freshwater foodwebs, as they are the main consumers of the algal primary producers. In addition, daphnids can be easily kept in the laboratory and through their short generation time lend themselves quite well for population dynamical experiments. Last but not least, daphnids have been the subject of many modeling studies, both to formulate models of individual physiology and life-history and for the derivation of population dynamic models. Therefore, daphnids are probably the best studied organism when it comes to population dynamics.

6.2.1 Predator-controlled, steady state abundance of prey

An elegant test of the prediction that steady state prey abundances are completely controlled by the predator life-history has been carried out by Arditi et al. (1991). Arditi et al. (1991) cultured several species of *Daphnia* and related organisms in semi-chemostat type culture vessels that were arranged in a serial order (see Figure 6.10). The first culture vessel was fed with a stock solution with a high algal concentration. All following vessels were fed with the outflow of the preceding culture vessel. At the start of the experiments, initial populations were established whereby culture vessels towards the end of the chain started out with lower abundances. The development of the populations in the various vessels in the chain were subsequently monitored. Several species of cladocerans, among which were two waterflea species *Daphnia magna* and *Ceriodaphnia reticulata*, were tested in this experimental setup.

Without explicitly writing down a model for the dynamics of the populations in the chain of culture vessels, the results obtained in the previous section are sufficient to formulate a prediction about the outcome of the experiments. In section 6.1.1 and 6.1.2 it was shown that a steady state in which both prey and predator coexist is only possible if the maximum prey abundance in the absence of any predators (i.e. the prey carrying capacity) is larger than the prey abundance in the internal steady state. For the Lotka-Volterra model with logistic prey growth and for

*Figure 6.9: Daphnia pulex* carrying asexual eggs in the brood pouch.
Figure 6.10: Schematic setup of the experiments by Arditi et al. (1991). Populations of *Daphnia* and some related species are cultured in semi-chemostat type culture vessels that are arranged in a serial order. The outflow of the culture vessels is only open to algae. Only the first vessel in the chain is fed by a stock solution with high algal density. All following vessels are fed by the outflow of the previous vessel.

In the Rosenzweig-MacArthur model it was derived that the internal steady state only adopted biologically meaningful (i.e. positive) values, iff

\[ K > K_c := F_3 \]

(see eq. (6.28) and (6.51)). In the experiments of Arditi et al. (1991) the prey growth is not logistic but follows a semi-chemostat growth equation (see eq. (4.9)). Nonetheless, the same model prediction holds: only if the maximum prey abundance is larger than the prey abundance in the internal steady state, a population of predators can persist. The maximum prey abundance in a semi-chemostat culture vessel is obviously equal to the abundance in the inflow. If the prey abundance in steady state \( F_3 \) is indeed completely controlled by the life-history parameters of the predators only the first culture vessel in the series will be subject to a prey inflow that is larger than the steady state prey abundance. The inflow of the second vessel in the chain is coupled to the outflow of the first, in which the prey abundance equals the predator-controlled steady state value \( F_3 \). Therefore, if the model prediction holds that the prey abundance in steady state is controlled by the predator at its subsistence level, only the predator population in the first culture vessel in the chain can survive, as the other vessels are subject to a prey inflow that equals the predator subsistence level \( F_3 \) and is hence not sufficient for the establishment of a predator population.

A more formal analysis involves writing down a coupled system of ODEs for the algal and daphnid populations in each culture vessel. Since daphnids tend to feed on algae following a type II functional response (see Fig. 6.3) this set of equations is very similar to Tilman’s
6.2. CONFRONTING MODELS AND EXPERIMENTS

More specifically, the dynamics of algae and daphnids in compartment $n$ can be described by:

$$\frac{dF_n}{dt} = D (I_n - F_n) - \frac{aF_n}{1 + ahF_n} C_n$$  \hspace{1cm} (6.59a)

$$\frac{dC_n}{dt} = \epsilon \frac{aF_n}{1 + ahF_n} C_n - \mu C_n$$  \hspace{1cm} (6.59b)

in which $D$ is the flow-through rate, $I_n$ refers to the algal abundance in the inflow of compartment $n$, $F_n$ and $C_n$ represent he algal and daphnid abundance in this compartment and the parameters $a$, $h$, $\epsilon$ and $\mu$ have the same interpretation as in the Rosenzweig-MacArthur model. Obviously, the internal steady state predicted by the model obeys:

$$F_n = F := \frac{\mu}{a(\epsilon - \mu h)}$$  \hspace{1cm} (6.60a)

$$C_n = \frac{\epsilon}{\mu} D (I_n - F)$$  \hspace{1cm} (6.60b)

Since for $n > 1$ the inflow $I_n$ is the outflow of the previous compartment, which equals $F$, it is clear that in all culture vessels except the first, persistence of the daphnid populations is not possible.

Figure 6.11 and 6.12 show the experimental results that Arditi et al. (1991) obtained: Clearly all populations of *Daphnia magna* in culture vessel 2 and higher go extinct. The same result holds for *Ceriodaphnia reticulata*, although here the extinction of these populations takes much longer. *Daphnia magna* is a much larger and more voracious filter-feeder on algae than *Ceriodaphnia reticulata*, which may explain the difference in transient time. Nonetheless, the experimental results fit the predictions of the predator-prey models quite well. Arditi et al. (1991) also obtained results for *Scapholeberis kingi*, a cladoceran species closely related to *Daphnia*, that did not fit the model predictions at all: predator populations persisted in all compartments in the chain. This species differed, however, in one important aspect from *Daphnia* in that the organisms tend to be surface-dwelling. Hence, the predator-prey models discussed in this chapter might not apply to these species, as they are based on an assumption that both the predator and the prey live in a homogeneous, well-mixed environment.

Murdoch et al. (1998) provide another test of the prediction that the prey abundance at steady state is completely controlled by the life-history parameters of the predator and not affected by the prey growth capacity. Murdoch et al. (1998) analyzed a number of datasets documenting the dynamics of *Daphnia* species in experimental tanks, ponds and lakes. Only those data sets were included for which it was ascertained that fish predation was either absent or could be corrected for. Moreover, only data sets for which there was complete information on the assemblage of algal species found in the studied system were included. *Daphnia* does not eat and is actually hampered in its feeding behavior by the presence of larger, inedible species of algae. The precise information on the algal assemblage made it possible that an accurate estimate was derived for the abundance of *Daphnia’s* prey, i.e. the edible algal species.

Figure 6.13 shows that over a large range of nutrient levels the mean abundance of edible algae in the presence of *Daphnia* remains relatively constant. The nutrient level of the system was estimated from the maximum algal abundance observed in the lake or pond during the spring algal bloom, a short period of time in the beginning of the year when the algae are not controlled.
by zooplankton yet. This estimate can hence be interpreted as an estimate of the carrying capacity of the algae. A Rosenzweig-MacArthur model for the interaction between *Daphnia* and algae had been derived previously (Nisbet et al. 1991). The parameters of this model were estimated on the basis of independent, mostly laboratory experiments. Hence, the model provided a completely independent estimate of the expected algal abundance in equilibrium, amounting to 0.05 mg C/L (prey abundance was consistently expressed as biomass in terms of amount of carbon). This estimate fits the observed algal densities reasonably well. A careful analysis of the data on *Daphnia* and its algal prey thus shows that the observations agree with the hypothesis that prey abundances in steady state are completely controlled and depend on the life-history parameters of the predator. Notice that this assessment only holds true after some complicating mechanisms, such as different levels of fish predation and the presence of inedible algae, have been corrected for. In other words, even though the model conclusion of a predator-controlled prey abundance in steady state in principle holds true, it may often be

*Figure 6.11:* Population dynamics of *Daphnia*, *Ceriodaphnia* and *Scapholeberis* in a chain of semi-chemostats. Population dynamics (log scale) of the three species in each chamber. Dotted lines denote extinctions. From the chosen initial conditions, equilibria were reached rapidly and without oscillations. In (a) and (b), extinct chambers were re-inoculated every week but became extinct again (data not shown). Source: Figure 2 in Arditi et al. (1991).
6.2. CONFRONTING MODELS AND EXPERIMENTS

6.2.1 Population equilibria of Daphnia and Ceriodaphnia in a chain of semi-chemostats.

Figure 6.12: Population equilibria of Daphnia and Ceriodaphnia in a chain of semi-chemostats. Populations declined to extinction in all compartments beyond the first one, in agreement with model predictions of the Lotka-Volterra type. Each point is the average of four values (last two weeks of two replicates). Source: Figure 3 in Arditi et al. (1991).

observed by mechanisms that are not accounted for in the basic model.

6.2.2 Oscillatory dynamics at high prey carrying capacities

The Rosenzweig-MacArthur model predicts that with increasing prey carrying capacity oscillatory dynamics are more likely to occur. The question whether cycles in population abundance also occur in natural populations has been a topic of many ecological studies. The dynamics of the snowshoe hare and the lynx population in northern Canada (see Figure 6.14) has been often cited as a classical example of cycles in population abundance in a predator-prey system. The data on these two species constitute one of the longest time series in ecology. The basis of this dataset are the fur trading records of the Hudson Bay Company in northern Canada. However, despite the fluctuations in the number of hare and lynx furs that the Hudson Bay Company bought up from trappers each year, the cycles do not have the characteristics of a predator-prey cycle. Figure 6.14 shows clearly that a phase shift between the predator and prey abundances, as is typical for the Rosenzweig-MacArthur model (see Fig. 6.8) is hard to detect in the data on hare and lynx. Indeed, Gilpin (1973) has shown that when the dynamics are represented in the phaseplane, the trajectory does not spiral in the direction that is typical for a predator-prey model (see, for example, Fig. 6.7).

Another system that has often been the focus of studies on population cycles, are the microtine rodent (vole and lemming) populations in northern Europe (see Fig. 6.15). Microtine rodent populations in Scandinavia have exhibited frequent population cycles with huge differences in abundance from year to year, which have not only captured the imagination of ecologists, but
**Figure 6.13:** Predicted and observed equilibrium values of algae in the presence of *Daphnia*. Only edible algae have been included in these estimates. Over a ten-fold range of nutrient levels, as expressed by the edible algal carrying capacity $K$, the observed algal abundance in steady state is relatively constant. The solid line indicates the prediction of an independently parameterized, Rosenzweig-MacArthur model. Source: Figure 7 in Murdoch et al. (1998).

also of the general public. Turchin et al. (2000) have argued convincingly that the cycles in abundance in voles are predator-prey cycles, in which the vole are the prey of their specialized predator, the weasel. However, data on fluctuations in abundance of the weasel are generally not available, hence it is not possible to compare the cycle characteristics with those of the limit cycles predicted by the Rosenzweig-MacArthur model.

The fluctuations in abundance of *Daphnia* and algae is a third system that has been used to study the occurrence of cyclic dynamics predicted by the Rosenzweig-MacArthur model. McCauley & Murdoch (1990) noted that over a wide range of nutrient levels, the amplitude in the fluctuations in *Daphnia* and algae does not increase with nutrient level (see Fig. 6.16). The Rosenzweig-MacArthur model predicts that with increasing prey carrying capacity $K$ both the amplitude in the predator-prey cycles and the period of the cycles increase. Neither of these two increases were distinguishable in the dataset collated by McCauley & Murdoch (1990). In addition, McCauley & Murdoch (1990) set up experiments in stock tanks in which they studied the dynamics of *Daphnia* and algae under nutrient-rich and nutrient-poor conditions. The nutrient-rich conditions had an estimated algal carrying capacity that was 10 times higher as in the nutrient-poor conditions. Under nutrient-rich conditions, the average biomass of *Daphnia* was significantly higher than under nutrient-poor conditions. However, when corrected for this increase in average biomass, no increase in cycle amplitude could be observed between the two sets of systems (see Fig. 6.17). Hence, even though cycles are observed in *Daphnia* and algae there seems no evidence that the cycles are of the predator-prey type predicted by the Rosenzweig-MacArthur model, since neither cycle amplitude nor cycle period tend to increase with increasing algal carrying capacity. McCauley & Murdoch (1990) argued that the cycles that are observed in *Daphnia* are caused by the delay between the birth of an individual waterflea
6.2. CONFRONTING MODELS AND EXPERIMENTS

Figure 6.14: Population dynamics of the snowshoe hare and the lynx in northern Canada. *Squares with solid line:* snowshoe hare abundance; *Triangles with dotted line:* lynx abundance. Data are partially derived from the fur trading records kept by the Hudson Bay Company. Source: NERC Centre for Population Biology, Imperial College (1999), The Global Population Dynamics Database, [http://www.sw.ic.ac.uk/cpb/cpb/gpdd.html](http://www.sw.ic.ac.uk/cpb/cpb/gpdd.html).

Figure 6.15: Population dynamics of two species of voles in northern Finland. *Squares with solid line:* Grey-sided vole (*Clethrionomys rufocanus*); *Triangles with dotted line:* Common vole (*Microtus*). Both species constitute important prey species for weasels. Source: NERC Centre for Population Biology, Imperial College (1999), The Global Population Dynamics Database, [http://www.sw.ic.ac.uk/cpb/cpb/gpdd.html](http://www.sw.ic.ac.uk/cpb/cpb/gpdd.html).
and the onset of its reproduction, since the cycle period was consistently close to the duration of the juvenile period.

The experiments by McCauley & Murdoch (1990) suffered from a complicated factor, though, in that in the experimental tanks also significant densities of inedible algae were present. As mentioned before, these algae are not only inedible for Daphnia, but they also interfere with the foraging of Daphnia on edible algae. Because this interference may lead to a reduced attack rate of Daphnia on edible algae and hence to stable dynamics, McCauley & Murdoch (1990) suggested that the presence of inedible algae was a potential mechanism explaining the absence of predator-prey cycles in Daphnia. This explanation has been tested more recently by McCauley et al. (1999) using similar studies with laboratory populations of Daphnia in experimental tanks. McCauley et al. (1999) avoided the interference of inedible algae by preventing any algae to grow on the walls of the tanks. These walls are thought to be the main spot in the tanks where large-bodied, inedible algae can establish themselves. Indeed, the experimental control of inedible algae led to the occurrence of large-amplitude, predator-prey cycles that resemble the dynamics exhibited by the Rosenzweig-MacArthur model (see panel A and B in Fig. 6.18). However, among the replicate experiments only about half of the time series of Daphnia and inedible algae displayed such predator-prey cycles. The other half displayed cycles with approximately the duration of the juvenile period of Daphnia that are attributed to the delay between birth and the onset of reproduction (McCauley & Murdoch 1990). Hence, the same experimental and initial conditions led to two different patterns of fluctuations. The occurrence of the small-amplitude cycles in Daphnia and inedible algae were observed to coincide with the occurrence of larger densities of female Daphnia carrying resting eggs. Normally, Daphnia is parthenogenetic with females producing large clutches of asexual eggs (see Fig. 6.9). Under adverse temperature and food conditions, though, females switch to producing sexual eggs that
6.2. CONFRONTING MODELS AND EXPERIMENTS

Figure 6.17: Examples of the dynamics of *Daphnia* and algae in nutrient-rich and nutrient-poor, experimental tanks. *Daphnia* is measured as biomass (mg dry weight per liter), while algae are measured as chlorophyll a density (μg per liter). Only edible algae are included. Nutrient-rich tanks had approximately 10 times higher nutrient levels than nutrient-poor tanks, leading to an estimated increase in algal carrying capacity of one order of magnitude. Abundances are represented as residual deviations from a long-term, simple 'seasonal' trend. Source: Figure 2 in McCauley & Murdoch (1990).

form a resting stage and can overwinter on the bottom of a lake or pond. It is these resting eggs that give rise to a new population of *Daphnia* each year. The production of such resting eggs implies a channeling of energy away from immediate reproduction of *Daphnia*, which might be another mechanism preventing large-amplitude predator-prey cycles. Indeed, when experimental tanks were manipulated such that females with sexual resting eggs were continuously replaced with similarly sized females carrying parthenogenetic eggs, all replicates exhibit large amplitude predator-prey cycles (see Fig. 6.19). Hence, when both inedible algae and the occurrence of sexually reproducing females in *Daphnia* were controlled for, the populations of *Daphnia* and edible algae indeed exhibited the type of dynamics predicted by the Rosenzweig-MacArthur, predator-prey model.

6.2.3 Concluding remarks

The above discussion and presentation of experimental evidence suggests that the two most fundamental predictions of the predator-prey models discussed in this chapter, i.e. the predator-controlled prey abundance in steady state and the occurrence of large-amplitude predator-prey cycles at high algal carrying capacity in homogeneous environments, can indeed be confirmed to hold in natural systems under specific conditions. However, as the discussion has also made clear there are many different, sometimes even very subtle, mechanisms that may obscure the observation of these cycles or may prevent them to occur. It is exactly the discrepancy between the basic predictions of the model and the experimental observations that leads to further study of the dynamics of a population, ultimately revealing new insight about factors that shape the pattern of dynamics observed. This has been most clearly demonstrated by the phenomenon that the production of sexual eggs in *Daphnia* can prevent the occurrence of large-amplitude
Figure 6.18: Large- and small-amplitude cycles of *Daphnia* and edible algae in the same global environment. All four data sets stem from comparable, nutrient-rich systems. *Red triangles: Daphnia; Green squares: algae.* The solid lines are spline fits to the time series. *A,B:* Examples of large-amplitude predator-prey cycles. *C,D:* Examples of small-amplitude, stage-structured cycles. The initial biomass of all replicates is similar. Source: Figure 1 in McCauley et al. (1999).

Figure 6.19: Energy channelling towards sexual reproduction prevents the occurrence of large-amplitude predator-prey cycles in *Daphnia.* *A:* Dynamics of replicate *Daphnia* populations illustrating that the replicates are asynchronous in time and can either be of large or small amplitude. *B:* Dynamics of the *Daphnia* populations in which energy channelling towards asexual reproduction is maintained by swapping adult females producing ephippial resting eggs with similarly sized females carrying asexual eggs. Source: Figure 5 in McCauley et al. (1999).
predator-prey cycles, as discussed in the last section.
Part III

Bifurcation theory
Chapter 7

One parameter bifurcations in continuous time models

Imagine yourself sitting on a swing, happily swinging back and forth. The strain exerted on the ropes with which the swing is fastened to the overhead beam can in principle be computed using well known relations from Newtonian mechanics. This strain is the resultant of the gravitational force and the force induced by the swinging motion. It will increase with increasing swinging speed. Even though the mechanical laws can be used to compute the strain on the ropes with good accuracy, you will probably be much more interested in the question whether the rope will break or not and what the critical swinging speed is at which the rope will break. In other words, your main interest will be whether an abrupt change in the resulting motion can occur and, if yes, at which values of the conditions this change will occur.

In modeling biological populations a similar argument applies: Often the main focus of a population dynamical study is whether abrupt changes in the dynamics of the populations occur and, if yes, at which values of parameters such changes do occur. An abrupt change in model dynamics with a (slight) change in parameters is called a bifurcation. The change of a steady state from a stable node into a saddle is an example of such a bifurcation. Bifurcation theory is the part of theory about population dynamic models, or more generally dynamical systems, that deals with classifying, ordering and studying the regularity in these changes. Bifurcations that occur in dynamical systems are generally robust against (small) changes in model structure. The dynamics of a particular model will of course depend on its precise formulation and on the chosen set of parameters. Moreover, changes in model formulation are likely to change the dynamics observed for a given set of parameters. But if a particular model exhibits a change in dynamics from a stable equilibrium to limit cycle behavior with a change in a particular parameter, this qualitative change in dynamics will in general also be observed in models that are analogous, but slightly different in formulation.

The scientific questions that are sought to be answered with a population dynamical model often translate into questions regarding bifurcations. For example, when investigating whether the fragmentation of natural habitat will lead to species extinction, one is actually asking whether an internal steady state with positive abundances will be predicted by the model as opposed to a steady state with zero population abundance. Similarly, when considering the question whether an epidemic of a particular disease is likely to occur, one is also asking about the likelihood of two different types of steady states: an internal steady state and an extinct steady state. The transition at a particular parameter value between a parameter domain where an extinct steady state is stable to a domain where an internal steady state is stable is an example of a transcritical bifurcation or branching point (see section 7.2). In many cases, population dynamical studies
thus aim at identifying *qualitative* changes in the long-term dynamics predicted by the model, i.e. changes in the likelihood and stability properties of the model steady states. From a biological point of view the robustness of bifurcations, as discussed above, implies that the occurrence of a particular change in the observed population dynamics will not sensitively depend on the precise biological mechanisms assumed in the model. Biological conclusions based on bifurcations are hence more robust than conclusions that are based on the dynamics of the model for a particular set of parameters.

In this chapter I will discuss the types of changes in dynamics that can occur in continuous-time models of biological populations when a single model parameter is varied. Only three types of such bifurcations can occur and these three types possess particular characteristics that hold independent of the model they occur in. For presentational purposes I will, however, focus on models that are formulated in terms of 2 ODEs. This chapter will essentially not introduce any new techniques or methods, as the discussion below depends entirely on the computation of steady states, their eigenvalues and stability properties, such as introduced in chapter 5. A new perspective will be added, because we will focus on the question how these model properties change when a parameter in the model is changed. For the discussion below it is important to note the following:

**Important:**

If one of the parameters in the model changes, the value of the steady state(s), the corresponding eigenvalues and hence the stability characteristics may change as well. However, these changes are in general *continuous*, which means that plotted as a function of the parameter value the value of the steady state(s) form a smooth and continuous curve. The same holds for the value of the corresponding eigenvalues (both the imaginary and real parts!).

### 7.1 General setting

In chapter 5 it was discussed that a steady state $\mathbf{X}$ of a population dynamic model, formulated as,

$$\frac{d\mathbf{x}}{dt} = \mathbf{H}(\mathbf{x})$$

(see eq. (5.4)) is stable if all the eigenvalues $\lambda$ pertaining to the steady state have a negative real part. It was also explained that the number of eigenvalues pertaining to a steady state equaled the dimension of the model, for example, in a model in terms of 2 ODEs every steady state is characterized two, unique eigenvalues $\lambda_1$ and $\lambda_2$. In such a 2-dimensional model there are 5 possible configurations of the eigenvalues, dependent on whether the steady state is a stable or unstable node, a stable or unstable focus or a saddle point. These configurations are presented in Table 7.1 together with the phaseportrait of the trajectories in the neighborhood of the steady state.

A *change* in stability properties of the steady state occurs when a *change* in a particular model parameter causes the real part of an eigenvalue to *change* from negative to positive. Represented in the complex plane, this implies that a change in stability of a steady state, and hence a
### Table 7.1: Characteristics of all possible types of steady states in a 2-dimensional, continuous-time model.

For each type of steady state the number of eigenvalues with a positive ($N_+$) and negative ($N_-$) real part are indicated, their position in the complex plane, the phaseportrait in the neighborhood of the steady state and its stability.

<table>
<thead>
<tr>
<th>Name</th>
<th>($N_-, N_+$)</th>
<th>Eigenvalues</th>
<th>Phaseportrait</th>
<th>Stability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>(2, 0)</td>
<td><img src="image1" alt="Eigenvectors" /></td>
<td><img src="image2" alt="Phaseportrait" /></td>
<td>Stable</td>
</tr>
<tr>
<td>Focus</td>
<td>(2, 0)</td>
<td><img src="image3" alt="Eigenvectors" /></td>
<td><img src="image4" alt="Phaseportrait" /></td>
<td>Stable</td>
</tr>
<tr>
<td>Saddle</td>
<td>(1, 1)</td>
<td><img src="image5" alt="Eigenvectors" /></td>
<td><img src="image6" alt="Phaseportrait" /></td>
<td>Unstable</td>
</tr>
<tr>
<td>Node</td>
<td>(0, 2)</td>
<td><img src="image7" alt="Eigenvectors" /></td>
<td><img src="image8" alt="Phaseportrait" /></td>
<td>Unstable</td>
</tr>
<tr>
<td>Focus</td>
<td>(0, 2)</td>
<td><img src="image9" alt="Eigenvectors" /></td>
<td><img src="image10" alt="Phaseportrait" /></td>
<td>Unstable</td>
</tr>
</tbody>
</table>
change in long-term dynamics of the model, occurs when an eigenvalues crosses the imaginary axis from the left-half plane to the right-half plane. Because the value of the steady state and its eigenvalues change continuously with a change in model parameters and complex eigenvalues always occur as a pair of complex conjugates, there are only two generic ways in which such a shift of eigenvalues from the left- to the right-half complex plane can come about (see Fig. 7.1):

- a real-valued eigenvalue $\lambda$ changes from negative to positive, crossing the (real) value 0,
- a pair of complex, conjugate eigenvalues $\lambda_1$ and $\lambda_2$ crosses the imaginary axis at a non-zero imaginary value $i\omega$ and $-i\omega$, respectively.

Referring to Table 7.1 this implies that

- a stable node can only destabilize by changing into a saddle point, and
- a stable focus can only destabilize by changing into an unstable focus.

The first of these situations is characteristic for two different types of bifurcations: the transcritical bifurcation (or branching point; see section 7.2) and the saddle-node bifurcation (or limit point; see section 7.3). The last of these situations is characteristic for a Hopf bifurcation (see section 7.4). The Hopf bifurcation can only occur in models of at least 2 ODEs, as it involves always two eigenvalues. The type of stability change is thus intimately tied to the changes in the eigenvalues that characterize the steady state. Sections 7.2, 7.3, and 7.4 discuss these three types of bifurcations using two example models.

The transcritical bifurcation and the saddle-node bifurcation will be illustrated using a model for the dynamics of a cannibalistic population, in which adult individuals forage on juvenile conspecifics, next to feeding on an alternative resource. Here, I will first introduce and discuss this particular model. Let $J$ denote the abundance of juvenile individuals and $A$ the abundance of adults. The dynamics of the population can then be described by the following system of 2 ODEs:
\[
\frac{dJ}{dt} = \alpha A - \delta J - \beta JA \quad (7.2a)
\]
\[
\frac{dA}{dt} = \delta J - \frac{\mu}{\rho + \beta J} A \quad (7.2b)
\]

In these equations, \(\alpha\) denotes the per capita reproduction rate of the adult individuals, which implies that \(\alpha A\) models the total number of offspring produced by all the adults per unit of time. \(\delta\) represents the developmental rate of the juvenile individuals, which implies that \(\delta J\) models the number of juvenile individuals that mature per unit of time. \(\beta JA\) represents the cannibalism of adult individuals on the juveniles. Adult individuals are assumed to forage also for an external, non-cannibalistic food source, the density of which is represented by \(\rho\). The death rate of adult individuals is assumed to be inversely proportional to their total food intake rate, which equals \(\rho + \beta J\). The proportionality constant is denoted by \(\mu\). Hence, \(\mu A/(\rho + \beta J)\) is the total number of adult individuals that are dying per unit of time. Notice that juvenile individuals are assumed to die from no other causes, but cannibalism.

From equation (7.2b) we can infer that in steady state the abundance of adult individuals \(A\) is always positively correlated with the abundance of juveniles \(J\):

\[
A = \frac{\delta J (\rho + \beta J)}{\mu} \quad (7.3)
\]

This implies that given a steady state value \(J\), the steady state abundance \(A\) is uniquely determined. Substituting the relation (7.3) into the right-hand side of the ODE (7.2a) and equating it to 0, yields the following equation for the steady state abundance \(J\):

\[
\frac{\delta J (\alpha \rho - \mu + \beta (\alpha - \rho) J - \beta^2 J^2)}{\mu} = 0 \quad (7.4)
\]

The model hence possesses a trivial steady state:

\[(J, A) = (0, 0) \quad (7.5)\]

and non-trivial steady states that have to fulfill the conditions:

\[
\beta^2 J^2 + \beta (\rho - \alpha) J + (\mu - \alpha \rho) = 0 \quad (7.6a)
\]
\[
A = \frac{\delta J (\rho + \beta J)}{\mu} \quad (7.6b)
\]

In the following the non-trivial steady state(s) and their stability will be investigated as a function of the parameter \(\mu\), which scales the food-dependent mortality of the adult individuals. Hence, if \(\mu\) increases adult mortality is higher and increases more rapidly with decreasing food conditions.

To construct graphs of the steady state abundance \(J\) as a function of the parameter \(\mu\) it will turn out to be most convenient to first construct the graph of \(\mu\) as a function of \(J\). The latter relation between \(\mu\), as the dependent variable, and \(J\), as the independent variable, is given by the following quadratic equation:

\[
\mu = \alpha \rho + \beta (\alpha - \rho) J - \beta^2 J^2 \quad (7.7)
\]
This parabola is easy to construct and can subsequently be flipped around the line \( \mu = \overline{J} \) to yield the required relation between \( \overline{J} \), as the dependent variable, and \( \mu \), as the independent variable.

The Jacobian matrix of the cannibalism model is given by the equation:

\[
\mathcal{J} = \begin{pmatrix}
-\delta - \beta \overline{A} & \alpha - \beta \overline{J} \\
\delta + \frac{\mu \beta}{(\rho + \beta \overline{J})^2} \overline{A} & -\frac{\mu}{\rho + \beta \overline{J}} 
\end{pmatrix}
\] (7.8)

Substitution of the trivial steady state values, \((\overline{J}, \overline{A}) = (0, 0)\), into this Jacobian matrix yields the following equation for the eigenvalues:

\[
\rho \lambda^2 + (\delta \rho + \mu) \lambda + \delta (\mu - \alpha \rho) = 0
\] (7.9)

(Check this by carrying out the substitution and determining the determinant of the resulting matrix!) From equation (7.9) it can be deduced that the trivial steady state is characterized by two real, but negative eigenvalues if:

\[
\frac{\alpha}{\mu/\rho} < 1
\] (7.10)

The left-hand side of this inequality can be interpreted as the expected number of offspring produced by a single individual during its entire life under conditions of very low population abundance. When abundance is low, density-dependent effects are absent and neither is juvenile mortality increased, nor is adult mortality decreased through cannibalism. The left-hand side of the inequality hence equals the expected lifetime reproduction when individuals are living more or less on their own. This quantity is usually denoted by the symbol \( R_0 \). For the cannibalism model \( R_0 \) is given by:

\[
R_0 = \frac{\alpha}{\mu/\rho}
\] (7.11)

The expression for \( R_0 \) can be derived as follows. Under conditions of low population abundance, death of juveniles is negligible since there are no adults to cannibalise a juvenile individual. For an adult individual, the probability to survive for a period of time \( t \) equals:

\[
S(t) = e^{-\left(\frac{\mu}{\rho}\right)t}
\] (7.12)

\( S(t) \) represents here the probability that an individual is still alive after \( t \) units of time and is obtained by solving ODE (7.2d) when \( J \) is taken equal to 0 in that equation (Remember the assumption of low population abundance!). Per unit of time an adult individual produces on average \( \alpha \) newborn offspring. Hence, the expected number of offspring produced during its entire life equals the integral of the \( \alpha S(t) \) for \( t = 0 \) to \( t = \infty \) (i.e. the integral over the entire adult lifespan):

\[
R_0 = \int_0^\infty \alpha e^{-\left(\frac{\mu}{\rho}\right)t} dt = \frac{\alpha}{\mu/\rho}
\] (7.13)

Condition (7.10) now states that the trivial steady state is stable if the expected lifetime reproduction on the basis of alternative, non-cannibalistic food, \( \alpha \rho/\mu \), is smaller than 1, i.e. if an individual cannot on average replace itself on the basis of non-cannibalistic food. If \( \alpha \rho/\mu \) is
larger than 1 the trivial steady state is unstable and the population is capable of growing away from low population abundances. Given the biological interpretation of the quantity $R_0 = \alpha \rho / \mu$ this is easily understood. Note that with increasing $\mu$ the adult mortality increases and hence their expected lifespan decreases. This implies that only for lower values of $\mu$ a population will be able to persist at non-zero population abundances.

The characteristic equation (7.9) for the trivial steady state thus indicates that at $\mu = \alpha \rho$ the stability properties of the trivial steady state change. Substitution of this value $\mu = \alpha \rho$ into the condition for the juvenile abundance in the non-trivial steady state (eq. (7.7)) shows that condition (7.7) yields a solution $J = 0$, as well as a second solution:

$$J = \frac{\alpha - \rho}{\beta}$$

(7.14)

For $\mu = \alpha \rho$ both the trivial steady state condition (7.5) and the internal steady state condition (7.7) hence yield the same solution $J = 0$. If the value of the trivial steady state and the internal steady state is plotted as a function of the parameter $\mu$ this implies that the curve representing the internal steady state intersects the curve for the trivial steady state at the parameter value $\mu = \alpha \rho$. In addition, equation (7.14) indicates that a second, positive, non-trivial steady state exists for $\mu = \alpha \rho$ if

$$\alpha > \rho .$$

(7.15)

Figure 7.2 and 7.3 illustrate the relationship between the steady state abundance $J$ and the adult mortality $\mu$ in case $\alpha < \rho$ and $\alpha > \rho$, respectively. Each of these two figures represents two curves: one curve indicating the trivial steady state and one curve representing the internal steady state, as a function of the parameter $\mu$. For each of these curves the figures also indicate for which parameter values the particular steady state is stable and for which values it is unstable. The two figures are representative for the two distinct situations that can occur dependent on $\alpha$ and $\rho$:

- If $\alpha < \rho$ the curve representing the internal steady state bends to the left at the point

$$(\mu, J) = (\alpha \rho, 0)$$

where it intersects the curve that represents the trivial steady state. For these parameter values condition (7.7) determining the internal steady state has a second, non-trivial solution at a negative juvenile abundance $J = (\alpha - \rho) / \beta$ for $\mu = \alpha \rho$. In accordance with this assessment we can infer that the quadratic relation (7.7), which specifies $\mu$ as a function of $J$, is a parabola with a maximum at a negative value of $J$. Hence, for increasing $J$ this condition determines that $\mu$ decreases monotonously. Flipping the parabola around the line $\mu = J$ yields the relationship illustrated in Figure 7.2.

- If $\alpha > \rho$ the curve representing the internal steady state bends to the right at the point

$$(\mu, J) = (\alpha \rho, 0)$$

where it intersects the curve that represents the trivial steady state. In other words, the curve initially extends towards higher values of the mortality parameter $\mu$ and curves back to lower values of $\mu$ at a positive value of $J$ (see Figure 7.3). In this case there is a second, positive internal steady state abundance $J = (\alpha - \rho) / \beta$ for $\mu = \alpha \rho$. When $\alpha > \rho$ the quadratic relation (7.7), which specifies $\mu$ as a function of $J$, is a parabola with a
maximum at a positive value of $J$, which yields the relationship as illustrated in Figure 7.3 when around the line $\mu = J$.

For positive value of both $J$ and $A$ it is immediately clear that the trace of the Jacobian matrix (7.8) is negative. Hence, the internal steady state can only destabilize when a real-valued eigenvalue becomes positive (see the left panel in Figure 7.1). The internal steady state is hence either a stable node or focus or it is a saddle point. The determinant of the Jacobian (7.8) evaluates to

$$\det J = \frac{\delta \left(3 \beta J^2 + 2 \beta (\rho - \alpha) J + (\mu - \alpha \rho)\right)}{\rho + \beta J}$$

(7.16)

which expression has been obtained after substituting expression (7.3) for $A$. The expression for the determinant $\det J$ can be simplified further by using the steady state relation (7.7) between $\mu$ and $J$ to:

$$\det J = \frac{\delta \beta J (2 \beta J + (\rho - \alpha))}{\rho + \beta J}$$

(7.17)

For small, positive values of $J$ the determinant is positive as long as $\alpha < \rho$ and negative if the
7.1. GENERAL SETTING

Figure 7.3: Bifurcation structure of the cannibalism model for $\alpha > \rho$. Both the positive, internal steady state and the trivial steady state are indicated with thick solid lines, when they are stable and thick dashed lines when they are unstable. The insets show the position of the eigenvalues in the complex plane for the different parts of the steady state curves.

opposite inequality holds. Hence, for $\alpha < \rho$ the internal steady state is always stable, as the determinant of the Jacobian matrix is positive while its trace is negative (see Table 5.1 and Figure 5.5 in chapter 5).

If, on the other hand, $\alpha > \rho$ the internal steady state is a saddle point, since the determinant $\det J$ is negative for small, but positive values of $J$. With increasing values of $J$ the value of the determinant increases as well to become equal to 0 when

$$J = \frac{\alpha - \rho}{2\beta}$$  \hspace{1cm} (7.18)

(see equation (7.17)). This value of $J$ is exactly the value where the curve representing the internal steady state in Figure 7.3 reaches its maximum value of $\mu$ and bends back towards lower $\mu$-values. The equilibrium relation between $\mu$ and $J$ indicates that this extremum is given by:

$$(\mu, J) = \left( \frac{(\alpha + \rho)^2}{4}, \frac{\alpha - \rho}{2\beta} \right)$$  \hspace{1cm} (7.19)

At this maximum value of $\mu$ (see Fig. 7.3) the internal steady state hence changes from a saddle point into a stable node. With further increases in $J$ the determinant will only increase further, while the trace of the Jacobian matrix will remain negative. Hence, for
the internal steady state will always be stable.

Figure 7.2 and 7.3 summarize the results derived above for the cannibalism model. The figures clearly indicate that there are two characteristic changes in stability of the internal steady state: one at the intersection point between the curve representing the internal and the trivial steady state and one where the curve of the internal steady state exhibits an extremum (see Fig. 7.3). These characteristic changes in stability, corresponding to a transcritical bifurcation and a saddle-node bifurcation, respectively, will be discussed next.

7.2 Transcritical bifurcation and branching point

From the analysis of the cannibalism model discussed above, we can infer that at the value \( \mu = \alpha \rho \) the curves representing the trivial steady state and the internal steady state, respectively, intersect. For decreasing values of \( \mu \) the stability of the trivial steady state changes at this intersection from being a stable node into a saddle point, while the internal steady state changes from a saddle point into a stable node. In other words, the trivial and internal steady state exchange their stability characteristics at the intersection point. In addition, the internal steady state enters the positive cone, i.e. the part of the \((J,A)\)-phaseplane with positive abundances for both juveniles and adults. Each of the steady states is characterized by a pair of eigenvalues that are both real. At the intersection point \((\mu,J) = (\alpha \rho, 0)\) from these two pairs of eigenvalues (i.e. one pair pertaining to the trivial steady state and the other pertaining to the internal steady state) always one member of the pair is negative, while the second member has a zero value. In other words, at the intersection point two eigenvalues equal to 0 coincide, but they pertain to two different steady states. When decreasing the value of \( \mu \) from above to below its critical value \( \alpha \rho \) the zero eigenvalue pertaining to the trivial steady state moves to the right (see Fig. 7.1) into the half of the complex plane where real parts are positive. Simultaneously, the zero eigenvalue pertaining to the internal steady state moves to the left, towards the half of the complex plane where real parts are negative.

The changes in steady state characteristics occurring at the value \( \mu = \alpha \rho \) are representative for a transcritical bifurcation. The intersection point itself, \((\mu,J) = (\alpha \rho, 0)\), is referred to as a branching point. Transcritical bifurcations are very common in population dynamic models in general. The characteristic properties of a transcritical bifurcation are:

- it is an intersection point, referred to as branching point, of two curves representing different steady states of the model,
- at the intersection point both steady states have a zero eigenvalue,
- when moving through the intersection point one of the two zero eigenvalues moves into the left half of the complex plane, the other one into the right half of the complex plane. Since they belong to two different steady states, the steady states exchange their stability characteristics.

These properties are independent of the detailed specification of the model, but depend solely on the changes in the value of the eigenvalues around the branching point. Hence, when an intersection point of two steady state curves is found in a particular model, we can immediately infer that an exchange in stability characteristics has to occur there.
7.3 Saddle-node bifurcation and limit point

For $\alpha > \rho$ the curve representing the internal steady state has an extremum at the point

$$(\mu, J) = \left( \frac{(\alpha + \rho)^2}{4}, \frac{\alpha - \rho}{2\beta} \right)$$

(see Figure 7.3). For $\mu$-values slightly larger than $(\alpha + \rho)^2/4$ there are no internal steady states at all, while for slightly smaller $\mu$-values there are two steady states, a saddle point and a stable node. At this point the internal steady state exhibits a change in stability from a stable node into a saddle point, when we follow its curve through the $(\mu, J)$-plane (see Fig. 7.3). The extremum point of the curve is called a limit point. The changes in steady state characteristics that occur around the limit point are referred to as a saddle-node bifurcation, because a saddle point and a stable node merge and disappear when $\mu$ increases past the limit point at $\mu = (\alpha + \rho)^2/4$. The changes in stability again relate to the fact that a real-valued eigenvalue changes sign when the steady state curve is followed around the limit point.

In general, we can state that

- a limit point is a point in the steady state curve, at which an extreme parameter value is reached, and

- at the limit point a saddle point and a stable node merge and disappear, or in other words, when following the steady state curve around the limit point, the steady state changes its stability, because a real-valued eigenvalue changes sign.

Limit points are frequently occurring constructs in dynamic systems of any kind. The characteristics of the dynamics in the neighborhood of the limit point are independent of the model specifics and are completely determined by the changes in the eigenvalues characterizing the steady states.

Therefore, when during the analysis of a model, a steady state curve exhibits a limit point, it immediately gives information about the stability properties of the steady state in the neighborhood of this point. Alternatively, if during numerical simulations of a dynamic model a steady state is reached for a particular range of parameter values, but a small increase or decrease in the parameter outside the range will cause the steady state to suddenly disappear, one has to strongly suspect the presence of a limit point and hence the presence of a saddle point close to the steady state that was initially approached. The presence of a limit point is hence a likely explanation for rather “catastrophic” changes in model dynamics with small changes in parameters.

From a biological point of view Figure 7.3 illustrates the most interesting effect of cannibalism on the population dynamics. For a range of $\mu$-values larger than $\mu = \alpha \rho$ the cannibalistic population can sustain itself in an internal steady state, while adult individuals are incapable to produce more than a single offspring during their life on the basis of the alternative, non-cannibalistic food source. Through cannibalism the adult individuals can make up for this deficiency such that on average they do replace themselves during their lifetime. This effect has been dubbed the “life-boat effect” of cannibalism (Van den Bosch et al. 1988).

7.4 Hopf bifurcation

The last bifurcation that can occur in a continuous-time model when varying a single parameter, is the change from a stable to an unstable focus (see Table 7.1). This change in stability occurs
CHAPTER 7. CONTINUOUS TIME MODELS

Figure 7.4: Schematic, 3-dimensional representation of the Hopf-bifurcation in the Rosenzweig-MacArthur model. The axes represent the carrying capacity \( K \), the prey abundance \( F \) and the predator abundance \( C \). The thick, solid line in the bottom plane indicates the prey-only steady state \( (F, C) = (K, 0) \) for those values of \( K \) where this steady state is stable. The positive, internal steady state is indicated with a thick solid line when stable and with a thick dashed line when it is unstable. With the destabilization of the internal steady state a limit cycle occurs. In the \((F,C)\)-phaseplane this limit cycle constitutes a closed curve. Every initial condition will ultimately approach this limit cycle, when it exists. With increasing value of \( K \) the amplitude of the limit cycle increases. The set of limit cycles for all \( K \) values forms a parabolic structure in the 3-dimensional space as sketched. \( K_c \) and \( K_s \) indicate the critical values of \( K \) where a transcritical and a Hopf-bifurcation occur, respectively.

when a pair of complex, conjugated eigenvalues crosses the imaginary axis from the left-half plane into the right-half plane (see Figure 7.1). This bifurcation has been encountered in the Rosenzweig-MacArthur model, discussed in section 6.1.2. The model analysis that has been presented in that particular section can be summarized as:

- The model possesses a trivial steady state
  \[
  (\overline{F}_1, \overline{C}_1) = (0, 0)
  \]
  which is always a saddle point (see equation (6.47) and the discussion following it).

- The model possesses a prey-only steady state
  \[
  (\overline{F}_2, \overline{C}_2) = (K, 0)
  \]
7.4. HOPF BIFURCATION

which is stable as long as

\[ K < K_c = \frac{\mu}{a(\epsilon - \mu h)} \]

(see equation (6.48) and the discussion following it). For larger values of \( K \) the prey-only steady state is a saddle point.

- The model possesses a internal steady state (i.e. with positive abundances of both prey and predator)

\[ (F_3, C_3) = \left( \frac{\mu}{a(\epsilon - \mu h)}, \frac{\epsilon r (aK(\epsilon - \mu h) - \mu)}{a^2 (\epsilon - \mu h)^2 K} \right) \]

when \( K > K_c \) (see equation (6.51) and the discussion following it). This steady state becomes unstable and limit cycles occur when the carrying capacity \( K \) exceeds the value

\[ K_s = \frac{\epsilon + \mu h}{ah(\epsilon - \mu h)} \]

(see equation (6.58) and the discussion preceding and following it).

From the above conclusions it is easy to infer that a transcritical bifurcation occurs at \( K = K_c \), where the curves representing the prey-only steady state and the internal steady state, respectively, intersect and moreover the internal steady state turns positive. At \( K = K_c \) hence a branching point occurs (see section 7.2), where the prey-only steady state changes from a stable node into a saddle point and the internal steady state exhibits the opposite change (see Figure 7.4).

At \( K = K_s \) the internal steady state changes stability through a Hopf-bifurcation. This type of bifurcation is characterized by the fact that:

- a pair of complex, conjugated eigenvalues cross the imaginary axis from the left half into the right half of the complex plane (see Fig. 7.1), such that their real part becomes positive, and

- at the bifurcation a limit cycle originates. A limit cycle is a closed, invariant loop in the state space. This means that if an initial point is chosen right on the limit cycle, the state of the system will move along the limit cycle for all time. At least for parameter values close to the bifurcation point the limit cycle will be an attractor of the model, meaning that starting from initial conditions close to the limit cycle, the state of the system will in the long run approach the limit cycle and follow it at smaller and smaller distance. In terms of dynamics over time, the limit cycle implies that population abundances will fluctuate (see the predator-prey cycles in Fig. 6.8). At the bifurcation point the amplitude of the limit cycle will initially be infinitely small, but will increase when moving away from the bifurcation point into the unstable parameter region.

Figure 7.4 illustrates the Hopf-bifurcation occurring in the Rosenzweig-MacArthur model (6.38) in a 3-dimensional space spanned by the prey carrying capacity parameter \( K \) and the prey and predator abundances, \( F \) and \( C \), respectively. For a number of parameter values \( K \) the limit cycle is also indicated in this figure. With increasing values of \( K \) the amplitude of the limit cycle increases. The (infinite) collection of limit cycles for all parameter values \( K \) constitutes a parabolic object in the 3-dimensional space, as shown in Figure 7.4.
7.5 Concluding remarks

Even though they are discussed here in the context of 2-dimensional models, these bifurcations are the only types of changes in equilibrium characteristics which can occur in a model when changing a single parameter, *irrespective of its dimension*. Hence, bifurcation theory learns us that there is order and regularity in the changes that can occur in equilibrium characteristics when changing parameters. It is this order and regularity that helps in understanding the properties of more complex models.
Part IV

Exercises
Chapter 8

Exercises

8.1 ODEs (differential equations) in 1 dimension

1. Keywords:
   - \( N(t) \) en \( f(N) \) population en population growth rate
   - equilibria
   - stability
   - solutions, orbits, and trajectories
   - asymptotic dynamics
   - initial conditions
   - dynamical systems

2. Questions:
   - What is a differential equation?
   - How do I analyze a differential equation?

8.1.1 Population size and population growth rate

In this assignment we consider the population size \( N(t) \) and the population growth rate \( dN/dt \). Suppose that the population size \( N(t) \) as a function of time is given by

\[
N(t) = 0.16 \cdot e^{0.5t}
\]

1. Draw \( N(t) \).
2. What is the population growth rate at time \( t \)?
3. Express the population growth rate as a function of \( N(t) \) and write this expression in the form of a differential equation
4. What is the per capita growth rate in this model?

8.1.2 Graphical analysis of differential equations

Consider the following differential equation:

\[
\frac{dN}{dt} = f(N)
\]

For each of the expressions of \( f(N) \) specified in assignments \textbf{8.1.2.1} until \textbf{8.1.2.6}, perform the following general assignments:

1. Draw \( f(N) \).
2. In the same figure, draw arrows on the \( N \)-axis that indicate the direction of change of \( N \)
3. How many equilibria are present?

4. In the $N/t$-plane, draw arrows (vectors) that indicate the direction of change of $N$. Do this for different values of $N$ and $t$.

5. Draw solutions (“orbits”, “trajectories”) of $N(t)$ in the $N/t$-plane.

6. Does the asymptotic behavior of $N(t)$ depend on the initial conditions? (“asymptotic behavior” is the behavior of the system for infinite values of $t$)

7. In case of any equilibria; which are/is stable?

8. Draw the per capita growth rate as a function of the population density

8.1.2.1 Immigration and emigration

$$f(N) = I - E$$

where $I$ and $E$ are constants. Perform the analysis with the assumption that:

a. $I > E$

b. $I < E$

8.1.2.2 Semi-chemostat

$$f(N) = r(K - N)$$

with $r > 0$, $K > 0$.

8.1.2.3 Logistic growth

$$f(N) = rN \left(1 - \frac{N}{K}\right)$$

with $r > 0$, $K > 0$.

8.1.2.4 Allee-effect

$$f(N) = bN^2 \left(1 - \frac{N}{\kappa}\right) - mN$$

with $b > 0$, $\kappa > 0$, $m > 0$, and assume that $b\kappa > 4m$.

8.1.2.5 De bumpfly, *Bizarrus periodicus alleei*

$$f(N) = -\sin(\pi N) N$$
8.1. ODES (DIFFERENTIAL EQUATIONS) IN 1 DIMENSION

8.1.2.6 Structural instability (a pathological case)

\[ f(N) = bN^2 \left(1 - \frac{N}{\kappa}\right) - mN \]

use \( b = 0.1, \kappa = 10, m = 0.25 \). In addition, perform the following assignments

9. Compare the following two orbits: the first orbit starts at \( N(0) = \frac{1}{2}\kappa + \epsilon \), the second orbit starts at \( N(0) = \frac{1}{2}\kappa - \epsilon \), with \( \epsilon \) a very small positive number. Where do the two orbits end for \( t \to \infty \)?

10. What happens with the number of equilibria when one of the parameters is changed to a slight degree?

8.1.3 Formulation and graphical analysis of a model

8.1.3.1 Herring Gulls

Consider a population of herring gulls (\( Larus argentatus \)) on the island of Schiermonnikoog. These ground breeding colonial birds compete for nesting sites, which leads to fierce fights for the best nesting spot. They gather their food around the whole island. During several decades students of zoology course at the University of Groningen studied the gull colony and recorded birth rates (per capita reproduction rate) and death rates (per capita mortality rate) by tracking the demography of the population. These data show that the primary cause of death is injury caused by territorial fights. The death rate is therefore density dependent and increases linearly as a function of population size with a fixed slope \( \alpha \) (which can be interpreted as a fixed chance of dying per fight) and a background death rate \( \delta_0 \). The birth rate is density independent (probably because the food supply on the island is not a limiting factor for the gull population) and given by the constant rate \( \beta \). (Assume that \( \beta > \delta_0 \)).

1. Formulate the differential equation.

2. Analyze the differential equation. (\( i.e. \), perform the assignments as described in 8.1.2).

8.1.3.2 Intraspecific competition and interspecific predation

The common toad (\( Bufo bufo \)) is an important food source for the grass snake (\( Natrix natrix \)). Toads compete with each other for food and space and the negative effects of competition depend on how often toads meet each other ("interference competition").

1. Formulate the differential equation for the dynamics of the population size of toads \( P \) (per hectare). Assume that the snakes have a constant population size \( S \) (per hectare). Furthermore assume that:

The per capita reproduction rate of toads is \( b \) (per day) and the per capita mortality rate is \( m \). How often toads meet each other depends on the population density, \( P \), and their mobility \( w \) (hectare per day). Assume that every encounter has a negative effect of size \( c \) on the per capita reproduction rate. Snakes search for toads with rate \( \alpha \) ("attack rate" in hectare per day). Obviously, the mortality by predation depends on how often toads encounter snakes.

2. Draw \( f(P) \) and the phase plane
3. Rewrite your model in the form of the logistic growth equation.

\[ \frac{dP}{dt} = rP \left(1 - \frac{P}{K}\right) \]

In order words: express the “intrinsic rate of increase” \( r \) and the “carrying capacity” \( K \) in terms of the parameters from your model.
8.2 Equilibria in 1D ODEs

1. **Keywords:**
   - equilibrium curve
   - parameter dependence
   - linearization
   - eigenvalues
   - equilibria
   - stability
   - structural stability/instability

2. **Questions:**
   - How do I analyze a differential equation?
   - How do I analytically determine the stability of an equilibrium?

8.2.1 Mathematical analysis of a differential equation

Consider the following differential equation:

\[ \frac{dN}{dt} = f(N) \]

For each of the expressions of \( f(N) \) specified in assignments 8.1.2.2 until 8.1.2.6, perform the following general assignments:

1. Express the equilibria in terms of parameters.
2. Determine the stability of the equilibria. That is to say: for each equilibrium calculate the corresponding eigenvalue(s).

8.2.1.1 Aquatic plants and wave erosion

"The relative growth rate of submerged vegetation declines linearly with vegetation biomass (\( V \)) due to competition in a logistically growing vegetation. Relative erosion mortality of plants caused by uprooting by waves or animals from unstable sediment approaches zero with increasing vegetation biomass due to consolidation of the sediment, dampening of wave action and exclusion of benthivorous fish." From: "Ecology of Shallow Lakes" by Marten Scheffer.

1. Does the above figure display population or per capita growth rates? (hint: read the text carefully).
2. Draw \( f(V) \) and the phase plane.
3. On a good day the local government of Friesland decided to create a windbreak around a recreational lake in order to improve swimming quality. To everyone’s surprise, and
dismay of the local dike-warden, the lake was rapidly overgrown with aquatic plants. These plants proved to be resistant, since their removal only resulted in reinvasion. Explain this phenomenon on the basis of the model given above.

8.2.1.2 Pitchfork bifurcation

\[
\frac{dx}{dt} = \alpha x - x^3
\]

with \( \alpha \) a constant parameter.

1. How many equilibria (including those for negative \( x \)) are present when:
   a. \( \alpha > 0 \)
   b. \( \alpha < 0 \)
   c. \( \alpha = 0 \)

2. Draw \( f(x) \) and the phase plane for \( \alpha = 1 \) in the region \( x \in (-2, 2) \). Also indicate the stability of the equilibria. Draw orbits in the \( x/t \) plane.

3. Repeat the previous assignment for \( \alpha = -1 \).

4. Parameter dependence, equilibrium curves: Draw a diagram that shows the dependence of the equilibria on \( \alpha \). That is to say: draw in the \( x/\alpha \) plane a curve that indicates the location of the equilibrium.

5. Calculate the eigenvalues of the equilibria as a function of \( \alpha \). At which value of \( \alpha \) does the stability of the zero equilibrium change? If any, what is the stability of other equilibria? Indicate the stability of the equilibria in the figure from question d.
8.3 Studying ODEs in two dimensions

1. **Keywords:**
   - systems of differential equations
   - phase plane
   - zero(iso)clines
   - equilibria
   - linearization
   - jacobian
   - eigenvalues
   - stability

2. **Questions:**
   - How do I analyze a system of differential equations?
   - What is the phase plane method?

### 8.3.1 Graphical analysis of a system of differential equations

Consider the following system of differential equations:

\[
\begin{cases}
\frac{dx}{dt} = f(x, y) \\
\frac{dy}{dt} = g(x, y)
\end{cases}
\]

For each of the functions of \( f(x, y) \) and \( g(x, y) \) specified in assignments 8.3.1.1 until 8.3.1.3, perform the following general assignments:

1. Draw the zero-isocline(s) for \( f(x, y) \) en \( g(x, y) \) in the \( x/y \) plane (the “phaseplane”). Indicate which zero-isocline belongs to which differential equation (you can for example use different colors or use solid or dashed lines).

2. How many equilibria are present?

3. Draw vectors in the phaseplane that indicate the direction of change in both \( x \) and \( y \) direction. The zero-isoclines divide the phaseplane in different sub-areas. Draw at least 1 vector per sub-area. Drawing vectors on the zero-isocline is also helpful.

4. Draw solutions (“orbits”, “trajectories”) of \([x(t), y(t)]\) in the phaseplane.

5. Is the asymptotic behavior of the orbits dependent on the starting values of \( x \) and \( y \) (the “initial conditions”)?

6. If possible, determine the stability of the equilibria on the basis of the phase plane. How many saddle points are present?

#### 8.3.1.1 Lotka-Volterra competition

\[
\begin{cases}
f(x, y) = x(1 - x - \alpha y) \\
g(x, y) = y(1 - y - \beta x)
\end{cases}
\]

where \( x, y, \alpha \) and \( \beta \) are positive. Distinguish the following four cases:

a. \( \alpha < 1, \beta < 1 \)
b. \( \alpha < 1, \beta > 1 \)
c. \( \alpha > 1, \beta < 1 \)
d. \( \alpha > 1, \beta > 1 \)
Compare the above four cases on the basis of the following questions:

1. Which biological conclusions can be made from these results with respect to the competition between two species?

2. What kind of ecological interaction does the model represent when $\alpha$ and $\beta$ are negative?

3. Assume that $\alpha < 0$ and $\beta < 0$. For which condition (in terms of $\alpha$ and $\beta$) does an internal, positive equilibrium exist?

### 8.3.1.2 Roots and squares

\[
\begin{cases}
    f(x, y) = x^2 - y \\
g(x, y) = -x + y^2
\end{cases}
\]

where $x$ and $y$ are real numbers.

### 8.3.1.3 Lotka-Volterra predator-prey

\[
\begin{cases}
    f(x, y) = \alpha x - \beta xy \\
g(x, y) = \gamma xy - \delta y
\end{cases}
\]

where $x$ and $y$ are positive variables and $\alpha$, $\beta$, $\gamma$ and $\delta$ positive parameters.

### 8.3.2 Mathematical analysis of a system of differential equations

Consider the following system of differential equations:

\[
\begin{cases}
    \frac{dx}{dt} = f(x, y) \\
    \frac{dy}{dt} = g(x, y)
\end{cases}
\]

For each of the functions of $f(x, y)$ and $g(x, y)$ specified in the assignments 8.3.1.1 until 8.3.1.3, perform the following general assignments. When calculating the stability of the internal equilibrium ($x \neq 0, y \neq 0$) you can assume the following two cases:

a. $\alpha = 2/3$, $\beta = 3/4$,

b. $\alpha = 3/2$, $\beta = 2$.

1. How many equilibria are present? Express the equilibria in terms of parameters.

2. Determine the stability of the equilibria. That is to say: for each equilibrium calculate the corresponding eigenvalue(s).
8.4 Sample Exam

Question 1

We study a mathematical model that consists of two ordinary differential equations (ODEs). The following diagram shows the equilibria as a function of one model parameter:

The value of the model parameter is plotted on the $x$-axis and the $y$-axis represents the value of one of the two variables of the model. The solid lines represent equilibrium curves, i.e. every point on a solid line corresponds to an equilibrium at that particular value of the model parameter. A, B, C and D represent all the bifurcation points (circles). The crosses, numbered 1 to 6, are random points on the equilibria curves (these are not bifurcation points). Assume that the equilibrium indicated by the cross with number 1 is a saddle point.

1. Name the bifurcation points A, B, C and D (that is to say, give the type of bifurcation point that they represent)

2. Describe what happens with the eigenvalues of the equilibrium (or equilibria) at points A and D if each bifurcation point is crossed from left (low parameter value) to right (high parameter value).

3. Describe what happens with the eigenvalues of the equilibrium (or equilibria) at point B and C if each bifurcation point is crossed from below (low equilibrium value) to above (high equilibrium value)

4. Draw the phase planes of the equilibria marked with crosses numbered 1 to 6. That is, for each of the cross-marked equilibria, draw solutions (orbits or trajectories) of the system in the neighborhood of that equilibrium.
Question 2

In a model for a single population with sexual reproduction, the per capita reproduction rate is given by:

\[
\frac{4.5 \cdot 1 + \alpha N}{1 + \alpha + \alpha N}
\]

In this formula, \(N\) denotes the density of the population and \(\alpha\) denotes strength of the Allee effect that arises because of sexual reproduction. In case \(\alpha = 0\) there is no Allee effect and the reproduction of the population is indistinguishable from asexual reproduction. For \(\alpha > 0\) reproduction is inhibited for low values of \(N\) because individuals are having trouble finding a mate.

We furthermore assume that the per capita chance of dying per unit time is equal to:

\[
(1 + N)
\]

1. Formulate the differential equation (ODE) for this model.
2. Take \(\alpha = 0\) and draw in one diagram the per capita reproduction rate and the per capita mortality rate as a function of the density \(N\).
3. Specify in this diagram all equilibria and denote their stability properties
4. Assume that \(\alpha \to \infty\). In this case the per capita reproduction rate is given by:

\[
\frac{4.5 \cdot N}{1 + N}
\]

Draw for this case in one diagram the per capita reproduction rate and the per capita mortality rate as a function of the density \(N\).
5. Specify in this diagram all equilibria and denote their stability properties
6. Compare the two diagrams found in questions c. and e. For which value of \(\alpha\) (larger than 0, but less than \(\infty\)) does a drastic change in the equilibria occur?
7. Draw the bifurcation diagram as a function of \(\alpha\).

Question 3

We are going to formulate a model for the dynamics of a prey and a predator population. The density of prey is denoted by \(F\) and the density of predators by \(C\). Assume that in absence of predators the prey population growth logistically with growth rate \(r\) and carrying capacity \(K\). Furthermore assume that the chance of dying per unit time of a predator individual is constant and denoted with the parameter \(d\). Prey that are captured by predators are converted into new predators with a conversion efficiency denoted by parameter \(\epsilon\).

For the functional response of the predator we use the functional response formula of Ivlev. This scientist assumed that predators have a maximum rate of eating prey, which is denoted by parameter \(M\). Ivlev furthermore assumed that with increasing prey density the number of prey eaten by one predator increases from 0 until this maximum level \(M\) according to an exponential relationship with the product of a parameter \(a\) and prey density \(F\).

1. Write down the full model specifications, i.e. formulate the differential equations (ODE) for both prey and predator densities.
By scaling the variables this model can be simplified to the following dimensionless model:

\[
\frac{df}{dt} = \rho f \left(1 - \frac{f}{\kappa}\right) - \left(1 - e^{-f}\right) c \tag{8.1}
\]
\[
\frac{dc}{dt} = \left(1 - e^{-f}\right) c - \mu c \tag{8.2}
\]

We continue by analyzing this dimensionless model.

2. Give the equations for all zeroclines of the prey.

3. Give the equations for all zeroclines of the predator.

4. Give expressions for all equilibria that occur in the model.

5. Derive the Jacobian for this system of differential equations.

6. Calculate the eigenvalues for the trivial equilibrium and the equilibrium in which only prey is present.

7. Also calculate the corresponding eigenvectors for these two equilibria.

8. For which conditions does an internal equilibrium with both prey and predators exist?

9. Indicate whether there are conditions for which the non trivial (internal) equilibrium is stable and, if any, give these conditions.

10. Draw the bifurcation diagram in which the equilibrium densities of the predators \(c\) are plotted as function of parameter \(\kappa\).
Answers

8.1 Single ODEs (differential equations)

8.1.1 \( N(t) = 0.16 \cdot e^{0.5t} \)

1. Draw \( N(t) \)

2. \( 0.5 \cdot 0.16 \cdot e^{0.5t} \)

3. \( \frac{dN}{dt} = r \cdot N \)

4. Per capita growth rate: \( \frac{1}{N} \frac{dN}{dt} = \frac{1}{N} r \cdot N = r \)

8.1.2.1 \( f(N) = I - E \)

1. Arrows: for \( a \) always positive; for \( b \) always negative

3. 0

4.
5. a. [Diagram with arrows indicating direction of change in N.]  
   b. [Diagram with arrows indicating direction of change in r.]  

6. no  
7. no equilibria, unless \( I = E \)  
8. [Graph showing relationship between \( N \) and \( f(N) \).]  

**8.1.2.2** \( f(N) = r(K - N) \)  
1, 2. [Graph showing the relationship between \( f(N) \) and \( N \).]  

3. 1 equilibrium \( N = K \)  
4, 5 see Excel spreadsheet RHS-1-ODE.xls  
6. no
7. \( N = K \) : stable equilibrium

\[
\frac{\partial}{\partial N} f(N) = -r \quad \text{(always stable, given the assumptions, } r > 0, K > 0 \text{ )}
\]

8. \[
\frac{1}{N} \, dN = \frac{1}{N} \, r(K - N) = r \frac{K}{N} - r
\]

To plot: use graphical calculator, Excel, Matlab or ..... 

8.1.2.3 \( f(N) = r \, N \left(1 - \frac{N}{K}\right) \)

Graphical analysis: see syllabus Chapter 3, p21 and further; see also computer lab 10.1.

3. 2 equilibria

6. no

7. \( \bar{N}_1 = 0 \) : unstable equilibrium

\( \bar{N}_2 = K \) : stable equilibrium

\[
\frac{\partial}{\partial N} f(N) = f'(N) = \frac{\partial}{\partial N} \left( r N - \frac{r}{K} N^2 \right) = r - 2 \frac{r}{K} N = r \left(1 - 2 \frac{N}{K}\right)
\]

\( f'(\bar{N}_1) = r \)

\( f'(\bar{N}_2) = -r \)

8.1.2.4 \( f(N) = b \, N^2 \left(1 - \frac{N}{K}\right) - m \, N \)

Graphical analysis: see syllabus Chapter 3, p21 and further.

3. 3 equilibria

6. yes

7. \( \bar{N}_1 = 0 \) : stable equilibrium

\[
\frac{\partial}{\partial N} f(N) = f'(N) = 2 b N - 3 \frac{b}{K} N^2 - m
\]

\( f'(\bar{N}_1) = -m \)

8. \[
\frac{1}{N} \, f(N) = b \, N \left(1 - \frac{N}{K}\right) - m
\]
To plot: use graphical calculator, Excel, Matlab or ….

8.1.2.5 \( f(N) = -\sin(\pi N) \) 

1, 2, 4, 5 use graphical calculator, Excel, Matlab or ….

3. \( \infty \)

6. yes

7. \( \bar{N} = 0, 1, 2, \ldots, n \)

\[
\frac{\partial}{\partial N} f(N) = f'(N) = -\cos(\pi N)N - \sin(\pi N)
\]

\( f'(N = 0) = -\sin(0) = 0 \) : neutrally stable

\( f'(N = 1, 3, 5, \ldots, n) = -\cos(\pi) - \sin(\pi) = +1 \) : unstable

\( f'(N = 2, 4, 6, \ldots, n) = -2\cos(2\pi) - \sin(2\pi) = -2 \) : stable

8. sinusoidal function

8.1.2.6 \( f(N) = bN^2\left(1 - \frac{N}{\bar{N}}\right) - mN \)

with: \( b = 0.1, n = 10, m = 0.25 \)

1, 2, 4, 5 use graphical calculator, Excel, Matlab or ….

3. 2 equilibria

6. yes

7. \( \bar{N}_1 = 0 \)

\( \bar{N}_2 = \frac{1}{2} \kappa \)

\( f'(N) \) zie 8.1.2.4

\( f'(\bar{N}_1) = -m \) : stable

\( f'(\bar{N}_2) = 0 \) : neutrally stable
8.1.3.1 Herring Gulls

\[
\frac{dZ}{dt} = \beta Z - \alpha Z^2 - \delta_0 Z
\]

\[= (\beta - \delta_0) Z - \alpha Z^2\]

\[= (\beta - \delta_0) Z \left(1 - \frac{\alpha}{(\beta - \delta_0)} Z \right)\]

Graphical analysis, see logistic growth (8.1.2.3)

8.1.3.2 Bufo bufo

\[
\frac{dP}{dt} = (b - m) P - c w P^2 - \alpha S P
\]

\[= (b - m - \alpha S) P \left(1 - \frac{c w}{b - m - \alpha S} P \right)\]

Graphical analysis, see logistic growth (8.1.2.3)
8.2 equilibria in 1D ODEs

8.2.1 see 8.1

8.2.2.1 Aquatic plants and wave erosion

1. *per capita*. The text states that the population grows according to the logistic growth equation, in which the *per capita* growth rate is a linearly decreasing function of population density. The population growth rate as function of the population density is hence a parabola.

2. \( f(V) \) and the phaseportrait: see the Two-sexes model (3.4 in the syllabus)

3. Because of the windbreak the growth curve will be above the erosion curve for low densities as well (the intersection point for low \( V \)-values disappears). The unstable, internal equilibrium hence disappears and the equilibrium \( \dot{V} = 0 \) becomes unstable. Only the internal equilibrium for high values of \( V \) is then still stable.

8.2.1.2 Pitchfork bifurcation

\[
\frac{dx}{dt} = \alpha x - x^3
\]

1. Number of equilibria for:

a) \( \alpha > 0 \) : \( \frac{dx}{dt} = 0 \) : \( \alpha x - x^3 = 0 \Rightarrow x = 0 \lor \alpha x^2 = 0 \Rightarrow x^2 = \alpha \Rightarrow x = \pm \sqrt{\alpha} \)

3 equilibria

b) \( \alpha < 0 \) : \( \frac{dx}{dt} = 0 \) : \( x = 0 \) (\( \pm \sqrt{\alpha} \) is imaginary)

1 equilibrium

c) \( \alpha = 0 \) : \( \frac{dx}{dt} = 0 \) : \( x = 0 \)

1 equilibrium
2. \( f(x) \) and the phase portrait for \( \alpha = 1 \)

3. \( \text{id} \) \( \alpha = -1 \) \hspace{2cm} \( \alpha = 0 \)

4. Equilibria as a function of \( \alpha \)
5. eigenvalues

\( \frac{\partial}{\partial x} \frac{dx}{dt} = \alpha - 3x^2 \)

\( \frac{\partial}{\partial x} \frac{dx}{dt} \bigg|_{x=0} = \alpha \Rightarrow \alpha > 0 \) unstable;

\( \alpha < 0 \) stable

\( x = 0 \) changes stability at \( \alpha = 0 \)

\( \frac{\partial}{\partial x} \frac{dx}{dt} \bigg|_{x=\pm\infty} = -2\alpha \Rightarrow \alpha > 0 \) stable
8.3 Investigating systems of 2 ODEs

8.3.1 and 8.3.2

8.3.1.1 Lotka-Volterra competition

\[ f(x, y) = x(1 - x - \alpha y) \]

\[ g(x, y) = y(1 - y - \beta x) \]

Graphical analysis: see §4.2 in the syllabus, p.52 and further; see also computer lab 10.3.

3. \( \alpha < 0 \) en \( \beta < 0 \) : positive, internal equilibrium if \( \alpha \beta < 1 \)

Mathematical analysis:

1. 4 equilibria

2. \[ J = \begin{pmatrix} 1 - \alpha y - 2x - \alpha x \\ -\beta y \\ 1 - \beta x - 2y \end{pmatrix} \]

\( Eq_1 : (0, 0) \Rightarrow J_{(0, 0)} = \begin{pmatrix} 1 \\ 0 \\ 1 \end{pmatrix} \) and \( \lambda_{1,2} = 1 \)

\( Eq_2 : (0, 1) \Rightarrow J_{(0, 1)} = \begin{pmatrix} 1 - \alpha \\ -\beta \\ -1 \end{pmatrix} \) and \( \lambda_1 = -1 \); \( \lambda_2 = 1 - \alpha \)

for \( \alpha < 1 \) : saddle point, otherwise stable node

\( Eq_3 : (1, 0) \) see \( Eq_2 \)

\[ Eq_4 : \begin{pmatrix} 1 - \alpha \\ 1 - \alpha \beta \end{pmatrix} \Rightarrow J_{(eq_4)} = \begin{pmatrix} 1 - \alpha \left( \frac{1 - \beta}{1 - \alpha \beta} \right) - \frac{2 - 2\alpha}{1 - \alpha \beta} - \frac{-\alpha(1 - \alpha)}{1 - \alpha \beta} \\ -\beta \left( \frac{1 - \beta}{1 - \alpha \beta} \right) - \frac{2(1 - \beta)}{1 - \alpha \beta} \end{pmatrix} \]

for \( \alpha = \frac{2}{3} \) and \( \beta = \frac{3}{4} \): \( \lambda_1 = -\frac{1}{6} \); \( \lambda_2 = -1 \) \( \Rightarrow \) stable node

for \( \alpha = \frac{3}{2} \) and \( \beta = 2 \): \( \lambda_1 = \frac{1}{4} \); \( \lambda_2 = -1 \) \( \Rightarrow \) saddle point
8.3.1.2 Roots and squares

\[ f(x, y) = x^2 - y \]

\[ g(x, y) = -x + y^2 \]

Graphical analysis:

Phaseportrait: red - x-isocline; blue - y-isocline

Mathematical analysis:

1. 2 equilibria

2. \[ J = \begin{pmatrix} 2x & -1 \\ -1 & 2y \end{pmatrix} \]

\[ Eq_1 : (0, 0) \Rightarrow J_{(0, 0)} = \begin{pmatrix} 0 & -1 \\ -1 & 0 \end{pmatrix} \quad \text{and} \quad \lambda_{1,2} = \pm 1 \quad \Rightarrow \text{saddle point} \]

\[ Eq_2 : (1, 1) \Rightarrow J_{(1, 1)} = \begin{pmatrix} 2 & -1 \\ -1 & 2 \end{pmatrix} \quad \text{and} \quad \lambda_1 = 3; \quad \lambda_2 = 1 \quad \Rightarrow \text{unstable node} \]

8.3.1.3 Lotka-Volterra prey-predator

\[ f(x, y) = \alpha x - \beta xy \]

\[ g(x, y) = \gamma xy - \delta y \]

This model (including its extensions) is discussed and analyzed in detail in §6.1 in the syllabus, p.100 and further; see also computer lab 10.5.
8.4 Sample exam

Question 1

1. A is a “branching point” (BP) or “transcritical bifurcation point”
   B and C are limit points (LP)
   D is a Hopf bifurcation point

2. At A one of the 2 real eigenvalues that belong to the trivial equilibrium (with density 0), changes from negative to positive (the other eigenvalues remains negative). At the same time one of the 2 real eigenvalues that belong to the non-trivial equilibrium (with density unequal to 0) changes from positive to negative (the other eigenvalue was already negative).
   At D the two complex eigenvalues that belong to the non-trival equilibrium move from the left half to the right half of the complex plane, the real parts of these eigenvalues hence change from negative to positive.

3. At B one of the two real eigenvalues that belong to the non-trivial equilibrium (with density unequal to 0) changes from negative to positive (the other eigenvalue remains negative).
   At C one of the two real eigenvalues that belong to the non-trivial equilibrium (with density unequal to 0) changes from positive to negative (the other eigenvalue was already negative).

4. At 1 and 4 the phaseportrait resembles the phaseportrait as in row 3 of Table 7.1.
   At 2, 3 and 5 the phaseportrait resembles the phaseportrait as in row 1 of Table 7.1.
   At 6 the phaseportrait resembles the phaseportrait as in row 5 of Table 7.1.
   (At 5 the alternative answer is that the phaseportrait resembles the phaseportrait as in row 2 of Table 7.1, this would also be counted as correct).

Question 2

1. \[ \frac{dN}{dt} = 4.5 N \frac{1 + \alpha N}{1 + \alpha + \alpha N} \]

2. Per-capita reproduction for \( \alpha = 0 \): horizontal line at 4.5
   Per-capita mortality for \( \alpha = 0 \): positive linear function of N, crosses y-axis at 1

3. \( N = 0 \) unstable; \( N = 3.5 \) stable
4. Per-capita reproduction rate in red, mortality in green

\[ \frac{dF}{dt} = \rho F \left( 1 - \frac{F}{K} \right) - M(1 - e^{-aF})C \]

\[ \frac{dC}{dt} = c M(1 - e^{-aF}) C - dC \]

5. \( N=0 \) stable; \( N=0.5 \) unstable; \( N=2 \) stable
6. \( \alpha=3.5 \)
7.

Question 3

1. \( \frac{df}{dt} = 0 : f = 0 \) or \( c = \frac{pf(f-k)}{k(e^{-f}-1)} \)
ANSWERS

3. \( \frac{dc}{dt} = 0 : \ c = 0 \quad \text{or} \quad f = -\ln(1 - \mu) \)

4. 
   \[ EQ \ 1 \ : \ (0, 0) \]
   \[ EQ \ 2 \ : \ (\kappa, 0) \]
   \[ EQ \ 3 : \ -\ln(1 - \mu), \ -\frac{\rho \ln(1 - \mu)(\kappa + \ln(1 - \mu))}{\mu \kappa} \]

This last equilibrium you can also write as \( \tilde{f} = -\ln(1 - \mu) \) and \( \tilde{c} = \frac{\rho \tilde{f}(\tilde{f} - k)}{k(e^{\tilde{f}} - 1)} \)

5. 
   \[
   \begin{pmatrix}
   \rho - 2\rho \frac{\tilde{f}}{\kappa} e^{-\tilde{f} c} & -(1 - e^{-\tilde{f}}) \\
   e^{-\tilde{f} c} & (1 - e^{-\tilde{f}}) - \mu
   \end{pmatrix}
   \]

6. Trivial equilibrium:
   Jacobian: \[
   \begin{pmatrix}
   \rho & 0 \\
   0 & -\mu
   \end{pmatrix}
   \Rightarrow \lambda_1 = \rho \quad \lambda_2 = -\mu
   
   equilibrium with only prey:
   Jacobian: \[
   \begin{pmatrix}
   -\rho & -(1 - e^{-x}) \\
   0 & (1 - e^{-x}) - \mu
   \end{pmatrix}
   \Rightarrow \lambda_1 = -\rho \quad \lambda_2 = (1 - e^{-x}) - \mu
   
7. Trivial equilibrium:
   \[
   \begin{pmatrix}
   1 \\
   0 \quad \text{and} \quad 0 \\
   1
   \end{pmatrix}
   \]
   equilibrium with only prey:
   \[
   \begin{pmatrix}
   e^{-x} - 1 \\
   \lambda_1 + \rho
   \end{pmatrix} \quad \text{and} \quad \begin{pmatrix}
   e^{-x} - 1 \\
   \lambda_2 + \rho
   \end{pmatrix}
   \]

8. \( \kappa > -\ln(1 - \mu) \)

9. stable if it exists and as long as \( \rho - 2\rho \frac{\tilde{f}}{\kappa} e^{-\tilde{f}} \tilde{c} < 0 \)

10. The bifurcation graph resembles Figure 7.4 in the syllabus, with \( C \) and \( K \) replaced by \( c \) and \( \kappa \) and with the \( F \)-axis removed.
Part V

Instructions for using MatCont
Chapter 9

MatCont: continuation software in MATLAB

9.1 How to use this manual

The first part of this document gives a step-by-step description of several basic system manipulation features of MatCont, a Matlab package for bifurcation analysis of systems of ordinary differential equations. Until you get the hang of it, it is a good idea to follow the steps in the manual. The second part is more of a general howto-document. It can be read as a guideline, and is by no means comprehensive. It provides a springboard to get you familiarized with the program, from which you should be able to start exploring its darker corners. Finally, MatCont has an built-in Help function, which you can always consult. However, the text is rather technical and less helpful for the beginning user. Use therefore this manual, and ask for help if you still have trouble.

9.2 Installing MatCont

1. Navigate to Blackboard/Course Documents/Files for Computer Practical.
2. Download Matcont.zip (save the .zip file on your Desktop).
3. Extract the .zip file to your desktop (select the .zip file, click the right mouse button and choose the menu item “Extract All...”). A welcome screen opens. Press “Next” to continue. Now a screen appears that allows you to choose where to put the unzipped directory. Put this directory on your Desktop. Make sure that the path in the box “Files will be extracted to this directory:” ends in Desktop.
4. Optional: Make a shortcut to Matlab on your Desktop. Choose the Windows start button and choose “All programs ► Matlab ► R2010b ► Matlab R2010b”. Do not choose this menu item yet by (left) clicking it. Instead, while highlighting the “Matlab R2010b” menu item click the right mouse button and choose the menu item “Send to ► Desktop (create Shortcut)”. Now a shortcut called “Matlab R2010b” has appeared on your desktop.

9.3 Starting MatCont

1. Start Matlab by double-clicking the shortcut “Matlab R2010b” on your desktop. If you did not create such a shortcut use the Windows start button and the menu item “All programs ► Matlab ► R2010b ► Matlab R2010b” to start Matlab.
2. After Matlab has started up you should have a desktop window containing 5 smaller windows with titles “Current Folder”, “Details”, “Command Window”, “Workspace” and “Command History”. (If you do not see this, choose in the menu bar “Desktop ► Desktop Layout ► Default”).
3. In the subpane called “Current Folder” locate the directory Matcont in which you have extracted the zip file under 1 (on your Desktop). Double click the Matcont directory to make it the current directory (just below the subpane title “Current Folder” the box should now read Matcont. In the subpane “Current Folder” you will now see a file matcont.m. Highlight this file, click the right mouse button and choose the menu item “Run”. As an alternative after highlighting you can also press the “F9” function key. Either way starts up the MATCONT program.

4. The following main window of MATCONT will now appear:

![MATCONT Main Window](image)

**Figure 9.1:** The main system window of MatCont.

### 9.4 Basic system manipulation in MatCont

#### 9.4.1 Create a new system

We will use the logistic growth equation to illustrate how to implement a system of ordinary differential equations in MatCont. The model is described by the ordinary differential equation:

\[
\frac{dN}{dt} = rN(1 - \frac{N}{K})
\]  

(9.1)

This model can be implemented in MatCont as follows:

1. In MatCont’s main system window (see figure 9.1) choose “Select ▶ System ▶ New”. This opens up an empty system specification window (see figure 9.2).

2. Enter a name for the model in the box labeled “Name”. Given the example, “LogisticGrowth” is an obvious choice for the name.

   *Notice that names in Matlab can not contain any spaces, dots, comma’s and other punctuation symbols! Also notice that some symbols can not be used in Matlab as a name for a variable or a parameter, as they are used internally by the program. For example, the symbol “ eps ” is used internally to indicate the smallest double value that is considered different from 0. Hence, “ eps ” can not be used in the model specification to represent a parameter ε. The program will check the validity of the names that are used for the system, the variables and parameters and ask you to revise them if they are invalid.*

3. In box labeled “Coordinates” specify the dependent variables in the model. If there are multiple variables (for example, X and Y) separate them with a comma in between.

4. In box labeled “Parameters” specify the parameters in the model. If there are multiple parameters (for example, r and K) separate them with a comma in between.

5. In the box labeled “Time” the name “t” is already used to indicate the time variable. Leave that unchanged.
9.4. BASIC SYSTEM MANIPULATION IN MATCONT

Figure 9.2: Empty system specification window of MatCont.

6. If the Matlab Symbolic Toolbox is present, there will be buttons indicated “SYMBOLICALLY” under the heading “DERIVATIVES”. These choices pertain to the (partial) derivatives of the right-hand side of the differential equations with respect to the variables and the parameters. The first-order derivatives are used in some of the integration algorithms, the first- and second-order derivatives are used in the continuation of equilibrium curves as a function of parameters. It is advisable to select “SYMBOLICALLY” for the first- and second-order derivatives.

7. Entering a model in MatCont uses standard Matlab language, which is quite straightforward. For example, the logistic growth equation (9.1) is implemented as:

\[ N' = r \cdot N \cdot (1 - N/K) \]

It is possible to use all functions and operators available in the C programming language. For example, if the differential equation contains an exponential function of the model variable \( N \), like \( e^{-aN} \), this can be implemented in MatCont as \( \exp(-a\cdot N) \).

8. The complete window after following the steps above should now look as shown in figure 9.3. When you’re done implementing the model click “OK”, if you change your mind select “CANCEL”.

When you are done with implementing your model you can continue with its analysis by following the step in section 9.7 below. The next subsection explain how you can edit or change, rename or remove a model that you have already implemented. In general you have to consult these sections only after you have already carried out some analysis with the program.

9.4.2 Manipulating already defined systems

To edit an existing system, follow the steps below:
Figure 9.3: Specification of the logistic growth model in MatCont.

1. In MatCont’s main system window (see figure 9.1) choose “SELECT ► SYSTEM ► EDIT/LOAD”.
2. In the list of systems that appears, select the one you intend to edit.
3. Press the “Edit” button to edit the system.
4. You are now presented with the system and you can start editing. Remember though that already computed curves and diagrams stored for the model may become invalid if names are changed in the “COORDINATES” or “PARAMETERS” lists.

To delete an existing system, carry out the following steps:

1. In MatCont’s main system window (see figure 9.1) choose “SELECT ► SYSTEM ► EDIT/LOAD”.
2. In the list of systems that appears, select the one you intend to delete.
3. Select the menu “ACTION ► DELETE”.

To start computations with an existing system, carry out the following steps:

1. In MatCont’s main system window (see figure 9.1) choose “SELECT ► SYSTEM ► EDIT/LOAD”.
2. In the list of systems that appears, select the one you intend to edit.
3. Press the “LOAD” button to load the system.

9.5 Visualizing output

The two main ways of inspecting output from calculations in MatCont are through numeric and through graphic windows. Note, however, that opening one of these windows is only possible after you have
9.5. VISUALIZING OUTPUT

defined which type of computation should be carried out (see section 9.7). To open a numeric window, select “WINDOW ▶ NUMERIC” from MatCont’s main system window. Numeric windows are quite straightforward. They show the current value of a number of properties of your system as the computation runs along. By selecting “WINDOW ▶ LAYOUT” in a numeric window, you can show or hide particular categories of model quantities (e.g. variables, parameters). See figure 9.4 for an illustration.

Figure 9.4: MatCont’s numeric window and its layout submenu. Left: MatCont’s numeric window shows all variables and parameters of the logistic growth model. Right: the window that shows up after selecting “WINDOW ▶ LAYOUT” in the numeric window. Categories of model quantities in capitals will be shown in the numeric window (here only the time variable and the model coordinates), while categories of model quantities in lower case are not shown. Specific categories can be shown/hidden by clicking on them.

Graphic windows can either be 2D-plots or 3D-plots, which can be opened by selecting either “WINDOW ▶ GRAPHIC ▶ 2DPLT” or “WINDOW ▶ GRAPHIC ▶ 3DPLT” in MatCont’s main system window. 3D-plots are rarely used in MatCont, as they tend to be messy and hard to read, so I will not discuss them here.

A 2D-plot can be opened by selecting “WINDOW ▶ GRAPHIC ▶ 2DPLT” in MatCont’s main system window. If you select this for the first time a window will pop up, in which you have to select what variable should be plotted on the x-axis (referred to as abscissa), the y-axis at the left-hand side of the graph (referred to as ordinate) and the optional, secondary y-axis at its right-hand side (referred to as ordinate2). You can select these variables from the different categories of model quantities available (e.g. variables, parameters). For the secondary y-axis (ordinate2) the category of model quantities can be set to “Undefined”, in which case the second y-axis on the right-hand side of the graph will be hidden. After selecting the time variable t and the population density N in the logistic growth model as variable to be plotted on the x- and y-axis, respectively, an empty 2D-plot window with default scaling of both axes between 0 (minimum) and 1 (maximum) shows up (see figure 9.5).

The variables plotted on the x-axis, y-axis and the optional secondary y-axis can be changed by selecting “LAYOUT ▶ VARIABLES ON AXES” in the menu bar of the 2D-plot window itself. By selecting “LAYOUT ▶ Plotting region” in the same menu bar the minimum and maximum values plotted on the x-axis, y-axis and the optional secondary y-axis can be changed to more appropriate values.

By selecting “PLOT ▶ Redraw diagram” in the menu bar of the 2D-plot window all the curves that have been computed and are contained in the current diagram can be redrawn (see section 9.6 for a discussion of curves and diagrams). The currently selected curve in the diagram can be redrawn by selecting “PLOT ▶ Redraw curve” in the menu bar of the 2D-plot window. The name of the currently selected curve is also shown in MatCont’s main system window (see figure 9.5).

Finally, by choosing “PLOT ▶ Clear” in the menu bar of a 2D-plot window the plot can be cleared, i.e. all curves drawn in the plot are erased. This does not, however, delete these curves. They are still stored on disk and can be redrawn by choosing either “PLOT ▶ Redraw curve” or “PLOT ▶ Redraw diagram” from the menu bar.
9.6 Storage and organization of computed curves

MatCont does not contain the familiar options “load” and “save” to store and retrieve results that you have computed earlier. Instead, MatCont stores computed curves by giving them temporary names. Curves with such temporary names are referred to as “untitled curves”. To view and access the curves that you have computed open the “Curve” window, which you reach by choosing “Select ► Curve” from MatCont’s main system window. This window shows you a list of all the computations within the current diagram, with the most recent one on top. Names of untitled curves are labeled with the point type, from which the computation was started, the curve type and a number. Examples of such names are: P\_O(1), EP\_EP(2) or LP\_LP(1).

There is however a maximum to the number of untitled curves that MatCont stores. If you compute more curves than the maximum number of untitled curves, the oldest curve will be deleted each time you calculate a new one. Note that calculating the same curve twice counts as calculating two curves. Also note that if you compute a new curve, it automatically becomes the currently selected curve. Thus it is not possible to “overwrite” a curve by computing a new one.

You can permanently store an untitled curve by changing its name. Renaming and deleting curves is done from the “Curve” window, which you reach by choosing “Select ► Curve” MatCont’s main system window. Once you have changed the name of a curve to something other that its temporary name (see above) it will only be deleted if you explicitly instruct the program to do so.

A good way of organizing stored computations is by using “diagrams”. These are analogous to the more familiar “folders”. They can be defined anew, renamed and deleted, and may contain any number of
9.7. COMPUTATION

computed curves. You switch to another diagram or create a new diagram by choosing “SELECT ▶ DIAGRAM” from MatCont’s main system window. When you do so you are given the option to preserve the numerical settings that MatCont is currently using, the graph windows that are open and the initial point and curve type of the computation that are currently selected. Preserving these settings allows you to select a particular bifurcation or initial point in the diagram that MatCont is using, but proceed with computation only after switching to another diagram or after creating a new diagram. Effectively, this allows for separating out, for example, curve computations as a function of a single free parameter from computations of curves that involve two free parameters, while still using special points in one diagram as the start for computations in the other.

From within MatCont itself it is not possible to move computed curves from one diagram to another. However, each curve is stored as a separate Matlab file with an extension ‘.mat’ and these files can be moved easily between diagrams using Matlab’s desktop. In the subpane called “CURRENT FOLDER” of your Matlab desktop a folder called “SYSTEMS” will be visible in the directory from which MatCont was started. In this folder MatCont stores all information regarding the models it has used for. All diagrams pertaining to a particular model are stored in a subdirectory of the “SYSTEMS” folder, which carries the same name as the model. Each diagram is in turn a subdirectory of this model-specific folder. Hence, all the curves contained in a diagram with the name “TimeSeries” of the logistic growth model are to be found in the folder “SYSTEMS/LOGISTICGROWTH/TIMESERIES” (Remember that the name “LogisticGrowth” had been assigned above to this particular model).

To view the contents of an already computed curve, you first have to select the curve, which can be done by choosing “SELECT ▶ CURVE” MatCont’s main system window, highlighting the curve you are interested in and pressing the “SELECT” button. In a 2D-plot window you have now the option to redraw the curve by selecting “PLOT ▶ REDRAW CURVE” in the appropriate graphic window. To redraw the results of all curves within the current diagram, choose “PLOT ▶ REDRAW DIAGRAM” in the appropriate graphic window.

9.7 Computation

To compute curves using MatCont several settings need to be defined. First of all, you have to tell the program the type of curve you intend to compute, and the type of point from which you will start the computation. The type of initial point to start computations from is set by choosing “TYPE ▶ INITIAL POINT” in MatCont’s main window. The type of curve to compute is set by choosing “TYPE ▶ CURVE” in the same window. Notice that the currently selected point type and curve type are also listed in the MatCont’s main window.

Second, you have to provide the initial values of all the necessary variables, parameters and computational settings. The computational settings have default values that suffice for fairly standard computations, but may need tweaking for more complex systems.

9.7.1 Orbits

The most basic computation type that MatCont performs is the computation of an orbit. This is a trajectory of the system in time from set initial conditions. To perform this type of computation, choose “POINT” as the type of initial point, the curve type is then automatically changed to “Orbit”. MatCont’s main window now list the name of the curve as P\textsubscript{O}(1), the point as “P” and the curve as “O”. Two new windows show up on your screen, called “STARTER” and “INTEGRATOR”. As the names suggest, one contains all system-specific information (like parameters etc) needed to start the requested computation, while the other contains the specifications of the computation itself, for example the length of time that you intend your orbit to continue. The integrator contains one menu item, called “METHOD”, which allows you to choose the integration method to apply.

If all the settings for your calculation are entered, you can start the computation by selecting “COMPUTE ▶ FORWARD” or “COMPUTE ▶ BACKWARD” from MatCont’s main window. In case of computations of orbits “COMPUTE ▶ FORWARD” means that integration to positive, increasing values of the time are carried out, while “COMPUTE ▶ BACKWARD” integrates back in time toward negative values of the time variable. The computation will run until it reaches the amount of time you specified in the “INTEGRATOR”
window, until you interrupt it, or until one of the error thresholds of the integration routine is crossed. You can pause the computation by hitting the space bar and end it by hitting the escape button. You can also pause or end a computation using the buttons “Pause” and “Stop” in the small window that pops up when you start a computation. When you pause a computation the “Pause” button will change to “Resume”. Pressing that button resumes the computation, which can also be achieved by hitting the space bar once again.

“Compute ▶ Extend” computes the same curve as the last computed one, starting at the last point of the previous computation. Thus, if you initially calculated \( t = 0 \) to \( t = 100 \), “Compute ▶ Extend” will compute \( t = 101 \) to 200. Note that this does not create a new curve, it appends the results to those of the first curve (refer to the description of curves and diagrams in section 9.6).

9.7.2 Equilibria

If the system converges to an equilibrium point during the computation of an orbit, MatCont allows you to compute the properties of that equilibrium when one or more parameters are changed. In order to do this, you need to tell MatCont to use the end point of the computed orbit as the starting point of a new calculation. For example, figure 9.6 shows all MatCont windows after computing an orbit of the logistic growth model with \( r = 0.1 \), \( K = 100 \) and \( N(0) = 0.1 \). Clearly, the dynamics converge to a stable equilibrium. Now select the final point of the orbit by choosing “Select ▶ Initial Point” in the MatCont’s main system window. A window appears showing all the curves in the current diagram,
and a list of “special points” for each curve. For an orbit, the “first point” and the “last point” are the only special points listed, as shown below:

Select the last point by highlighting it and then click on “Select”. To compute an equilibrium curve, select “Type ➤ Initial Point ➤ Equilibrium” from MatCont’s main system window. This will automatically change the curve type to “Equilibrium” as well. If for one reason or the other the curve type is not automatically changed to “Equilibrium”, do so by choosing “Type ➤ Curve ➤ Equilibrium” from MatCont’s main system window.

Now two new calculation windows appear that are different from those when calculating an orbit. The “Starter” window now gives you the opportunity to select the parameter that you want to vary. This is done by selecting the radio button in front of the parameter name. If it is selected, the radio button is black. Notice that you can select more than one parameter by clicking their corresponding radio buttons. For equilibrium curves, however, only one parameter should be selected. A selected parameter can be deselected by clicking once again the radio button in front of its name.

Furthermore, there are 2 new sections in the starter window that are of importance. In the section “Monitor singularities” you can turn on or off the option to check whether a point on the equilibrium curve is a bifurcation point. As the names suggest, branching detects branching points, limit point detects limit points (of fold bifurcations) and Hopf detects Hopf bifurcations. In the section “Calculate eigenvalues” you can toggle the option to compute the eigenvalues of the system. This is a very handy option, as it allows you to plot the value of these eigenvalues in the complex plane. The sections that are not discussed do not matter for now, their default values suffice for all computations you will encounter.

Instead of an “Integrator” window, a new window named “Continuer” has appeared. Here the parameters are set for the algorithm that is used to continue the selected equilibrium curve in parameter space. A useful variable in this window is “MaxStepsize”, which controls the maximum step size along the computed curve. If calculations take very long because the program takes very small steps increase the value of “MaxStepsize”. If computed curves look very much like composed of a few straight line sections, decrease the value of “MaxStepsize”. The setting titled “MaxNumPoints” defines after how many computations steps the calculation stops. There is no 1:1 correspondence between the value of the varied parameter and the number of points, since the continuation algorithm uses a variable time step.

Once all settings are entered correctly, you can compute the equilibrium curve by choosing “Compute ➤ forward”, “Compute ➤ backward” or “Compute ➤ extend”. When all the options under “Monitor singularities” in the “Continuer” window are set to “yes”, the computation will automatically pause when one of such special points is encountered.
9.7.3 Bifurcation points

Bifurcation points themselves can be used as initial points and can be continued in parameter space. To do this, the bifurcation point should be selected as initial point. A good procedure to follow is to first selected the curve, in which the bifurcation point occurs, by choosing “Select ▶ Curve” from MatCont’s main system window. By first selecting the curve all numerical settings that were used to compute the curve are preserved for the subsequent calculation. Next choose “Select ▶ Initial point” in MatCont’s main system window and select the particular bifurcation point that you want to continue. Selecting the initial point will automatically change the point type and the curve that MatCont defaults to computing. For example, if you have encountered a Hopf bifurcation point and you select this as initial point for further computations, in MatCont’s main system window the point type defaults to “H” (from Hopf) and the curve type defaults to “LC”, as shorthand for limit cycle. This default setting hence allows you to start the continuation of a limit cycle as a function of a single parameter, which originates from the detected Hopf bifurcation point (see section 9.7.5). If instead you want to continue the curve of the Hopf bifurcation point as a function of 2 parameters you will have to change the curve type by choosing “Type ▶ Curve ▶ Hopf”.

To continue the Hopf bifurcation, you will need to select 2 parameters in the starter window by clicking the radio buttons in front of their names, since a Hopf bifurcation is of order 2. To compute the curve select “Compute ▶ forward” or “Compute ▶ backward” and afterward possibly “Compute ▶ extend”.

Figure 9.7: Implementation of the Rosenzweig-MacArthur model in MatCont.
9.7. COMPUTATION

9.7.4 Branching points and their continuation

To illustrate the procedure of detecting branching points and continuing branching point curves in a two parameter plane, consider the following classical predator-prey model:

\[
\frac{dF}{dt} = rF \left(1 - \frac{F}{K}\right) - \frac{aF}{1 + ahF} C 
\]

(9.2a)

\[
\frac{dC}{dt} = \epsilon \frac{aF}{1 + ahF} C - \mu C 
\]

(9.2b)

This so-called Rosenzweig-MacArthur model is discussed in detail on page 108-117 of the syllabus. This model is implemented in MatCont as shown in figure 9.7. Two things should be noted regarding this implementation: the symbol “C” can not be used in MatCont as a variable name because of a conflict with an internal variable. Hence, the predator is indicated in the implementation with “N”. Secondly, an additional parameter “invN” is added to the differential equation of the predator. This parameter resembles an immigration/emigration term, but in effect will always be equal to 0. MatCont needs this additional parameter, however, to continue branching points as a function of 2 model parameters.

Figure 9.8: Desktop view of the Rosenzweig-MacArthur model in MatCont after computation of the branch of trivial equilibria (with zero predator density).

After implementing and compiling the Rosenzweig-MacArthur model the curve of trivial equilibria (where \( N = 0 \)) can be computed as a function of the prey carrying capacity \( K \) with \( r = 0.5, a = 5.0, h = 3.0, \epsilon = 0.5 \) and \( \mu = 0.1 \) by taking as initial value \( K = 0.001 \), for the prey density also \( F = 0.001 \) and \( N = 0 \). Choosing “Compute ▶ Forward” leads to the detection of a branching point. Hit the space bar to continue the computation of the curve of trivial equilibria even beyond this branching point. Figure 9.8 shows the desktop with all MatCont windows (a numeric window is not shown) after this computation. Note the branching point labeled “BP” in the 2D-plot window. Alternatively, you can press the “Switch” button in the small computation window that also contains the “Pause” and “Stop”. The “Switch” button gets activated after the branching point is detected and can be used as a short-cut to immediately stop the current computation and to switch to a computation using the detected branching point as initial point, as also described below.

The detected branching point is selected as starting point for further computations by choosing “Select ▶ Initial point” in MatCont’s main system window. Selection of the branching point as initial point for further computations changes the default type of initial point to “BP” (branching point) and the
default type of curve also to “BP”. This can be read off in MatCont’s main system window. At the same time MatCont’s “STARTER” and “CONTINUER” window change. From this point onward two different roads can be followed: either the curve of branching points is computed as a function of 2 model parameters or the branching point is used as a starting point for a continuation of the curve of non-trivial equilibria that intersects the curve of trivial equilibria in the branching point.

Figure 9.9: Desktop view of the Rosenzweig-MacArthur model in MatCont. The state of the desktop is shown after computation of the curve of branching points as a function of the prey carrying capacity $K$ (on the $y$-axis) and the predator death rate $\mu$ (on the $x$-axis)

To compute the curve of branching points as a function of 2 model parameters the curve type should be labeled “BP” in MatCont’s main system window (if necessary change by choosing “TYPE ► CURVE ► BRANCH POINT”). In the “STARTER” window now two columns of radio buttons have appeared in front of the names of the parameters. The first column is labeled “BP”, the second column is labeled “Active”. In the “Active” column select the radio buttons in front of the 2 model parameters that you want to vary in the computation of the curve of branching points. In addition, select the radio button in front of the dummy parameter “invN”. In the column labeled “BP” select the radio button in front of the parameter $K$. Effectively, this selection tells MatCont that a branching point has been detected in an equilibrium continuation as a function of the parameter $K$. MatCont needs that to understand along which parameter axis the branching point occurs. Choosing “COMPUTE ► FORWARD” and subsequently “COMPUTE ► BACKWARD” now computes the branching point curve as a function of the 2 model parameters.

Figure 9.9 provides a desktop view of all MatCont windows after a computation of the curve of branching points as a function of the prey carrying capacity $K$ and the predator death rate $\mu$ for $r = 0.5$, $a = 5.0$, $h = 3.0$, and $\epsilon = 0.5$. MatCont’s 2D-plot window has been modified for this figure to show $\mu$ on the $x$-axis (ranging from 0 to 0.2) and $K$ on the $y$-axis (ranging from 0 to 1).

Alternatively, from the branching point that was initially detected in the curve of trivial equilibria (with $C = 0$) the curve of non-trivial equilibria that intersects the curve of trivial equilibria in the branching point can be computed. To do so, just change the curve type to be computed to “Equilibrium” (choose “TYPE ► CURVE ► EQUILIBRIUM”), after having selected the branching point as initial point (see above).
9.7.5 Limit cycles

In addition to numerical investigations of fixed points, MatCont can also be used to calculate properties of limit cycles. If you find a Hopf bifurcation point, it is easy to pick up the limit cycle that departs from it, and continue it in parameter space. Select the Hopf bifurcation point as the initial point (select it by choosing from the list under “SELECT Initial point”). This sets automatically the default type of the initial point of the computation to “H” (from Hopf) and the default type of the curve to be computed to “LC” (from limit cycle). Now, “Compute Forward”, “Compute Backward” and “Compute Extend” can be used to continue the limit cycle and its properties in parameter space. Note that in this case, you must select only one parameter in MatCont’s “Starter” window. You can also start limit cycle continuation directly from an orbit computation, however, the procedure to do this is more complex and usually it is easier to first find the Hopf bifurcation where the limit cycle originated, and continue it from there.

9.8 Modifying and exporting graphs

MatCont’s 2D-plot window are standard Matlab plot windows and hence allow a lot of editing and modifying to suite your needs. It should, however, be noted that all edits and modifications will be lost as soon as the 2D-plot window is cleared via “Plot Clear” in the menu bar of the window. Modifications are also lost after you have stopped MatCont and have restarted. Hence, all modifications should be done just before exporting the image of the graph to a file.

9.8.1 Modifying the layout of graphs with only a single $y$-axis

![Figure 9.10: Modifying the curve colors in MatCont’s 2D-plot window. Note the highlighted white arrow in toolbar (sixth from left), indicating the edit icon](image)

Graphs with only a single $y$-axis are more easy to edit than graphs, in which also the second, optional $y$-axis at the right-hand side of the graph is shown. Editing the latter graphs is the topic of the next
subsection, here only the editing of simple graphs with a single \( y \)-axis is discussed. To start editing such a graph click the white arrow in toolbar of the 2D-plot window (see figure 9.10 where it is the sixth icon from the left, showing up highlighted). After clicking this edit icon in the toolbar, curves in the plot can be selected. Clicking the right mouse button then pops up a context menu, as shown in figure 9.11 which allows to change the line properties (color, style, width, marker, etc.). Figure 9.10 shows orbits of the logistic growth model, similar to the one shown in figure 9.6 but then started from 3 different initial values. The colors of two of the orbits have been changed to red and green, respectively. A curve can be selected by clicking on it. As long as a curve is selected it is indicated with black markers. Figure 9.11 shows that the red curve is selected and that the right mouse button has been clicked to bring up the context menu. Notice the different items in this menu. After changing line properties click with the mouse anywhere in the 2D-plot window to deselect the curve and to let the property changes take effect.

Finally, these editing facilities also allow you to collect different curves, representing different model quantities in one and the same graph. For example, to plot in the Rosenzweig-MacArthur model both the prey and the predator density as a function of the time in a single graph with only a single \( y \)-axis, first create separate 2D-plot windows for the prey and the predator density, respectively, showing the two curves that you want to plot in one graph. Start editing the two 2D-plot windows by highlighting in both the edit icon (the white arrow in the toolbar). If required, change the line properties of the curve following the steps outlined above. After completing the necessary modification of the line properties, select the curve in the 2D-plot window showing the prey density as a function of time and copy this curve by clicking the right mouse button and choosing “Copy” in the pop-up context menu (see figure 9.10). Now click anywhere in the 2D-plot window showing the predator density as a function of time (but do not select the predator curve itself!) and once again click the right mouse button. This brings up a context menu with a menu item “Paste”. Selecting this menu item inserts the curve of the prey density as a function of time into the 2D-plot of the curve of predator density as a function of the time (of course, the reverse operation of copying the predator curve to the prey window could have been done as well). Remember, however, that also these changes are lost as soon as the 2D-plot window is closed or cleared. Hence, save the figure to an image file if needed following the steps above.

### 9.8.2 Modifying the layout of graphs with both a left and right \( y \)-axis

Editing a graph with \( y \)-axes at both the left- and the right-hand size is more complicated because the curve that is plotted on the right \( y \)-axis is contained in a separate layer that cannot be selected. Hence, only the curve shown on the left \( y \)-axis can be edited following the procedure presented in the previous subsection. In cases that the simplified procedure of the previous subsection does not suffice Matlab’s Figure editor has to be used to edit a graph.

To edit a MatCont 2D-plot in Matlab’s figure editor, press the plot tools icon on the particular graph window that you want to edit, which is the right-most icon on the toolbar of the 2D-plot window (see figure 9.10). Pressing this plot tools icon opens up the window of Matlab’s Figure editor and docks the MatCont 2D-plot window as a subpane in the figure editor window (see figure 9.11). To edit the elements of the MatCont figure now first make sure that the figure editor also shows the “Plot Browser” and “Property Editor” panes like they are in figure 9.11. If these subpanes are not shown, activate them by choosing “Desktop ▶ Plot Browser” and “Desktop ▶ Property Editor” from the the menu bar of the figure editor. Notice that the precise arrangement of the 3 subpanes of the figure editor can differ from their placement as shown in figure 9.11. The exact position of a subpane can in fact be changed by the user by simply dragging the top bar of the subpane around. Figure 9.11 shows a MatCont 2D-plot with 2 curves. Correspondingly, in the plot browser subpane of the figure editor entries are visible for two sets of axes (the left and right \( y \)-axis together with their \( x \)-axis which are plotted directly on top of each other). After selecting in the plot browser subpane a graph element (e.g. a particular set of axes, the lines, or even the symbols used to mark bifurcation points) the property editor subpane will show a list of properties of the selected item that can be changed. All elements of the plot can now be changed. Figure 9.11 shows in fact a plot after increasing the font size of its axes labels and titles, after increasing the line width of the curves shown and after changing the style of one of the curve to dashed. Even the letters used to label the bifurcation points have been moved slightly in figure 9.11 for better visibility. Their size and appearance can also be changed freely by selecting through clicking on them in the plot itself. Sometimes it is necessary to hide one of the set of axes (usually the lowest one in the plot browser list) to be able to select the items associated with the other axes. For example, selecting and moving
9.8. MODIFYING AND EXPORTING GRAPHS

Figure 9.11: Modifying a MatCont 2D-plot using the Matlab’s Figure editor. The image shows the window of figure editor with a docked graph window of MatCont. Apart from the docked graph window also the “Plot Browser” and “Property Editor” panes are visible in the figure editor, which can be activated by choosing “Desktop ➤ Plot Browser” and “Desktop ➤ Property Editor” from the figure editor’s menu bar.

the upper-most symbol “H” (associated with the right y-axis in the graph) shown in figure 9.11 was only possible after temporarily hiding the left y-axis and its associated x-axis (by removing the check mark in front of lowest “Axes” item shown in the plot browser subpane).

Using Matlab’s figure editor all elements of a MatCont 2D-graph can be changed in many ways. To discuss all the possibilities goes beyond the purpose of this section, but you are invited to try out the capabilities of the figure editor. Notice, however, that all changes that you make to a 2D-plot of MatCont are lost as soon as you refresh the graph (by choosing any of the entries of its “Plot” menu), close off MatCont or start a new computation. Hence, changing a graph layout is only useful shortly before you export the graph to an image file, which is discussed below.

In principle you can leave a MatCont graph window docked inside Matlab’s figure editor even while carrying out computations, but you will discover that computations then take a long time, as Matlab continuously has to update the plot browser list in the figure editor. Hence, it is advisable to undock MatCont’s 2D-plot window from the figure editor after changing a graph and to close the window of the figure editor entirely. Undocking a graph can be achieved to press the undock icon on toolbar of the figure editor, which is the curved arrow symbol pointing upward shown second from the left in the toolbar in figure 9.11.

9.8.3 Exporting graphs

After modifying a 2D-graph it can be exported to an image file. To this end, choose “File ➤ Save As...” from the menu bar in the 2D-graph window. You can save the image in a number of different file formats, it is best to use either JPEG or PNG (Portable Network Graphics). Save the image file in a folder of your choice with a name that is meaningful to you. (If you by accident do not change anything,
the 2D-plot window will be saved to the file D2.fig, which is a MatCont core file in Matlab format. Not so handy!)

9.9 Special cases

9.9.1 Special case 1: plots of eigenvalues in the complex plane

In many situations plots of the eigenvalues pertaining to a particular equilibrium give you insight into exactly how equilibrium stability changes with parameters. To define such a plot open a 2D-plot window and set the scales for the $x$- and $y$-axis from -1 to 1 by choosing “Layout ▶ Plotting region” from the menu bar of MatCont’s 2D-plot window. Then choose “Layout ▶ Variables on axes” from the same menu bar. Setting the category of variables (the second column of drop-down menu’s in the window) to “Eigenvalues” for either the abscissa ($x$-axis) or the ordinate ($y$-axis) makes that a third column pops up with a drop-down menu that is by default set to “Real part”. The alternatives to “Real part” are “Imag. part” and “Norm”. The 3 choices select between the real part of the eigenvalues, their imaginary part or their absolute value (Euclidean norm). Suppose you are investigating a 2-dimensional system. If then the real part of the eigenvalues is selected for plotting, the variable in the first column of drop-down menu’s can be set to either Re[1], Re[2] or Re[All]. Choosing between these 3 alternatives will lead to plotting the real part of the first eigenvalue, the second eigenvalue and simultaneous plotting of both the first and second eigenvalue, respectively. In case the imaginary part is selected for plotting, the variable in the first column of drop-down menu’s can be set to either Im[1], Im[2] or Im[All], while selecting the norm of the eigenvalues for plotting changes the choices to Norm[1], Norm[2] or Norm[All]. Selecting Re[All] to be plotted on the abscissa ($x$-axis) and Im[All] to be for the ordinate ($y$-axis) defines a plot showing how the eigenvalues of your system “dance” around the origin in the complex plane, as you change a parameter (by calculating an equilibrium curve).
Part VI

Computer Labs
Chapter 10

Computer Labs

10.1 Harvesting Cod

In 1497 the ocean around Newfoundland (Canada) was once so full of cod that explorer John Cabot marveled that they virtually blocked his ship. In 1992 the Canadian cod industry collapsed. Years of over-fishing had reduced the stock to dangerous levels, and the Canadian government was finally forced to put a stop to the drastic over-fishing. 40,000 people lost their jobs. In 2001 Cod stocks in the North Sea are down to one-tenth of the level 30 years ago. Scientists fear that North Sea cod may go the way of those in the Grand Banks of Canada, where over-fished stocks disappeared in 1992 and have not revived.

Consider the following differential equation:

\[ \frac{dN}{dt} = r N \left( 1 - \frac{N}{K} \right) \]

Here \( N \) stands for the Cod population (in 100,000 tons of cod), \( r \) is the intrinsic growth rate (per day), and \( K \) is the carrying capacity (in 100,000 tons of cod). This is the familiar logistic growth equation that describes the growth of most self-limiting populations. We are interested in describing the qualitative behavior of the cod population of the North Sea and wish to make a few statements about fishing and more importantly about the risks of over-fishing. For the sake of simplicity, we will start with this simplest of models.

1. Use Excel (the worksheet “RHS-1-ODE.xls”) to investigate the properties of the right-hand side of the ODE for different values of \( r \) and \( K \). Which equilibria can you find? How do they change as a function of \( K \) and \( r \)?

2. Now implement the model in MATCONT. Compute some orbits for different parameter combinations of \( K \) and \( r \). Use this as an exercise to familiarize yourself with MATCONT.

3. Subsequently, try to construct a graph of the equilibrium as a function of \( K \).

Fishing - Constant effort

Let’s play around with the logistic growth equation for a bit to study the effects of fishing mortality. Assume that the fishing mortality is such that fisherman make a constant effort per day and so harvest a fraction \( f \) of the actual cod population in the water.

4. Think about what this means. How would you change the logistic growth model so as to include this?

5. Implement this model also in MATCONT & Excel. Parameters are: \( K = 10 \), \( r = 0.1 \), \( f = .01 \).

6. Start off by making several numerical integrations (orbits) of this model. Make sure to start at several different initial conditions. How many equilibria does the model have? How stable are they? What is the effect of increasing \( f \)?
7. Now move on to continuing equilibria in MATCONT. Select a final point of a computed orbit to start continuing the equilibrium curve. Do not forget to change the point and curve type.

8. Follow the equilibria of this model as a function of $f$. Can you link what you see here to what you have observed previously?

**Fishing - Constant quota**

The situation in the North Sea is not as quite as rose-colored as shown above, at least not from a fish’s point of view. The fact of the matter is that governments set fixed, yearly, quotas ($Q$) for the capture of fish and so fishing pressure is more or less a constant.

9. Think about what this means. How would you change the existing model for fish growth in the North Sea so as to include this constant fishing pressure?

10. Implement the model in MATCONT. Parameters are: $K = 10$, $r = 0.1$, $Q = 0.05$. Do you still have a logistic or modified logistic growth model?

11. Make several orbits with different initial conditions. How has the behavior of the system changed from that of the logistic model? Next, set $Q$ to 0.1, 0.2, 0.25, and 0.26. What happens to the fish population for each of these quotas?

12. Select an orbit for parameters that support a viable fish population. Select as initial point the end point of the orbit to start continuing an equilibrium curve. Do not forget to change the point and curve type.

13. Open a new 2D-plot window and select $Q$ and $N$ for the axis variables. Plot the equilibrium. What is stable? Unstable? Relate what you see now to what you have observed previously.

14. What is the effect of a) faster fish stock re-growth and b) an increased fish carrying capacity on the equilibrium curve? (tip: see the section on Bifurcation points in the MATCONT manual).

15. Is a constant quota a good thing for fish? For the fishing industry? Compare with the constant effort model.
10.2 The spruce-budworm (*Choristoneura fumiferana*)

The spruce budworm (*Choristoneura fumiferana*) is a moth that inhabits northern American pine forests. Normally, the density of these moths is not very high, and their impact upon the forest is small. However, approximately once every 40 years, their density increases explosively, and entire forests are picked clean of needles in a very short time span. Obviously, this has severe negative effects on local timber production. The major predators of these budworms are birds, and at high densities budworms make up a major part of the birds diet. The budworms themselves eat the newly emerging needles of pine and spruce trees. The following model has been proposed to explain the outbreaks of budworm population dynamics.

\[
\frac{dN}{dt} = rN(1 - \frac{N}{K}) - \frac{EPN^2}{N_0 + N^2}
\]

with \( K = qA \) and \( N_0 = fA \).

Both \( K \) and \( N_0 \) depend on \( A \), which is the leaf (or needle) density of the forest. Of course, in reality \( A \) is not a constant. But the dynamics of the forest are on such a slow timescale compared to the dynamics of the budworms, that we treat it as such. \( P \), the density of the predatory birds, is also assumed constant. This is because if budworm density is low, the birds either switch to other prey, or migrate out of the area. Either way, there is no numerical response of birds to changes in budworm density.

A valid parameter setting for this model is: \( A = 0.5, q = 20, E = 0.314, f = 0.474, P = 0.7 \) and \( r = 0.1 \). This parameter setting reflects the conditions in North American pine forests.

1. Implement the model in MATCONT and open an 2D-plot window with time on the x-axis and the density \( N \) on the y-axis.
2. Compute several orbits for the default parameter set, while varying the initial value of \( N \). Make sure to study not only high population densities, but also to consider the range \( N = 0.0 \ldots 0.1 \).
3. Repeat this procedure for various values of \( A \) between 0.1 and 5.0. What is the most remarkable feature that you encounter?
4. Compute now also several orbits for the default parameter set and various initial values of \( N \), but going backward in time (Use “Compute→backward”). What do you reach by carrying out this backward computation?
5. Now turn to Excel (use the worksheet “RHS-1-ODE.xls”) and investigate the right-hand side of the ODE as a function of \( N \). Do this for a number of different values of \( A \) between 0.1 and 5.0. Explain the results you obtained by integration with MATCONT using the changes you observe in the graphs of the right-hand side of the ODE.
6. Turn back to MATCONT. Select one of the final points of an orbit to start a continuation of the equilibrium as a function of \( A \). Do not forget to change the point and curve type. Relate your findings of the integrations to the picture you have constructed.
7. Explain in words the mechanism behind the regular outbreaks of the spruce budworm in North American forests.
8. One way to prevent outbreaks is to spray the forest with insecticides. Assume that this would make a smaller fraction of the foliage available for consumption by the budworms, i.e. change the value of \( q \). We can obtain insight about the dynamics of the model for various combinations of \( A \) and \( q \) by continuing the limit points (LP) as a function of these two parameters. Open a 2D-graph with the two parameters on the axis. As initial point now choose one of the limit points that have been computed and continue it.
9. Interpret the graph you have just constructed. To that end, sketch the bifurcation graphs of the density \( N \) as a function of \( A \) for different values of \( q \). What does the point denoted “Cusp” represent? What type of structural change occurs at this particular point?
10. Repeat the limit point continuation for the parameters combination \( A \) and \( P \). \( P \) could be increased by providing more nesting sites for birds. Is this an effective strategy to prevent budworm outbreaks?
10.3 Interspecific competition

Competition is one of the most studied subjects in ecology. It is generally thought to be one of the key factors that shape community structure and dynamics. The foundations of competition between species are illustrated by the following model:

\[
\frac{dN_1}{dt} = r_1 N_1 \left(1 - \frac{N_1 + \beta_{12} N_2}{K_1}\right)
\]

\[
\frac{dN_2}{dt} = r_2 N_2 \left(1 - \frac{N_2 + \beta_{21} N_1}{K_2}\right)
\]

1. Here \(N_1\) and \(N_2\) are competing species. \(r_1\) and \(r_2\) are the growth rates, and \(K_1\) and \(K_2\) are the carrying capacities of species \(N_1\) and \(N_2\) respectively. What is the function of the parameters \(\beta_{12}\) and \(\beta_{21}\)?

2. Examine in MATCONT the behavior of the model (compute orbits for different initial conditions). Set the parameters \(r_1 = r_2 = 0.1, K_1 = K_2 = 100\) and \(\beta_{12} = \beta_{21} = 1.0\). What is going on with these species? Under what condition does one or the other “win” the competition, and why?

3. Compute an orbit starting from \(N_1(0) = 1\) and \(N_2(0) = 3\). Then change the value of \(K_1\) to 101 and compute the orbit anew. What is the difference between these two orbits?

4. Repeat the previous exercise, but now computing the orbits from \(t = 0\) to 7000. The orbit you just computed for \(K_1 = 101\) can be divided into two distinct types of dynamics. Which types? Which processes are important in each?

5. How does the equilibrium you just found depend on \(K_1\)?

6. Use the Excel worksheet “Analysis-2-ODEs.xls” to examine the zero-isoclines and the vector field of the system. Which qualitatively different isocline configurations are possible when \(K_1\) changes, and which types of dynamics do you expect for each configuration?

7. What is the isocline configuration for the symmetrical case \(r_1 = r_2 = 0.1, K_1 = K_2 = 100\) and \(\beta_{12} = \beta_{21} = 1.0\) that you studied above? Does this corroborate your previous results?

8. Calculate the isoclines for \(r_1 = 0.1, r_2 = 0.08, K_1 = K_2 = 100\) and \(\beta_{12} = \beta_{21} = 1.2\). What are the dynamics you expect from the phaseplane analysis? Confirm your expectations in MATCONT.

9. Use MATCONT to construct a graph of all equilibria as a function of the parameter \(K_1\). As starting points you can exploit the fact that both \(N_1 = 0, N_2 = K_2\) and \(N_1 = K_1, N_2 = 0\) are obvious equilibria that might be stable for some ranges of parameters. Use the branching points that you encounter to locate all equilibrium curves. Explain for which ranges of \(K_1\) the equilibria you find represent a stable or an unstable equilibrium.

10. What are the conditions (in words, not math) for coexistence between the species in this model?
10.4 Vegetation catastrophes

In semi-arid regions of the world like the Sahel vegetated areas are slowly giving way to desert regions. One of the hypotheses concerning the disappearance of vegetation cover in these areas is that this is under the influence of grazing pressure from cattle. A mystery has been why vegetated areas do not return when grazing stops.

Semi-arid regions are characterized by sparse rainfall. Plant growth is water limited and so their growth rate is primarily a function of water availability in the soil. Water infiltration into the soil in semi-arid areas has a positive relationship with plant density: the higher vegetation biomass is, the more water infiltrates into the soil.

Rietkerk et al (1997) described vegetation dynamics as a function of water infiltration into the soil, plant growth and herbivory.

\[
\frac{dW}{dt} = W_{in}(P) - c_{max} g(W) P - r_w W
\]

\[
\frac{dP}{dt} = g_{max} g(W) P - d P - b P
\]

\(W_{in}(P)\) is a function describing infiltration of water into the soil as a function of rainfall \((R)\) a half saturation constant \(k_2\), and \(W_o\), the minimum water infiltration in the absence of plants. \(g(W)\) describes the growth of plants as a saturating function of water availability in the soil, with a half saturation constant \(k_1\).

\[
W_{in}(P) = R \frac{P + k_2 W_o}{P + k_2}
\]

\[
g(W) = \frac{W}{W + k_1}
\]

Default parameters are: \(g_{max} = 0.5, k_1 = 3, d = 0.1, c_{max} = 0.05, R = 2, r_w = 0.1, k_2 = 5\). The parameter \(b\) indicates the grazing pressure of cattle on the vegetation (i.e. the herbivory) and is human-controlled.

The main question of this computer lab is how the interplay of grazing and water availability affects vegetation biomass. Steps you may take to investigate this are:

1. Start with a high minimum water infiltration into the soil: \(W_o = 0.9\) and no grazing. Describe the relationship between plant biomass and soil water availability with increasing herbivory. What do the isoclines look like: how do they change with increasing herbivory?

2. How does lowering the minimum water infiltration into the soil (\(W_o = 0.2\)) affect the patterns you see? What happens as grazing pressure increases?

3. Illustrate the different qualitative behaviors of the system with pictures of isoclines. Summarize these different states as a function of \(W_o\) and \(b\).
CHAPTER 10. COMPUTER LABS

10.5 Lotka-Volterra Predation

The classical equations concerning predator-prey interactions (also: consumer-resource interactions) are:

$$\frac{dR}{dt} = rR - aRH$$
$$\frac{dH}{dt} = saRH - \mu H$$

And are attributed to Lotka (1932) and Volterra (1926).

Here $H$ stands for consumers, and $R$ for resources. $r$ is the rate of resource replenishment. $H$ attacks $R$ with a type I functional response (non-saturating: i.e. constant): $a$. The conversion rate of sequestered $R$ biomass to new $H$ individuals is $s$, and $\mu$ is the consumer death rate.

1. What are the possible equilibria? Examine isoclines.

2. Implement the model in MATCONT with parameters $r = 0.5$, $a = 0.2$, $s = 0.5$ and $\mu = 0.1$. Examine the stability of the equilibrium to disturbances: is this equilibrium stable? Unstable? Hint: (look at eigenvalues).


We now assume that resources grow according to the logistic growth model, equilibrating at a carrying capacity $K$ in the absence of consumption by consumers.

4. What are the equilibria now? What can you say about the feasibility of equilibria? Draw isoclines. How has the stability of the equilibria changed?

5. Implement the model (in MATCONT) with parameters as above and $K = 10$. How does the model behave differently from the previous one?

6. Examine equilibria as a function of $K$. Pay special attention to the point “BP” in MATCONT: it marks the intersection of two equilibria, and a subsequent change in stability.

7. Examine the approach to the internal (two-species) equilibrium. What do you notice at small $K (=1.1)$ and at very large $K$?

8. What do you notice about the isoclines at extremely large values of $K$? Why does this happen? Link the behavior of the two models.
10.6 The Paradox of Enrichment

One of man’s greatest effects on ecosystems is caused by non-point pollution of surface waters. Runoff from farms and cities enrich lakes (and other bodies of water) with phosphorous and nitrogen. This has far reaching effects for species composition and the persistence of ecosystems.

We will examine the effects of an increase of nutrient input into a lake populated by phytoplankton "prey" \((P)\) and Daphnia "predators" \((D)\) feeding on phytoplankton.

\[
\frac{dP}{dt} = rP \left(1 - \frac{P}{K}\right) - f(P)D
\]

\[
\frac{dD}{dt} = \epsilon f(P)D - \delta D
\]

Phytoplankton grows logistically with growth rate \(r\) and carrying capacity \(K\). We assume that phytoplankton are nutrient limited, i.e. that a linear increase in phosphorous and nitrogen levels translates into a linear increase in the equilibrium levels that phytoplankton can attain if growing on their own \((K)\). \(f(P)\) is a function determining how many phytoplankton are eaten by Daphnia given an encounter, \(\epsilon\) is the conversion efficiency of phytoplankton to Daphnia biomass, and \(\delta\) is the Daphnia death rate.

1. Assume that Daphnia attack phytoplankton according to a satiating, type II functional response. At low prey densities Daphnia are limited by the amount of prey they can find while at high prey densities, Daphnia are limited by the time it takes to handle and digest a prey individual. A function describing this is:

\[
f(P) = \frac{aP}{1 + aT_h P}
\]

with \(a\), the attack rate and \(T_h\) the time it takes a predator to attack and digest a prey individual.

2. Implement the model first in the Excel worksheet “Fasevlak-2-ODEs.xls”, with parameters \(r = 0.2\), \(\epsilon = 1\), \(a = 0.02\), \(\delta = 0.25\), and \(T_h = 1\). Examine the effect of increasing \(K\). What equilibria are possible? Are they stable/unstable? When is coexistence possible? When not? Now examine your findings in MATCONT. Make several orbits with different initial conditions. What is the effect of increasing carrying capacity?

3. Examine your equilibria as a function of \(K\) in MATCONT.

4. Examine eigenvalues of the model as a function of \(K\). What can you say about the relationship between their values and the observed dynamics of your system with increasing \(K\)? Make a diagram of the types of observed dynamics in relationship to \(K\).

5. What is a Hopf bifurcation?

6. Point out when a Hopf bifurcation occurs in terms of the configuration of your predator/prey isoclines.

7. What is the "paradox of enrichment"?

8. Why does the paradox of enrichment occur? (In words or in math).

9. Construct the Hopf bifurcation boundary as a function of \(K\) and \(\delta\). This boundary separates the parameter combinations for which limit cycles occur from those for which the equilibrium is stable.

10. Sketch with pen and paper a bifurcation diagram as a function of \(\delta\), based on your \((\delta, K)\)-graph and the bifurcation diagram as a function of \(K\).

11. A challenge: Use MATCONT to locate the existence boundary of Daphnia as a function of \(K\) and \(\delta\).

12. Another challenge: Use a 3D-plot to visualize the limit cycle as a function of \(K\).
10.7 The Return of the Paradox of Enrichment

Recall the "paradox of enrichment", where the interactions between Daphnia and phytoplankton lead to destabilization with increasing carrying capacity. The objective of this lab will be to examine the robustness of those conclusions to predation pressure by fish (F) on Daphnia. Fish imposed mortality saturates according to a type III functional response. We assume that fish stocks are constant at $F$.

$$\frac{dP}{dt} = rP \left(1 - \frac{P}{K}\right) - f(P)D$$

$$\frac{dD}{dt} = \epsilon f(P)D - d(D)$$

in which

$$f(P) = \frac{aP}{1 + aT_h P}$$

and

$$d(D) = \delta D + F \frac{D^2}{1 + A_d D^2}$$

Use parameters $r = 2$, $\epsilon = 0.5$, $A_d = 44.444$, $F = 6.667$, $a = 9.1463$, $T_h = 0.667$, $\delta = 0.1$.

NB: There is no particular order in the suggestions a-c given under the study questions.

1. Occurrence and stability of equilibria: Start with the qualitative behavior of the model for different levels of productivity (i.e. different values of $K$, between 0 and 1.0) by studying:
   a). Isocline configurations in the phase-plane (use the Excel spreadsheet).
   b). Time series starting from different initial conditions (use Excel and/or MATCONT).
   c). Bifurcation of equilibria as a function of $K$.
   d). Limit cycles (or the minima and maxima of these) as a function of $K$.
   e). The global behavior of the model.

Make sure you have a picture (mentally or on paper) of the isocline configurations in every different region of $K$.

2. How does the bifurcation graph over $K$ compare to the system without fish predation on Daphnia? (See the computer practical 10.6 The Paradox of Enrichment). Make an explicit comparison of the bifurcation graphs in the two systems and describe the qualitatively different regions.

3. Effects of predator-induced mortality: Continue with the qualitative behavior of the model for different values of $F$, by studying:
   a). Isocline configurations in the phase-plane (use the Excel spreadsheet).
   b). Time series starting from different initial conditions (use Excel and/or MATCONT).
   c). Two-parameter bifurcation of all (3 types of) special points found in the bifurcation over $K$.

Deduce from the two-parameter plot a bifurcation graph of the equilibria in the system as a function of $F$, for different values of $K$; verify your interpretation with the help of MATCONT.

4. Biological interpretation: What is the effect of a top-predator on the paradox of enrichment?
10.8 Cannibalism

The following model describes the dynamics of a cannibalistic population, composed of juveniles $X$ and adults $Y$. The adult individuals eat juveniles in addition to alternative food. After scaling the density and time variables the model can be expressed by the following equations:

\[
\frac{dX}{dt} = \alpha Y - X - XY
\]
\[
\frac{dY}{dt} = X - \frac{\mu}{\rho} + \frac{X}{Y}
\]

in which $\alpha$ is the (scaled) fecundity of adult individuals; $\rho$ the (scaled) availability of alternative, non-cannibalistic food for the adults and $\mu$ represents the constant mortality rate of the adults.

Analyze the model described above, such that you understand as much as possible which type of dynamics the model can exhibit for different parameter values. Use both Excel (worksheet “LV1_Fasevlak-2-ODEs.xls”) and MATCONT to develop this understanding.

Here are some useful guidelines:

1. Use as default parameters: $\alpha = 0.4$, $\mu = 0.05$ and $\rho = 0.05$.
2. Use Excel to construct isocline graphs.
3. To get an initial understanding compute orbits for different starting values of $X$ and $Y$. Use $\rho = 0.05$ as parameter value.
4. Construct bifurcation graphs as a function of $\rho$ for different values of $\mu$. Sketch these graphs, while indicating which equilibria are stable and which are not.
5. If you encounter any bifurcation points (limit points) construct a graph that shows the location of this bifurcation point as a function of two parameters, for example, as function of $\mu$ and $\rho$. 

10.9 A predator-prey model with density-dependent prey development

Consider a prey population that is subdivided into juveniles and adults. We will denote the densities of juvenile and adult prey by $J$ and $A$, respectively. We will assume that adult prey produce offspring at a per capita rate $\beta$, while juvenile and adult prey die at a per capita rate of $\mu_j$ and $\mu_a$, respectively. Both reproduction and mortality are hence density-independent processes. The regulation of the prey population in the absence of any predator is assumed to operate through density-dependent development. The per capita rate of maturation from juvenile to adult is assumed to follow the function:

$$\frac{\phi}{1 + dJ^2}$$

1. Formulate the system of two differential equations describing the dynamics of juvenile and adult prey density $J$ and $A$, respectively.

Take as default values for the parameters: $\beta$ varying between 0.2 and 1.5, $\phi = 1$, $d = 1$, $\mu_j$ varying between 0 and 0.15 and $\mu_a = 0.2$.

2. Investigate the properties of the model as completely as possible, focusing on the influence of the parameters $\beta$ and $\mu_j$.

We will assume that predators, indicated with the variable $P$, of this prey population only attack adult prey following a linear functional response with an attack rate equal to $a = 1$ (default value). Predators convert the prey biomass they consume into offspring with conversion efficiency $\epsilon$ equal to 1.0. Predators experience a per capita death rate of $\delta$ per unit of time.

3. Formulate the system of three differential equations describing the dynamics of juvenile and adult prey density $J$ and $A$ and their predators $P$, respectively.

4. Investigate the properties of the model taking $\delta$ as a bifurcation parameter for different values of $\beta$ and $\mu_j$.

5. In total there are 4 different parameter regions to be found, in which the number and type of equilibria differs from the other regions. Try to localize these 4 different areas by computing the boundaries between these regions as a function of $\beta$ and $\mu_j$.

Extra: Now assume that in addition to a predator on adults, there is also a predator population, indicated with the variable $Q$, which exclusively forages on juvenile prey. Again assume a linear functional response with an attack rate symbolized by $b = 1$. Furthermore, assume that the conversion efficiency of this predator on juveniles equals $m$.

6. Formulate the system of 4 differential equations and investigate its properties.


Index

$\mathbb{R}^n$-theory, 59
$R_0$, 138
i-state, 9
p-state, 8
age distribution, 8
age structure, 5
Allee effect, 28
basin of attraction, 27
bifurcation, 133
bifurcation analysis, 24
Bifurcation theory, 133
branching point, 133, 142
characteristic equation, 32, 82
closed populations, 11
closed systems, 11
competition, 37
competition theory, 58
competitive exclusion principle, 60
consumption vector, 61
continuous-time models, 13
density independent, 15
deterministic models, 19
direction field, 47
direction vector, 47
discrete-time models, 19
eigenvalue, 32
eigenvalues, 57
eigenvector, 59
emigration, 11
equilibrium, 24
essential resources, 61
exploitation competition, 37
functional response, 108
globally stable, 28
Hopf-bifurcation, 145
immigration, 11
individual state, 9
initial state, 14
interference competition, 57
interspecific competition, 37
invariant loop, 116
isocline, 14, 45
Jacobian, 51
law of large numbers, 19
law of mass action, 17
limit cycle, 145
limit point, 143
linear differential equation, 22
linear stability analysis, 31
linear stability theory, 77
local linearization, 51
local stability, 27, 77
locally stable, 27
Malthusian parameter, 16
mass action law, 17
model analysis, 21
Mont Carlo, 19
neutral center, 94
neutrally stable, 94
non-linear differential equation, 22
nullclines, 17
numerical integration, 23
numerical integration methods, 23
open populations, 11
open systems, 11
ordinary differential equation, 14
Paradox-of-Enrichment, 118
parameter, 18
per capita birth rate, 14
per capita death rate, 14
phase plane, 45
phase plane portrait, 47
phase space, 45
population abundance, 8
population balance equation, 10
population birth rate, 14
population death rate, 14
population size, 8
population state, 8, 12
population structure, 8, 12
position vector, 17
pseudo-steady-state, 111
resource, 87
Rosenzweig-MacArthur model, 111
Routh-Hurwitz criteria, 18
saddle node, 89
saddle point, 27, 50, 89
saddle-node bifurcation, 143
separatrix, 27
sink, 88
source, 89
stable equilibrium, 26
stable node, 85
stable spiral point, 93
state space, 45
state variables, 18
steady state, 25, 28
stochastic models, 19
Structural stability, 108
structurally stable, 108
structured population models, 12
substitutable resources, 61
superposition principle, 51

Taylor expansion, 29
time budget, 110
trajectory, 19
transcritical bifurcation, 133, 142
trial solution, 81, 81
type II functional response, 108

unstable node, 89
unstable spiral point, 93
unstructured population models, 12
velocity vector, 47
wash-out, 62
zero net growth isocline, 62